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Introduction

This reference manual describes how to install and configure the OpX broadcast-automation
system from Broadcast Software International (BSI). OpX has been designed from the
ground up to deliver superior performance in single and multi-station environments. OpX
offers an intuitive on-air environment, with full touch-screen capability, simple yet powerful
voicetracking, and an easy-to-use production interface.

Before using this manual, familiarize yourself with the Table of Contents on page 3. All first-
time users should read Chapter 1. A glossary of terms appears in Appendix C - Glossary
and troubleshooting suggestions are in Chapter 20.

Audience

This guide is intended for the person who installs, uses, and maintains the OpX software.
This document assumes the reader has moderate hardware, computer, and Internet skills.

Document Revision Level

This section provides a history of the revision changes to this document.

Revision Document Version Date Description

A Version 2 April 21, 2016 Initial release
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Introduction

Changes in this Revision

Created new format and organization.

Added the following new modules:

FTP Server

UMix

Data Repeater

Remote Voice track Transfer

Mobile Gateway/Client
Stinger

AS Watchdog

Document Conventions

This guide uses the following conventions to draw your attention to certain information.

Safety and Warnings

This guide uses the following symbols to draw your attention to certain information.

Symbol Meaning Description
1'-., Note Notes emphasize or supplement important points of the main text.
Tip Tips provide helpful information, guidelines, or suggestions for performing tasks more
effectively.
.\ Warning Warnings indicate that failure to take a specified action could result in damage to the
(e ) device, or could result in serious bodily injury.
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Typographic Conventions

This guide also uses the following typographic conventions.

Convention Description

Bold Indicates text on a window, other than the window title, including menus, menu options, buttons, fields, and labels.

Italic Indicates a variable, which is a placeholder for actual text provided by the user or system. Angled brackets (< >)
are also used to indicate variables.

screen/code | Indicates text that is displayed on screen or entered by the user.

> bracket Indicates a shortcut for selecting menu options. For example, Edit > Settings means to select the Settings option
from the Edit menu.

<> angled Indicates a variable, which is a placeholder for actual text provided by the user or system. Italic font is also used to

brackets indicate variables.

[1square Indicates optional values.

brackets

{} braces Indicates required or expected values.

| vertical bar Indicates that you have a choice between two or more options or arguments.
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1 Product Overview

Topics: This chapter provides an overview of the OpX broadcast-
automation system.
4 OpX Modules (page 16) y
4 Matching User Tasks with
Modules (page 17)
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Product Overview

1.1 OpX Modules

OpX is composed of separate modules. Each module can run on the same computer for
single-station installations, or they can run on separate computers for redundancy and multi-
station cluster setups.

Table 1-1 describes the OpX modules. For more information about a module, go to the page

in the “See Page” column.

Table 1-1. OpX Modules

Module Description See Page
File Server Tracks your audio files, their locations and attributes, stations to which they 44
belong, and data transfer between OpX Audio Servers and OpX Studio Clients.
Audio Server Plays logs, executes macros, and performs record functions. 60
Auxiliary Audio Server Same as the main audio server, except that a studio client cannot connect to it. 134
This module can do background recording, as well as run a full station.
Studio Client Controls the audio server logs, plays back Hot Keys and used in voicetracking. 136
File Manager Performs all Info Editor functions, with the added ability to transfer files. 189
Clock Builder Creates clock templates. 219
Import-Merge Imports program logs from traffic- and music log-generating software, and merges 265
them into a single log along with clocks generated by the Clock Builder module.
Info Editor Creates and modifies audio file tags. Also, sets intro and segue points of cuts. 303
File Sync Transfers files between the file server and clients. 316
Serial Device Server Allows a serial device, such as an audio switcher or trigger interface, to be shared 326
between stations over your local-area network.
Allow Stations Module Limits station profiles availability to OpX modules on the local machine. 342
FTP Server Transfers files to audio servers. 350
UMix Virtual mixer for incoming audio feeds from satellites and Internet streams. 359
Data Repeater Takes the PAD data output from the audio server, reformats the output if 370
necessary, and sends it to multiple destinations, such as RDS or stream
encoders.
Mobile Gateway/Client Used for IOS remote operation. 383
o The gateway runs on the OpX network and allows access from the 10S device.
o The client is the software that runs on the I0S device.
Stinger Updates Hot Keys in real time across multiple clients. 391
AS Watchdog Monitors the audio server process and restarts the Audio Server module if the 418
module becomes nonresponsive.
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1.2 Matching User Tasks with Modules

The information in this guide is designed so that you can begin using OpX modules in the
shortest possible time, without having to read the entire guide. In fact, you might not have to
read some chapters and appendixes, except out of curiosity. To find out which chapters and
appendixes you need to read, identify the type of reader you are in Table 1-2.

Table 1-2. Matching Readers with Modules

Chapter User Type
On-Air Satellite Program Engineer Traffic Support
Personality Program User Director Personnel | Technician

2 [ )

3 [ )

4 ® ) ) )

5 ® ) ) )

6 ® ) ) o

7 ® ) () )

8 ® ) ) () )

9 ® ) ) () )

10 [ [ )

11 ® ) ()

12 ° [ [ )

13 [ )

14 [ )

15 ® ) ()

16 [ )

17 [ )

18 ® ) o

19 [ )

20 ® ® ) ()

Appendix On-Air Satellite Program Engineer Traffic Support
Personality Program User Director Personnel Technician

A [ )

B ® o

C [ )

D [ [ ] [ ] [ ] [ J
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Topics:

A

Installation Configurations
(page 19)

System Requirements
(page 24)

Installation Instructions
(page 25)

Installing the USB

Registration Key (page
35)

Registering Your OpX
System (page 41)
Modifying the Current

Authorization Code (page
42)

Where to Go from Here
(page 43)

2 Installing the OpX Software

This chapter describes how to install the OpX software.
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Installing the OpX Software

2.1 Installation Configurations

OpX supports several installation configurations. Because OpX is modular, you can run all of
its components from a single computer or divide the modules between several computers in
varying degrees. For the most common setup variations, see figures 14.1, 14.2, 14.3, 14.4,
and 14.5. Because the Studio Client, Audio Server, and File Server are separate modules,
there are other setup configurations possible. Production workstations can also be added
(see Figure 14.6 for an example).

2.1.1 Single Workstation/Single Station

Figure 2-1 shows the simplest installation configuration, where all modules are installed and
run from a single machine. This installation is the easiest to maintain, but offers the least
flexibility. If your hardware fails, there is not a quick way to get your station back on the air
quickly.

Figure 2-1. All-in-One Configuration

2.1.2 Dual Workstation/Single Station

Figure 2-2 shows an installation where the File Server is installed on a second computer and
the Audio Server is installed on both computers, but run on only one server at a time. This
arrangement offers redundancy by enabling you to switch the computer quickly that is
creating your audio output in case of hardware failure. If the Studio client fails for any
reason, such as from a hard drive failure, the Audio Server can be opened and run on the
File Server to get you back on the air until the hardware issue is corrected on the Studio
Client workstation.
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Studio Client File Server

Figure 2-2. Dual Workstation/Single Station Configuration

2.1.3 Triple Workstation/Single Station

Figure 2-3 shows the most expanded and highly redundant installation configuration for a
single station. In this configuration, the Audio Server module and Studio Client module are
installed on all workstations, but active on only one workstation at a time. A hardware failure
on the Studio Client or Audio Server will not render the system inoperable. This configuration
is also recommended if you will add other OpX stations to your cluster at a later time.

You can also install the File Server on multiple machines, have the active version running on
one workstation at a time, and then use File Sync, OpX’s file-mirroring utility, to keep a
completely redundant set of audio files and program logs. If your main file server has a
hardware failure, you can close the File Server module on the main file server workstation,
open it on your secondary file server workstation, and you'll be back up and running in no
time.
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(W )

Studio Client Audio Server File Server

Network

Figure 2-3. Triple Workstation/Single Station Configuration

2.1.4 Simple Multi-Station

Figure 2-4 shows the simplest configuration for a multi-station cluster. The on-air
workstations have both the Studio Client module and the Audio Server module installed. The
File Server module is installed on its own workstation. All the on-air workstations access the
audio files and program logs on the file server through the network.

Figure 2-4. Simple Multi-Station Configuration

Page 21 of 487



Installing the OpX Software

2.1.5 Robust Multi-Station

Figure 2-5 shows the most robust installation supported:

«  The on-air workstations only have the Studio Client module installed.

- The Audio Server workstations have only the Audio Server module installed.

- The file server houses all the audio and program logs for all the workstations to access.

With this arrangement, multiple Studio Clients and Audio Servers can access the file server
and run their own program logs, have their own audio, and share some audio. New Studio
Clients and Audio Servers can be added to expand your cluster at any time, and extra
Studio Clients can be added to your production room. As in Figure 2-2 on page 20, the
Studio Client and Audio Server can be installed on redundant machines for quick recovery in
case of hardware failure.

Studio Client 2

Network

Audio Server 1 Audio Server 2 Audio Server 3 File Server

Figure 2-5. Robust Multi-Station Configuration
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2.1.6 Production Workstation

An OpX production workstation is a workstation with the Studio Client module installed along
with the utility modules: Clock Builder, Import-Merge, and File Manager. The production
workstation will access all the same audio and program logs as the on-air workstations. OpX
production workstations can be added to your network, so you can import logs and voice
track independently of the on-air workstations.

Q Tip: Because any Studio Client can access all the Audio Servers on your
network, a Studio Client can control or perform production work for any other
station. If your on-air workstation has a hardware failure, or if you need to
perform maintenance, you can run your station from a production workstation.

Production Workstation(s)

| OnArOpX |
{ -
|
| OnAirOpX | | OnArrOpX || FileServer |

Figure 2-6. Production Workstation Configuration
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2.2 System Requirements

OpX was designed and tested with the specifications in Table 2-1. Using hardware that has
not been tested and certified by BSI can cause issues that can be avoided by using the

following specifications.

Table 2-1. System Requirements

Specification

Description

Processor Intel Xeon i5 or i7
RAM 4GB
File server File server with hard drive for operating system and applications, with one or more separate hard

drives for audio files. For clients/audio servers, use RAID 1. For file server, use RAID 10.

Operating system

o Microsoft Windows 7

o Microsoft Windows 10
 Microsoft Windows Server 2008
o Microsoft Windows Server 2012

Network Two Gigabit Ethernet network-interface cards (NICs) and switches

Audio cards AudioScience 5xxx and 6xxx series PCl and PCle audio cards, including:
o Digital and analog audio cards
o Livewire cards
o AXIA or WheatStone AolP drivers

Broadcast tools e SS8.2 - 8-channel audio switcher/16 channel GPIO

e SS16.4 - 16-channel audio switcher/24 channel GPIO
o ACS 8.2 — 8-channel audio switcher/16 channel GPIO
e GPI-32 - 32-channel GPI

e SRC 8-lll - 8-channel GPIO

e SRC 16 - 16-channel GPIO

Miscellaneous

o Telos Axia audio drivers:

- Analog and digital audio nodes GPIO nodes
— Element control surfaces

o Audio nodes
o Control surfaces
e GPIO nodes

Audio files

o All audio files must have the same sample rate: 44.1 kHz, 32 kHz, or 22.05 kHz. If you have
audio files with differing sample rates, convert the files to a single sample rate. Tools such as
Adobe Audition have a batch-convert function to convert the sample rate for multiple audio files.

 You can mix mono and stereo audio files, as long as they are the same sample rate.
o OpX supports PCM wave 16-bit, MPEG 1 layer 2 (AKA MPEG 2), and mp3 audio files as long as:

— A suitable Windows ACM codec is installed for compressed format audio files, and

— The extension of each audio file is .wav (for example, “my audio file.wav”), even if the audio
file is formatted as an mpeg 2 or mp3 internally.
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2.3 Installation Instructions

This section provides instructions for installing the OpX software.
Before you install the OpX software:

+ Identify the installation configuration in section 2.1 that is best suited to your
requirements.

- Identify two static IP addresses that are available for use: one for the local PC on which
you will install the software and one for the OpX file server. These are long-term IP
addresses that must remain static during the entire time you use OpX. The installation
uses this information in the configuration files and shortcuts.

@ Tip: If you want to add modules to an OpX workstation at a later time, run the
installer again and add just the modules you want. If you accidentally add a
module that is already installed, do not worry. The installer will not overwrite
your configuration and preferences for existing modules.

> To install the OpX software
1. Exit all Windows programs.
2. Obtain the OpX_Setup executable file and double-click it.

The Welcome screen appears.
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OpX 1.6.5

W'elcome to the installer for Opi< 1.6.5.

It iz strongly recommended that pou ext all Windows programs
before continuing with thiz installation.

[f your havve ary athier programs running, please click Cancel and
cloze thoze programs before restarting thiz installer.

Othermize, chck Mest to cantinue.

[ M et = ] [ Cancel

3. Click Next.

The license agreement appears.
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License Agreement
Pleaze read the licenze agreement below and click Mest to continue.

ATTEMTION: PLEASE READ THIS DOCUMENT CAREFULLY. THE -
INDIMADUAL OR EXTITY IMSTALLIMG THIS SOFTWARE [the "End-User") M
AGREES TO BE BOUMD BY THE TERMS OF THIS LICENSE AND SUPPORT  —
AGREEMEMT. IF%0U DO MOT AGREE TO THE TERMS OF THIS LICEMSE

AMD SUPPORT AGREEMEMT. REMOYE THIS SOFTWARE FROM ¥OUR
SYSTEM, DO WOT USE THE SOFTwWARE AMD PROMPTLY RETURN THE
SOFTWARE PACKAGE ANDITS COMTEMTS, AWD THE LICEMSE PRICE 'WILL

BEE REFUNDED.
BROADCAST SOFTWARE INTERMATIONAL
SOFTwWARE LICENSE AMD TECHMICAL SUPPORT AGREEMEMT

(") | agree ta the terms of thiz license agreement

@) | do ot agree to the temms of this icense agreement

4. Read the license agreement, and then click | agree to the terms of this license
agreement.

‘j Note: You must agree to the terms to proceed with the installation.

5. Click Next.
You are prompted to select the options you want to install on this computer.
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Select Options

Select the optionz below and click Mest to continue.

Please zelect the options below:

Inztall File Server
Inctall udio Server
Inztall Studio Client

Inztall File Manager, Import/terge, Clock Builder

[ < Back ][ Memt » ] [ Cancel

6. Check the options you want to install on this computer. Click Next.

You are prompted for a folder where the selected options will be installed.
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povsor I ==

Installation Folder

Select an inztallation falder and chck Mest to continue.

The zaftware will be installed in the folder izted below. Ta install to a different falder,
either lwpe in a new path, or click Change to browse for an existing folder.

Inztall Ope to:

:"Frogram File WBroadcast Software |ntermationalt0 pe Change. ..

Space required on drive: 623 B
Space available on selected drive: 408692 MEB
[ < Back ][ Mext » ] [ Cancel ]

7. Accept the default location shown, or enter a different location or click the Change button
and select the location where you want to install the OpX options.

The bottom of the page shows the amount of space required to install the selected
options and the amount of space available on the selected drive.

8. Click Next.

You are prompted for IP addresses of the local system and the OpX file server system.

d Note: If you need to change the IP address of the OpX file server system, use
Edit > Settings in the OpX File Server module (see section 3.3).
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Enter Data

Fill i the items below and click Nest bo continue.

Pleaze provide the following infarmatian:

YWhat iz the P address of the local system?
"What iz the IP address of the Op file zerver system?
10.1.1.10

[ < Back ][ Mext » ] [ Cancel

9. Enter the IP addresses in their respective fields, and then click Next.

You are prompted to select a shortcut folder.
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Shortcut Folder

Select a shartcut folder and click Nest to continue.

Setup will add shortcut iconz to the folder indicated below. |f you don't want to uze the
default folder, pou can either lype a new name, or zelect an existing folder from the list.
For T, 2000 and =P uzers the folder will be created in the cument uzer's profile.

Shartcut Falder:

Broadc ] -

[ < Back “ Mext = ] [ Cancel ]

10. Accept the default folder shown or select a different folder, and then click Next.

The Ready to Install screen tells you that there is enough information to install OpX on
your computer.
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Ready to Install
Y'ou are now ready to install Ops 1.6.5.

The inztaller now has enough information ta install Dpe on vour complter,
T he follawing settingz will be uzed:
Inztall folder: C:hProgram Files [#86)\Broadzast Software InternationalsO pe

Shortcut folder: Broadcast Software

Pleaze click Mest to proceed with the installation.

[ < Back “ Mext = J [ Cancel ]

To review or change your settings, click Back until you reach the appropriate screen,
make the required changes, and then click Next until the screen above appears.

Click Next to install OpX using the settings you specified. The OpX software is installed
and the Installation Complete screen appears.
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Inztallation Complete

Inztallation completed successfully.

Op 1.6.5 haz been succesziully installed on your spstem.

Fleaze click Finizh to exit this installer,

| Finizh

Click Finish to close the screen.

Change the permissions of the BSI folder in %PROGRAMFILES% so that everyone can
modify the folder. Otherwise, the system places user data in %PROGRAMDATA% instead of
%PROGRAMFILES%. For Microsoft Windows systems:

a. Right-click the BSI folder, click Properties.
b. Click the Security tab, and then click the Edit button.
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. Permissions for Common Files @

Security

Object name:  C:\Program Files"Common Files

Group or user names:

“ ACREATOR OWNER

82 5YSTEM

.‘.?JMministmtors ftest-PC\Administrators)
82, Users fest-PC\Users)

82 Trustedinstaller

Permissions for CREATOR

OWNER Alow Deny

Full control & (&

Modify (] (]

Read & exscute o 0o
[l l
O O

List folder contents
Read

Leam about access control and pemissions

[ ok || cancel || sppy

c. Click the Add button.

d. At the Select Users or Groups dialog box, type Everyone in the Enter the object
names to select field.

e. Click Check Names.

f. At the Permissions for VNC Shortcuts dialog box, click Everyone in the Security tab,
check Modify in the Allow column, and click OK.

15. Proceed to the next section to register your OpX system.
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2.4 Installing the USB Registration Key

After you install the OpX software, you install the USB registration key. Registration is
performed using a hardware registration key on the supplied Universal Serial Bus (USB)
memory (data) stick.

The hardware key requires a software diver called the Sentinel Protection Windows driver in
order for the File Server to access the hardware. The driver can be provided on a BSI
installation CD (see section 2.4.1) or downloaded from the Drivers page on the BSI website
(see section 2.4.2). Always ensure that you have the latest BSI-tested driver when
purchasing a new product.

¢! Note: Install the driver and USB registration key and driver on your File Server
_ workstation only. Other BSI products may require their own hardware key. Only one
hardware key can be installed per workstation. If you received multiple registration
keys for BSI products you intend to run on a single machine, contact BSI Sales.

!\ Warning: Do not insert the registration key into a USB port on your file server until
the Windows software driver is installed using the following procedure.

2.4.1 Installing the driver from the BSI Installation CD

The following procedure describes how to install the Sentinel Protection Windows driver
from a BSI Installation CD. If you downloaded the driver from the BSI website, use the drive-
installation instructions in section 2.4.2 instead.

> To install the driver from the BSI Installation CD
1. Insert the supplied CD into your computer's CD-ROM or DVD-ROM drive.

The BSI utility launches automatically. In the unlikely event that the BSI utility does not
launch, use Windows Explorer to browse to your computer’'s CD-ROM or DVD-ROM
drive and double-click the Install.exe file on the CD. The application selection window
appears.
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2. Using the Application drop-down list, click Sentinel Protection Installer — for BSI
Dongle. This is the first option from the drop-down list.

3. Click Install.

4. Proceed to section 2.4.3 to install the Sentinel Protection Windows driver.

2.4.2 Downloading the Driver from the BSI Website

The following procedure describes how to install the Sentinel Protection Windows driver
from a BSI Installation CD. To install the driver from CD, use the drive-installation
instructions in section 2.4.1 instead.

1. Launch a web browser and go to the BSI Drivers page at http://www.bsiusa.com.

2. Download the driver into a new folder.

3. After downloading the driver, extract the files into the new folder.
4. Double-click the .exe file that was extracted in the previous step.
5

. Proceed to section 2.4.3 to install the Sentinel Protection Windows driver.

2.4.3 Installing the Sentinel Protection Windows Driver

After starting the Sentinel Protection Installer from the BSI Installation CD or by downloading
from the internet, use the following procedure to complete the installation.


http://www.bsiusa.com/

Installing the OpX Software

» To install the Sentinel Protection Windows driver

1. If the following security warning appears, click the Run button.

File Download - Security Warning 3 x|

Do you want to run this file?

Mame: Sentinel Protection Installer 7.5.0.exe
I- Publizher: SafeMet, Inc.

Type:  Application

'- Yhile filez from the Internet can be useful, thiz file type can
g potentially harm vour computer. Dol win software from publishers
wou brust, What's the risk?

2. At the next screen, click Next.

i?._% Sentinel Protection Installer 7.5.0 - InstallShield Wizard x|

Welcome to the InstallShield Wizard for
Sentinel Protection Installer 7.5.0

The Installhield{R) Wizard will install Sentinel Protection
Installer 7.5.0 on your computer. To continue, click Mext.

Senﬁwel

Protection Installer

= Back Cancel

3. When the License Agreement page appears, read the Software License Agreement. If
you agree to its terms, click the | accept radio button, and then click Next.

qj Note: You must agree to the terms to continue with the installation.
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{&? Sentinel Protection Installer 7.5.0 - InstallShield Wizard

License Agreement 2 s : lﬁ '.

Protection Installer

Please read the Following license agreement carefully.

License GrantWarranty for Software i’

This License describes limited rights granted by SafeMet, Inc. andfor one of its
subsidiaties (such grantor, "Seller”) to the Buyer.

A.  The term "Software”, as used herein, shall mean a program or programs
consisting of machine readable logical instruction and tables of infarmation
designed as libraries or drivers to work in conjunction with Seller's Sentinel

Keys ("Products’). Title to all Software furnished to Buyer hereunder shall i

USRS PSP oy Y | DN oy D | SPPRRYURPY SO ) PRSPV PY PRSPV SUG oy Ky 1y

% T accept the terms in the license agreement: Brint |

" 1 donot accept the terms in the license agresment

Installshisld

< Back I Mext = I Cancel |

4. Atthe Setup Type page, click Custom, and then click Next.

{&? Sentinel Protection Installer 7.5.0 - InstallShield Wizard

Ilx

Setup Type 2 s : lﬁ '.
Protection Installer
Flease select a setup tvpe,
" Complete
[ All pragram Features will be installed. {Requires the most disk

space.)

Choose which program features vou wank to install, Recommended
for advanced users,

Installshisld

< Back I Mext = I Cancel

5. At the Custom Setup page, disable all options for installing the Sentinel Protection Server
driver component and the Sentinel Keys Server driver component by clicking the
Selection button, and then clicking This feature will not be available, as shown below.

Page 38 of 487



Installing the OpX Software

i@ Sentinel Protection Installer 7.5.0 - InstallShield Wi x|
—
Custom Setup - s < li ’
Select the program Featur mant installed, i . Protection .fnsraﬂér

Click on an icon in the list below to change how a feature is installed.

Feature Description

The network license manager for
) protected applications with

= - | USE System Driver Sentinel Hardware Keys.

¥~ | Sentinel Protection Server
Sentir weEr

=) This feature will be inskalled onlocal hard drive,

B2 YI Sentinel System Drivers
i (=) = | Parallel Driver

=3B This feature, and all subfeatures, will be installed on local hard drive.

This Feakure will nat be available,

Install ko
CiiPragram FilesiCommon FilesiSafelet SentinehSentinel Yeyvs Server),

Installshield

Help Space | = Back I Mext = I Cancel

6. Click Next.

The installer is ready to copy its files to your computer’s hard drive.

{&# Sentinel Protection Installer 7.5

Ilx

Ready to Install the Program 5 s 2 i

rd is * bo begin installation, Protection .fnsra.fk;r

Click Install to begin the installation.

If ywou want ko review or change any of your installation settings, click Back. Click Cancel ko
exit the wizard,

Installshisld

< Back

Cancel |

7. Click Install.
The files are copied to your hard drive.

8. After the Sentinel Protection driver is installed, click Finish at the InstallShield Wizard
Complete page to complete the installation.
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|§- Sentinel Protection Installer 7.5.0 - InstallShield Wizard x|

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Sentinel
Protection Inskaller 7.5.0, Click Finish to exit the wizard,

Protection Installer

= Back Garncel

9. Reboot your computer.

10. After the computer reboots, insert the USB memory stick into an available USB port on
your computer.

Windows detects the hardware key and displays the Found New Hardware message in
the system tray.

1) Found New Hardware |X

SafeMet USE SuperProfUlkraPro

11. You now have installed the USB Registration Key. Proceed to section 2.5 to enter the
Validation Code to register your OpX system.
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2.5 Registering Your OpX System

OpX is licensed by the number of Audio Servers (or “stations”) you can run concurrently.
The File Server module handles registration information for your OpX system. The
registration (or “validation”) code you received when you purchased your OpX system
determines the number of Audio Servers the File Server will allow to connect at the same
time.

Neither the number of station profiles you can define on the File Server, nor the number of
Studio Clients (or any other OpX module) you can run, is limited in any way. Only the
number of Audio Servers that can be run at the same time are limited by your registration
license.

Before you enter your registration code into the OpX File Server module, you must install the
Sentinel Protection driver, which is the driver for the USB Registration Key (see section 2.4).
If you have not already done so, install the driver, and then register your OpX system.

> To register your OpX system

1. Insert the USB Registration Key driver into an available USB port on the workstation
running the OpX File Server module.

a9
\ﬁ.

2. Click the Windows Start menu and click Programs > Broadcast Software > OpX File
Server.

The OpX File Server module opens and the Register page prompts you for an
authorization code.

¢ Note: Inthe unlikely event the Register page does not appear, go to the Edit menu
in the File Server module and click Register.
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3. Enter your authorization code in the Authorization Code field. The authorization code
consists of five sets of four digits, separated by dashes (for example, ###HE-HHHH-HHEHE-
#H##-H#H##H##). Your authorization code is provided by your OpX Distributor. If you do not
have an Authorization Code, or if you lost it, contact your distributor or BSI sales.

CETEE— x|

Sensl Numbes
[6018-014E-2E72-850C I

Austhonization Code

| o

[Zo] _xcoms]

Figure 2-7. Register Window

4. After you enter your authorization code, click OK.

Your OpX system is registered and your File Server is now ready to accept connections from
Audio Servers, Studio Clients, and all other OpX modules.

2.6 Modifying the Current Authorization Code

In the unlikely event that your authorization code is not accepted, or if you want to modify
your authorization code because you purchased an upgrade registration with more stations:

1. Go to the Edit menu in the File Server module and click Register.

The Register window in Figure 2-7 appears.
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2. Inthe Authorization Code field, enter your new authorization code, and then click OK.

3. Restart the File Server for your changes to take effect.

2.7 Where to Go from Here

You have now installed OpX on your workstation. If you are installing all the components of
OpX on a single workstation for a single workstation/single station installation (as in Figure

2-1 on page 19), you have finished the installation.

If you are installing the OpX modules across multiple workstations, repeat the procedure in
section 2.3 for each workstation. After you finish installing OpX on all your workstations, you
are ready to configure the modules. Proceed to the remaining chapters in this guide for
information about configuring the OpX modules you intend to use. For assistance matching

users and modules, see Table 1-2 on page 17.
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Topics:

A

Starting the File Server
Module (page 45)

Quick Tour (page 46)

Configuring the File
Server Module (page 51)

Adding and Removing
Stations (page 52)

Enabling or Disabling the
Virtual Audio Server (page
57)

Enabling or Disabling the
Voicetrack Transfer
Module (page 58)

Remote Voice Track
Transfer Module (page
59)

3 File Server Module

This chapter describes the OpX File Server module.

The OpX File Server module acts as the traffic cop that
oversees the repository for all your audio files and
configuration files. The File Server tracks your audio
files, their locations, their attributes (Artist, Title, Genre,
etc.), the stations to which they belong, and data transfer
to and from the OpX Audio Servers and OpX Studio
Client. An OpX system contains a singular OpX File
Server, regardless of whether your system is a single
station or a multi-station cluster.
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3.1 Starting the File Server Module

The File Server module is the foundation of the OpX system. It directs communications
between the other OpX modules. Therefore, you must start the File Server module before
you start any other OpX module.

> To start the File Server module

1. In an available Universal Serial Bus (USB) port on your PC, insert the supplied dongle
containing the OpX serial number and authentication code.

2. Onyour PC, click the Start button on the Windows taskbar, and then click Programs >
Broadcast Software > OpX File Server.

An OpX File Server window similar to the following appears. The first time the window
appears, it will be empty.

T4 OpX File Server - REGISTERED o & |3
File Edit About

Q ©
Al L 4 )

TCP Connections O

FTP Connections 0

v0.0.0.169

¢ Note: If the message Security key / driver is not installed appears, see
section 20.1.
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3.2 Quick Tour

The following sections provide a quick tour of the File Server module interface.

rri OpX File Server - Registered - 10 Stations

O 3 & Qh S

>

TCP Cannectins 2 wBSl | WBSIRECORD | § wOPX e | v —m @
:}g” :Ilg “All Justin's mugic. all the timel™
Folder Cantents Diescription
DA0pASpots. SPOTS Spots
DoADpAMews AUDIO Mews
D:MOpA\Records RECORDS Recordsz
D:40p<sSharedConfig SHAREDCOMFIG  Shared Configuration
D:AOpsKIUB S Music MUSIC Music e
9 D:AOph K UBY Logs LOGS Program Logs @
_ DA K UBYRunLogs RUNLOGS Fun Logs
MDA UBYCarts CARTS Carts
DoMO K UB Y Hotkeys HOTKEYS Hotkeys
MO AR UBYYoicetracks WOICETRALCKS Woicetracks
ETF Carnentions 1 DeAD A UBM Conlig COMFIG Configuration
e e DA AR UBAT emparary TEMPORARY Temporary
101110 LMD KU maging AUDID Imagirg
DebOpAIUBNFll FILL Fill M aterial
D:AOp<AKIUBNLiners AUDID Liners
D:AOpskIUB NS ingles AUDID Jingles
D:40peAKIUB Pramos AUDID Promos
V0.0.0, 141  (— o
Number Description

Menu bar. See section 3.2.1.

Tool bar. See section 3.2.2.

Connection list. See section 3.2.3.

File Server module version.

Station folder list. See section 3.2.4.

© 00600

Each station appears as a tab. Click the tab to view the contents in the station folder. If the
number of folders exceeds what can be shown, use the - or 1% button to scroll left or
right.
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3.2.1 Menu Bar

The menu bar appears at the top of the File Server window. The following sections describe
the menu options.

3.2.1.1 File Menu

Enable Remove Voicetrack Stations =

Edit About enables or disables the Audio Server to allow
Enable Remote Voicetrack Stations studio clients to edit voice tracks on other OpX
Enable Remote Voicetrack Transfer system locations. See section 3.5.

Exit Enable Remove Voicetrack Transfer =

enables or disables the Voicetrack Transfer
module. This module updates your local OpX
File Server with the latest voicetrack and log
information from remote OpX systems. See
section 3.6.

Exit = exits the File Server module.

3.2.1.2 Edit Menu

Settings = configures File Server module
File About settings. See section 3.3.

Setti : :
=" Register = shows the serial number and

validation code for your OpX software. If the
message Security key / driver is not
installed appears, see section 20.1.

Register

3.2.1.3 About Menu

Opens a window that shows the version and
File Edit [About| build date of the File Server module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the File Server
module has been running. See Figure 3-1 for
an example. To close the window, click OK.
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w[.0.0.163 s

Build D ate:;
Aug 11 2014 07:24:00

bemaory Uzage:;
11.912K A 11,924k

Wil sage:
B.236E. / B 416K

Running Time: 1 Hour, 23 Minutes, 48 Seconds

Figure 3-1. Example of About Information
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3.2.2 Tool Bar

The File Server module tool bar appears below the menu bar.

= o
A o R

& O

Moving the screen pointer over a tool displays the tool’s function as a tooltip. For example:

File  About

b
4l

TCP C add station

Table 3-1 describes the tools on the tool bar.

Table 3-1. File Server Module Tool Bar

Tool Tool Name Description Tool Tool Name Description
Add Station Adds stations to the File Remove Folder This function is
= Server module. See disabled. Contact BSI
j section 3.4.1. ® for information about
removing folders.
Remove Station This function is disabled. Enable Remote Enables remote
Contact BSlI for Voicetrack voicetrack stations.
b information about m Stations See section 3.5.
removing stations.
Add Folder Adds folders to a station. Enable Automatic | Updates the latest
% See section 3.4.2. ; Voicetrack voicetrack and log
= Q‘) Transfers information between

the local and remote
OpX systems. See
section 3.6.
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3.2.3 Connections List :
TCF Connections 3

The Connections List shows the IP address of each module 192.168.1.90
accessing the File Server. If multiple modules are accessing the File lgg'lggq'gé

Server at the same time from the same machine, the same IP
address might be shown multiple times.

The Connections List has two fields:

« TCP Connections at the top shows connections by any module
performing real-time control. Examples include Studio Clients,
Audio Servers and Auxiliary Audio Servers, the Import — Merge
module, or the Clock Builder module. A number at the top-right (3
in the example to the right) shows the number of current FTF Connections 1
connections. 192.166.1.94

- FTP Connections at the bottom shows any connections that are
transferring files. Examples include the File Manager module, Info
Edit module, or an Audio Server actively transferring audio files. A
number at the top-right (1 in the example on the right) shows the
number of current connections.

3.2.4 Station Folder List MEHRK| WESIRRER D |
"WOPX - The Best Rock!"
The Station Folder List creates a tab for Folder Carbents Descrption
D:MOpsiNews AUDIO News
each Statlon you add to your OpX SyStem g:gﬁtgﬁggddéonﬂg EEEQES@DNHG E‘Ifggddstonfiguration
. . DO O P Music MUSIC Music
Each tab shows a list of the folders available DADRAWORALogs LoGs Fiogam Logs
. i . D:MOpwOPEMRunLogs RUMLOGS Fun Logs
to each station and contains the following S el o
R D:AOpvw D PR oicetracks WOICETRACKS “Voicetracks
columns: DAORRW IR Corfig CONFIG Configurtion
D:MOpeA WO FEAT emparary TEMPORARY Temporary
D:AOpw O PN maging AUDID Imaging
. = DO RO Ol FILL Fill b aterial
FOlder fu” path to the f0|der D:\Dﬁ\WDPK\LmerS ALDID Limarst
DAOpHYWO PR ingles AUDID Jinglez
. Contents = type of data in the folder (for DAD Mo ot aloiD My o Foke
4

example, AUDIO, RECORDS, LOGS).

- Description = description of folder contents (for example, News, Records, Music).
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3.3 Configuring the File Server Module

The File Server module comes with default configuration settings that should suit most
users. Using the Settings option on the Edit menu, you can change these settings to suit
your requirements.

> To configure the File Server module settings
1. Onthe Edit menu, click Settings.
The Settings dialog box appears.

| Settings @1

[ Delete Voicetracks After [ | Z Days

[ Enable Mext Play Updates From Future Frogram Logs
[v Keep FTP Server Running

Metwork, Interface

[10.1.1.10 - Opix ~|

Comprezsion For Remote Stations

Bit Rate
128 | kbps

Stations Ta Search For Common Falder Duplicates

v WESI
v KBSI

o UK x Cancel |

2. Complete the fields in the dialog box (see Table 3-2).
3. Click OK.
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Table 3-2. Fields in the Settings Dialog Box

Field Description Default

Delete Voicetracks After n Days Maximum number of days that the system retains voice tracks before Disabled
deleting them. To enable this option, check the check box, and then either
accept the preset value (7) or change it.

Enable Next Play Updates From When using the studio interface, enabling this option allows the jock to see Disabled
Future Program Logs when a selected item is going to play next, If this option is enabled, OpX
looks at future logs as well as today's log to find the item.
Keep FTP Server Running Allows the File Server to check whether the FTP server is running and Enabled
restarts it if it is not running.
Network Interface IP address of the OpX network interface. See GUI
Bit Rate Allows you to change the native bitrate of the audio files in OpX. Only files 128 kbps
that are encoded with that bit rate will be able to be imported.
Stations To Search For Common | Check to have OpX search for files withthe same name in other folders for Enabled
Folder Duplicates the stations you are managing.

3.4 Adding and Removing Stations

The OpX system is organized by “station.” This means you must create a station on the File
Server for each Audio Server or Auxiliary Audio Server you want to run.

3.4.1 Adding Stations to Your File Server

The following procedure describes how to create a single station. To create multiple stations,
repeat this procedure for each additional station you want to create.

> To create a single station

1. On the tool bar, click i
The Add Station dialog box appears.
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Add Station

Statiaon

D ezcription

k ark et
|Nn:|t.-i'-.|:||:|lin::al:ule j aF Mew Market |

4% [ Local Station - ¥oicetracked / Programmed Remotely

4 [~ Remote Station - Yoicetracked Locally
[

Common Folders
v Spats

W MNews

v Records

X Cancel

2. Complete the fields in the dialog box (see Table 3-3).
3. Click OK.

4. To create additional stations, repeat this procedure.

Table 3-3. Fields in the Add Station Dialog Box

Field Description Default
Station Enter the call sign for identifying this station. —
Description Enter a full description of the station. This description will identify this station —
in OpX.
Market Use this field and the New Market button when using Remote Voicetracking Not Applicable

(see section 3.7). For a standard station profile, you can leave this field set
to “Not Applicable,” although you can configure a market name if desired.

Local Station — Voicetracked Check this check box when using Remote Voicetracking (see section 3.7). Not checked
[Programmed Remotely For a standard station profile, you can leave this check box unchecked.
Remote Station - Voicetracked Check this check box when using Remote Voicetracking (see section 3.7). Not checked
Locally For a standard station profile, you can leave this check box unchecked.
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Field Description Default
Programmed Locally Check this check box when logs are being built at the same offsite location Not checked
where voice tracks are being recorded. Leave this check box unchecked
when logs are merged back at the primary location.
Common Folders Check the folders you want this station to use. All files in the Common Checked

folders can be made available to any other stations.

3.4.2 Adding a New Folder to a Station

When you create a station in OpX, a set of default folders is created for that station.
However, you can add more folders to organize your audio files or other file types to your

liking.

» To add a new folder to a station

=k
1. On the tool bar, click LS

An Add Folder dialog box similar to the following appears.

3. Click OK.

take effect.

AddFolder - WBSI - The Best Of

MHame

=]

[ Use Common Folder

Contents

=]

Drezcription

x Cancel |

Complete the fields in the dialog box (see Table 3-4).

Restart the station's FTP server, Audio server and File Sync modules for the change to
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Table 3-4. Fields in the Add Folder Dialog Box

Field Description Default

Name Enter the name of the folder. This name should allow you to differentiate this —
folder from other folders.

Use Common Folder To share this folder with other stations in your OpX system, check this check Not checked
box. You can then share this station with other stations using the procedure
in section 55. When checked, OpX does not add the folder to other stations
automatically.

Contents Select the type of data you will store in the folder. —

Description Enter a description of the contents in the folder. —

3.4.3 Adding a Common Folder to a Station

After you add a new folder to a station using the procedure in section 3.4.2, you can make
that folder available on another station. This feature is useful if you want to share the same
content, such as spots, jingles, sound effects, between stations.

» To add acommon folder to a station

1. On the tool bar, click E?

An Add Folder dialog box similar to the following appears.

AddFolder - WBSI - The Best Of

MHame

| =]

[ Use Common Folder

Contents
| |

Drezcription

x Cancel |

2. Complete the fields in the dialog box (see Table 3-5).
3. Click OK.
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4. Restart the FTP server followed by the Audio Server and File Sync modules for the
change to take effect.

Table 3-5. Fields in the Add Folder Dialog Box

Field Description Default
Name Use the drop-down list to select the folder you want to make available to this —
station.
Use Common Folder Check this check box to make this folder available to this station. Not checked

Contents

Select the type of data you will store in the folder.

Description

Enter a description of the contents in the folder.
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3.5 Enabling or Disabling the Virtual Audio Server

The File Server’s Virtual Audio Server must be enabled to allow studio clients to edit voice
tracks on other OpX system locations. If the File Server’s Virtual Audio Server is not running,
the Remote Voicetrack station profile will not appear in the Station Selection window of the
studio client.

> To enable the Virtual Audio Server

1. Click Enable Remote Voicetrack Stations on the File menu.

OR
Click the & ' icon.

2. To confirm that the Virtual Audio Server is running, click the File menu and confirm that a
check mark appears next to Enable Remote Voicetrack Stations.

File | Edit About
v | Enable Remote Voicetrack Stations
Enable Remote Voicetrack Transfer

Exit

> To disable the Virtual Audio Server

1. Click Enable Remote Voicetrack Stations on the File menu.

OR
Click the & icon.

2. To confirm that the Virtual Audio Server is no longer running, click the File menu and
confirm that a check mark no longer appears next to Enable Remote Voicetrack
Stations.

Edit About

Enable Remote Voicetrack Stations
Enable Rermote Voicetrack Transfer

Exit
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3.6 Enabling or Disabling the Voicetrack Transfer Module

The File Server’s Voicetrack Transfer module updates the latest voicetrack and log
information between the local OpX File Server and remote OpX systems.

> To enable the Voicetrack Transfer module

1. Click Enable Remote Voicetrack Transfer on the File menu.

OR
Click the @ ' icon.

2. To confirm that Voicetrack Transfer module is running, click the File menu and confirm
that a check mark appears next to Enable Remote Voicetrack Transfer.

Edit About
Enable Remote Voicetrack Stations
v Enable Remote Voicetrack Transfer

Exit

> To disable the Voicetrack Transfer module

1. Click Enable Remote Voicetrack Transfer on the File menu.

OR
Click the '@ icon.

2. To confirm that the Voicetrack Transfer module is no longer running, click the File menu
and confirm that a check mark no longer appears next to Enable Remote Voicetrack
Transfer.

Edit About

Enable Remote Voicetrack Stations
Enable Remote Voicetrack Transfer

Exit
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3.7 Remote Voice Track Transfer Module

The Remote Voice Track Transfer module transfers voice tracks from a remote studio to the
primary OpX network automatically, without requiring user intervention. Just run this module
on the local and remote file servers, and the files transfer between the serves automatically.
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Topics:

A

Starting the Audio Server
Module (page 61)

Quick Tour (page 63)

Configuring the Audio
Server Module (page 72)

Loading the Program Log
(page 129)

Adding, Editing, and
Deleting Items in the
Program Log (page 130)

Playing Back a Program
Log Item (page 133)

4 Audio Server Module

This chapter describes the OpX Audio Server module.

The OpX Audio Server module handles audio playback
and recording. If you have a multi-station cluster, you
have an OpX Audio Server for each station.

The OpX Audio Server module reads your program log,
requests songs and audio content from the File Server
for playback, interfaces with general-purpose
input/output (GPIO) devices and your audio switcher,
and handles background recording of audio.
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4.1 Starting the Audio Server Module

You must start the File Server module before you start the Audio Server module.

> To start the Audio Server module
1. Start the File Server module (see section 3.1).

2. Double-click the Audio Server icon on your desktop Q or click the Windows Start
button and click Programs > Broadcast Software > OpX Audio Server.

An Audio Server window similar to the following appears. The first time the window
appears, it will be empty.
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File Edit Action About

> B 2

Log Pozition -
Deck Count -

b ain

|Item |Desu:ripti|:un |Name | Sched / Actual | Lengthl

Aupsiliary

Tirne: Shift

T
i
i

Audition




4.2 Quick To

ur

Audio Server Module

The following sections provide a quick tour of the Audio Server module interface.

|'§j Audio Server - WBSI - import

File Edt Action About

L
§

v

|~

= .. ltem | Description Hame Sched /Actual | Length
§ LogPosiion ] COMMERCIALER... 00:30:00 / 051914
B UDsck Bt n + 10 04:00 Local Spats 00.30:00 i
St « 1 MIN SFO MIM 5., D0:30:00 /031914 0o 2
B - 12 IMINGP TMINS. | /032014 00
s [MINSPOT + 13 MIN SFOT2 CA... TMINS... 00:32:00 00 1
E 14 MIN SPOT CART TMIN § 00:33:00 oo 2
= + 15 COMMERCIALER. . 00:30:00
2 Auiian 16 COMMERCIALER,. . 005750
: 17 02.00 Local Spots 00:57.50
= - 18 IMIN SPOT2 CA.. TMIN G... 005750 0o 3
9 e : + 19 MIN SPOT CART TMIN § 005850 0o 1
g Ei] COMMERCIALER,. .. 00:57:50
% + 21 SATEHOW STO.. 00:55:50
£ @ 2 SATSHOW 5TA.. 01:00.00
S Time Shit + B3 TIMESHIFT AEC . 011:00:00
e 1 @ 24 COMMERCIALER 10500
ﬁ 0 26 01:00 Local Spats 01:08:00
7 + & IMIN SPOTZCA . TMIN G 0500 nn 2
8 | Hendried .. o COMMERCIALER.. 1:05:00
= @ 2 SATSHOW STA. . 00500
: + 2 TIMESHIFT Di La... r1:08:00
Audition kil COMMERCIALER . 011:15:00
+ 3 0300 Local Spots m-15:00
. 2 MIN SFOT CART TMIN 5. . 1:18:00 0o 3
+ 3 IMIN SPOT2 CA... TMINS... 0:20:00 0o 1 o
P! MIN SFOT CART TMIN S, . 2100 pg 2 P
+ B COMMERCIALER,.. 01:18:00
kS COMMERCIALER n-32.00
+ 37 03:00 Local Spats 0:32:00 L
y— 0 AR COCLLO A, JRALC, LL20.00, A0 8
+0.0.0.319
Number Description

Menu bar. See section 4.2.1.

Tool bar. See section 4.2.2.

Playback, Record, Status, Connections, and Devices tabs. See sections 4.2.3, 4.2.4, 4.2.5,
4.2.6,and 4.2.7.

2]
©
o

Program log display. See section 4.2.8.
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4.2.1 Audio Server Module Menu Bar

The menu bar appears at the top of the Audio Server window. The following sections

describe the menus on the menu bar.

4.2.1.1 File Menu

File | Edit Action About
Load Log...  Ctrl+L

Exit

4.2.1.2 Edit Menu

File Action About

Add...
Edit...
Delete

Settings..  Cirl+5

4.2.1.3 Action Menu

File Edit About
> start
Stop

i Run Macro...

Ctrl+T
Ctrl+X

Ctrl+M

Load Log = loads logs manually. See section
4.4,

Exit = exits the Audio Server module.

Add = inserts items manually into the currently
loaded program log. See section 4.5.1.

Edit = edits items in the program log. See
section 4.5.2.

Delete = deletes items from the program log.
See section 4.5.3.

Settings = configures the Audio Server
module settings. See section 4.3.

Start = starts playback of the highlighted item
in the program log. See section 4.5.

Stop = stops all audio playback, including the
Main, Auxiliary, Time Shift, and Audition
decks. It does not stop playback of Hot Keys
playing on a Studio Client module. See section
4.5.

Run Macro = allows you to run macros.
Common uses are to run maintenance macros
or one-time on-the-fly macros. See Appendix
A - Macros.
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4.2.1.4 About Menu

Opens a window that shows the version and
il build date of the Audio Server module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the Audio Server
module has been running. See Figure 4-1for
an example. To close the window, click OK.

-

" About =

w0.0.0.729 &

Build Drate:
Jul 2 2014 075541

m

kemar Uzage:
14,352k / 14,392k

Whd | zage:
10,956k / 10,976k

Running Time: 0 Hours, 26 Minutes, 37 Seconds

Figure 4-1. Example of About Information
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4.2.2 Audio Server Tool Bar

The Audio Server module tool bar appears below the menu bar.

> B %

Moving the screen pointer over a tool displays the tool’s function as a tooltip. For example:

» T

The following table describes the tools on the tool bar.

Tool Description

Starts playback of the highlighted item in the program log. See section 4.6.

Stops all audio playback, including the Main, Auxiliary, Time Shift, and Audition decks. It does not stop playback
of Hot Keys playing on a Studio Client module. See section 4.6.
&

Allows you to run macros. Common uses are to run maintenance macros or one-time on-the-fly macros. See
Appendix A - Macros.

{“;-.
b 4%

Page 66 of 487



4.2.3 Playback Tab

The Playback tab on the left side of the Audio Server
window shows the current status of all the audio
playback devices. The following table describes the 12213

fields on the tab. [ oose0

Audio Server Module

Log Pogition  [EEEH

Deck Count “

b airy

| Playback

Avsiliary
Field Description %]Em
'r |
Log Position Line item in the program log that is currently playing. If
playback is stopped, Log Position is the item that will 1840-05
play next.
Deck Count Total number of audio files playing on the Main Deck.
For example: Time Shift
o If two tracks are segueing, the Deck Count
increments from 1 to 2.
« When a voice track occurs, the Deck Count can
increment up to 3 to show the total number of
elements playing at the same time.
Main Shows the most recently started audio event in the B
Playback Deck Stack. There are three playback decks Audition
in the Playback Deck stack that cycle through the audio
events in the program log. If a segue starts or multiple
audio files are playing, the display shows the segueing
in audio file, not the audio file segueing out.
The top half of the display shows the name of the audio
file that is currently playing. The bottom half shows the
time until the end of the file is reached. A blue bar on
the left side shows the intro point and a red bar is the
segue point embedded into the playing audio file.
The example below looks slightly different than the example to the right. The example below shows a song that is
02:43.6 long (2 minutes and 43.6 seconds) and has just started, while the example to the right shows a track that
is 03:50.4 in length and has played % of the way through, with 56.0 seconds remaining in the track.
175912
| 02434
The solid green bar in the example to the right shows the position of playback within the audio file and moves from
left to right as the audio file playback progresses.
Auxiliary Shows audio events playing in the Auxiliary deck. The Auxiliary deck is used by events from trigger sets,
scheduled events sets, and some macros that play audio events.
Time Shift Display The Time Shift display shows audio events for the Time Shift function (see Chapter 8). The Time Shift event list
and Time Shift box shows stacked-up events.

event list box

Audition display and
Audition event list
box

Show items being auditioned, including audio elements played while an OpX Studio Client is in Cue mode (see
Chapter 5).
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4.2.4 Record Tab

The Record tab shows the status of all four Audio
Server record decks. If enough audio recording devices
(audio cards) are installed on your Audio Server, you
can record four separate audio streams at the same
time.

| Status

While actively recording each deck display shows the
name of the audio file being recorded on the top half,
while the bottom half shows the current record position.
For example, in the figure to the right, Record Deck
One is recording a half-hour program and is 04:28.7
into the file. The green bar shows the progress of the
audio file, with a specified length.

When performing a record with no specified length, no
progress bar will appear; however, a countdown timer
shows the maximum length possible, along with the
available hard drive space.

Trigaers
Tiger St |
Time Events

Step Through

Sched Events -
sched 5ot |

Satellite Shows > o
M ame | D etailz

| | r
1]
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4.2.5 Status Tab

The Status tab shows all real- time modifiable settings that affect the way OpX plays audio
and interacts with outboard hardware. Exercise care when changing these settings. The
following table describes the fields on the tab.

Field Description -

Mod Mode AUTO

oae Adjusts how items in the program log progress. To .
adjust the mode click the On (| I |) or off (| [ |) Triggers -
icon. Three modes are available: Trigger Set
¢ In Auto mode, playback of the program log follows :
the specified cue types of each event. The system Time Events
obeys the Start Items Using Remote Channel
check box setting (see Table 4-2 on page 78). - Step Through
: . : =
e In Assist mode, similar to Auto mode, but items must
be started manually. The system obeys the Start i Sched Events -
Items Using Remote Channel check box setting Sched Set _
(see Table 4-2 on page 78).
¢ In Manual mode, cue types are ignored and each . [
event in the program log is treated as a manual cue. S atelite Shoves > e
The system ignores the Start Items Using Remote Marne | Details
Channel check box.

Triggers Show On when the Audio Server is monitoring
incoming triggers or Off when incoming triggers are
disregarded. To toggle the Triggers indicator between
on and Off, click the on (R ) or off (R ]) icon.

Trigger Set Shows the name of the currently loaded Trigger set. If
no set is loaded, this field is blank. You cannot change 4| | 4
this field from this tab. To change it, run the
LOADTRIGGERS macro from a scheduled event, ]
trigger set, program log, Hot Key, or by clicking the Run
Macro button in the Audio Server tool bar. For more
information, see Appendix A - Macros.

Time Events Shows whether the Audio Server is monitoring events in the program log with time-based cues. When Time
Events are set to On, scheduled events are played at the specified times. If Time Events is set to Off, all time-
based functions of the Audio Server are ignored. To toggle the Time Events indicator between On and Off, click
the On ( ) or Off (|_EZL J) icon.

Step Through This is an automatic system function.

Sched Events

Shows whether the Audio Server is monitoring the currently selected scheduled events set. When set to On,
events in the scheduled events set run at the times specified in the set. When set to Off, all events in the set are

ignored. To toggle the Sched Events indicator between On and Off, click the On ( ) or Off ( [0 ) icon.

Sched Set

Shows currently loaded scheduled events. This field usually is used to run macros at specific times without being
subject to what is happening in the program log. For more information, see section 4.3.11. You cannot change this
field from this tab. To change it, run the LOADSCHEDULED macro from a scheduled event, trigger set,
program log, Hot Key, or by clicking the Run Macro button in the Audio Server tool bar. For more information, see
Appendix A - Macros.
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Satellite Shows Lists all Satellite Shows scheduled in the current hour's Clock (created using the OpX Clock Builder described in
Chapter 8). Satellite Shows in this field can be started manually by highlighting the Satellite Show in the list and
clicking the Start button at the top of the Satellite Shows list.

4.2.6 Connections Tab

The Connections tab shows the IP addresses of: 2 s 2 e

192.168.1.92
- Workstations connected to the Audio Server. }gg'}gg'}'g;
+ The File Server to which the Audio Server is .
File Server
connected. 192.168.1.90 - FILE_SERVER
The following table describes the fields on the tab.
Field Description
@
Client Connections Shows the IP address of any workstation running =
the OpX Studio Client. If more than one Audio ﬁ
Server is running on your network, Client =
Connections lists only the Studio Clients that are =
connected to this Audio Server b
File Server Shows the IP address of the File Server to which
the Audio Server is connected.
4.2.7 Devices Tab WOPRACSE? |
The Devices tab shows the status of incoming
triggers. The following table describes the fields on the S, e
tab.
Field Description
Closure Grid Shows the status of each closure input. This Gionie | Status
display is useful when setting up or troubleshooting
closures to verify that your wiring connections are WOFH-ALTES N
correct. Each indicator turns green when a closure
is received. If more than one device is configured,
tabs at the top appear for each.
For troubleshooting, closure numbers in the grid Closures
are clickable. When you click a number a pseudo 11:52:17 - 4 [Closure #4) - LIVE :I
closure is generated and any function using that g 11:5E:13. 2 (Closure #2] - LIVE
closure is triggered. & [11:57.46 - 6 (Closwre #5) - LIVE
Device list Shows the name and status of all hardware 1/0 E Hg;ig g EE:EEE:E Eg} HEE
devices configured on your Audio Server. You 1534710 [Closure #2] - LIVE
cannot change the statuses from this tab. To 1115515? -1 [Closure #1] - LIVE
change it, run the DEV I CE macro by clicking the 120457 - F [Closure H#6] - LIVE
Run Macro button in the Audio Server tool bar. For 1210515? -2 (Closure #2) - LIVE
more information, see Appendix A - Macros. 170557 -7 [Closure #7) - LIVE
Closures History List Shows the history of all closure activity since the ::%1 glg i EE:EEE:; Ei% :::EE _
Audio Server was last started. The most recently 12:20:5? -2 [Closure 2] - LIVE
activated closure appears at the bottom of the list. 12121 135 -7 (Closure #7) - LIVE
This list is useful when troubleshooting missing, 123531 - 3 [Closure #3) - LIVE LI
incorrectly timed, or repeated closures to see which
closures have or have not been activated.
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4.2.8 Program Log Display

The program log display lists the audio files
and other automation (macro) events to be
executed throughout the day (audio and
macro events can also be executed from the
scheduled events and Hot Keys). Think of the
program log as the piano-roll and the Audio
Server as the player-piano.

Program logs in OpX are expected to be for a
24-hour period. Usually, program logs are
imported from Traffic Log- and Music Log-
generating applications. However, they can
also be generated manually using the OpX
Import — Merge application (see Chapter 9).
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4.3 Configuring the Audio Server Module

The Audio Server module comes with default configuration settings. Using the Settings
option on the Edit menu, you can change these settings to suit your requirements. For
convenience, the settings are organized in tabs in the Settings window.

> To configure the Audio Server module settings
1. Onthe Edit menu, click Settings.
The Settings dialog box appears, with the General tab displayed.

Settings ==
Trigger Sets | hdimers | [rata | Scheduled Events Sets | Modes / Logs | Clozures £ Relays |
General | Flayback, ] Auko Fill £ Time Scaling ] Record ] Categories ] Folders | Device [/0 |

Station

* Changing the ztation requires a restart of
the Audio Server to take effect.

Program Log Mame Template
ErmnizddiEzyw _?—_| [+ Clear Program Log Status

[w Thiz lz The Primary Audio Server For This Station
Sample Fate

144,100 Hz =] [Steren E

Start In Mode

b anual -

|aLILIARY

[ Spnc Spstem Time *ith The File Server

| 10 1 1 10
Part Offzet
[10.1.1.10 - Op =l o [
| 1
¢ k. x Cancel | E Apply |
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2. Complete the fields in the dialog box tabs.

General Settings — see
section 4.3.1

Playback settings — see
section 4.3.2

Auto fill and time scaling
settings — see section 4.3.3

Record settings — see
section 4.3.4

Category settings — see
section 4.3.5

Folder settings — see section
4.3.6

Device 1/O settings — see
section 4.3.7

Trigger sets — see section
4.3.8

Mixer settings — see section
4.3.9

Data settings — see section
4.3.10

Scheduled event sets — see
section 4.3.11

Modes and logs — see
section 4.3.12

Closures and relays — see
section 4.3.13

3. When you finish, click Apply and OK.
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4.3.1 General Configuration Settings

The General tab contains basic settings for setting up your Audio Server.

Settings

Station

= Changing the station requires a restart of
the Audio Server to take effect.

Frogram Log Mame Template

v This |z The Primary Audio Server For This Station

Sample Rate

Trigger Sets | Mixers | Data | Scheduled Events Sets | Modes / Logs | Closures / Relays |
General | Plapback | dute Fil / Time Sealing | Record | Categeries | Folders | Devies 1/0 |

ZmmZddZm Z [v Clear Pragram Log Status

44100 Hz =l [Steren

Start In Mode

[GEGUE] hd

=

[aLELIARY

[~ Sync System Time YWith The File Server

[ 10 1 1 10

Part Offzet

[10.1.1.10- 0px

=l o %]

=

=3

o OK

X Cancel ‘

& 2ooly ‘

Figure 4-2. General Tab

Table 4-1. Fields in the General Tab

Field Description

Default

Station Allows you to select the default station. All Stations configured on your OpX

File Server will be listed.

Varies by setup
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Field

Description

Default

Program Log Name Template

Determines the file name that OpX loads when the log automatically loads at
midnight. Your entry can include standard characters and meta-variables,
which are used to add a dynamic element to program log loading. Rather
than limiting the log to a static name, specific sequences of characters can
be used to represent dynamically changing information, such as the date,
day, year, and day of the week.

The following meta-variables can be entered into this field:

° %yy
Year as a 2-digit number.
Examples: For 2009, replace %yy with “09”. For 2016, replace %yy with
“16".

o %yyyy
Year as a 4-digit number.
Example: For 2016, replace %yyyy with “2016".

e %m
Month as a 1- or 2-digit number without a leading zero.
Examples: For June, replace %m with “6". For November, replace %m
with “11".
e %mm
Month as a 2-digit number with a leading zero.
Examples: For July, replace %mm with “07”. For October, replace %mm
with “10".
e %mmm
Month as a 3-letter abbreviation.
Example: For November, replace %mmm with “Nov”.

e %mmmm
Month as a full name.
Example: For August, replace %mmmm with “August”.

o %d
Day as a 1- or2-digit number without a leading zero.
Examples: For the 5%, replace %d with “5.” For the 12t replace %d with
“qo"
o %dd
Day as a 2-digit number with a leading zero
Examples: For the 7, replace %d with “07". For the 24™, replace %d with
24",
o %ddd
Day as a 3-letter abbreviation.
Example: For Tuesday, replace %ddd with “Tue”.

o %dddd
Day as a full name.
Example: For Friday, replace %dddd with “Friday”.

If you generate new logs every day and your log-generation software
creates logs with titles such as:

e “020108t.log", “102607t.log", or “120708t.log", enter “¥%omm%dd%yyt.log”
into this field.

o Monday.txt”, “Wednesday.txt”, or “Saturday.txt”, enter “%dddd” into this
field.

e “Jan 2, 2008.log", “Nov 30, 2009.log", or “Jul 4, 2008", enter “Y%ommm %d,
%yyyy" into this field.

Do not include extensions. The OpX import process adds a .xml extension
automatically. For more information about importing and merging logs, see
Chapter 9.

%mm0dd%yy
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Field

Description

Default

Clear Program Log Status

Automatically clears as- played information when a program log is loaded.
This is useful for re-using logs or to ensure that the information shown when
airing a log is not from a previous playback.

Checked

This Is The Primary Audio Server
For This Station

Check this check box to have your station’s main (“Primary”) Audio Server
write all hardware settings to the server, so the Clock Builder module and
any backup Audio Servers that are running are aware of the hardware
settings from your station’s Primary Audio Server, such as names you
assigned to audio switcher channels, triggers and relays.

On backup Audio Servers, uncheck this check box to prevent inadvertent
changes you make on the backup server from overwriting critical settings on
your on-air Primary Audio Server.

Checked

Sample Rate

Selects the output sample rate (very significant when used with a digital
audio card) and the rate of the audio files that OpX will play. OpX plays
audio files that have a singular rate, so be sure all your audio files have the
same sample rate.

44,100 MHz

Mode

Output stereo/mono mode. A mix of stereo and mono audio files is
acceptable to play with OpX, but they must be the same sample rate. If
mono is selected, all stereo and mono audio files played will be summed
and output to both left and right channels. If Stereo is selected, stereo audio
files remain stereo and mono files are summed out both left and right
channels.

Stereo

Start in Mode

Determines the automation mode in which the application starts. Always use
Auto.

Manual

Banner

Not used with a standard Audio Server. This field is reserved for naming the
Auxiliary Audio Server. See Chapter 5.

AUXILIARY

Sync System Time With The File
Server

Do not use (for legacy systems only).

Unchecked

File Server Address

IP address of the File Server.

OpX Network Interface

OpX can communicate with Axia/Wheatstone hardware on a separate NIC.
If OpX detects an Axia or Wheatstone audio driver installed, select the NIC
used for your Axia or Wheatstone audio network; otherwise, this field is
unavailable.

10.1.1.10 - OpX

Port Offset

The communication port for clients. This value must be unique for each
Audio Server.

Axia/Wheatstone Network
Interface for GPIO Devices

If OpX detects an Axia or Wheatstone audio driver installed, enter the local
IP address of the NIC that will use the Axia or Wheatstone audio network;
otherwise, this field is unavailable.
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4.3.2 Playback Configuration Settings

The Playback tab contains configuration settings for audio playback devices are designated
for each playback deck in OpX.

Settings @
Trigger Sets | Mixers | D' ata | Scheduled Everts Sets | Modes / Logs | Closures / Felays |
General  Plapback |.-’-¥.utn:- Fill / Time Scaling ] Record ] Categories ] Falders | Device 170 |

Channel / Deck #1 Playback Device Default Segue Time

A1 DM Out [AudioS 280 E | Milliseconds
Chanrel / Deck #2 Plapback Device ¥ FadeIn
| 1 - ASIER20 /02 WDk Out [AudicS j 100 Milizeconds
Channel ¢ Deck #3 Playback Device [ Maimum Fade Out

|1 - 8516520 A03 WDOM Out [AudioS j 3000 zl

Avriliam Deck. #4 Playback Device DR D3 Lo

a0 z Percent
1 - 4516520 /04 WDM Out [fudins |

[v Usze Mext Available Device IF Busy [ Fade Out Cut Befare Woicetrack
YW'hen Cut After Woicetrack Starts
Tirne Shift Deck #5 Playback Device 2000 Zl

1 - 4516520 /04 WDM Out [fudins |
Fade & Go Fade Out

3000 Miliseconds
Auta Maode Through Breaks

™ In Manual Mode [ Check Dates And Tirmes

™ InAssist Mode [ Start Itemns Using Remate Channel

[ Reassign Device On Make Nest

J ] x Cancel | E Apply |

Figure 4-3. Playback Tab
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Table 4-2. Fields in the Playback Tab

Field

Description

Default

Channel/Deck #1 Playback Device
Channel/Deck #2 Playback Device
Channel/Deck #3 Playback Device

These fields determine which audio devices are used for each of the three
main playback decks. The main playback decks are rotated as playback
occurs. The deck with which each item will play appears in the far-right
column of the Program Log Display in the Audio Server.

Because OpX uses a software-based audio mixing engine, all three
Channel Playback fields can be set to the same device or, for more control,
to their own individual device. We recommend you set each deck to its own
device. Typically, deck 1 would be 1WDML, deck 2 would be 2WDML, and
so on. Setting each Channel Playback Device field to a different audio
device is useful for manual control over fades when each device is
connected to a separate channel strip on your console.

Note: Always use WDM drivers. Never select Wave, even if Wave drivers
are installed.

1 - AS16520/01
WDM Out (AudioS)

1- AS16520/02
WDM Out (AudioS)

1 - AS16520/03
WDM Out (AudioS)

Auxiliary Deck #4 Playback Device

Used to playback triggered events. You can select an independent device
for flexibility or the same device as your main decks playback device.
Because OpX has internal mixing, multiple decks can use the same
playback device.

1 - AS16520/04
WDM Out (AudioS)

Use Next Available Device If Busy

Do not use for legacy systems.

Checked

Time Shift Deck #5 Playback
Device

Used to play back satellite shows recorded using the Clock Builder Record
function. If you use Time Shift functionality, select a unique device for this
deck and configure a Mixer that controls this deck, so the Satellite Show
settings can mute and unmute this channel independently of other
playback decks for spot-replacement functionality.

1 - AS16520/04
WDM Out (AudioS)

Auto Mode Through Breaks

These options allow the Audio Server to enter Auto mode automatically
when breaks are encountered in Manual or Assist mode. This means that
when a break starts, all the audio files segue automatically and continue to
play through as if in Auto mode.

Unchecked

Default Segue Time

OpX segues between audio cuts at the points you set in each audio file. To
segue between cuts, even if the cuts do not have segue points set, set this
option to the length a default segue should take to overlap the cuts. Even
with this feature enabled, the set cue points are used if they are set in the
particular cuts. This setting applies only when one or both cuts have no
segue points set (see Chapter 10).

250 milliseconds

Fade In

Determines the fade-in time applied to the starting audio element when a
segue occurs.

Checked
100 milliseconds

Maximum Fade Out

Maximum fade out time of the audio element that is ending during a segue.

o Unchecked = time of the full intro/segue (length of either the ending
element’s segue time or the starting element’s intro time, whichever is
shorter) is used as the fade out length.

o Checked = fade out time is either the full intro/segue time determined
on-the-fly or the length set here, whichever is shorter.

Unchecked
300 milliseconds

Default Ducking Level Ducking attenuates audio elements when a voicetrack is playing. This 90 percent
option ducks songs or other audio element types down under a voice track.
You can set the ducking level on a per-voicetrack basis, but this setting
determines the default level on new voicetracks.

Fade Out Cut Before Voicetrack Unchecked

When Cut After Voicetrack Starts

Fades down the volume of the cut before a voicetrack. Use only with cuts
produced in a manner that requires this feature.

3000 milliseconds
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Field Description Default

Fade & Go Fade Out Length of the cut fade when using the "Fade-and-Go" feature on the studio 3000 milliseconds
client.

Check Dates And Times To have OpX check that all your audio elements are valid for the dates set Unchecked
in the audio files, enable this option (see Chapter 10). If OpX finds an
audio file that is outside its date range, playback of that audio event causes
an error and the event is skipped.

Start Items Using Remote Channel | When checked, the next playback deck changes to whichever pot the Start Unchecked
Next button is on. If Deck 2 is next and you push start on remote start 1, for
example, the next cut plays out of deck 1.

Reassign Device on Make Next When using the Make Next feature, this option always changes the device Unchecked

on that item to deck 1.

4.3.3 Auto Fill and Time Scaling Configuration Settings

The Auto Fill / Time Scaling tab contains configuration settings for auto-fill and time

scaling.
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s

Settings @

Trigger Setz | Mixers | Data | Scheduled Events Sets | Modes / Logs | Clozures / Relaps |
General ] Playback Auto Fill / Time Scaling | Record ] Categories ] Folders | Device 140 |

~

=

-

o OFK % Cancel | = Apply |

Figure 4-4. Auto Fill / Time Scaling Tab

Table 4-3. Fields in the Auto Fill / Time Scaling Tab

Field Description Default

Enable Auto Fill and Time Scaling | When checked, Auto Fill fills mandatory breaks automatically (created with Unchecked
OpX’s Clock Builder module) that do not have enough content to complete
their set length. The Auto Fill function uses audio files you place in your
station’s Fill folder. Checking this check box enables the remaining options
in this tab.

Fill Breaks Randomly When checked, audio events are chosen at random from your Fill folder Disabled
until your break is filled.

Fill Breaks Largest To Smallest When checked, the longest audio file from your Fill folder that will fit your Disabled

remaining break period is added to your break. If there is time in your
break, that time continues to be filled with the largest file that fits that time
until your break is filled completely.
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Native Time Scaling (Real-Time) Select Native Real Time. Other selections are provided for legacy or Disabled
special-case use.

Native Time Scaling (Background) | Select Native Real Time. Other selections are provided for legacy or Disabled
special-case use.

Maximum Time Scaling Determines the maximum time scaling percentage possible. For best Disabled
results, use a value from 5 to 15%,
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4.3.4 Record Configuration Settings

The Record tab has drop-down lists for selecting the record device for each record deck.
You can set record decks to their own specific device for flexibility, allowing you to record
four sources simultaneously. If the audio hardware installed on your system does not have
four record devices available, decks can share the same record device. When two or more
decks share the same record device, only one can access it at a time. The first deck to start
recording with a device locks out other decks that try to use that same device until the first

deck finishes recording.

s

Settings

First Record Deck Device

1 - A516520 /071 WD In [AudioSc

Second Record Deck Device
11 - 4516520 /02 WOM In [fudinSe |

Third Record Deck Device
1 - 4516520 /01 WOM In [fudicSc |

Forth Record Deck Device
1 - 4516520 /02 WDM In [fudicSc |

* Changes to the record device
settings requires restarting the
Audio Server to take effect.

Trigger Sets | hdixers | [rata | Scheduled Events Setz | todez / Logs | Clogures / Relays |
General ] Playback. ] Auta Fill / Time Scaling  Fecord | Categaries ] Folders | Device 140 |

-

(3]

0K

x Cancel |

& 2ol |

Figure 4-5. Record Tab

Page 82 of 487



Audio Server Module

4.3.5 Category Configuration Settings

OpX uses categories to organize your audio and add another dimension to the types of
searches you can do when adding audio files to your logs. You add, delete, or edit
categories using the Categories tab. You set an audio cut’s category using the Info Edit
module (see Chapter 10).

If you define a category field to import, you must specify it here.

Settings 5
Trigger Setz | biners | Drata | Scheduled Events Sets | Modes / Logs | Clozures / Relays |
General ] Flayback ] Auta Fill # Time Scaling ] Fecord Categones | Falders | Device 170 |

#New| A Edit | 3¢ Del |
Cateqory Tvpe D' ezcriptian

alDIo Audio file or cart
COMMEMT COMMENT Frogram log comment
MACRO kMACRO b acro cammarnd
TEXT TE=T Test for dizplay
WTRACE, WTRALCK Wioice track audio file

/ (] x Cancel | E Apply |

Figure 4-6. Categories Tab
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The following sections describe how to add, edit, or delete categories.

4.3.5.1 Adding Categories

> To add a category to your Audio Server
1. Inthe Categories tab, click the New button M
The Category dialog box appears.

r o

Category @
Category
|
Type
|&UDI0 ~|
Drescription
|
X Cancel |

Figure 4-7. Category Dialog Box
2. Complete the fields in the dialog box (see Table 4-4).

3. Click OK.
Table 4-4. Fields in the Category Dialog Box
Field Description Default
Category Enter a short name. —
Type Select the content type. Generally, Audio should be selected. AUDIO
Description Enter a description of the category. —
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4.3.5.2 Editing Categories

There might be times when you need to edit a category. For example, you might want to
change the category name, type, or description.

« Note: You cannot edit default categories.

> To edit a category
1. Inthe Categories tab, click the category you want to edit.
2. Click the Edit button _f'Edk
The Category dialog box appears.
3. Edit the fields you want to change (see Table 4-4).
4. Click OK.

4.3.5.3 Deleting Categories

If you no longer need a category, you can delete it. You can delete any category, except
default categories.

« Note: A precautionary message does not appear before you delete a category.
Therefore, be sure you do not need a category before you delete it. You cannot
undo a category after it has been deleted.

> To delete a category
1. Inthe Categories tab, click the category you want to delete.

2. Click the Del button 3 Del
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4.3.6 Folder Configuration Settings

The Folders tab allows you to select a path for the local storage of your audio, carts, logs,
and items. Local Audio Folder shows the path where the files are stored. For example, in
Figure 4-8, the path in Local Audio Folder is “D:\" and the path for Liners is “D:\WBSI\Liners”.
To specify the path, either enter it in the Local Audio Folder field or click the & icon,
navigate to the desired folder, and then click the folder and click OK.

(ﬂ Note: Do not use the root folder to store files. Always use Drive :\OpXAudio.

[ Settings @

Trigger Setz | Mixerz | Data | Scheduled Eventz Sets | M odes / Logs | Closures / Flela_l.Js]
General ] F'Ia_l,lbau:k] Auta Fill / Time Scaling | Record | Categories  Folders ] Device 140 |

Local Audio Folder

[D:% udiawBS| =
Folder Type Dezcription -
Dy dinWRSAS pots SPOTS
DA AudiowBS W ews AUDIO Mews
DaAudioVwWBS|I\Records RECORDS Records
D AudioWwWE SN ugic MUSIC Music
0 YAudiohwB SN maging AUDIO Imaging
D:MAudio B SINFil FILL Fill M atenial 3
b vAudioWwBSILiners AUDID Liners 3
D:saudioWwB Sl ingles ALDIO Jingles
0 AudioswB SN Promos AUDIO Prarmos
D:saudichWwBSINCarts CARTS Carts
0 vAudiohwBSINRunLogs RUMLOGS Run Logs
D SAudiowBS I LogshAudio Ser... LOGS Pragram Logs
D: vaudioWWwEBS N oicetracks YOICETRACES Woicetracks =
D: s&udio'wBS14\Canfig CONFIG Configuration o
M- |'\J':‘ujr|in VARSIV T erannram TEFMPORARY T armnnran
4 1 r

* Adding folders to the File Server requires
a restart of the Audio Server to take effect.
Click DK below to write the zettings locally,
then restart FileSync as well.

o O X Cancel | = 2peh |

Figure 4-8. Folders Tab
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4.3.7 Device Configuration 1/O Settings

Any device that sends closures to outboard devices, receives closures from other devices,
or switches audio is considered an 1/O device. The Device /O tab allows you to configure
these devices.

-

Settings 5
Trigger Setz | biners | Drata | Scheduled Events Sets | bodez / Logs | Clozures / Relays |
General ] Flayback ] Auta Fill # Time Scaling ] Record ] Categories ] Folders Device 10

o | 0ol
M ame Device Puart D' ezcriptian Drefault
g Senal Device g Senal Server @ IP' Connection
#Rocrn fyia GPIO Node | @0cra Auia Diiver GPID & Audio Server
b wheatstone Console b wheatstone Blade B MCC PDIS08
.-*"-f""f‘:_' SAS Conzole B Advantech
/ (] x Cancel | E Apply |

Figure 4-9. Device I/O Tab
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4.3.7.1 Adding a Serial Device

Serial devices supported by OpX are the Broadcast Tools SS 8.2, ACS 8.2, SS 16.4, GPI-

32, and SRC 8-llI.

» To add a serial device

1. Be sure the device you are configuring for OpX is connected and configured properly.

2. Inthe Device I/O tab, click the Serial Device button 8 Serial Device

The Serial Device dialog box appeatrs.

r

Serial Device

MName Description
Paort Device
1 x | |
Bsud Bate Broadcast Tools
l—_|' . Specify the actual Lnit 1D
3600 Unit ID# not AUTO when uzing

i AUTO - | multiple devices an the
Data Bits zame poark,
= Iz
Par
arty |+ lgnore Subsequent Closures For
Mone -

250 z Miliseconds

Stop Bits
1 :lﬂllr v Append Temination Characters
Flow Control |CWLF j
Mone = [~ Connect & Start Up

X Cancel |

Figure 4-10. Serial Device Dialog Box

3. Complete the fields in the dialog box (see Table 4-5).
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Table 4-5. Fields in the Serial Device Dialog Box

Field

Description

Default

Name

Enter a short identification name for your serial device. This name should
allow you to differentiate this device from other devices.

Description

Enter a verbose description for your serial device.

Port

Enter the port number based on the requirements for your serial device.
Refer to the documentation for your serial device.

Baud Rate

Set the baud rate, in bits per second (bps), based on the requirements for
your serial device. Refer to the documentation for your serial device.

9600

Data Bits

Set the number of data bits based on the requirements for your serial
device. Refer to the documentation for your serial device.

Parity

Set the parity setting based on the requirements for your serial device.

None

Stop Bits

Set the number of stop bits based on the requirements for your serial
device. Refer to the documentation for your serial device.

Flow Control

Set the flow control based on the requirements for your serial device. Refer
to the documentation for your serial device.

None

Device

Available options are for Raw Serial Device (used for serial devices not
explicitly supported by OpX), Broadcast Tools SS 8.2, ACS 8.2, SS 16.4,
GPI-32, SRC 8-IIl, 8&2 D/ev, SRC-16, and GPI-16.

For Broadcast Tools devices:

o Select the ID address that your device is set to from the Unit ID# drop-
down list. The default device ID for Broadcast Tools switchers purchased
through BSl is “1”.

o To avoid invalid or “chattering” relays, set a period of time for OpX to
ignore subsequent closures after an initial closure is received enable by
enabling the Ignore Subsequent Closures For... option and selecting a
time-out time (in milliseconds).

o To aid identification of what is connected to your Broadcast Tools device,
click the Closure Descriptions and/or Switcher Descriptions buttons.

Figure 4-11 shows an example Closure Descriptions list. As this example
shows, it is easier to remember the friendly closure name “Rosh Limberg
Commercial Break Start” after several months than it is to remember
“Closure #2".

Figure 4-12 and Figure 4-13 show input and output description lists which
are editable by clicking on the Switcher Descriptions button.

Append Termination Characters

Select the terminating characters that will be appended to the end of each
command sent to the serial device. The default termination characters are a
carriage return and line feed.

Checked
CRILF

Connect At Start Up

To have your Audio Server connect to this serial device automatically at
startup, check this check box.

Unchecked
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x|
SWITCHERZ
Switcher 2 - Broadcast Tools 55 16.4
Closure Fin [ ezcription
1 C-1 Rosh Limberg Start =
2 R Fozh Limberg Commercial Break Start
3 C-4 Rosh Limberg Station 1D
4 C-E Closure 4
5 C-7 Clazure #5
5 R Closure #E
7 C-10 Cr. Laurie Commnercial Break Start
a8 C-12 Dr. Laurie Station 1D
9 C-13 Clazure #9
10 C-15 Closure #10
15| C-16  |Joans Music TOH ID/Start i
12 C-18  |Joans Music Commercial Break Start
] D-1 Joan: Music Magic Call
14 D-3 Closure #14
15 D-4 Closure #15
16 D-6 Bill O'Fieally Star -]
v’ ak. I x Cancel |

Figure 4-11. Closure Description List for a Broadcast Tools Switcher/Trigger Device

Broadcast Tools S5 16.4 T x|
SwTCHERZ
Switcher 2 - Broadcast Tools 55 16.4

Inputs | Cutputs

Input | Dezcription

1 ABG MNews Feed
StarGuilde 111 #1
StarGuilde |11 #2
ity 4000 $#1
ity 4000 #2
StarGuilde |1 #1
StarGuilde || #2
Direct Conzale Dutput LI

| »

OOf —f O3 P Femf DO P2

& 0K X Cancel |

Figure 4-12. Input Description List for a Broadcast Tools Switcher Device
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Broadcast Tools 55 16.4 N x|

SwWITCHERZ
Switcher 2 - Broadcast Tool: 55 16.4

Inpuits Outputs |

[ Dutput [ Description

1 Opi Pazs-Through [S atellite-ta-dir]
2 |0p¥ Record 1
3 Opx Record 2
4 Op Record 3

o 0K X Cancel |

Figure 4-13. Output Description List for a Broadcast Tools Switcher Device

4.3.7.2 Adding a Remote Serial Device Server

To allow your Audio Server to access a Serial Device Server’s serial device, add a Remote
Serial Server Device definition to your Audio Server.

» To add aremote serial device server

1. Inthe Device /O tab, click the Serial Server button e S B

The Serial Server Device dialog box appears.
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Fa

Serial Server Device @

Mame Dezcrption

Station

Device

[ Connect Ak Start Up

X Cancel |

Figure 4-14. Serial Server Device Dialog Box

2. Complete the fields in the dialog box (see Table 4-6).

3. Click OK.
Table 4-6. Fields in the Serial Server Device Dialog Box
Field Description Default
Name Enter a short identification name for your serial server device. This name —
should allow you to differentiate this device from other devices.
Description Enter a verbose description for your serial server device. —
Station Select the audio server that is running the Serial Device Server. Only —
stations with currently running Serial Device Servers are shown in the drop-
down list.
Device Select a remote device. —
Connect At Start Up To have your Audio Server connect to this serial server device automatically Unchecked

at startup, check this check box.
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4.3.7.3 Adding an IP Connection

You can add a TCP or UDP IP connection to the Audio Server.

» To add an IP connection

1. Inthe Device I/O tab, click the IP Connection button % IP Conrection

The IP Connection dialog box appears.

IP Connection @
M arne D'ezcription
10.1.1.10- O ~]

Pratocol Type

* TCP * Client

" UDP " Server

[ Connect / Send / Disconnect

Address Pt
| o . 0o . 0 . 0 1000

[+ Append Termination Characters [ Must Be CR/LF To Send To Another Audio Server |

|\CR/LF |

[ Connect At Start Up

% Commands |

x Cancel |

Figure 4-15. IP Connection Dialog Box

2. Complete the fields in the dialog box (see Table 4-7).

3. Click OK.
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Table 4-7. Fields in the IP Connection Dialog Box

Field Description Default

Name Enter a short identification name for your IP connection. This name should —
allow you to differentiate this IP connection from other IP connections.

Description Enter a verbose description for your IP connection. —

Network Interface Select the IP address of the OpX network interface for this IP connection. 10.1.1.20 - OpX

Protocol Select the protocol used with this IP connection: TCP or UDP TCP

Type Select whether the device at the other end of the IP connection is a client or Client
server of the Audio Server.

Connect/Send/Disconnect To send requests to and disconnect from the IP connection, check this Unchecked
check box.

Address Enter the IP address of the device at the other end of the IP connection. 0.0.0.0

Port Enter the port number based on the requirements for your device. Refer to 1000
the documentation for your device.

Append Termination Characters Select the terminating characters that will be appended to the end of each Checked
command sent to the device at the other end of the IP connection. The CRILF
default termination characters are a carriage return and line feed.

Connect At Start Up To have your Audio Server connect to this IP connection automatically at Unchecked
startup, check this check box.

Commands Click this button to open the Watch Text dialog box (see Figure 4-16). Use —

this dialog box to add, edit, or delete watch text.

4.3.7.3.1 Adding Watch Text

This function sends the system a command via TCP/UDP and ties that command to a
macro. When the Audio Server sees that watch string, it executes the defined macro.

» To add watch text

1. Inthe IP Connection dialog box, click the Commands button

Iﬁﬂ Comrnands |

The Watch Text dialog box appeatrs.
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YWatch Test | Command [Macro] | Loagic | +New

[EHYEdit |
K Del |

Figure 4-16. Watch Text Dialog Box

2. Click the New button
The Watch Text Iltem dialog box appears.

Watch Test

ki acro Command

Logiz

Execute Command [f % atch Test [z Present i

o OK X Cancel |

Figure 4-17. Watch Text Item Dialog Box

3. Complete the fields in the dialog box (see Table 4-8).
4. Click OK.
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Table 4-8. Fields in the Watch Text Time Dialog Box

Field Description Default
Watch Text Enter a short identification name for your device. This name should allow —
you to differentiate this device from other devices.
Macro Command Enter the macro command. For more information, see Appendix A - Macros. —
Logic Select whether the command is to be executed when the watch text is Execute Command
present or missing. If Watch Text Is

Present

4.3.7.3.2 Editing Watch Text

There might be times when you need to edit watch text. For example, you may want to
change the macro associated with the watch text.

» To edit watch text

1. Inthe IP Connection dialog box, click the Commands button [y Bt |

The Watch Text dialog box appears (see Figure 4-16).

2. Click the watch text you want to edit, and then click the Edit button ﬂ
The Watch Text Item dialog box appears (see Figure 4-17).

3. Edit the fields you want to change (see Table 4-8).

4. Click OK.

4.3.7.3.3 Deleting Watch Text

If you no longer need watch text, you can delete it.

« Note: A precautionary message does not appear before you delete watch text.
Therefore, be sure you do not need watch text before you delete it. You cannot
undo watch text after it has been deleted.

» To delete watch text

1. Inthe IP Connection dialog box, click the Commands button (4 Cormmands |

The Watch Text dialog box appears (see Figure 4-16).
2. Click the watch text you want to delete.

3. Click the Del button # Del
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4.3.7.4 Adding an Axia GPIO Node

> To add an Axia I/O GPIO node to your OpX Audio Server

1. In the Device /O tab, click the AXIA GPIO Node button

The Axia

ﬂ'?im Axia GPIO Mode

GPIO dialog box appears.

[ Avia GPIO ==

Mame Dezcrption
Axia GPIO Address
| o . 0 . 0 . 0

[ Connect A Start Up

[ Closure Descriptions

X Cancel |

Figure 4-18. Axia GPIO Dialog Box

2. Complete the fields in the dialog box (see Table 4-9).

3. Click OK.
Table 4-9. Fields in the Axia GPIO Dialog Box

Field Description Default

Name Enter a short identification name for your Axia GPIO node. This name —
should allow you to differentiate this device from other devices.

Description Enter a verbose description for your Axia GPIO node. —
Axia GPIO Address Enter the IP address of your Axia I/O device. 0.0.0.0
Connect At Start Up To have your Audio Server connect to this Axia GPIO node automatically at Unchecked

startup, check this check box.
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Field

Description

Default

Closure Descriptions

To make identification of what is connected to your Axia I/O device’s
closures, click this button and enter friendly names for each connected
closure. Figure 4-19 shows an example of a closure list.

Axia GPIO - 10.1.1.90 - x|

GRIO3
Awia GPIO Mode 3

Closure Fir Dezcription

1 Part 1 Rosh Limberg Start =
2 Part 1 Rosh Limberg Commercial Break Start
3 Port 1 Riosh Limberg Station 10
4 Port 1 Closure #4
K Part 1 Clozure #5
B
7
]

Part 2 Clozure HE
Port 2 Dir. Laurie Commercial Break Start —
Port 2 |Dr. Laurie Station 1D

g Port 2 Clozure #9

10 Port 2 Closure #10

1 Port3  |Joans Music TOH D /Start

12 Port 3 |Joans Music Commercial Break Start

13 Fort3  |loans Music Magic Call

14 Port 3 Closure #14

15 Port 3 Clozure #15

16 Port 4 [Bill I'Really Start |

& OK I x Cancel |

Figure 4-19. Example of a Closure List
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4.3.7.5 Adding an Axia Driver GPIO

> To add an Axia I/O Driver GPIO to your OpX Audio Server

1. Inthe Dev

=2 s Driver GPIO

ice 1/O tab, click the AXIA Driver GPIO button —

The Axia GPIO dialog box appears.

[ Asia GPIO ==

M ame D escription
Ayia GPIO Address
| 127 0 0 1

[ Connect Ak Start Up

x Cancel |

Figure 4-20. Axia GPIO Dialog Box

2. Complete the fields in the dialog box (see Table 4-10).

3. Click OK.

Table 4-10. Fields in the Axia GPIO Dialog Box

Field Description Default
Name Enter a short identification name for your Axia Driver GPIO device. This —
name should allow you to differentiate this device from other devices.

Description Enter a verbose description for your Axia driver GPIO device. —
Axia GPIO Address Enter the IP address of your Axia driver GPIO device. 0.0.0.0
Connect At Start Up To have your Audio Server connect to this Axia driver GPIO device Unchecked

automatically at startup, check this check box.
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4.3.7.6 Adding an Audio Server

> To add an audio server to your OpX Audio Server

1. In the Device I/O tab, click the Audio Server button

& Audio Server

The Audio Server dialog box appears.

I

Audio Server

M ame D escription

|

Statian

| |
Address

| o . 0o . 0 . 0

| Connect A Start Up

x Cancel |

Figure 4-21. Audio Server Dialog Box

2. Complete the fields in the dialog box (see Table 4-11).

3. Click OK.
Table 4-11. Fields in the Audio Server Dialog Box
Field Description Default
Name Enter a short identification name for your audio server. This name should —
allow you to differentiate this device from other devices.
Description Enter a verbose description for your audio server. —
Station Select a station that will be used with this audio server. Only stations with
currently running Serial Device Servers are shown in the drop-down list.
Address Enter the IP address of the audio server. 0.0.0.0
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Field Description Default
Connect At Start Up To have your Audio Server connect to this audio server automatically at Unchecked
startup, check this check box.
4.3.7.7 Adding a Wheatstone Console
> To add a Wheatstone console to your OpX Audio Server
1. Inthe Device I/O tab, click the Wheatstone Console button &) Wheatstone Console |
The Wheatstone Console dialog box appears.
Wheatstone Console @
M ame D ezcription
Conzole Address
o . o . o . a0
Deck #1 = Conzole Channel: |'|_|Z|
[+ [gnore Subsequent Deck Starts
= N 2

Deck #2 = Consale Channel: l_@ 250 Millissconds

Deck #3 = Conzale Channel: |3_|E

[ Connect A Start Up

x Cancel |
Figure 4-22. Wheatstone Console Dialog Box
2. Complete the fields in the dialog box (see Table 4-12).
3. Click OK.
Table 4-12. Fields in the Wheatstone Console Dialog Box
Field Description Default
Name Enter a short identification name for your Wheatstone console. This name —
should allow you to differentiate this device from other devices.

Page 101 of 487




Audio Server Module

Field Description Default
Description Enter a verbose description for your Wheatstone console. —
Console Address Enter the IP address of your Wheatstone console. 0.0.0.0
Deck #1 — Console Channel Select a remote device. 1
Deck #2 — Console Channel 2
Deck #3 — Console Channel 3
Ignore Subsequent Deck Starts To have your Audio Server connect to this Wheatstone console Unchecked

automatically at startup, check this check box and either accept the default
value or change it.

250 milliseconds

Connect At Start Up To have your Audio Server connect to this Wheatstone console Unchecked
automatically at startup, check this check box.

Closure Descriptions To make identification of what is connected to your Wheatstone console’s —
closures, click this button and enter friendly names for each connected
closure.

4.3.7.8 Adding a Wheatstone Blade

> To add a Wheatstone blade to your OpX Audio Server

1. Inthe Device /O tab, click the Wheatstone Blade button ) Wheatstone Blade

The Wheatstone Blade dialog box appears.
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r

[ Clasure Descriptions

Wheatstone Blade
Mame Dezcrption
Blade Address
| 0 0 0 0

|+ [gnore Subzequent Deck Starts

250 Zs

[~ Connect At Start Up

1 Switcher Descriptions

x Cancel |

Figure 4-23. Wheatstone Blade Dialog Box

2. Complete the fields in the dialog box (see Table 4-13).

3. Click OK.
Table 4-13. Fields in the Wheatstone Blade Dialog Box
Field Description Default
Name Enter a short identification name for your Wheatstone blade. This name —
should allow you to differentiate this device from other devices.
Description Enter a verbose description for your Wheatstone blade. —
Blade Address Enter the IP address of your Wheatstone blade. 0.0.0.0
Ignore Subsequent Deck Starts To have your Audio Server connect to this Wheatstone blade automatically Unchecked

at startup, check this check box and either accept the default value or
change it.

250 milliseconds

Connect At Start Up

To have your Audio Server connect to this Wheatstone blade automatically
at startup, check this check box and either accept the default value or
change it.

Unchecked
250 milliseconds

Closure Descriptions

To make identification of what is connected to your Wheatstone blade’s
closures, click this button and enter friendly names for each connected
closure.
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Field

Description

Default

Switcher Descriptions

To make identification of the inputs and outputs connected to your switcher,
click this button and enter friendly names for each input and output.

4.3.7.9 Adding an MCC PDISO8

> To add an MCC PDISO8 to your OpX Audio Server

1. Install and configure the device (refer to the documentation for your device).

2. Inthe Device I/O tab, click the MCC PDIS08 button

E@ MCC POIS0S |

The Measurement Computing Device dialog box appears.

r

Measurement Computing Device

Mame Dezcrption

Device

| =]

[ lgrnore Subsequent Closures For
200 Millizeconds

[~ Connect At Start Up

[ Closure Descriptions

x Cancel |

Figure 4-24. Measurement Computing Device Dialog Box

3. Complete the fields in the dialog box (see Table 4-14).

4. Click OK.
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Table 4-14. Fields in the Measurement Computing Device Dialog Box

Field Description Default
Name Enter a short identification name for your device. This name should allow —
you to differentiate this device from other devices.
Description Enter a verbose description for your serial server device. —
Device Select a remote device. —
Ignore Subsequent Closures For | To minimize accidental double-clicks, check this check box to set a period of Unchecked

time that each console button will be ignored after it is clicked.

250 milliseconds

Connect At Start Up

To have your Audio Server connect to this device automatically at startup,
check this check box.

Unchecked

Closure Descriptions

To make identification of what is connected to your Wheatstone blade’s
closures, click this button and enter friendly names for each connected
closure.

4.3.7.10 Adding a SAS Console

> To add a SAS console to your OpX Audio Server

1. In the Device I/O tab, click the SAS Console button

P 55 Console

The SAS Console dialog box appears.
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ﬁj SAS Console E@
M arme Drezcription

Conzole &ddresz Puart Congole |0 [ 1 - 256 ]
L =TT R A
Deck #1 Source Channel [ 1 - 9938 ]

1 z
Deck #2 Source Channel #

2 Z
Deck #3 Source Channel #

T

[T Connect At Start Up

x Cancel |

Figure 4-25. SAS Console Dialog Box
2. Complete the fields in the dialog box (see Table 4-15).

3. Click OK.
Table 4-15. Fields in the SAS Console Dialog Box
Field Description Default
Name Enter a short identification name for your SAS console. This name should —
allow you to differentiate this device from other devices.
Description Enter a verbose description for your SAS console. —
Console Address Enter the IP address of the SAS console. 0.0.0.0
Port Enter the port number based on the requirements for your SAS console. 1024
Refer to the documentation for your SAS console.
Console ID Enter a unique ID to identify this SAS console. 1
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Field Description Default

Deck #1 Source Channel # Determine which audio devices are used for each of the three main 1
Deck #2 Source Channel # playback decks. The main playback decks are rotated as playback occurs. 2
Deck #3 Source Channel # The deck with which each item will play appears in the far-right column of 3

the Program Log Display in the Audio Server.

Because OpX uses a software-based audio mixing engine, all three Channel

Playback fields can be set to the same device or, for more control, to their

own individual device. Setting each Channel Playback Device field to a

different audio device is useful for manual control over fades when each

device is connected to a separate channel strip on your console.
Connect At Start Up To have your Audio Server connect to this device automatically at startup, Unchecked

check this check box.

4.3.7.11 Adding an Advantech Device

> To add an Advantech Device to your OpX Audio Server

1. Inthe Device I/O tab, click the Advantech button

B Advantech |

The 1/0O Card Device dialog box appears.

M ame

&) VO Card Device EI@

Dreszcription

|40 Card Type

Device

[ Connect At Start Up

ey

X Cancel |

Figure 4-26. 1/0O Card Device Dialog Box

2. Complete the fields in the dialog box (see Table 4-16).

3. Click OK.
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Table 4-16. Fields in the I/O Card Device Dialog Box

Field Description Default

Name Enter a short identification name for your I/O card device. This name should —
allow you to differentiate this device from other devices.

Description Enter a verbose description for your 1/0 card device. —

I/O Card Type Select the type of I/O card. —

Device Select the device. —

Connect At Start Up To have your Audio Server connect to this I/O card automatically at startup, Unchecked
check this check box.

Closure Descriptions To make identification of what is connected to your Axia I/O device's

closures, click this button and enter friendly names for each connected
closure. Figure 4-19 on page 98 shows an example of a closure list.
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4.3.8 Trigger Set Configuration Settings

You can use triggers to execute (play) audio events, carts, or macros when a closure is
received by your 1/0O device hardware. Common uses for this function are to use Start and/or
Stop buttons on your console, or “button boxes” for sound effects or other audio events.

A “trigger set” is a list of audio or macro events that are executed when a closure is
received. OpX allows you to define multiple trigger sets and load them at will. They can be
loaded using the LOADTRIGGERS macro (see Appendix A - Macros).

4.3.8.1 Creating Trigger Sets

> To create a new trigger set

1. From the Settings dialog box, click the Trigger Sets tab.
The Trigger Sets tab appears.

Settings @

"General | Playback | Auto Fill/ Time Scaling | Record | Categories | Falders | Device 140 |
Trigger Sets l Mirers | Data | Scheduled Events Sets | Modes / Logs | Clozures / Hela_l,ls]

dptien| @ea| x|

Mame Description

\/ Ok x Cancel | E Apply ‘

Figure 4-27. Trigger Sets Tab
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2. Click the New button 4 new

The Trigger Set dialog box appears.

D ezcription

Device

| =}

[ E dit |

# | Clazure | M ame | Cateqary | Dezcriptiaon

X Cancel |

Figure 4-28. Trigger Set Dialog Box
3. Complete the fields in the dialog box (see Table 4-17).
4. Click OK.

Table 4-17. Fields in the Trigger Set Dialog Box

Name Enter a short identification name for your trigger set. This name should allow —
you to differentiate this trigger from other trigger sets.
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Field Description Default
Description Enter a verbose description for the trigger set. —
Device Select the device from which triggers will be received for this trigger set. —

4.3.8.1.1 Editing Trigger Sets

There might be times when you need to edit a trigger set. For example, you may want to
change the macro associated with the trigger set.

> To edit atrigger set

1. From the Settings dialog box, click the Trigger Sets tab.
The Trigger Sets tab appears (see Figure 4-27).

2. Click the trigger set you want to edit, and then click the Edit button ~_ “f*Ed
The Trigger Set Item dialog box appears (see Figure 4-28).

3. Edit the fields you want to change (see Table 4-17).

4. Click OK.

4.3.8.1.2 Deleting Trigger Sets

If you no longer need a trigger set, you can delete it.

« Note: A precautionary message does not appear before you delete a trigger set.
Therefore, be sure you do not need a trigger set before you delete it. You cannot
undo a trigger set after it has been deleted.

> To delete a trigger set

1. From the Settings dialog box, click the Trigger Sets tab.
The Trigger Sets tab appears (see Figure 4-27).

2. Click the trigger set you want to delete.

3. Click the Del button 3D |
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4.3.9 Mixer Configuration Settings

The Mixers tab allows OpX to control the volume levels of the audio devices installed on
your Audio Server machine. The main use for this function is control of audio feeds from
satellite. The Audio Server allows you to configure 10 mixer profiles, each of which is
controllable using macros or the Clock Builder.

4.3.9.1 Creating and Editing Mixers
» To create and edit mixers

1. From the Settings dialog box, click the Mixers tab.

A tab similar to the following appears.

Settings @

" General ] Flayback. ] Auto Fill # Time Scaling | Record | Cateqgories | Folders | Device [/0 |
Trigger Sets  Mixers ] Data | Scheduled Events Sets | Modes / Logs | Closures / Helays]

[ Edit

# | Mame Deszcription
1 MIXER1 tIXERT
2 MI¥ERZ MIXERZ
3 MIKER3 MIXER3
4 MIXER4 MI<ER4
5 MIXERS MIXERS
E MIXERE MI=ERE
7 MIKERT MIXERT
8  MIXERS MIXERE
9 MIXERS MI=ERI
10 MIXERTO MI=ERT0

o OK XK Cancel ‘ S ‘

Figure 4-29. Mixers Tab
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2. Click a mixer profile, and then click the Edit button

A Mixer dialog box similar to the following appears. The left pane shows the installed

audio devices and each controllable function of that audio card.

o

&) MIXERL / MIXERL

+| x|[# =&

A" Faders

B--4= Master Volume
B 1 - ASIERZ0 /02 WDk |1
4= Master Yolume
B 1 - ASIERZ0 /03 WD I
4= Master Yolume
BIE 1 - ASIERZ0 /04 WDk |
4= Master Yolume
B 1 - ASIERZ0 Miner
[-4d= Record 1
[-4d= Record 2
G-48= Line Out 1
[-48= Line Out 2
B Speakers [2- High Defir
4= Master Yolume

L L} 2

-~

m

Dezcription
MIXER
#| Card Contral | Description
4 T
o 0K

x Cancel

Figure 4-30. Mixer Dialog Box

3. Browse through the list in the left pane, and then click the volume control of your desired
device’s input or output channel.

4. To add a device to the mixer’s configuration, click the Add button 4 |

5. To remove a control from the mixer’s configuration, click the control in the list on the right
(see Figure 4-31), and then click the Delete button il

6. When you finish, click OK.
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¥ MLEERL §MIREE ]

H.-.- - ot i EE
JUNEH_T |Unein1 1o Line Dut 1 on ASIBIT 21
| x|l w| |
[m 1-ASIEDI2Mme al |8 Cod | Corivol| Descption |
- 4 Recoed 1 Bl 67 Line Dut 1/ Line In 1 /Vohume

Figure 4-31. Mixer Editor with an AudioScience 6012 Model’s
Line In 1 Pass-through Volume Control Selected
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4.3.10 Data Configuration Settings

PAD data is an industry-standard format of data output used by HD radio transmitters and
RDS encoders to communicate artist, title, description, and other information. PAD data can
either be transmitted from the OpX system as a .xml file or sent directly to a device in the
network using that device’s IP address.

To set up PAD data output, use the Data tab.

> To configure data settings
1. From the Settings dialog box, click the Data tab.

A tab similar to the following appears.
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Settings

Trigger Sets | Mixers Data

Gereral ] Playback ] Auta Fill / Tirme Szaling | Recaord | Categaries | Faolders | Device 140 |
l Scheduled Eventz Sets | bodes / Logs | Clozures / Relays ]

i File Mame
| =
P Address Part
0o . 0 .0 0
[10.1.1.10 - Opx |
Fields Ewclude Categonies [ Folders |
[CcuTio & [ 5pots &
DT'TLE _| DNE‘-‘WS E|
[ &RTIST [ Music
[CJLEMGTH 1 Imaging
Flrreor E ... i
1| 1} 3 1| 1 3
Mext Events kdirirnLm Length

1] Z 0 Z a0 Z Secondz

| Remove Test Between Specified Character in Title & Artist Fields |"_

-

(]

Drefault Drefault
Tithe * Btigt =
* Defaults Are Uzed Faor Excluded tems
v’ (] x Cancel | E Apply |

Figure 4-32. Data Tab

2. Complete the fields in the dialog box (see Table 4-18).

3. Click OK.
Table 4-18. Fields in the Data Tab
Field Description Default
Enable PAD Output To enable output of PAD data, check this check box. Checking this check Unchecked

box enables the remaining options in this tab. To stop PAD data output,
uncheck this check box.
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Field Description Default
File Name To output PAD data to an .xml-formatted file, check this option, and then —
either enter the path in the field or click the ¢! icon, go to the desired
location in the Browse dialog box, and click Open. Each time the PAD data
is updated, the specified filename are overwritten with a new copy of the
xml file with the current data
IP Address To have OpX output PAD data directly to an IP address, check this option 0.0.0.0
Port and enter the IP address and port number. —
Network Interface Select the IP address of the OpX network interface for this IP connection. 10.1.1.20 - OpX
Fields Check the types of data you want the Audio Server to output as PAD data. Unchecked
Exclude Categories (Folders) Each audio event category you defined appears in this list. Enabling one of Unchecked
the categories in this list causes the Audio Server to NOT output the data of
that event to the PAD data.
Previous Events Allows you to transmit a desired number of data about the previously played 0
audio events.
Next Events Allows you to set a desired number of upcoming audio events for which to 0
send data.
Minimum Length Allows you to exclude events from transmitting PAD data. This option allows 30 seconds

you to set a limit by the minimum length audio events that must send PAD
data (in seconds).

Remove Text Between Specified
Characters in Title & Artist Fields

Data from the artist or title fields to be removed when sending pad data. This
is determined using a special character. If you have an artist that looked like
"grateful dead 1972 Europe," for example, and you want the pad to display
only "grateful dead," you can change it to "grateful dead *1972 Europe*" and
set the asterisk to be our delimiting character.

Default Title Default information to show if the title field is missing or if the data is being —
skipped.
Default Artist Default information to show if the artist field is missing or if the data is being —

skipped.
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4.3.11 Scheduled Event Set Configuration Settings

Scheduled events are events — audio files or macros — that you want executed
automatically, regardless of other activities being performed in the program log or any other
area of the OpX system. They are ideal for starting records, sending serial strings,
controlling switchers, or any other event you want to occur in the background.

Scheduled events are added to a Scheduled Events Set. OpX works with only one
Scheduled events set at a time. It is possible to switch which Scheduled Events Set is
loaded using the LOADSCHEDULED macro. You can also run the LOADSCHEDULED macro from
within a Scheduled Events Set to load another Scheduled Events Set.

4.3.11.1 Adding Scheduled Events

> To configure a new scheduled event

1. From the Settings dialog box, click the Scheduled Events Sets tab.

A tab similar to the following appears.
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General I Plavback I Auta Fill / Tire Szaling I Recaord | Categaries I Fu:ulu:lersl Device [0 |
Trigger Sets | Mixers | Data  Scheduled Events Sets I Modes / Logs | Closures / Relays |

-l-Newl B‘Editl xDell

Mame | Deszcription

X Cancel | = A |

Figure 4-33. Scheduled Events Sets Tab

2. Click the New button e
The Scheduled Event Sets dialog box appears.
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r

Scheduled Events Set @
Mame Dezcrption
dprion| mtea| ool
# | Schedule Cateqaory Mame Dezcription # Command
X Cancel |

Figure 4-34. Scheduled Event Sets Dialog Box

3. Complete the fields in the dialog box (see Table 4-19).

4. Click OK.
Table 4-19. Fields in the Scheduled Event Sets Dialog Box
Field Description Default
Name Enter a short identification name for your scheduled event. This name —
should allow you to differentiate this trigger from other scheduled events.
Description Enter a verbose description for the Scheduled Event Set.
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4.3.11.2 Editing Scheduled Events

There might be times when you need to edit scheduled events. For example, you may want
to change the name or description associated with the scheduled event.

> To edit a scheduled event

1. From the Settings dialog box, click the Scheduled Event Sets tab.
The Scheduled Event Sets tab appears (see Figure 4-33).

2. Click the Scheduled Event Sets you want to edit, and then click the Edit button FEdt
The Scheduled Event Sets Item dialog box appears (see Figure 4-34).

3. Edit the fields you want to change (see Table 4-19).

4. Click OK.

4.3.11.3 Deleting Scheduled Events

If you no longer need a scheduled event, you can delete it.

« Note: A precautionary message does not appear before you delete a scheduled
event. Therefore, be sure you do not need a scheduled event before you delete
it. You cannot undo a scheduled event after it has been deleted.

> To delete scheduled events

1. From the Settings dialog box, click the Scheduled Event Sets tab.
The Scheduled Event Sets tab appears (see Figure 4-33).

2. Click the scheduled event you want to delete.

3. Click the Del button € Del
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4.3.12 Mode and Log Configuration Settings

The Modes tab allows you to configure OpX modes, program log options, and macro
options.

To configure modes and logs
1. Inthe Device /O tab, click the Modes / Logs tab.

The following tab appears.

Settings

" General I Flayback | Auta Fill / Time Scaling | Fecord I Cateqaries | Falders I Device 1/0 I
Trigger Setz I b imers | [rata I Scheduled Events Sets  Modes / Logs | Clozures £ Relapz

Allowed Modes

v
¥ Assist

¥ Auto

Program Log Options

[¥ File Server Updates To Log ltems [ If Unchecked Depend On FileSync Only |
¥ Update &l Program Logs [ 1f Unchecked Depend On FileSync Only )
[T Check Flle Server Program Log And Merge Changes Inka One-dir Log

Macro Ophions

hacro Separatar Character

m

J 0k x Cancel | E Apply |

Figure 4-35. Modes / Logs Tab
2. Complete the fields in the tab (see Table 4-20).
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Table 4-20. Fields in the Modes / Logs Tab

Field

Description

Default

Allowed Modes

Designates how each OpX Audio Server advances through a program log.
There are three modes for each Audio Server: manual, assist, and auto.

o Manual mode = the Audio Server steps through the log manually, relying
on outside input before advancing.

o Assist mode = intended for use by live talent. Audio events load from the
program log into the Playback Deck Stack, but segues do not execute
automatically as they are in auto mode. Events are played by clicking the
Start/Start Next button, an individual deck’s play button, a timed event, or
by a closure (if configured)

o Auto mode = the Audio Server advances through the log automatically,
unless it encounters a command in a log directing it to do otherwise.

Checked

Program Log Options

Allows you to configure the following options:

o File Server Updates = when checked, the Audio Server transfers new
program logs. Not necessary with FileSync.

o Update All Program Logs = updates anything in the Logs folder, not just
logs that match the program log template. For example, TESTLOG
transfers, even though the template is %mm%dd%yy.

o Check File Server Program Log = moves updates in real-time into the
program log.

Checked

Macro Options

Allows you to define the character that separates macros.

4.3.13 Closure and Relay Configuration Settings

The Closure/Relay tab allows you to configure the following settings:

. Start deck closures — see section 4.3.13.1.

«  Stop deck closures — see section 4.3.13.2.

« Channel on relays — see section 4.3.13.3.

« Channel off relays — see section 4.3.13.4.

- Voicetrack relays — see section 4.3.13.5.
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4.3.13.1 Configuring Start Deck Closures

The Start Deck Closures tab allows you to configure incoming closures to trigger Deck #1,
Deck #2, and Deck #3 to start playing their currently loaded events. This feature is most
commonly used with Start buttons on your station’s console. The Ignore Start Closure For
option allows you to set an ignore period for the incoming closure so that an accidental
double-press of the button will not cause the deck to play 2 items.

Settings @

" General ] Playback ] Auto Fill / Time Scaling | Record | Categories | Folders | Device 140 |
Trigger Sets | Mimers | Data | Scheduled Events Sets | Modes / Loge  Clozures / Relays

Device
Channel On Felays i Channel OFf Relays | Yoicetrack Felays |
Start Deck Closures | Stop Deck Closures |
Deck #1 [ Start Mext For Assizt & Auto Modes |
| Mat &pplicable j
Deck #2
| Mot Applicable j
Deck #3
| Mat &pplicable j

[+ lgnore Start Closure For | 1000 Milliseconds After & Deck Starts

o OF x Cancel | H el |

Figure 4-36. Start Deck Closures Tab
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4.3.13.2 Configuring Stop Deck Closures

The Stop Deck Closures tab allows you to configure incoming closures to trigger Deck #1,
Deck #2, and Deck #3 to stop playing their currently playing event

[ Settings @ﬁ

General ] Playback. ] Auto Fill / Time Scaling | Record | Categoniesz | Folders | Device 140 |
Trigger Setz | Miners | Drata | Scheduled Events Sets | Modes / Logs  Closures / Felays

Device

=]

Channel On Felays | Channel Off Felays | Woicetrack Felays |
Stop Deck Clozures {

Start Deck Closures

Deck #1
| Mot &pplicable j
Deck #2
| Mat &pplicable ﬂ
Deck #3
| Mot dpplicable ﬂ

\/ k. x Cancel | E Apply |

Figure 4-37. Stop Deck Closures Tab
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4.3.13.3 Configuring Channel On Relays

The Channel On Relays tab allows you to configure outgoing relay closures to pulse or
latch on when Deck #1, Deck #2, or Deck #3 are playing on the Audio Server.

If using Pulse At Beginning Of Playback For, specify the duration of the pulse from the
Milliseconds selector (for a secondary closure when each deck stops, see section
4.3.13.4). Otherwise, to keep the relay latched, select On For Duration Of Playback

Settings 5
Gereral ] Playback ] Auta Fill / Tirme Szaling | Recaord | Categaries | Faolders | Device 140 |
Trigger Sets | Mixers | Data | Scheduled Events Sets | Modes / Loge  Closures / Relaps

Device
Start Deck Closures | Stop Deck Closures |
Charnel On Relays | Channel Off Aelays | Yoicetrack Felays |

¥ Pulze At Beginning OF Playback For | 500 Millizeconds

" On For Duration Of Playback

Deck #1
| Mot &pplicable ﬂ
Deck #2
| Mot &pplicable j
Deck #3
| Mot Applicable j

/ (] x Cancel | E Apply |

Figure 4-38. Channel On Relays Tab
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4.3.13.4 Configuring Channel Off Relays

The Channel Off Relay tab settings are used to configure a momentary outgoing relay
closure to for Playback Deck #1, Deck#2, or Deck #3 when and will pulse the selected relay
when playback is stopped.

The relay options on this tab are used only when the Pulse At Beginning Of Playback
option on the Channel On Relays tab is enabled (see section 4.3.13.3). The pulse length
setting for the Channel Off Relays are the same as those configured in the Millisecond field
on the Channel On Relays tab.

Settings =5
" General ] Flayback. ] Auto Fill / Time Scaling | Record | Categories | Folders | Device /0 |
Trigger Setz | Misers | Data | Scheduled Events Set$| Maodes / Lags  Closures / Relaps

Device
Start Deck Closures | Stop Deck Closures |

Channel On Relaps Channel 0K Relays | Yoicetrack Relays |
Deck #1
|Nnt Applicable j
Deck #2
|N0t Applicable j
Deck #3
|Nnt Applicable j
* Channel Off Relays are only
applicable if the Channel On
FRelays are zet to pulse.

o 0K x Cancel ‘ & “pply ‘

Figure 4-39. Channel Off Relays Tab
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4.3.13.5 Configuring Voicetrack Relays

The voicetrack relay function works with BSI Skimmer Plus to enhance your skimming
functionality and the validity of what is played on the air.

When a voicetrack is played over the air, the relay chosen in the Playing Voicetrack Relay
field will be latched closed.

Voicetrack Inhibit Relay is used to have Skimmer Plus ignore its “mic open” closure while
the OpX Studio Client is in the Voicetrack Editor. This prevents Skimmer Plus from recording
the creation of your voicetrack before it is completed so that the voicetrack is not recorded
as if it was played over the air.

Settings @
General ] Playback. ] Auta Fill # Time Scaling | Record | Categories | Folders | Device 1/0 |
Trigger Sets | Misers | Data | Scheduled Events Sets | Modes / Lags  Closures / Relays

Device
Start Deck Closures | Stop Deck Closures |
Chanrel On Felays | Channel Off Felays i Woicetrack Relays
Playing Yoicetrack Relay
| Mat Applicable j
| Mot Applicable
W OK h 4 Eanci}| = N |

Figure 4-40. Voicetrack Relays Tab
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4.4 Loading the Program Log

Clicking Load Log on the File menu allows you to load a log ad-hoc manually. This is useful

when you want to play content that is not part of your scheduled programming, or need to
reload or restart a log.

> To load the program log
1. Onthe File menu, click Load Log.

The Load Program Log dialog box appears.

Load Program Log @
Today Tomarraw Yesterday |
test
[ Load From Server o OF X Cancel |

Figure 4-41. Load Program Log Dialog Box
2. Complete the fields in the dialog box (see Table 4-21).
3. Click OK.
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Table 4-21. Fields in the Load Program Log Dialog Box

Field

Description

Default

Today
Tomorrow
Yesterday

Automatically loads the log specified for each day based on the “Program
Log Name Template” setting in the General tab of the Settings window (see
section 4.3.1). Clicking one of the Today, Tomorrow, or Yesterday buttons
loads the specified log instantly and closes the dialog box.

To select a specific log instead of using the Today, Tomorrow, and
Yesterday buttons, click the name of the log in the log list and click OK. If
you do not want to load a log, click the Cancel button.

Load From Server

By default, logs are loaded from the Audio Server's local hard drive.
Checking this check box shows the logs stored on your File Server.

Unchecked

4.5 Adding, Editing, and Deleting Items in the Program Log

The Edit menu has Add, Edit, and Delete options for adding, editing, and deleting items in

the program log.

4.5.1 Adding Items to the Program Log

Use the Add button on the File menu to insert files manually into the currently loaded

program log ad-hoc.

> To add an item

1. Inthe program log, click the item above where you want to insert the item.

2. On the Edit menu, click Add.

The Add dialog box appears.

Page 130 of 487




Audio Server Module

Add ==

Cue

Ao Skart [ + ]

Scheduled Time [ HH:MM:55]
000000 .

Categary

| =~
Mame [ Cut |d / File ]

|

Dezcription # kM acro Command

W OF x Cancel |

Figure 4-42. Add Dialog Box

3. Complete the fields in the dialog box (see Figure 4-42).

4. Click OK.

Table 4-22. Fields in the Add/Edit Dialog Box

Field

Description

Default

Cue

Allows you to set the cue type for the item being inserted. For more
information, see Appendix B - Cue Types.

Auto Start (+)

Scheduled Time

Set the time the event is scheduled to play. This setting is not required for
events with a cue type of Auto Start or Stop because it has no effect on
playback, although it is useful to track when your events should play.

With Time Immediate and Time Next events, however, the Scheduled Time
is required because it determines when OpX plays the event. Enter the time
in HH:MM:SS format (2 digits for the hour, 2 digits for the minutes, and 2
digits for the seconds, each separated by a colon).

00:00:00

Category

Three types of events can be added:

o Audio = all Audio files belong to the type ‘Audio’ (even if they were given
a custom category)

e Macro

o Comment = remarks that can help you track of your log, but do not
perform a function. The cue type of a comment does affect the flow of
playback; a Stop cue on a comment stops playback, as it would on an
audio file.
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Field

Description

Default

Name

Enter the name of the audio file you want to insert. This field is used only by
the add function when entering items with “Audio” selected from the
Category drop-down list.

Description / Macro Command

All categories use this field.
o Audio events = enter the description of what you are entering.
o Comments = enter the text of the comment.

o Macro = enter the command to be performed (see Appendix A - Macros
for information about the available macros and their command structure).

4.5.2 Editing Items in the Program Log

There might be times when you need to edit items in the program log.

» To edit an item

1. Inthe program log, click the item you want to edit.

2. On the Edit menu, click Edit.

An Edit dialog box similar to the following appears.

[ Edit - 48b-00 ==

Cue

Aubo Skart [ + ]

Scheduled Time [ HH:Mi:55]
000000 ==

Category

|4UDID |

Mame [ Cut |d / File ]
|3468b-09

Dezcnption / Macro Command
|[H ock] Superstar[Clean Edit] - Cypress Hi

W OF X Cancel |

Figure 4-43. Edit Dialog Box

3. Edit the fields you want to change (see Table 4-22).
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4. Click OK.

4.5.3 Deleting Items from the Program Log

If you no longer need an item in the program log, you can delete the item.

<« Note: A precautionary message does not appear before you delete an item.
Therefore, be sure you do not need the item before you delete it. You cannot
undo an item after it has been deleted.

> To delete an item
1. Inthe program log, click the item you want to edit.

2. On the Edit menu, click Delete.

4.6 Playing Back a Program Log Item

The following procedure describes how to play back an item in the program log.

If the program log is playing when you click the Start option or button, playback of the
current item continues and the selected item will play back at the highlighted point. To move
playback to a new point in the program log from the Audio Server, use the Stop option or
button to stop playback, then select the item in the program log at the point where you want
to restart playback and click the Start option or button.

> To play back an item in the program log
1. Inthe program log, click the item you want to play back.
2. Perform one of the following steps:

— Onthe Action menu, click Start.

— On the tool bar, click }
3. To stop playback, perform one of the following steps:

— Onthe Action menu, click Stop.

— On the tool bar, click
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Starting the Auxiliary
Audio Server Module
(page 135)

5 Auxiliary Audio Server Module

This chapter describes the OpX Auxiliary Audio Server
module.

The OpX Auxiliary Audio Server is an OpX Audio Server
that you can run to perform tasks such as performing
background recordings. Performing recordings and other
utility tasks in the background removes these tasks from
having to be performed by the main Audio Server. The
Auxiliary Audio Server has the same functions as the
main Audio Server, except that it is not accessible from
an OpX Studio Client. Consequently, only an engineer
with permission to the workstation running the Auxiliary
Audio Server can modify it.
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5.1 Starting the Auxiliary Audio Server Module

You must start the File Server module before you start the Auxiliary Audio Server.

> To start the Auxiliary Audio Server module

1. Start the File Server module (see section 3.1).

AUXILIARYOpX AudioServer.

The Auxiliary Audio Server module appears.

§ Audio Server - WBSIRECORD - AuxRec
Eile Edit Action About

Click the Windows Start button and click Programs > Broadcast Software >

=10 x]

> @

Triggers

=
=)
(=8
@

Trigger Set

Time Events

Step Through -
Sched Events
DEFAULT

< AUXILIARY —

Sched Set
D x

Satellite 5hows

Mame | Dietails

IDeuic&s IConna:tionsl Status Record |Playhal:l(

J Item

(&3 1) () B (D (2D VB r) VB VN VB 1D 1) VE) ) E) V) 1B VD 1) B 1) rE) iE) 1) (B (E) R 1E)

| Dezcription

|Name _ Sched / Actual | Length|;|

52
53
54
55
56
57
5&
59
=11]
B1
62
B3
64
(=471
(=]
67
=]
B3
70
71
Ve
73
74
75
76
77
7a
74

on

SATSHOW START. A...
SATSHOW STOP, AB..
SATSHOW START. L.
SATSHOW STOP, LA
SATSHOW START. A
SATSHOW STOP, AB..
SATSHOW START.H...
SATSHOW STOF, HE...
SATSHOW START. A
SATSHOW STOP, AB..
SATSHOW START. L.
SATSHOW STOP, LA
SATSHOW START, A
SATSHOW STOP, AB..
SATSHOW START.H..
SATSHOW STOF, HE...
SATSHOW START. A
SATSHOW STOP, &B..
SATSHOW START. L.
SATSHOW STOR, LA
SATSHOW START, A...
SATSHOW STOP, AB...
SATSHOW START.H..
SATSHOW STOF, HE...
SATSHOW START. A..
SATSHOW STOP, &B..
SATSHOW START. L.
SATSHOW STOP, L&,

CATCUM I CTADT i

12:00:00/ 16:33:07
12:08:15 / 16:33:07
132:06:00 / 16:33:07
12:5%:00 / 16:33:07
14:00:00 / 16:33:07
14:05:00 / 16:33:07
14:06:00 / 16:33:07
14:59:50 / 16:32:07
15:00:00 / 16:33:07
15:05:15 / 16:33:07
15:06:00 / 16:33:07
15:59:00 / 16:33:07
16:00:00 / 16:33:07
16:05:00 / 16:33:07
1E:06:00 / 16:33:07
TE:59:50
17:00:00
170515
17:06:00
17:59:00
18:00:00
18:05:00
18:06:00
18:553:50
19:00:00
15:05:15
15:06:00
12:59:00

00000

ol

v0L0.0.343 4

Figure 5-1. Auxiliary Audio Server Module

3. Refer to the equivalent sections in Chapter 4, as the module setup and usage are

the same as the Audio Server module.
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A

Starting the Studio Client
Module (page 137)

Quick Tour (page 138)

Configuring the Studio
Client Module (page 146)

Operating Modes (page
159)

Verifying a Program Log
(page 161)

Loading a Program Log
(page 162)

Playing Back a Log
(page 164)

Editing a Program Log
(page 165)

Using Hot Keys (page
167)
Saving the Hot Key

Page to theFileServer
(page 175)

Using the Voicetrack
Editor (page 176)

6 Studio Client Module

This chapter describes the OpX Studio Client module.

The OpX Studio Client module is the module used in the
on-air studio and production studio. The Studio Client
module includes the Voicetrack Editor, which allows you
to edit voicetracks for the program log currently on the
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6.1 Starting the Studio Client Module

You must start the File Server module before you start the Studio Client module.

> To start the Studio Client module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX
Studio Client.

OpX searches for stations, and then shows the stations found.
3. Click a station, and then click Done.

A Studio Client window similar to the following appears.

A KLIF-FM - OpX - Broadcast Software International

ZANN
Hot Traffic Sweeper
Bed Whisper TNH
933

ZANN
Sweeper
Whisper

205 1.34 3|22
@ TODAY'S HIT MUSIC

ZANN
Sweeper All
Request

Log: 041316 Air Date: 041372016 p
Empire State Hot Traffic

gag  HOT : YaanAs | DUSSORrL Bed Bed

1001 TALKE BREAK

WOMAN
1002 AL

1004

1005

DELETE MOVE

19:39:04

10.0 1.9

0.0 0
<3:25.0>

START
NEXT

MAKE
NEXT

ZANN
Sweeper Freek-A-Leek
Commercial Bed

ZANN
Sweeper
Urban
Dictionary

ZANN
Sweeper
Hashtag

Frontin' Bed

3 48 3 202

B 5x1 " O

EDIT

SEGUE OPTIONS

INSERT
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6.2 Quick Tour

Studio Client Module

The following sections provide a quick tour of the Studio Client module interface.

# KLIF-FM - OpX - Broadcast Software International

TALK BREAK

DANGEROUS WOMAN

1005 TALK BREA

(5) MOVE

ZANN
Hot Traffic Sweeper
Bed Whisper TNH
933

ZANN
Sweeper
Whisper

134
9 TODAY'S HIT MUSIC

Air Date: 04/13/2016 ZANN
—EesMetliEel .

e - Empire State | Hot Traffic
. : 0 6 Sweeper All
Haus 19:35:
CcK 9.35:43 Bed Bed Request

15 19:38:04
ZANN
Sweeper Freek-A-Leek
Commercial Bed
Free

" 142926 19:39:04

19:42.:28

ZANN
Sweeper
Urban
Dictionary

ZANN
Sweeper Frontin' Bed
Hashtag

11 318
= <>

START EDIT

COPY NEXT INSERT SEGUE

OPTIONS

Number

Description

Date/time panel. See section 6.2.1.

Station panel. See section 6.2.2.

Hot Key panel. See section 6.2.7.

Navigation bar. See section 6.2.5.

Menu bar. See section 6.2.6.

Program log. See section 6.2.4.

0 6/60/00 00

Playback decks. See section 6.2.3.
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6.2.1 Date/Time Panel

The date/time panel shows the current system date and time.

fKLIf FM - OpX - Broadcast Software Intemnational

Clicking the Time section allows you to toggle between 12-hour and 24-hour display
formats.

Clicking the weather information opens a pop-up window that shows current weather and
forecast details.

6.2.2 Station Panel

The station panel shows the logo of the station (Audio Server) to which
the Studio Client is connected. You can click the station panel to

change stations. TODAY'S HIT MUSIC

Tip: To add a station logo to this panel, save a picture in .jpg format in the
Shared Config folder on your file server. Name the file after the station name. In
the example above, for instance, the file is named wopx.jpg.

6.2.3 Playback Decks

The playback deck stack shows the
currently playing audio files along with
those that are upcoming. As your
program log runs, it populates the decks
with the audio files to be played.

The three decks in the stack are shown in

the example above, with the top-most deck currently playing an audio file. The currently
playing audio file always moves to the top of the stack, with the next-to-play audio file
second, and third-to-play deck last. This is referred to as a stack because the decks are not
in order numerically; instead they are in order by which file is currently playing, then the next
to play, and then third to play. When the currently playing deck finishes with its event, it
rotates out of the stack, the next items move up, and a new third-to-play item is added to the
bottom of the stack.
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When an audio file is playing, you can use the Stop Button to stop playback of the deck.
The progress meter shows the length remaining of the audio file in text. In the example
above, 2 minutes, 39.7 seconds remain) and creates a bar-graph representation in the
background.

The color of the text and progress bar depends on the portion of the audio file that is playing:
- Blue = appears during intro.

- Green = appears during the main section.

- Red appears during the segue.

The deck from which the audio file is playing appears at the far right, with a @), 2, or @
icon.

6.2.4 Program Log

Log: 041316 Air Date: 04/13/2016
S HOT OUICK —

The program log shows the schedule of
events that will be played, including audio
files, carts, and macros. s ki : H=EG,

1002 & y SRRl 120: 19:39:04

The name of the currently loaded log
appears after the Log: tag at the top of the
log. If the intended air date of the log is set,
it appears after the Air Date: tag.

Except for the first and last columns, the
header of the list contains titles for the data
type of each column of the program log.
Table 6-1 describes each column in the
program log.
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Table 6-1. Columns in the Program Log

Column Description

Cue Uses an icon to show the cue type of each program log item:

 [No Icon] Auto Start = Auto Start cued events have no icon in the Studio Client's program
log display. This is equivalent to the + cue the Audio Server shows for Auto Start events.

. (9 Time Immediate = event with a cue type of Time Immediate. This icon is equivalent
to the @ cue on the Audio Server.

(B
. \.) Time Next = items with a cue type of Time Next. This icon appears for events
designated with the # cue on the Audio Server.

. @ Stop Cue = audio playback will stop. This icon appears for items with no cue type
on the Audio Server.

# Shows the event number of each event in the program log. The first event at the top of the
program log is event 1 and each event after that is incremented. This makes it easy to track
your location in your log should you exit and re-open OpX or edit in a production room. The
currently playing event displays Play rather than its event number.

Description Shows the Artist and Title data from your audio files and carts. For Macro events or
Comments, the specified entry is shown. For quick identification, an icon appears to the
right of the description text for common category types:

. ﬁ = commercials

. ;E = music
e,
. &) cart

. l_.'_._ = voice track

o ¥ = macro
Name Shows the physical file name (the name the audio file on the hard drive) of audio events.
Time Shows the time your audio file is scheduled to play. The time can be configured to show the

estimated time, scheduled time, or both using the Log Time drop-down list in the General
tab of the Studio Client module (see Table 6-5 on page 149). If no time is specified by your
traffic or music log-generating software, OpX estimates when the subsequent files will play
based on the currently playing item and the system clock setting. This field changes to a
Play button (or a Stop button on the currently playing event) on the highlighted event in the
program log.

Length Shows (from left to right) the intro length, total length, and segue length of audio events.
Macros and comments do not have an associated length and do not show a length.

Deck Number Uses an icon to show which deck number will be used to play each item. This is useful if
you configure your audio server to use separate line outputs to your console for performing
manual fades, etc. If you force a re-load of the decks or change the next-to-play item, the
playback order in this column is reset and the order can change.
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6.2.5 Navigation Bar

The navigation bar runs along the right side of the program log. It contains the icons in Table
6-2 that simplify navigation in the program log.

Table 6-2. Icons in the Program Log Navigation Bar

Icon Icon Name Description

Page Up Click to move the program log up one page at a time.

Event Up Click to move up one item at a time.

Current Event | Automatically scrolls the program log to the currently playing event.

Go To Time Click to go to a specific time in your program log. A grid appears with a button for each hour
of the day. Click the desired hour to go to that portion of your program log.

L B B &

Detach If you have two monitors, click to place the Hot Keys to detach the Hot Key Panel from the
Hotkey Panel | main user interface and make the panel a separate user-sizable window.

Event Down Click to move down one item at a time.

Page Down Click to move the program log down one page at a time.

E 8 0
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MAKE START EDIT

626 Men u Bar AUTO  DELETE  MOVE COPY CUE T il e OPTIONS

The menu bar contains the main function buttons of the user interface. The buttons that
appear on the menu bar vary with the operating mode selected using the Mode button (the
far left button in the figure below, shown set to Auto mode). Table 6-3 describes the buttons
in the menu bar.

For more information about operating modes of the Studio Client module, see section 6.4.

Table 6-3. Menu Bar Buttons

Button Description

Use to switch operating modes of the Studio Client module.

e Highlight an item in the program log and click this button to delete the event.

Highlight an event in the program log, click this button, and then click another location to move the event.

Highlight an event in the program log, click this button, and then click another location to copy the event.

Sets the program log to cue mode to preview intros and segues of each audio event.

OB RE

To reload the Playback Deck Stack with the currently highlighted event in the Program Log as the next-to-
play item, click this button.

§

Starts playback or forces a segue to the next event.

Opens the Event Insert window to add items to the program log or Hot Keys.

Edits the cross-over length and type for an individual segue, click this button to open the Segue Editor.

Provides access to various Studio Client options, including voicetracking and loading and saving of logs.
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6.2.7 Hot Key Panel

Hot Keys are “instant-fire” audio files, carts, or macro
commands available at the touch of a button. You
create Hot Key Sets to organize the Hot Keys
available.

The Hot Key Panel has a Hot Key Set loaded with
audio files and carts. Clicking any Hot Key plays the
specified audio event.

Adding or replacing items is as easy as dragging-and-
dropping from the Insert Item window (shown in Figure
6.4) onto the desired Hot Key. Random 1:00

Spot

woly

To edit the color, options, or clear a Hot Key right-click
a Hot Key and click the corresponding option from the
pop-up menu.

To switch between Hot Key Sets, click the Next . or
Previous . button.

To save Hot Key Sets to your local machine, click the
Save To Server  button. To load a previously saved
Hot Key Set from the server, click the Load From
Serverﬂ button. To refresh the currently loaded Hot
Key Set, click the &JRefresh button. To adjust the number of rows and columns displayed
on the Hot Key Panel, click the Hot Buttons Settings button.
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6.2.8 Insert Panel

The Insert Panel inserts audio events into the program | HLTER oL
log display and adds audio events to the Hot Keys.

To access the insert panel, click the Insert button in
the menu bar at the bottom of the Studio Client user
interface. The insert panel can be displayed in two

locations: 8.6/ 4. _ Fii.Dec 15. 06 48

636 ltems

«  Superimposed over the top of the Hotkeys Panel.

«  Over top of the left side of the program log display.

Fri. Dec 15, 06

To switch orientations, click the Insert button on the
menu bar to toggle between views. The panel
switches between the orientations with each click. This
allows you to drag audio events into the program log
(when the panel is over the Hot Keys) or to the Hot 126/ Fr Dec 15,1644
Keys (when the panel overlaps the program log).

Mon. Dec 1. 024

The Quick field shows the file name of the event you
highlighted in the event list. If you know the name of
the event you want to insert, enter the file name using
your keyboard. After you select and highlight your
event, the insert method you use depends on where you place your event:

Fri, Dec 15, 0648

INSERT REFRESH DONE

- Toinsert an event into the program log, click the Insert m button. The button will
switch its label to Insert Where? i at which point you can click on the location in
your program log where you want your event placed. The event you click shifts down,
along with all subsequent events, and the new event is inserted.

- To add your event to a Hot Key, use your mouse cursor to drag the event from the event
list and drop it onto your desired Hot Key.
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6.3 Configuring the Studio Client Module

The Studio Client module comes with default configuration settings. Using the Config option
on the Options menu, you can change these settings to suit your requirements. For
convenience, the settings are organized in tabs in the Settings window.

> To configure the Studio Client module settings

1. Onthe Options menu, click Config.

The Configuration dialog box appears, with the General tab displayed.

Configuration

General Modes Playback Voicetracking) CAudition f Cue

Sample Rate

44,100 HZ v

< §<i

Hot Buttons Folder

C:AProgram Files [#26]4Broadcast Safhware Intematior =

EEEN

k Folder

C:\Program Files [#26)\Eroadcast 5 oftware Intermatior =
low He

HEE

ion To Executing / Next Time QOut

Hot Button Pages

Hot Button Update Interval

Log Time

Configuration ore Estimated Time

Skin OpXSkinOptions
Options

CANCEL
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2. Complete the fields in the dialog box tabs.

General Settings — see section 6.3.1
Mode settings — see section 6.3.2

Playback settings — see section 6.3.3

Voicetracking settings — see section 6.3.4

Audition/cue settings — see section 6.3.5

3. When you finish, click Done.
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6.3.1 General Configuration Settings

The General tab contains basic settings for setting up your Studio Client module.

Configuration

General Modes Playback Voicetracking) | Aadition //Cue

Sample Rate ] ommands

44,100 HZ -

Made
STEREOQ hd

Hot Buttons Folder
C:%Program Files [36MBroadcast Software Internatior =

ck Folder

C:%Program Files [36MBroadcast Software Internatior = Sk

Enable Hot Buttons Settings
Fow Height
r Buttons
og Info Aboy
Jrag Drop From
ngth Minus

[=

Lljlg Time

Eztimated Time -

Skin
Options

CANCEL

Table 6-4. General Tab
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Table 6-5. Fields in the General Tab

Field

Description

Default

Sample Rate

Output sample rate for all audio files played by the Studio Client (for
example, monitoring voice tracks, intros, segues, and Hot Keys).

44,100 HZ

Mode

Determines whether audio will be stereo or mono (summed) for all audio
files played by the Studio Client (for example, monitoring voice tracks, intros,
segues, and Hot Keys).

Stereo

Hot Buttons Folder

Path where audio files used in Hot Key sets will be cached.

See the tab

Voicetrack Folder

Path where voicetrack files, and associated intro and segue audio file
portions used to create and edit your voicetracks, will be cached.

See the tab

Row Height

Amount of space each line of the program log display is allowed to use. A
higher number allows more data to be displayed per event. A lower number
allows more events to be displayed at the expense of the amount of data per
event that can be shown.

38

Auto Position To Executing/Next
Time Out

Number of seconds before the position line reappears on the voicetrack and
segue editors.

45

Hot Button Pages

Maximum number of Hot Key sets that the Hot Key panel will show. A lower
number is non-destructive, so setting the maximum page lower than an
existing Hot Key set does not delete or destroy the Hot Key sets above the
maximum number set.

10

Hot Button Update interval

Amount of time before the studio client checks for new version of the file
associated with the hot button.

30

Configuration Password

Security password that allows only intended users can access the
Configuration window. After a case-sensitive password is entered in this
field, a prompt appears when a user tries to go to the Configuration window.

Allow Delete Of Macro
Commands

Allows you to delete macro commands from the Studio Client program log
display.

Checked

Delete Yes/No Prompt

o Checked = a confirmation prompt appears before items are deleted.

o Unchecked = a confirmation prompt does not appear before items are
deleted.

Unchecked

Fade Current On Log Item Play

o Checked = currently playing audio event fades out when the log loads
and the first event in the newly loaded program log starts to play.

o Unchecked = when a new log is loaded, the currently playing event stops
playing before the first item in the next log starts.

Checked

Disable Keyboard Functions

o Checked = disable Studio Client Control + [Key] shortcuts. Normal
keyboard usage, such as typing in a name to search, is still possible. This
setting is helpful if you accidentally press or bump keys on your keyboard
that unintentionally affect playback.

o Unchecked = enable Studio Client Control + [Key] shortcuts.

Unchecked

Show Voicetracks Folder in
INSERT List

o Checked = insert previously created voicetrack files into the program log
or Hot Keys.

o Unchecked = hides the voicetrack folder in the Insert window’s Folder
drop-down list.

Unchecked
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Field

Description

Default

Rotation On Hotkeys

o Checked = adding an audio event to a Hot Key that has an audio event
already associated with it displays a prompt to replace the existing audio
event or add it as a rotation. Each time you click the Hot Key, it plays one
of the audio events in the rotation.

o Unchecked = the added audio event always replaces the one associated
with the Hot Key without displaying a prompt.

Checked

Stop Button On Playing Item

o Checked = currently playing event displays a stop button in the program
log display rather than a play button. This setting does not affect the Stop
button in the decks on the Playback Deck Stack.

o Unchecked = currently playing event displays a play button in the
program log display.

Checked

Call Letters

o Checked = call letters appear to the left of the date/weather information in
the Studio Client interface. A field is provided for entering the call letters.

o Unchecked = call letters do not appear in the Studio Client user interface.

Checked

Slogan

o Checked = slogan appears to the left of the date/weather information in
the Studio Client interface. A field is provided for entering the slogan.

¢ Unchecked = slogan does not appear in the Studio Client user interface.

Checked

Enable Splitter

o Checked = program log and Hot Key Panel widths can be moved by
dragging the splitter bar between them.

o Unchecked = program log and Hot Key Panel widths are locked to their
current position.

Unchecked

Enable Hot Buttons Settings

o Checked = number of Hot Key rows and columns can be changed.
o Unchecked = number of Hot Key rows and columns is locked.

Unchecked

Enable Hot Button Unlock

o Checked = Hot Key panel can be unlocked.
o Unchecked = Hot Key panel cannot be unlocked.

Unchecked

Multi-Color Buttons

o Checked = color layout of the Studio Client can be changed.
o Unchecked = color layout of the Studio Client cannot be changed.

Unchecked

Show Log Info Above Program
Log

o Checked = shows program log info information, including the name of the
program log, at the top of the program log display.

o Unchecked = hides program log info information.

Checked

Drag Drop From Hotkeys

o Checked = items from the currently showing Hot Key Set can be dragged
and dropped into the program log.

¢ Unchecked = events cannot be dragged from your Hot Keys to the
program log.

Unchecked

Length Minus Segue In Log &
INSERT List

Track length as calculated at the segue marker, not as calculated from the
end of the track.

Unchecked

Sync System Time With The File
Server

Do not use this check box.

Unchecked

Alternate Last/Next Play Date

o Checked = last and next play dates are alternated.
o Unchecked = last and next play dates are not alternated.

Unchecked

Add Sort By Year

Allows you to sort songs by the year they were produced. For example, this
feature is useful with classic rock stations.

Unchecked
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Field Description Default
Show Scheduled Time On Stops | Time that items are scheduled to run, instead of the estimated time they will Unchecked
& Time Events play. Timed events can be programmed, so they will hit the scheduled time
exactly by using the @ cue type.
Max Voicetrack Length Maximum allowed length of the voicetracks. 5
Log Time o Estimated Time = time when the system thinks the item will play. Estimated Time
o Scheduled Time = scheduled time derived from an external scheduling
software application.
o Both Estimated & Scheduled Times = estimated and scheduled times.
Skin Options Allows you to customize the appearance of the Studio Client user interface. —

For more information, see section 6.12.9.
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6.3.2 Mode Configuration Settings

The Modes tab allows you to configure the initial and available modes for the Studio Client
module.

Configuration

General Modes Playback Yoicetracking) [ Audition / Cue

Initial Mode

Air
Edit
Woicetrack

Available Modes
it
Edit

CANCEL

Table 6-6. Modes Tab
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Table 6-7. Fields in the Modes Tab

Initial Mode Allows you to set the default mode for the Studio Client when you open the Air
Studio Client Module.

Available Modes Uncheck options to disable modes from the Studio Client on your machine. Air
This is useful for production machines that you do not want to potentially Edit
allow to control the on-air playback Voicetrack
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6.3.3 Playback Configuration Settings

Hot Keys are one of two types of audio events not played by the Audio Server module
(voicetrack editing is the other). The Playback tab allows you to select which playback
devices the Hot Keys will use. The Studio Client can use three playback devices for Hot Key
playback. You can either choose an independent device for each of the three selections, or

use the same device for all three.

By default, the left-most column of Hot Keys use Hotkey Playback Device #1, the middle

column uses Device #2, and the right column uses Device #3.

Configuration

laeneral Modes Playback YVorcetracking) [Aodition /) Coe

Hatkey Playback Device #1 ia Channel On / Off
Hotkey Playback Device H2
Nane -

Hotkey Playback Device #3

Nene -

Play first hot button on device #1. second on #2 and third on #3

CANCEL

Table 6-8. Playback Tab
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6.3.4 Voicetracking Configuration Settings

The Voicetracking tab allows you to configure voicetrack settings.

Configuration

General Modes Playback Yoicetracking FAndition) /iCue

Voicetrack Playback Device

Speakers (Parallelz Audio Contr -

rack R d De

Vo e
Microphone (Parallels Audic Con -

Lompres!

CANCEL

Table 6-9. Voicetracking Tab
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Table 6-10. Fields in the Voicetracking Tab

Field Description Default

Voicetrack Playback Device Playback device the Voicetrack Editor will use. See the tab

Voicetrack Record Device Record device the Voicetrack Editor will use. See the tab

Auto Position Playback Cursor Allows you to choose the default position of playback start. Checked

3

Cursor Restore Timeout Number of milliseconds before the cursor reappears after adjusting the start 1000
point of the voicetrack or Cut 2.

Fine Positioning Interval Number of milliseconds by which each track will be shifted when clicking the 100
advance or recede buttons.

Fine Position Button Repeat Allows you to enable a repeat function when holding the advance and pull- Checked

Mode back buttons and adjust the amount of time between each repeat. 100

Record Volume The Voicetrack Editor records at the full volume coming into the audio Unchecked
device being used. Use this field to set a specific record volume other than 100
100%.

Load Voicetrack Cuts With NEXT | Used with the voicetrack marker configured in the Import-Merge module’s Unchecked

Button Import Format settings. Importing voicetrack markers into your program log

simplifies voicetracking by allowing your talent to click the NEXT button in
the Voicetrack Editor to automatically move the Voicetrack Editor to the
position in the program log for which they need to record the next voicetrack.

Compress Voicetracks Check to have the system compress the audio. (Instead of using WAV, the Unchecked
system uses the method defined in the file server.)
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6.3.5 Audition/Cue Configuration Settings

If you use the audition/cue function, you can check the Audition check box and configure the
following settings.

Configuration

General Modies Playbick Yisetracking Audition / Cue

Courtdown Segue

Seconds After Intro / Prior To Segue

ol

Play Out Assigned Audio Server Channel

CANCEL

Table 6-11. Audition/Cue Tab
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Table 6-12. Fields in the Audition/Cue Tab

Field Description Default

Countdown Segue o Checked = when auditioning the segue, the timer counts down to zero at Unchecked
the segue point, and then restarts the timer and count down through the
segue length.

o Unchecked = countdown clock counts down the length to the end of the

track.
Seconds After Intro / Prior To Starting point of the segue audition. With the default of 10 seconds, the 10
Segue segue audition starts its playback 10 seconds prior to the segue point. For

example, a segue point of 13 seconds before the end of a song plays the
last 23 seconds of your audio file.

Play Out Assigned Audio Server Plays the audition channel out of the audition device on the audio server Checked
Channel instead of the audition channel on the studio client.
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The Studio Client module has several operating modes that affect the playback of the
program log. You select an operating mode by clicking the left button in the tool bar, and
then clicking a button from the Pop-up menu.

ASSIST

MANUAL

VERIFY

DONE | DELETE | MOVE COPY

Figure 6-1. Pop-up Menu for Selecting Operating Modes

Table 6-13. Operating Modes

Button

Mode

Description

AUTO

Auto

Auto mode is the most widely used operating mode. In Auto mode, all cue types are
adhered to and full automation is possible.

ASSIST

Live Assist

Live Assist mode is used by live talent. Audio events load from the program log into
the Playback Deck Stack, but segues do not automatically execute, as they are in
Auto Mode. Events are played by clicking the Start/Start Next button, an individual
deck’s play button, a timed event, or they can be started by a closure (if configured).

OpX can respect cues for breaks, so that your entire break can be played as if in Auto
mode. This allows your break to play in its entirety without stopping between each
break element/commercial/PSA if you configured Audio Server preferences to do so.

MANUAL

Manual

In Manual mode, no items are automatically placed into the Playback Deck Stack.
Instead you click the individual Play button on the desired event in the program log.
While in Manual mode, no timed events or Auto Start cued events execute
automatically.

OpX can respect cues for breaks, so that your entire break can be played as if in Auto
mode. This allows your break to play in its entirety without stopping between each
break element/commercial/PSA if you configured Audio Server preferences to do so.
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Button

Mode

Description

VERIFY

Verify

After importing or creating a Program Log, verify your program log to be sure all the
events are valid to be played — that the audio files exist, and that the start and end
dates allow the events to be played:

1. Click the Mode button, and then click Verify from the Mode menu.

2. When the verification process ends, a window similar to the one in Figure 6-2
appears, with a list of all faults shown in your program log.

3. Go to the position of the errored item by clicking its listing in the error log.
4. When you finish with the report, click Done.

EDIT

Edit

Edit mode is the most common mode to enter when working in your production room
or on-air studio to add voicetracks and edit logs. It is the only mode you can enter in
the Studio Client that allows you to work with OpX without directly affecting the on-air
playback of the Audio Server module for the station to which you are connected.

Edit mode allows you to edit a program log other than the one currently being aired or
edit the on-air log without affecting the on-the-air playback. When you enter Edit
mode, a pop-up window prompts you to select the log you want to edit. Click the log
and commence your edits. When you finish, click the Options menu and click Save
Log.

Missing: 322

10:00:00 Inflatable T... QUT OF DATE Sun. Jul 8, ...

10:00:06 606-12
10:02:41 2025
10:02:45 16162
10:04:47 2025
10:04:51 19749
10:07:32 2025
10:07:36 15018
10:13:62 2025
10:13:56 15947
10:17:12 2025
10:17:16 16798
10:19:63 2025

Qut Of Date: 2

MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING
MISSING

DONE

Figure 6-2. Example of Faults in the Program Log
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6.5 Verifying a Program Log

After you import or create a program log, verify your program log to be sure all the events
are valid to be played — that the audio files exist, and that the start and end dates allow the
events to be played.

> To verify a program log
1. Click the Mode button on the menu bar, and then click Verify.

At the end of the verification process, a window similar to the one in Figure 6-4 lists all
faults in your program log.

AUTO

ASSIST

MANUAL

VERIFY

S

Figure 6-3. Clicking Verify from the Mode Button
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Missing: 322 Out Of Date: 2

10:00:00 Inflatable T... OUT OF DATE Sun, Jul 8. ...
10:00:06 606-12 MISSING
10:02:41 2026 MISSING
10:02:45 16162 MISSING
10:04:47 2026 MISSING
10:04:61 19749 MISSING
10:07:32 2025 MISSING
10:07:36 15018 MISSING
10:13:62 2025 MISSING
10:13:66 15947 MISSING
10:17:12 2026 MISSING
10:17:16 16798 MISSING
10:19:63 2026 MISSING

DONE

Figure 6-4. Example of Errors in Program Log
2. Go to the position of the error by clicking its listing in the error log.

3. Click Done when you finish with the report.

6.6 Loading a Program Log

> To load an existing log from the Studio Client module

1. Click the Options menu button on the menu bar, and then click Load Log (see Figure
6-5).

The Program Log window appears (see Figure 6-6).
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CONFIG

VOICE
TRACK

)

SAVE LOG

Figure 6-5. Clicking Load Log from the Options Menu
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Program Logs

TODAY TOMORROW

CALENDAR LIST

< March Wednesday April 13th

3 4 5
10 1 12

17 18 19 20 21 23
24 25 26 27 28 29 30

DONE CANCEL

Figure 6-6. Example of Errors in Program Log

2. To load the log specified for today, tomorrow, or yesterday, as determined by the Audio
Server's Program Log Name Template setting, click the Today, Tomorrow, or
Yesterday button.

3. To load a specific log by file name, click the desired program log in the Logs list.

4. When you finish, click the Done button.

6.7 Playing Back a Log

In Auto mode, loading a log executes the first event in the log automatically.

In Assist or Manual mode, perform the following procedure to play back a log. You can
also use this procedure to start playback at a specific point while in any mode.

> To play back a log
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1. Click the event you want to play.

2. Click the Make Next button, and then click the Start or Start Next button.

6.8 Editing a Program Log

You can use the Studio Client to edit the currently playing program log while in Auto, Live
Assist, or Manual mode. You can also use it to edit a log in Edit mode while the on air
program log is playing. The procedure for editing the program log (add events, remove
events, move events, or copy events) in any mode is the same.

6.8.1 Adding Events

> To add an event
1. Click the Insert button in the tool bar
The Insert Panel appears.

2. Find the event you want to add to your program log, and then click the Insert button on
the Insert panel. Do not click the Insert button on the tool bar.

The Insert button changes to Insert Where?
3. Click the location in the program log where you want to place your event.

The event is placed in the location you clicked and the item you clicked in the program
log and all items below it shift down.
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6.8.2 Removing an Event

« Note: A precautionary message does not appear before you remove an event.
Therefore, be sure you do not need an event before you remove it. You cannot
undo an event after it has been removed from the program list.

> To remove an existing event from your program log
1. Click the item to highlight it, and then click the Delete button in the tool bar

The item is removed from the program log.

6.8.3 Moving an Event

The following procedure describes how to move an existing event from one location to
another location in your program log (for example, how to move a song from before a break
to after a break, or switch the order of commercials in a break).

> To move an existing event from one location to another location in your program log
1. Click the item you want to move in the program log.
2. Click the Move button in the tool bar m
The Move button changes to Move Where? -
3. Click the location in your program log to where you want to move the event.

The event moves to the new location and the events between the old and new locations
shift to accommodate the move.

« Note: If you decide not to move an event after clicking the Move button, click
the Move Where? button to cancel the move process -
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6.8.4 Copying an Event

You can copy an event in your program log to another location. This procedure creates a
duplicate event at a different point in your program log.

»> To copy an event
1. Click the event.
2. Click the Copy button
The Copy button changes to “ Copy Where?” -
3. Click the location in your program log where you want to place the copy of the event.

The duplicate event is added to the location where you clicked in the program log and
the event that was at that location, and all subsequent events, shift down.

tﬁ‘. Note: If you decide not to copy an event after clicking the Copy button, click the
Copy Where? button to cancel the copy process -

6.9 Using Hot Keys
Hot Keys are used for instant playback of events. The most common uses of the Hot Keys
are for sound effects, jingles, or weather beds for live shows.

Playing a Hot Key is as simple as clicking the Hot Key event button or touching the
desired event button if you use a touch screen.

Initially, there will be no events in your Hot Keys.

Figure 6-7. Clicking a Hot Key to Play an Event
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6.9.1 Adding an Event to a Hot Key

> To add an event to a Hot Key

INSERT

1. Click the Insert button in the tool bar two times

The Insert Panel opens.

Figure 6-8. Insert Panel
2. Inthe list of events, find the event you want to add to your Hot Key.
3. Click-and-drag the event from the Insert Panel event list and to the desired Hot Key.

The event is added to the Hot Key.
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(Rock) Superstar[Clean Edit-no intro.]
Cypress Hill

347b-09

<4:15.3» /0.2 Wed, Jan 27, 10, 14:49:32

(You Gotta) Fight For Your Right (To P...
Beastie Boys

1728-12

€3:24.1> /4.2 Fri, Jan 29, 10, 10:22-20

__And Justice For All .JAnd'Justice

Tue. Jan 26. 10, 13:22:54

Tue. Jan 26. 10. 13:22:38

Tue. Jan 26. 10, 13:23:04

INSERT REFRESH

Figure 6-9. Example of Dragging an Event to a Hot Key

6.9.2 Creating Rotating Hot Keys

If you add an event to a Hot Key that has an event associated with it, you are prompted by
one of the following windows, depending on how the Rotation On Hotkeys is configured
in the Studio Client’s configuration settings.

6.9.2.1 Rotation On Hotkeys is Enabled

> If Rotation On Hotkeys is enabled

1. You are prompted by a window similar to the following:
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Page: 1 - Button: 14 - "Weather Bed”

L2

Add To Rotation

Replace All

Cancel

2. Perform one of the following steps:

— To add the event to the existing list of rotation events, click the Add To Rotation
button.

— To delete the existing list of rotation events and replace it with the newly added
event, click the Replace All button.

— To cancel the procedure, click the Cancel button.
6.9.2.2 Rotation On Hotkeys is Not Enabled

> If Rotation On Hotkeys is not enabled

1. You are prompted by a window similar to the following:

Page: 1 - Button: 14 - "Weather Bed™ K.

3

Overwrite?

2. Perform one of the following steps:
— To replace the existing event with the new one, click the Yes button.

— To keep the old event or cancel the procedure, click the No button.
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6.9.3 Working with Hot Keys

When a Hot Key is set up as a Rotating Hot Key, the Hot Key button adds a caption to the
top-right corner that shows which event file will play next and the total number of events in
the rotation (see Figure 6-10).

2o0f3 Event list item

Random 1:00

number caption

Spot

Figure 6-10. Example of a Rotating Hot Key

» To view the list of events in the rotation

1. Right click the Hot Key, and then click List....

An Event Rotation List window similar to the one in Figure 6-11 appears.

Page: 1 - Button: 13 - "Random 1:00 Spot™

Mext To Play: #2

1 G749 ITASCA

GC1755 Certifie...

3 Guaranty - 1700 ..

CANCEL

Figure 6-11. Sample Event Rotation List Window
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2. To select which event will be the next event to play, highlight the
event, or clicking the Up .or Down .button

3. To remove an event from the list, highlight it and click the Delete ([
button

6.9.4 Setting Hot Key Properties

You can select the color of Hot Key buttons, the button’s caption, and which playback
device each Hot Key will use.

You can also configure a Hot Key to act as an “Insert” button rather than a playback
button. This feature allows you to insert a commonly used event into your program log
directly from the Hot Key panel.

> To configure Hot Key properties
1. Right-click the Hot Key whose properties you want to set.
2. From the pop-up menu, click Properties (see Figure 6-12).

The Properties dialog box appears (see Figure 6-13).

2of 3

Random 1:00

Laser Fire

Figure 6-12. Clicking Properties from the Pop-up Window
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Random 1:00 Spot 4

Caption
F andom 1:00 5 pot

Color

Font

Picture

Device

[l Insert Into Program Log
Bl Start Yoicetrack Record

CANCEL

Figure 6-13. Properties Dialog Box

3. Complete fields in the dialog box (see Table 6-14).

4. Click OK.
Table 6-14. Fields in the Properties Dialog Box
Field Description Default
Caption By default, your Hot Key shows the file name of the audio event you've File name of the
added. To change the caption, change the text in this field. audio event
Color Changes the background color of the Hot Key. Green
Font Changes the font style, size, and color. Avrial
Picture Replaces the Hot Key caption text with a picture. Click the Browse button to —
select your picture. To remove a picture and return to showing the caption
text, click the Clear button.
Device Hot Keys use the audio playback device associated with each column of Hot

Key buttons, as configured in the Studio Client’s configuration settings. If
you want a Hot Key to use a different column’s playback device, select it
from this drop-down list.
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Field

Description

Default

Insert Into Program Log

Changes the operation of the Hot Key without affecting other Hot Keys in
your Hot Key Set. Enabling this option changes the behavior of the Hot Key
to act as an Insert key. This means that rather than playing an event, as a
normal Hot Key does, the Hot Key will allow you to insert the associated
event into your program log. When you click an Insert Hot Key, its caption
changes to Insert Where? You can then click a location in your program log
to insert the Hot Key's event. Use this as a quick shortcut for inserting a
commonly used event without having to use the Insert Panel. Insert Hot
Keys can be easily identified by the Insert tag added to the top corner of the
specific Hot Key (see the Weather Bed Hotkey in Figure 6.2)

Start Voicetrack Record

Enabling this option make a Hot Key to initiate voicetrack recording, enable
this option.
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6.10 Using Hot Key Pages

The previous sections described how to use individual Hot Keys. The following sections
describe how to use a Hot Key page.

6.10.1 Navigating Hot Key Pages

> To switching between Hot Key pages

1. Click the Next . or Previous . button.

The counter above the Refresh button indicates which Hot Key page is loaded

6.11 Saving the Hot Key Page to the File Server
The Hot Key page is saved to your local machine.

However, you can save a copy of it to the File Server.

> To save a Hot Key page to the file server

1. Click the Save Page To Server button.

6.11.1 Loading a Hot Key Page fromthe File Server

> To load a previously saved Hot Key page from the file

1. Click the Load Page From Server button.

6.11.2 Refreshing a Hot Key Page

> To refresh the currently loaded Hot Key page

1. Click the Refresh button.
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6.12 Using the Voicetrack Editor

Voicetracking is the act of pre-recording voiceovers specific to the content of your program
log to give your listening audience the impression that your station has live talent on the air.
Users produce their voicetracks ahead of the scheduled air time of their program log. It is
common to find stations that appear to be staffed 24 hours a day because of content-specific
voiceovers that are, in reality, voice tracked by only a couple staff members. Each on-air
talent need only spend a couple hours a day recording their voicetracks for 4, 8, or more
hour shifts. Some talent can even record full shifts for multiple different stations using
voicetracking.

The following sections assume you created a program log and configured the Studio Client
settings with appropriate recording and playback audio devices for the Voicetrack Editor. If
you produce voicetracks on your on-air workstation, be sure the audio playback device you
configured for voicetracking does not go on.

6.12.1 Voicetrack Editor User Interface

The following figure shows the Voicetrack Editor user interface. The following sections
describe the Voicetrack Editor user interface. Table 6-15 describes the key user interface
components shown in Figure 6-14.

/ WEMS - OpX - Broadcast Software International = o X

Air Date: 04/14/2016

VOICETR.. 411557
T 37619 41157 2
<
11409 41538
T 37601 41538
F1031 418.00
T 34394 EREE
<
VOICETR. 4:22:38
T 3RS 4:22:38 g
7
B 141 4:26.04

"T 32026 426.01

|
VOICE | PLAY m
TRACK ALL || || INSERT| BLEX |

Figure 6-14. Voicetrack Editor
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Table 6-15. Key Components in the Voicetrack Editor User Interface

Component Component Name Description

Start Point Shift Earlier | Clicking Cut 2's Shift Earlier button shifts the start
Button time of the second audio file earlier as compared to
the end of Cut 1. Clicking voicetrack’s Shift Earlier
button shifts the start time of the voicetrack and the
Cut 2 audio file earlier.

Go To Cut 1 Button If you venture elsewhere in the program log while
creating voicetracks, clicking this button scrolls the
program log display to the Cut 1 audio file loaded in
the Voicetrack Editor.

Cutl The dark green bar represents the first cut of the
segue between which you are inserting your
voicetrack. The light green section shows the Artist
and Title data from the audio file. The dark green
section represents the segue portion of the cut and
displays that length.

12.4-VT160413213621_602_3 Voicetrack The middle yellow bar represents the voicetrack that
has been recorded. This bar does not appear until
you record your voicetrack, and its width depends on
the length of the file recorded. The bar shows the
length and filename automatically given to the file.
The voicetrack start position can be shifted by
clicking on the left or right side of the yellow bar
(great for touchscreen users).

_ Cut2 The lower green bar represents the second cut of the

segue that you are inserting your voicetrack
between. The light green section shows the Artist
and Title data from the audio file. The dark green
section represents the intro portion of the cut and
displays that length. Cut 2's start position can be
shifted by clicking on the left or right side of the
green bar (great for touchscreen users).

Channel Mute Buttons | To temporarily mute audio cuts, click the

ON corresponding Channel Mute buttons. The button’s
text shows ON when a channel is unmuted or OFF
when it is muted.

Start Point Shift Later | Clicking Cut 2's Shift Later button shifts the start time
Buttons of the second audio file later as compared to the end
of Cut 1. Clicking Voicetrack’s Shift Later button
shifts the start time of the voicetrack and the Cut 2
audio file later.
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Component

Component Name

Description

Ducking Level Adjust
Buttons & Ducking
Level Display

Each track, Cut 1, voicetrack, and Cut 2, have
adjustment buttons for their ducking levels. Each cut
automatically ducks its volume to the percentage
chosen while the voicetrack is actively playing.

PLAY

'
=
-

Play All Button

Click this button to preview the full voicetrack,
including the ducking levels set, the segue of Cut 1,
and the intro of Cut 2 as currently set.

Stop Button

This button is active only while playback or recording
is taking place. Click this button to stop playback
after clicking the Play All button or to stop recording
when creating a Voicetrack.

VOI

Q
m

Voice Track Button

This button is used when creating your voicetrack.
During the creation process this button is used
multiple times and acquires different functions as the
voice track is recorded:

1. Click to start playback of Cut 1. The button caption
changes to RECORD.

2. When Cut 1 is playing, clicking the button a
second time starts recording from your microphone
and the button caption changes to PLAY CUT2.

3. Clicking once more sets the start point of Cut 2.

4. Click the STOP button to stop recording from your
microphone.

LOAD

Load Button

Click this button to load the audio event you've
highlighted in the Program Log Display into the Cut 1
and the subsequent event into Cut 2.

INSERT

Align Button To quickly reset the start position of the recorded
voicetrack and Cut 2 to the segue point of Cut 1,
click this button.

Insert Button After you finish creating and editing your voicetrack,

click this button to insert the voicetrack into your
program log.

Time Scale Display

The length of time selected here determines the
length of time represented by the full width of the
Voicetrack Editor graphic display.

DROEE

Done Button

When you finish creating or editing voicetracks, click
this button to exit the Voicetrack Editor.
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6.12.2 Creating Voicetracks

You can perform voicetracking in any mode (Auto, Live Assist, and Manual); more often than
not, however, you will perform voicetracking in Edit mode. The Studio Client is set up so that
you can edit the voicetracks for the program log loaded on your screen. This means you can
edit voicetracks in the currently playing program log while you are in Auto, Live Assist, or
Manual mode, or you can edit a completely separate program log from the on-air content
using the Studio Client’s Edit mode.

> To access the Voicetrack Editor
1. Click the Options button in the menu bar.
2. Click the Voice Track button in the pop- up menu.

The Studio Client displays the Voicetrack Editor at the bottom of the user interface (see
Figure 6-14 on page 176).

6.12.3 Loading Audio Events into the Voicetrack Editor

You can load any audio events into the Voicetrack Editor, whether they are music, talk, or
other audio content.

» To load events into the Voicetrack Editor

1. Highlight the first of the two adjacent tracks in the program log event list between which
you want to insert your voicetrack (see Figure 6-15).

My Eyes Adored You L 150102 ok
2 o F?m 3164

o My Girl

Wy Gy

My Swaat Lord

o by Waorld 15 Emply Withowt =

L eV I ) PR 1 iy PR

Figure 6-15. Highlighting a Track After which a Voicetrack will be Placed
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2. Click the Load button in the lower left corner of the Voicetrack Editor (see Figure 6-16).

Your two audio events are loaded as Cut 1 and Cut 2 in the Voicetrack Editor, as in
Figure 6-14 on page 176.

Figure 6-16. Clicking the Load Button

6.12.4 Recording a Voicetrack

After you load your audio events into the Voicetrack Editor using the previous procedure,
you can record your voicetrack. Recording the voicetrack involves multiple presses of a

single button to simplify recording your voicetrack.

» To record a voicetrack

1. Click the Voice Track button (see Figure 6-17).

Playback of Cut 1 begins and the button toggles to Record. As playback progresses, a
vertical line moves from left to right to show the progress through the playback of your

audio event (see Figure 6-14 on page 176).

Figure 6-17. Clicking the Voice Track Button

g. As Cut 1 plays, click the Record button at the point you want to start recording from
your microphone (see Figure 6-18).
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”b‘

PLAY
LOAD RECDRDRM iy

Figure 6-18. Clicking the Record Button

h. As the voicetrack is being recorded, a yellow bar appears on the track display. The
yellow bar, as shown in Figure 6-19 represents the playback position and length of
your recorded voicetrack.

-¥T10071312 -

Figure 6-19. Yellow Bar Representing Recorded Audio

2. To set the start point of Cut 2, click the Play Cut 2 button (see Figure 6-20).
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TR
‘ I - WTIR0F 3 Ei

Figure 6-20. Clicking the Play Cut 2 Button

3. To end the recording progress, click the Stop button (see Figure 6-21).

Figure 6-21. Clicking the STOP Button

You have now recorded a voicetrack. To preview it, go to section 6.12.5.

6.12.5 Previewing Your Voicetrack

After you use the procedure in the previous section to record your voicetrack, you can
preview your voicetrack.

> To hear a preview of your voicetrack

1. Click the Play All button (see Figure 6-22).
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Cut 1

|
‘ 13.0-VT100713130112

VOICE PLAY

Figure 6-22. Clicking the Play All Button

2. To stop playback, click the Stop button.

6.12.6 Adjusting Segue/Start Points

After you preview your voicetrack, you can adjust the start points of the voicetrack audio or
Cut 2 if they are not to your liking.

> To adjust segue/start points

1. Click the segue or start point, and then drag it to the desired location.

¢ Note: You can also use the Align button to adjust segues and start points
automatically or use the arrow buttons to adjust segues and start points manually.

6.12.7 Adjusting Ducking Levels

The term “ducking” means: to turn down a portion of overlapping audio to de-emphasize one
part (the ducked audio track) and emphasize another (the non-ducked audio track).

You can perform ducking with the Voicetrack Editor independently for each portion of the
voicetrack. The ducking effect for all tracks occurs while the voicetrack audio portion is
playing. This means that if you set a ducking level on Cut 1, it will not be turned down — or
ducked — until the voicetrack audio starts. When ducking is set on Cut 2, it will not return to
its normal, non- ducking level until the end of the voicetrack audio is reached.

The voicetrack itself has a ducking level. Since all ducking occurs while the voicetrack audio
is playing, this setting is useful for adjusting the overall volume of the voicetrack.
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¢ Note: Normally, you should not have to adjust ducking levels. Instead, use the
_ voice track level setting in the Studio Client to set the level at which the voice track
is played back and use the ducking level setting in the Audio Server songs to set
the level at which songs are ducked.

> To adjust the ducking level of Cut 1, the voicetrack, or Cut 2

1. Click the Ducking Level Adjustment buttons next to the Ducking Level Display (see Figure
3-1) to adjust in 5% volume increments.

The Ducking Level Adjust Up button increases the volume of the corresponding track,
up to a maximum of 100% of the audio file's actual recorded volume. The Ducking
Level Adjust Down button decreases the volume of the corresponding track while the
voicetrack is playing. You can adjust this a minimum of 5% of its original volume.

Figure 6-23. Ducking Level Adjustment Buttons with Current Ducking level Set to 90%

6.12.8 Inserting Your Completed Voicetrack into the Program Log

After you create and edit your voicetrack, you can insert tor completed voicetrack into the
program log.

> To insert the completed voicetrack into the program log

1. Click the Insert button.

The voicetrack audio file are saved to the OpX Audio Server and inserted into the
program log directly below the currently highlighted item in the program log.

¢ Note: If you inadvertently highlight an item other than the audio event that
_ loaded into the Voicetrack Editor's Cut 1 position, confirm that the Voicetrack
Editor’'s Cut 1 event is the same event highlighted in the program log before you
click the Voicetrack Editor Insert button so that you are inserting your
voicetrack into the proper location.
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Figure 6-24. Clicking Insert

6.12.9 Customizing the Studio Client Appearance

Since most users of OpX will spend hours a day using the Studio Client, OpX allows you to
create custom themes (or “skins”) to enhance your experience using the Studio Client.

> To change the skin options
1. Click the Options button on the main menu bar, and then click Config.
The Studio Client’s Configuration window appears.

2. Click the Skin Options button in the lower right corner of the General tab on the
Configuration window (see Figure 6-25).

The Skin Options window appears (see Figure 6-26). The top section of the Skin Options
window has buttons for each skin option you can customize.
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SKin S O X SkinOptions
Options

CANCEL

Figure 6-25. Clicking the Skin Options Button

Skin Options

Audio ltem Error ltem Comment ltem

‘ une tem Cart ltem

Restore Save Current
Defaults Az

CANCEL

Figure 6-26. Skin Options Window

3. Click a button in the top section.

The Skin Item Option dialog box appears (see Figure 6-27).
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Skin Item Option - Top Deck

Gradient

Starting Color

Ending Color

.

Font

CANCEL

Figure 6-27. Skin Item Option Dialog Box

4. Use this window to edit the skin option as desired (see Table 6-16).

Table 6-16. Fields in the Skin Item Option Dialog Box (Top Section)

Field Description Default
Gradient Most skin items are displayed with a gradient (fading between two colors). Top To Bottom
This drop-down list allows you to choose the format of the gradient.
Starting Color Click the color block to select the top color for your gradient. —
Ending Color Click this color block to select the ending color for the gradient —
Font Click the Caption button to display the Font Selection dialog box (see Figure —

6-28). Select the font, style, size, and color for your skin option.
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Fort: Font style:
Microsoft Sans Serf Bold
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Figure 6-28. Font Selection Dialog Box

5. Use the buttons in the middle section of the Skin Item Option dialog box as appropriate
(see Table 6-17).

Table 6-17. Buttons in the Skin Item Option Dialog Box (Middle Section)

Field

Click This Button to...

Restore Defaults Restore all default colors and fonts for your skin.
Load

Load a previously saved Skin Item Option Profile.

Save Current As Save your current skin options as a new skin options profile.

6. When you finish, click the appropriate button at the bottom of the Skin Item Option dialog
box (see Table 6-18).

Table 6-18. Buttons in the Skin Item Option Dialog Box (Bottom Section)

Field Click This Button to...
Done Apply any changes you made and close the Skin Item Option dialog box.
Apply Save the changes you made and leave the Skin Item Option dialog box open for you to make
further refinements to your skin's settings.
Cancel Close the Skin Item Option dialog box and discard all changes you made since you opened the
Skin Item Option dialog box or clicked the Apply button.
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Topics: This chapter describes the OpX File Manager

A

_ _ module.
Starting the File Manager

Module (page 190) The File Manager module shows the files each
station has available. It also allows you to transfer
your audio files from your production machines
Configuring the File Manager into the OpX File Server, generate reports, and
Module (page 196) create carts. When you create audio files to put on
the air, you use the File Manager module to
transfer those audio files into the File Server.

Quick Tour (page 191)

Transferring Files (page 198)
Working with carts (page 202)

Editing Local Audio File
Tagging Info (page 208)
Editing Audio Tagging Info
on the File Server (page 211)
Generating and Viewing

Automation Reports (page
212)

<« Note: Although you can put audio files directly into the File Server using disks,

flash drives, and mapped network drives, we recommend you use the File
Manager to perform these tasks. This is because the File Manager
communicates directly with the File Server module to notify it of newly added
files. Not using the File Manager to copy files delays the recognition of audio files
that you add.

Tip: Because the File Manager module does not use mapped drives to
communicate with the File Server module, mapped drives are not necessary with
the OpX system. Without mapped drives on the PC running OpX, you'll have
greatly enhanced network security.
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7.1 Starting the File Manager Module

You must start the File Server module before you start the File Manager module.

> To start the File Manager module

Manager.

Start the File Server module (see section 3.1).

Click the Windows Start button and click Programs > Broadcast Software > OpX File

An OpX File Manager window similar to the following appears.

!! OpX File Manager = ;Iglll
File Edit About
My Computer - ALEX™ Server - OFPXFILESERVER™
2l & x| = @ 3| vl 2l x| # = = & B
[ Didies x a OP<-FILESERVER
- - = - 'WBSI - BSI SAT Station
Hmer | ecind | i i - $| ; g WBSIRE CORD - WBS| Aus Audia Server (BACKGROUND RECORDS)
[0 B428-05... Tue Map5, ... I've Gotd Crush On ... Stewart, Fod Due E"@ WOR - The Best Fockl
[0 B1520.w.. Tue Maph. .. ThenHeKissed Me  Crystals J = Spots
O B19-09.w... Tue May 5, .. wiords Apart Cole, Jude = News
[0 B25-06.w... Tue, May 5, ... Helter Skelter Beatles ﬂ = Records
O 80517 w.. Tue May 5, . Thiz| PromizeYoulR... M Sunc i Music
OO 91204 Tue, Map5, .. |%Wish Itwould Rain .. Collins, Phi (= Program Logs
O 914-02.w... Tue, May5, .. The LastWorthless .. Herley, Don = Run Logs
O 91607 w... Tue, Map5, . Time After Time Lauper, Cyndi @l =y Carts
0 90713.w.. Tue, Map5, .. The Flame Cheap Trick {7 Woicetracks
0 801-02.w... Tue, May5. .. At This Moment Yera, Billy & The . (= Configuration
O 90317.w.. Tue May 5, .. True[Edi] Spandau Ballet ) Tempolary
[0 907-02.w... Tue, May5, .. TheHeart Of The ... Henley, Don 3 Imaglng :
[0 B1201.w... Tue, May5. .. Revolution Beatles ""‘Ef' F!" M aterial
O 585-02.w.. Tue Map5, . Money Beatles ""112' L.|ners
O 885-14.w... Tue, May 5, . Mercy Mercy Me [Th.. Gaye, Marvin ""1lf| ingles
[ 887-14.w.. Tue,May5, . Cy Like A Baby Bax Tops @ Panes
. (= My Mew Folder
[ 582417.w... Tue, May5, ... Eleanor Righy Beatles = Oldiss Music
[ 580-10.w... Tue May 5, . SanFrancisco (Be 5. McKenzie, Scott (= Sound Effects
O 5012w, Tue May 5, . Turl Tuml Turl Byrdz []...@ wUE
[0 58216.w... Tue, May5, .. The'wreck Of The E... Lightfoot, Gordon - WIDH
[ 592-04.w... Tue. May 5, .. South Ciy Midright L. Doobie Brothers
O B03-07.w... Tue, May5, .. In The Midnight Hour  Pickett, Wilzon
O BO03-20w... Tue, May 5, .. ‘working My ‘way Ba.. Four Seasons_lﬂ
« »
|501 Ttems [
| /
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7.2 Quick Tour

File Manager Module

The following sections provide a quick tour of the File Manager module interface.

&) 0pX File Manager o ] 5|
QO —o=
My Compuder - ALEX™ Server - OFPX-FILESERVER™
2 Bl x| # @ 3| 2| Bl x| ® = = k) B
(= Oidies - @ OPXFILESERVER
- > = - WBS - BSI 5AT Statian
Hane ST T [ $ - WBSIRECORD - WHS| Aux Audio Server [BACKGROUND RECORDS)
[ 542005 Tus, May5, . I've GotA CrushOn . Stewart, Rod Due 5§ WOP.- The Best Rack
O 51520, Tue, Map5. .. ThenHeKissedMe  Crpstals - = Spats
O] 519090, Tue, Map 5. .. Worlds Apart Cole. Jude & Hews
1 62506 Tue, May5, . Helter Skelter Bestles ﬂ & Records
1 50517, Tue, Map 5. .. This | Promise YoulR... N Sync = Music
1 91204 . Tue, May5, .. |'Wish It Would Riain .. Colins, Phil & Progiam Logs
9 O 51402w.. Tue, Map5. .. TheLastWorthless... Henley, Don =) Fiun Logs
] 916-07.w... Tue, May5, .. Time Alter Time Lauper, Cyndi @ & Cats
1 5907-13m... Tue, May . .. The Flame Cheap Tiick ry =) Voicelracks
1 90-02w.. Tue Map 5. . At This Moment era, Bily & The = Configuration
] 90317.w.. Tue, May5, .. TruslEdi] Spandau Ballet () Temporary
O] 50702, Tue, M5, .. The Heart 0f TheM... Henley, Don () Imaging
1 613071 w . Tus, May5, . Fevolution Bestles & [‘”Mate”a‘
[ 565024 Tue,May5. .. Money Bealles Baiei
1 50514 . Tue, May5, . Mercy Mercy Me (Th. Gays, Marvin P F::"nge;
1 56714, Tue, Map5, .. Ty Like & Baby Box Tops =
<= My New Folder
] 56217.w... Tue, May5, .. Eleanor Rigby Beaties b Dides Music
1 580-10.. Tue. May5, . San Francisco (Be S... MoKenzis, Seott & SoundEfcts
[ 560-120... Tue, Map 5. .. Tunl Turm! Turl Eynds @ wale
[ 56216 Tus, May5, . The'wieck Of The E.. Lightfact, Gordon @ WJOH
1 53204, Tue, Map5, .. South City Midnight L... Doobie Brothers
[ 50307 .. Tue, May5, _ I The Midnight Hour  Pickekt, wilson
[ 60320 Tue. May5, ... Working My'Way Ba.. Four Seasons ';|I
4 | »
501 Items | 1
4
Number Description

Menu bar. See section 7.2.1.

Local file list See section 7.2.2.

Transfer buttons. See section 7.2.4.

Server file list. See section 7.2.3.
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7.2.1 File Manager Module Menu Bar

The menu bar appears at the top of the File Manager window. The following sections
describe the menus on the menu bar.

7.2.1.1 File Menu

Exit = exits the File Manager Module.
Edit About

Exit Ctrl+Q

7.2.1.2 Edit Menu

Settings = inserts items manually into the
File About currently loaded program log. See section 7.3.

Settings
Define Reports...

Define Reports = allows you to create report
templates. See section 7.8.1.

7.2.1.3 About Menu

Opens a window that shows the version and
File Edit [About] build date of the File Manager module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the File Manager
module has been running. See Figure 7-1 for
an example. To close the window, click OK.
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About - OpX File Manager @

w0.0.0.195 »

Build D ate:
Aug 15 2014 03:47:09

kemorny Ugage:
23,932k / 23,932k

Wi | zage:
16,012k / 16,048k,

Figure 7-1. Example of About Information

7.2.2 Local File List

The local file list allows you to browse through the drives and folders on your local computer.
Use this list to browse the audio files you want to transfer to your OpX File Server.

The local file list has several icons at the top of the list. Table 7-1 describes these icons.

The local file list also contains a location drop-down list. Clicking this drop-down list shows a
list of your drives and the folder you are currently viewing. In Figure 7-2, the Spots folder
appears at the top of the drop-down list because it is the folder currently displayed.

Table 7-1. Local File List Icons

Icon Name Description
Parent Folder To display the contents of the folder one level above (that is, the parent folder), click this
button.
Refresh To get the most up-to-date list offiles on the local hard drive, click this button to refresh the
list offiles.
Delete To delete the files selected in thelocal file list, click this button. Files are deleted

permanently, so exercise care when deleting files.

Info Tags Click this button to open a pop-up window for editing common audio file tags. This feature
can be thought of as a trimmed down (or “light”) version of the Info Edit module.

Record When you need to record a file ASAP while using the File Manager module, click this
button to open a pop-up window with a simple record deck.

Ol S Y
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{23 Spors -

j My Documents -
i My Compuber

J 3 Fleppy 5]

gl Sygtem [C) =
&ga Local Dusk: [D-)

= |
ook DWD-RL D [E2)
ﬁ.tnﬂrﬂ arel -

Figure 7-2. Example of Location Drop-Down List

7.2.3 Server File List
To browse the folders for each configured station on your File Server, use the server file list.
The server file list has two display modes:

- Directory Tree mode. You use this mode while browsing the available stations and their
subfolders. When you double-click a station’s folder, the server file list switches to File
List mode, so you can see the files in the station’s folders. Figure 7-3 shows an example
of Directory Tree mode, with the station’s directory tree expanded to show its subfolders.

- File List mode. You use this mode when you are inside a folder.

Server - "OPX-FILESERVER"

5l 7| 2| X1 %) | 3 x

@ DP<FILESERVER

+ @ WEBSI - BSI SAT Station

# @ WESIRECORD - WBS! Aux Aucho Server [BACKGROUND RECORDS)

= @ WOP - The Best Rock!
Spots
News
Recoeds
M
Fe i

Figure 7-3. Example of Directory Tree Mode

The server file list contains icons across the top of the list of files. Table 7-2 describes these
icons.
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Table 7-2. Server File List Icons

Icon Icon Name Description

s | Station View Returns the file list to the ‘top level’, showingall the stations available.

._Lf;l Filter To filter the types of files shown in the server file list, click this button.

Refresh To get the most up-to-date list offiles on the File Server, click this button to refresh the list

2 offiles.

Delete To delete the files selected in the server file list, click this button. Files are deleted

Xl permanently, so exercise care when deleting files.

Info Tags Click this button to open a pop-up window forediting common audio file tags. This feature
ﬁﬂ | can be thought of as a trimmed down (or “light”) version of the Info Edit module.

. Find To search for a file by name, click this button,

=5 Find Next After using the Find button to find an item, clickthis button to find the next file using the

=>| same searchcriteria.
Check For To have OpX search for files with the same name in other folders for the station you are
k‘tll Duplicates managing, click this button.

B New Cart To create a new cart, click this button. When prompted, enter a name for your cart and
click the OK button. When the Cart Editor window appears, drag items from the Server's
file list on the right side of the File Manager window into the Cart's Event List in the cart
editor. The new cart will be saved into the Carts folder of the current station’s profile.

7.2.4 Transfer Buttons

After you find the audio file you want to transfer and the location to where you
want to transfer it, click the appropriate transfer button to copy your file.

»

«  The button with the arrow pointing to the right ﬂ transfers the file
selected in the Local File List to the location selected in the server file
list.

«  The button with the arrow pointing to the left ﬂ copies the file selected in
the Server File List to the location selected in the local file list.

To copy a file from your local drive to your File Server and add it to a cart at
the same time, click the Transfer File To Cart ﬁl button. You are prompted
to enter the name of the cart to which you want to add the file.

L
@

("_‘. Note: The arrows will be gray if the All folder is selected. Choose an actual

station within a folder.
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7.3 Configuring the File Manager Module

The File Manager module comes with default configuration settings that should suit most
users. Using the Settings option on the Edit menu, you can change these settings to suit
your requirements.

> To configure the File Manager module settings
1. Onthe Edit menu, click Settings.
The Settings dialog box appears.

Settings [mEsal
Metwork Interface
[10.1.1.10 - Opix ~|
1 10
Default Folder
|C:\LIsers\build-pc'&DDcuments ﬂ
Drefault Station
Flayback Device
|Default Device ﬂ
Fecord Device
|Default Device ﬂ
Sample R ate
| 44,100 Hz -
Local 5ave Options
|Save Tags Ta Local File Only j
Sort Column Sort Direction
|M|:u:|ified j |Descending j
W OF | x Cancel |

2. Complete the fields in the dialog box (see Table 7-3).
3. Click OK.
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Table 7-3. Fields in the Settings Dialog Box

Field

Description

Default

Network interface

A read-only field that shows the IP address to which the OpX File Server
module is connected.

See the dialog box

File Server Address o Checked = enter an IP address of the File Server module to which the Checked
File Manager will connect.
o Unchecked = shows the IP address of the server to which the File
Manager is connected.
Use Alternate FTP Port Leave at its default setting. Checked

Default Folder

Allows you to set a specific ‘home’ folder that the File Manager displays
automatically in the local file list when the File Manager opens initially.

See the dialog box

Default Station

Allows you to select the station that appears when you open the File Server.
You can still switch to other stations at will. However, if you spend most of
your time working on one of your stations, selecting that station here can
save you time.

Playback Device

Select an audio device that the File Manager uses to preview audio files.
The default setting means that the File Manager will use the same audio
device Microsoft Windows selected when previewing audio.

Default Device

Record Device

Select the device the File Manager uses to record audio with its record deck.
The default setting means that the File Manager will use the same audio
device Microsoft Windows selected as the recording device.

Default Device

Sample Rate

Select the audio sample rate for recording and playback of audio using the
File Manager.

44.100 MHz

Local Save Options

Select how the Edit Tags function saves changes to the tags of audio files.

Save Tags To Local
File Only

Sort Column

Select how files are ordered in the local file list and the server file list.
Choices are:

o Name

o Modified (date)
o Title

o Artist

e Length

o Start Date

o End Date

Modified

Sort Direction

Select whether files listed in the local file list and the server file list are
ordered in ascending order (0-9, A-Z) or descending order (9-0, Z-A).

Descending
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7.4 Transferring Files

You can use the File Manager to transfer files to and from your File Server.

7.4.1 Copying Files to Your File Server

> To copy files to your file server

1. Using the Local File List on the left side of the File Manager, browse to the desired
audio file on your local hard drive.

) Spots j
I} My Documents -
¢ My Computer
i 3% Floppy (&)

Ggd Spztem ()
&g Local Disk D]

g |
£ DVD-RLsDrive [E2)
[ Cantral Panel -

2. Check each audio file you want to transfer.

L] 6422 waw  Thu, May 19, ..
(] 6309way  Thu, May 13, .. TSUMAM

B B263way  Thu, May 19, ...
513f way Thu, May 19, ... AUDITIO
O] 5513eway Thu, May 13, ... 33

3. Click the plus [+l button to expand the list of folders for the station to which you
want to copy your audio files.
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—— R

W OPXFS0f

#- @ WKKD -K-100

P WLOR - 1470 The Ticket

+- ) WRON - 935 Rock & Rol Dl

= PR LML AAR T ™

Note: You can choose a valid file (44.1khz 16 bit Windows PCM wave) only. If
there is no check box to select the cut, double-check the format and sample rate.

o

4. Click the subfolder of the station to display its contents.

—— —y —y .y ] J

FEEEE
= WKKD - K100

| g

- Tk i

5. Click the right-pointing File Transfer button to start copying.

(= WKKD - Spots

rhist | | Name | M

S AFEWAY ; ﬁ> [ Inflatable . Thu

sUDAFED 1 O BTG Mar
4 P |

CATUCD DCTD C1 =rn L4

6. If the File Manager finds files with the same name on the server, a message asks
whether you want to keep or overwrite the file. Click Yes (or Yes to All in the case of

multiple files) to overwrite or No to not overwrite.
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i
\i}) Owerwrite File?
L

Mo | Yes bo all |

7. When the transfer completes, click the Done button.

| | [T 6532 TR, el 3

7.4.2 Copying Files from Your File Server

> To copy files from your file server

1. Using the Server File List on the right side of the File Manager, browse to the desired
audio file.

i’ DU S JEOpe—_1 e—— p— |
FEEEE

=1 WEKD - K100
j

=4 Spots

Tiiow

— i i

2. Check each audio file you want to transfer.
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L1 kltdfg4a... Mon, Mar al. ...

[] 5513e Man, Mar 31, ... 33
M, Mar 31, ...
ton, Mar 31, .
= e hdmpn b zr 1 (=]

3. Using the Location drop down on the Local File List, click the drive to which you
want like to copy the files.

< Local Disk (D7) e
@_Desktop =
(5 My Documents
d My Computer
;ﬂ 3% Floppy [&:] o

&g@ System [C2]
=% ocal Disk [

£ DDA DiivlagE:
Control Panel ;l

4. Browse to the folder to where you want to transfer the server’s file.

Up

way zpots
b\T alk. Shows

SkimmerFlus

[N PR sy

5. Click the left-pointing File Transfer button to start copying.

- ——
- | Narne | Modified
stible A Flailing Tube @ [J EMERAL... Maon, Ma
SE JINGLE SERVICE] 00 GC1743 .. Mon, Ma
[0 5513 Man, Ma

3E JINGLE SERVICE) @ FE12d
[0 FORRES... Mon, Ma

6. If the File Manager finds files with the same name on the server, a message asks
whether you want to keep or overwrite the file. Click Yes (or Yes to All in the case of
multiple files) to overwrite or No not to overwrite.
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coniem
\i\?r) Owerwrite File?
L

Mo | Yes bo all |

7. When the transfer completes, click the Done button.

TAar, far 3

7.5 Working with carts

7.5.1 Creating a New Cart

> To create a new cart
1. At the top of the File Server List, click the New Cart button

The Cart Name dialog box appears.

2. Enter a new name for your cart, and then click the OK button.
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x

Cart Mame
IM u M ew Cart

o OK X Cancsl |
\)

The Cart Editor dialog box appears.

WOPX - Carts - "My New Cart" h

Artizt / Advertizer

Title # Description

Length: [HH:kM:55]
00:00:00 o

M ame | Airtigh | Title

=
X

« | .

" SAVE I X Cancel | /
4

. Complete the fields in the dialog box (see Table 7-4).

. To add items to the cart editor’s event list, find items in your station’s audio folders in the
File Manager's server file list and drag and drop them into the cart editor’s event list.

. After you have events in your cart’s event list, you can edit an event'’s tag info by clicking
the Edit Tags ﬁl button.

. To remove events from the cart’s event list, click the ﬁl Delete button.

. To set the next-to-play item in the cart, highlight the desired event in the cart’s event list
and click the Make Next il button.

. When you finish creating your cart, click Save.
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Table 7-4. Fields in the Cart Editor Dialog Box

Field Description Default
Artist/Advertiser Enter an artist or advertiser that describes the contents of your cart. —
Title/Description Enter a title or description about the contents of your cart. —
Length Enter an average length of the items that will be in your cart. 00:00:00

7.5.2 Using the Cart Editor to Edit a Cart

Using the Cart Editor, you can edit the contents of an existing cart, including adding new

files, removing events from the event list, or modifying the Artist/Advertiser and

Title/Description tags.

» To edit a cart

1. Browse to your desired cart file in the server file list.

2. Right-click the cart file, and then click Edit Tags.

| Modified ¥ | Title

a_l

The Cart Editor window appears.

O MyCart
O Oldies Songs

M ame
@ by Mewvs Cart

£dd T cart Cart D escripti

Edit Tags
Delete
(=

Cancel - Esc
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WOPX - Carts - "My New Cart" B

Artizt / Advertizer
I.-'l'-.dvertiser Marne

Title / Description

IEart Dezcription
Length: [HH:MM:55]

|uu:m:nu j

M ame | Atz | Title - ﬁq
I?' 5513 BEM -OME HO... INTRODLUCT —
55130 BEMJAMIN FRA... #2 ] X
55130 BEM -OME HO...  INTRODUCT _\ ——
e st _'I_I >

x Cancel
Koo |

3. Edit the files as desired
4. When you finish, click Save.

7.5.3 Adding Local Files Directly to Carts

> To add local files directly to carts

1. Inthe local file list (the left list in the File Manager), highlight the audio file you want to
add to a cart on the file server.

A check mark appears next to the item.

—1 =1 == 1 =]

i) Spats j
Mamed | Modifed | Title | st |

O EMERAL... Mor, Jum 8, 09... Betier Than Fair Ermrald Pool & Pati

5. Mon,Jun 8, 09... County Fair Farrest Paint
O GE.... Maon, Jun 8, 09... BARTER (PREMI... RELP&S
50 .. Mon, Jun 8, 03.. BARTER (PREMI... QUICK BOOKS

2. Onthe server file list (the right list in the File Manager), browse to the folder where you
want to store the actual audio file (not the location of the cart).
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III" UL L iy P Qe P N R | K [N (W1 |
a WESIRECORD - WEBSI Aux Audio Server [BACKGROLUML
Ela WO - The Best Rockl

= New
i Rec
= Music

3. Click the Add To Cart button.

(] FORREST Fé...
- ] EMERALD ...
1l... QUICK BOOKS 1 EFIE
1l... SUDAFED O 6473
1l... SUDAFED O e7s0
ALPIME BAME P
apve sance.{ff AN (01 peas
The Cart Names dialog box appears.
WBSI - BSI SAT Station f
WBSIRECORD - wBS| Aus.. |
WIOF - The Best Rock! [ My Cart Mame

KJUB - All Justin's music, allt. |

KJDH - &ll Jahrny's music, al .. |

=8 Copy To &l | o OF | XK Cancel |

4. Enter the name of the carts to which you want to add audio files.

If you selected a shared folder, the Cart Name dialog in Figure 7-4 appears. Otherwise,
the Cart Name dialog box in Figure 7-5 appears.
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x

WwBS| - B5I SAT Station |

'WBSIRECORD - WEBSI dux ... I

WP - The Best Rock! [ My Cart Mame

KIUE - All Justin's music, allt. |

KIDH - All Jokinny's music, &ll.. |

=8 Copyp To &l | o OF | ¥ Carcel |

Figure 7-4. Cart Name When Selecting a Shared Folder

x

Cart Mame
IM u Mew Cart

4" dE. x Cancel |
\3

Figure 7-5. Cart Name When Selecting a Non-shared Folder
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7.6 Editing Local Audio File Tagging Info

> To edit local audio file tagging info

1. Right-click an audio file in the local file list (left side in the File Manager), and then click
Edit Tags from the pop-up menu.

11711,

mal \What You'y... Scaggs, Boz

F'aradise [.. Renao, Mike &

Edit Tags

O] 11808, Delete
O 11811.w..,  cend ToServer

Be The Sa.. Cross, Chiistc
Breaker Whanwick, Dic
our Eves Only  Eazton, Shee
nce Jones, Quing,

Cancel - Esc
P P L= ) = 1 R R

L

A Tag Editor dialog box similar to the following appears.

£3|

On The Street Where You Live - Robert Goulet
From start Length From end
@ Copy Info | | Paste Info
Title / Description
|On The Street Where You Live

Atist / Advertiser
|R0bert Goulet

Name
|R0bert Goulet - On the Street Where You Live - My Fair Lac

QutCue
|My Fair Lady [Original Soundtr ) ': .1:::”] ! -];Izlj ' .]:'4[, ' 2:::”]

1
220

ISCI Code

| O Pay Qut @ou Figt @ [155ec -]
Start Date & Time (24 hr.) I Segue

Play - F2, Stop -F3, Pause - F4,

End Date & Time (24 hr) Set Infro- F7, Set Seque - FB,
I @ : "_:) Zoom Left - F10, Zoom Out - F11, Zoom Right - F12

Command To Run At Start

[~ Mo Fade At Seque TRIM |

[ Protect Intra OF Nest kem |Cc:n'ln'lElnchnHJ.lr'lPiSegl.le

Command To Run At End

' Save | X Cancel |

2. Complete the fields in the dialog box (see Table 7-5).

3. When you finish, click Save.
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Table 7-5. Fields in the Tag Editor Dialog Box

Field

Description

Copy Info button

Click this button to copy the current tags to the Windows’ Clipboard.

Paste Info button

Click this button to paste the current tags from the Windows’ Clipboard.

Title/Description Enter a title or description about the contents of your cart.

Artist/Advertiser Enter an artist or advertiser that describes the contents of your cart.

Name Name of the file in the system. Edit the name if desired.

OutCue Enter the words at the end of a vocal or commercial so they know when it is time to talk.

ISCI Code Enter Industry Standard Coding Identification (ISCI) code if applicable.

Start Date & Time Date and time when a commercial is to start running.

End Date & Time Date and time when a commercial is to stop running.

No Fade at Segue As afile plays, the system applies a fade when the file hits a segue point. If a song has a fade at

the end, check this check box unchecked to avoid applying a second fade.

Protect Intro Of Next Iltem

Controls overlap between items. For example, if an item has a long segue and is followed by
another item that has a short intro, checking this check box protects the intro of the second item. In
this example, if you uncheck the check box, the segue point of the first item would trail over the
vocals of the next item. Typically, you would check this box for items that end with long segues.

TRIM button Click this button to remove silence from the beginning and end of the item.

RESAMPLE bhutton If an item has a sample rate that is different from the other items in your audio library, click this
button to resample the audio for consistency with your other items.

From start Read-only field that shows the amount of time from the start of the item.

Length Read-only field that shows the duration of the item.

From end Read-only field that shows the amount of time to the end of the item.

Waveform Shows the waveform of the currently playing item. You can click in the waveform, and then use the
lightning bolt icon to set intro and segue points in the waveform.

Play button Click this button to play the file. You can also play the file by pressing the F2 key on your
keyboard.

Stop button Click this button to stop the file. You can also stop the file by pressing the F3 key on your

keyboard.

Pause button

Click this button to pause playing. You can also pause playing by pressing the F4 key on your
keyboard.

Left button Click this button to zoom into the left of the waveform. You can also zoom to the left by pressing
the F10 key on your keyboard.

Out button Click this button to zoom out to the normal waveform view. You can also zoom out by pressing the
F11 key on your keyboard.

Right button Click this button to zoom into the right of the waveform. You can also zoom in to the right by

pressing the F12 key on your keyboard.

Zoom Dropdown

Sets the zoom view time period.

Intro

Length of the item’s intro.

Segue

Length of the item’s segue.
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Command To Run At Start Allows you to run a macro command as soon as the audio starts playing.

Command To Run At Segue Allows you to run a macro command when the audio start segue point is reached. For example,

you might want to run a macro that triggers an external Emergency Alert System (EAS) device
after running an EAS message.

Command To Run At End Allows you to run a macro command when the audio end point is reached.
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7.7 Editing Audio Tagging Info on the File Server

> To edit audio tagging info on the file server

1. Right-click an audio file in the file server list (right side in the File Manager), and then click
Edit Tags from the pop-up menu.

|| BEe[Fadio Edit]  McCain, Ex
od Must Have ... M Sync
Colorg[Radio.. Colling, Phil
= jzs[Fadio ... Hil, Faith
estly Love ... Mewton-Job
=rtirnental . Kenny
b= Both ways Estefan, Gl

O 9&2-08 Add To Cart
0O 93112 3l Edit Tags
O 380-14 Fri Delete
O 57312 Frij iz

O g52-04 Fi cancel -Esc

O 94117 Pl oo

An Tag Editor dialog box similar to the following appears.

WBSI - Music - "CCR - Bad Moon Riosing-Front Channels" [

Title / Description

Artizt / Advertizer

M ame
|EEF| - Bad Moon Riozing-Front Channels

OutCue

Start Date & Time [24 hr.]

IR ]| )

End Date & Time [24 hr.]

| A/ ﬂ| : ﬂ l—ﬂ [ MoFade At Seque

[ Protect Intra OF Mext lkem

of Save X Cancel |

2. Complete the fields in the dialog box (see Table 7-5 on page 209).
3. When you finish, click Save.

Page 211 of 487



File Manager Module

7.8 Generating and Viewing Automation Reports

Automation system reports are an important and indispensable feature used by general
managers and traffic managers. They are most commonly used to verify aired spots and
promos to ensure your customer spots are getting aired in accordance with your promise
to your customers. In addition, many traffic and billing software packages use automation
reports to create affidavits and automatically verify spots and insert “make goods” for your
station(s) later program logs.

OpX’s report generating facilities allow you to create report templates to include or ignore
data types of your choosing. The following sections describe how to create a report
template and run areport.

7.8.1 Creating a Report Template

Report templates in OpX define the information that will be added to a report when a report
is run. Defining a template involves selecting the types of data you want the report to show
and selecting a format for your report. Table 7-6 describes the data types you can include in

your report.

Table 7-6. Report Data Types

Data Type Description

Spots Events playing from a folder, with its Contents type set to “Spots” and all events inserted into the
program log by importing a trafficlog.

Skipped Spots Spot events skipped over because of timed events or time syncs, but not errored.

Music Events playing from a folder, with its Contents type set to “Music” and all events inserted into the
program log by importing a music log.

Skipped Music Music events skipped because of timed events or time syncs, but not errored.

Carts Any cart played will record this data type.

Other Audio Anything event stored in a folder, with its contents type set to “Audio” will record this data type
when played.

Errors Events attempted to be played that cannot play because the item does not exist, is in an incorrect
format, or a playback device is not available will record this data type.

Warnings Started a new sat show while one was already running.

Infos Internal system tasks, such as getting files from the server or updating program logs, or uploading
run logs, and so on.

Closures Any time a trigger device receives a closure, it will record that event with this data type.

Inserts When an item is inserted into the program log, a record of this occurrence is recorded with this
data type.

Deletes If a user deletes an item from the program log, this data type keeps record of that occurring.

Stops Clicking the Stop button of a deck will report this datatype.
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Data Type Description
Macros Executing a macro by a playback deck will record this datatype.
Time Events Any event that has a set time — including music, spots, or macros — that have a cue type of Time
Immediate or Time Next. Includes any event added to the Scheduled Events.

OpX automation reports can be generated in ASCII text formats, with either a position-
dependent or delimited format. Column order and position are user configurable.

> To create an automation report template

1. On the Edit menu, click Define Reports.

" OpX File Manager

File | Edit About
Settings

My Co

wler - ALEXT

The Reports dialog box appears.

CEE—— x
#Newl [t | 5 Dl |
Mame | Dezcription
MYREPORT ty Report
AS-RUM Az-Run Daily Beport

2. From this dialog box, you can:
— Define a new report: Click the New button.
— Edit a report: Highlight the report from the list, and then click the Edit button.
— Delete a report: Highlight the report from the list, and then click the Delete button.
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If you clicked New or Edit, the Report Settings dialog box appears.

CEETTE— x
Homs | Contert | Foemat | Postion |
Hame

W NEWREFOAT

Desciplon
[t Herwe Rt Termelate

VO | X Caneel |

3. For a new report, enter a short name in the Name field and enter a description in the
Description field. Click the Content tab.

4. On the Content tab, select the types of data want to include in your report. The example
in the figure below includes events that did not play, which is useful for determining your
“make-goods.” To limit your report to show only data pertaining to a single file name, or
several particular file names, use the Single Name or Multiple Names section to
configure file name filters.

x

Mame Content | Formatl Positionl

Include In Report

[ Spats I Single Name
L] Skipped Spots l— Wil match any part of the
L1 Music name field,
[ Skipped Musi
O Ealrltjspe He [~ Prompt For Mame Each Time The Repart s Run
[ Other Audio
L] Errars
L] amings 1 Multiple Names
L1 Infas
O Fr::g:::[ses 4 | Will match any
[ Deletes part of the name
[] Staps % | figld.
[ Macroz
[] Time Events
[ Recards
& OF x Cancel |

5. Check the types of content to include.

6. After you select all the data types you want to include, click the Format tab.
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7. The Format tab allows you to select the output format of your report. Two formats are
available:

— Position Dependent — select this format to read your report directly or if the
application you want to import the report into asks for this data type.

— Delimited — select this format if the application you want to import specifies this
format or allows you to make your own choice. Setup for this format is easier than
position dependent.

x

Mame I Cortent  Format |Positi0nl

i+ Position Dependent

" Delimited
Delimiting Character r

o 0K I XK Cancel |

— If you selected Position Dependent, click the Position tab. The following dialog box
appears, except that a new report template has zeros for all the Start and Length
settings. The Start and Length settings depend on what you are importing the data
into. If you are going to view the report directly without importing your data into
another application, the settings in the following figure will work for most cases.
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x

Marne I Contentl Format  Fosition |

Start Lenath
Statuz I‘I_ r
Actual Time |3_ lB_
SchedTime [12  [3
Diuration l? lB_
Name l? lB_
[iescription l? IF
Type IE IB_
Folder I? IT

o OK I x Cancel |

— If you selected Delimited, enter the delimiting character into the Delimiting
Character field on the Format tab (most applications use the | symbol). Click the
Position tab. A tab similar to the one below appears, except that a new report
template has zeros for all the Position settings. The Position settings determine the
order each field will be added to the report.

x

Hame I Contentl Format  Position |

EEsition For the delimited format enter the position
Status I'I nurmber for each of the field or 0 ta nat include
Actual Time |2 e Tl
: l_ For example, a Start Time position of 4 will
Sched Time. |3 place the time in the forth position.
Cruarati |4
el The pozitions should be either 0, or a number
Mame |5 from 1 to 6.
[rescription IB
Type I?
Falder |B

" OK I X Cancel |

8. After completing the Report Settings dialog box, click OK.
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7.8.2 Running a Report

The following procedure describes how to run a report. This procedure assumes you created
a report template (see section 7.8.1).

> To run areport using an automation report template you created

1. Browse through the station folder tree on the right side of the File Manager module to find
the Run Logs folder for your desired station, and then click it.

The right-side of the window switches to Report Viewer mode.

1 O ¢ T
@ OFFILESERVER
(- WESI - BSI SAT Station

$| - WEBSIRECORD - WESI dux Audio Server [BACKGROUND RECOF

£ WOPX - The Best Rockl
-y Spots

=y Mews
ﬂ -+ Records
-y Music

-y Program Logs

-y Run Log
¢| -y Carts
-y Woicetia

= Configuratio

2. Select the month and date that the report will cover.

1| 7| @l X F =] ¥ %l @

E-__.WDF’X-F!un Logs j

®| :l May 10, 2010 il

Mon | Tue | Wed | Thu | Fui | Sat

cid

Report
| MYREPORT My Fiepart =

Fun Report On E May 10, 2010

3. Using the Report Template drop-down list, select a report template.

Page 217 of 487



File Manager Module

4. Click the Run Report On button.

The report is generated and automatically opens in your default .txt viewing application
(typically Windows Notepad).
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8 Clock Builder Module

This chapter describes the OpX Clock Builder module.
This module creates clock templates.

Many stations require the ability to rebroadcast satellite
originated shows. These shows include signals
(closures) to tell automation systems such as OpX when
the show starts, stops, and when to play ID’s, liners, and
breaks.

Unlike other automation systems, OpX uses a Clock
Builder to determine how to work with your satellite
broadcasts. Not only does the Clock Builder offer a
visually familiar method of configuration, it offers an
intuitive and quick method to add or modify shows,
schedule satellite breaks, and more in a visual, easy-to-
understand way.

With the multitude of station formats, some stations will
have all their content originate from files stored on their
local hard drive (such as with “music—from—hard—
drive” stations), while other stations will have a
combination of local from-hard-drive content and satellite
rebroadcasts. The extreme case is a station that gets all
of its content from satellite, as in Figure 8-1 on page 221.
The OpX Clock Builder module allows easy handling of
these situations without requiring you to memorize or
look up special commands to enter. The result is
simplified setup and modification of your station’s format.
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Before you set up clocks or schedule breaks:

Configure the OpX Audio Server because clock setup depends on the configuration of
your Audio Server. See Chapter 4 for information about setting up your OpX Audio
Server.

Confirm that the following parts of OpX are configured:

— Your switcher device, so OpX can switch between sources automatically

— Your closure device, so OpX can respond to network triggers

— A mixer in your OpX Audio Server, so OpX can control the volume of your source

Connect and configure your hardware, including your trigger device, any switcher, and
your OpX Mixers. See Chapter 4.

After you perform these tasks, start the Clock Builder module.

> To start the Clock Builder module

1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > Clock

Builder.

You are prompted to select a station.

Select a Station

Stationz

3. Using the Stations drop-down list, click a station.

4. Click OK.

The OpX Clock Builder module is populated with the information from the selected
station.
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@ Clock Builder - WNAM - 1280 AM - Ameri

's Best Music i o im] 3
File Edit About

L DX |G

FH | |WMAM - 1280 AM - America's Best x|

5 am &
6 am
7 am
8 am
9 am

10 am

11 am

Moon

I

[ Prsaomo  GETET S
Tom T
2 pm FEIM AEM

3 pm AEM

4 pm | AEM
5 pm | W WEAY Ao
b pm ¢
7 pm
8 pm
il : e it

10 pm

PH | AUTO 1 Selected
| |

Figure 8-1. Example of Clock Builder Module
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8.2 Quick Tour

The following sections provide a quick tour of the Clock Builder module interface.

Menu bar. See section 8.2.1.

Tool bar and station selector. See section 8.2.2.

Grid display. See section 8.2.3.

Status bar. See section 8.2.4.
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8.2.1 Menu Bar

The menu bar appears at the top of the Clock Builder window. The following sections
describe the menu options.

8.2.1.1 File Menu

Exit = exits the Clock Builder module.
File Edit About

Bat  Ctrl+Q

8.2.1.2 Edit Menu

Edit = opens the Clock Editor for the

File | Edit About highlighted clock on the grid display.

! Edit Ctrl+E
4 e H Cut = removes the highlighted clock from the

grid display and copies it to the Windows’

Clipboard.
(4 List Satellite Shows.. : : -
] Show Alternates Copy = copies to the Windows’ Clipboard the

highlighted clock on the grid display.
Settings...

Paste = pastes a cut or copied clock from the
Windows’ Clipboard over the currently
highlighted clock on the grid display.

List Satellite Shows = shows all Satellite
Show Start events in a list or tree view
window.

Show Alternates = switches the current
grid display view to show alternate clocks
instead of Monday-Sunday clocks.

Settings = configures Clock Builder module
settings. See section 8.3.

8.2.1.3 About Menu

Opens a window that shows the version and

File Edit [About] build date of the Clock Builder module you are
running. This window also shows the amount
of memory and virtual memory being used,

Page 223 of 487



Clock Builder Module

and the amount of time that the Clock Builder
module has been running See Figure 8-2 for
an example. To close the window, click OK.

-

[ About ==

»0.0.0123 -

Build [ ate:
Qct 23 2013 07:53:09

m

kemorny U zage:
18,842k, / 18,248k

Wi | zage:
11,888k /12 11BK

Figure 8-2. Example of About Information
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8.2.2 Tool Bar and Station Selector

The tool bar and station selector appear below the menu bar. Table 8-1describes the tools
on the tool bar.

‘ |WOPX - The Best Rock! ~|

Figure 8-3. Log Name and Station Selector

Table 8-1. Clock Builder Tool Bar and Station Selector

Tool

Tool
Name

Description

Tool

Tool Name

Description

Edit Clock

Opens the Clock
Editor for the
highlighted hour
on the grid
dsplay.

Cp

List Satellite Shows

Shows all satellite show
start events in a list or tree
view window.

Copy

Copies the
highlighted hour
in the grid display
to the Windows’
Clipboard.

2]

Show Alternates

Switches the grid display
current view to show
alternate clocks instead of
the Monday-Sunday clocks.

Paste

Pastes a copied
clock from the
Clipboard to the
highlighted hour
in the grid display
and replaces any
existing clock
settings.

Delete

Removes all clock
settings from the
currently
highlighted clock
on the grid
display.

Station Selector
drop-down list

Switches between stations
on your OpX system to
view and edit the clock sets
foreach.

WOPX - The Best Rockl!
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8.2.3 Grid Display

The grid display is a spread-sheet style diagram of the clocks you create for each hour of
each day of the week.

- The x-axis (horizontal) has columns for each day of the week or, while in the Show
Alternates view, the columns are for each alternate day.

- The y- axis (vertical) has rows for each hour of the day.

To edit a clock, double-click the clock block in the grid display to open that time period’s
clock in the Clock Editor.

Figure 8-4. Sample Grid Display
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The status bar shows the title of the currently highlighted clock. If you have multiple items
selected (by shift-clicking or ctrl-clicking), the status bar also shows the number of items

selected.

PH { AUTO

1 Selected

Figure 8-5. Status Bar

8.2.5 Navigating the Clock Editor Window

The Clock Editor has its own tool bar and description bar for creating and modifying clocks.

@ Monday 1 am x|
’ b U Ny
Q—=S Q&2 0%
9 ——c 0T |Laura Calor |I:| ‘ellow j
| Time | Tepe | Catego|y| Detaily ‘
R 4@ 0000 StatSal. MACRO  SATSHOW START, ABCNEWS *
| S@ 0500 Commerc.. MACRO  MANDATORY MOFADE 50 NOPLAYIFEMPTY
S+ OE00 Stop Sat..  MACRO  SATSHOW STOP. ABCMEWS +
—h+  DE:00 Start Sat..  MACRO  SATSHOW START. LaURA
;‘ 15:00 Commerc... MACRO  MAMDATORYMOFADE S0MOPLAYIFEMPTY ‘ o
il; 3z00 Commerc... MACRO  MANDATORY MOFADE 50 NOPLAYIFEMPTY
e $ 4700 Commerc... MACRO  MANDATORY MOFADE 50 NOPLAYIFEMPTY
$ 5760 Commerz.. MACRO  MANDATORY MOFADE 50 NOPLAYIFEMPTY
at+ 5359 Stop Sat..  MACRO  SATSHOW STOP. LALURA
L 2
3332 3130202827
& OK I X Cancel | B 2pely |
e

Number Description
(1] Tool bar. See section 8.2.5.1.
(2] Description bar. See section 8.2.5.2.
© Clock display. See section 8.2.5.3.
(4] Event List. See section 8.2.5.4.

8.2.5.1 Clock Editor Window Tool Bar

The Clock Editor tool bar contains icons for performing the tasks described in Table 8-2.

Page 227 of 487



Clock Builder Module

Figure 8-6. Clock Editor Toolbar

Table 8-2. Clock Editor Tool Bar

Tool Tool Name Description Tool Tool Name Description
New Satellite Opens the Satellite Edit Event Edits an event that has
" Show Show editor to create a 0y been added to your
@ new satellite show start @ clock.
— event. ——
Start Existing Creates a new satellite Copy Copies the highlighted
Satellite Show show start event from a Iy event to the Windows'
@D previously created Ll_':] Clipboard.
— satellite show item. ——
Stop Satellite Returns the automation Paste Pastes a copied event
Show system to local audio from the Clipboard to
@- playback or stops the J the highlighted event in
— satellite audio. —— your event list.
New Commercial Adds commercial breaks Delete Removes an event that
Break to your clock. you added to your
$ x clock.
New Event Creates new non-stopset
events such as audio
f@i events, macros, or
— comments.

8.2.5.2 Clock Editor Window Description Bar

The Description Bar contains the Description field and the Color drop-down list. The text
you type into the Description field and the color you select from the Color drop-down list
allow you to name and color your clock’s block on the grid display for easy identification in
the Clock Builder. Figure 8-1 on page 221 shows an example of a grid display that has
descriptions and colors selected for each clock.
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Description; (O Laurie

Calar:

[ Yellow j

Figure 8-7. Description Bar

8.2.5.3 Clock Display

The clock display provides a visual representation of the events

you add to the event list.

- Green “pie wedges” represent breaks.

- Thin black radius lines represent satellite show start, satellite

show stop, and custom events.

8.2.5.4 Event List

The event list shows all the events your clock
will perform. To shuffle an event up or down in
the list, highlight the desired event and click the
Up or Down icon in the top-right corner of the
event list.

Time
4 @ D000
& & 0500
4+ D600
P E 1E00

@ 000

4 & a0
- a7
i@ SE0
- 5650

St St
Cometec
i Sal
Evenl
Comereic
Eveni
Commeic
Ewvend
Commeic
Event
Comreic

8.3 Configuring the Clock Builder Module

Calegogy | Delads

WACAD
HACRO
WACAD
COMM
HACROD
COMK
WACROD
COML
WACAD
COMM
HACAO

SATSHDW START, ARGHEWS L
MANDATORY NOFADE SONORL
SATSHOW START, LALRIE
Tiemes Spnc

MAHDATORY MOFADE S0 HOFL
Tme Spnc

MANDATORY MOFADE SOMOFL
Tena S

MANDATORY MOFADE SOMOPL
Temes Spnc

MANDATORY NOFADE SONOPL

The Clock Builder module comes with default configuration settings that should suit most
users. Using the Settings option on the Edit menu, you can change these settings to suit

your requirements.

> To configure the Clock Builder module settings
1. Onthe Edit menu, click Settings.
The Settings dialog box appears.
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[ Settings @

10.1.1.10 - Op ~|

1 . 1 . 1 10

[ Force Default Miker In Live S atellite Shows

o 0K x Cancel |

2. Complete the fields in the dialog box (see Table 8-3).

3. Click OK.
Table 8-3. Fields in the Settings Dialog Box
Field Description Default
Network Interface Read-only field that shows the IP address to which the OpX network 10.1.1.10 - OpX
interface is connected
File Server Address o Checked = use the FTP server IP address. Enter the IP address in the Unchecked
dotted-decimal field.
o Unchecked = do not use the FTP server IP address.
Force Default Mixer In Live Check this check box to have the system pick the first mixer configured on Unchecked

Satellite Shows

the New Satellite Show dialog box.
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8.4 Creating a New Clock

To set up your satellite clocks, open the OpX Clock Builder module. You will be prompted to
select which station you would like to work on (see Figure 9.3). Figure 9.2 shows the initial
screen you will see when opening the Clock Builder. It is a grid representation with columns
for each day and rows for each hour of the day. The grid will be empty until clocks are
added. Figure 9.1 shows what a Clock Builder grid looks like when fully populated with
clocks

> To create a new clock

1. Inthe Clock Editor, double-click the hour block for the hour/day on which you want to
create the clock.

8 am
9 am [
10 am h

11 am

M nonn

The Clock Editor appears for the hour you selected.
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) Monday 2 am @
QGG $&LNHBX
¥ Merge Music Log
. . ] - .
Description: | Colar: |- avy J [¥ Merge Traffic Log
Tirne Type Category | Details
556575859 01z 3,
+
43
48 12
47 13
46 14
45 15
44 16
43 17
42 18
19
5,
34, 2
3332 1130292877
\/ QK x Cancel | ﬁ Apply

In the Description field, enter a title for this clock.

If desired, select a color for the clock’s hour-block in the Clock Builder grid display for
easy identification.

. The most common satellite rebroadcast clock consists of the following events:

— A command to put your satellite show on the air (a satellite show start event), which
controls your audio switching and I/O hardware.

— Commercial break periods, where OpX is to replace network spots with your local
content (a commercial break event).

— A command to turn off the satellite show and return the automation system to local
audio (a satellite show stop event) or another satellite show.

To put your satellite show on the air, OpX must know how to start your satellite show-
what inputs to turn on, what triggers to use, and how to behave. Leave the Clock Builder
open and see the following sections for procedures about performing these tasks.
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8.4.1 Creating a New Satellite Show Start Event

You create a new satellite show start event using the New Satellite Show dialog box. This
dialog box presents a number of pages containing configuration settings. To see examples
of completed clocks, see section 8.5.

» To create a new satellite start event

1. Click the New Satellite Show icon.

OAOTORE ¥

Drezcrption: I

The New Satellite Show dialog box appears.
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New Satellite Show ==

F Enter the cue. time, name and dezcription of the

o zatellite show. Thiz is the cue time of the show.
Later pages will allow start by time or closure if
applicable.

CuLe

| Time Immediate [@)] |

Time - kk:55
0000 =

L

M ame

Dezcrption

[ eesb |

o 0K X Cancel |

2. Complete the fields in the dialog box (see Table 8-4).

Table 8-4. Page 1 Fields in the New Satellite Show Settings Dialog Box

Field Description Default
Cue Under most circumstances, select Time Immediate [@]. Time Immediate [@}
Time Select start time of your satellite show. For shows that start at the top of the 00:00
hour, select 00:00.
Name Enter a short name for your show. —
Description Enter a name that will be added to the list of created satellite shows. —
3. Click Next.

The second page appears in the New Satellite Show dialog box.
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New Satellite Show ==

@ Enter the talent and type of the zatellite show.

[w Live
[ Time Shift [ %irtual Clazures Only |

| Record

| Mot &pplicable J

File Mame

| kd

[ Trim File After Record

[ Share ‘With Other Stations [ Upload To File Server |

= Back Mest =

o 0K X Cancel |

4. Complete the fields in the dialog box (see Table 8-5).

Table 8-5. Page 2 Fields in the New Satellite Show Settings Dialog Box

Field Description Default
Live Check this check box to go to the satellite feed playing at that time. Checked
Time Shift Check this box to play back a previously recorded show. Unchecked
Record If you want to record a satellite show at a time other than when the Unchecked

show is being broadcast, check this check. The file will then be
recorded at the time you specified in the previous dialog box.

Record Deck

Select one of the four record decks in the system.

Not Applicable

File Name Enter the name you want to assign to the recorded file. —

Trim File After Record Check this check box to remove the silence from the recorded file. Unchecked

Share With Other Stations Check this check box to upload the recorded file to the File Server, Unchecked
so the file can be shared with other stations.

5. Click Next.

The third page appears in the New Satellite Show dialog box.
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-

Clazu

Mew Satellite Show

Select the closure device, start of stop-zet
clozure, switching and mixer.

re Device

Start Commercial Break Claozure Delap 110 Sec

|Nnt.-'1‘-.ppli|:al:ule ﬂ | 0 %

r
I
Switching
Device Input Cutput Mt | HO i
P
(%
Piser

v
>

Mot Applicable

7!

= Back Mest =

" 0K X Cancel |

6. Complete the fields in the dialog box (see Table 8-6).

Table 8-6. Page 3 Fields in the New Satellite Show Settings Dialog Box

Field

Description

Default

Closure Device

Select your closure hardware device.

Not Applicable

Start Commercial Break Closure

Select your local break trigger.

Not Applicable

Delay

Adds a delay to the commercial break closure.

0

Commercial Breaks Float Past

The Top Of The Hour

Causes OpX to look ahead in your clock each time a break start trigger
is received.

o Checked = if more break closures are received and there are no
more breaks in your clock (for example, all expected breaks have
been played), the closure is ignored.

o Unchecked = use this setting if you set up multi-hour satellite shows
that only have a satellite show start event in the first hour's clock.

Unchecked

Automatically Fill Commercial

Breaks

o Checked = OpX automatically fills breaks that are not filled with
content from your traffic software.

o Unchecked = OpX does not automatically fill breaks.

Checked
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Field

Description

Default

Switching

Add profiles to determine the routing of audio-switching devices for this
satellite show. If you do not have any audio routing/switching hardware,
leave this field empty.

o Click the Add Switcher Routing button il to add a profile.

o Click the Delete Switcher Routing button % | 10 remove the
highlighted device from the list.

Mixer

Determines what input/output of your audio card(s) are unmuted at the
start of your satellite show, muted during breaks, and muted at the end
of your show. For configurations with an audio switcher, connect your
audio switcher's output to an input on your soundcard and set up the
audio switcher as a mixer in your audio server configuration. For
configurations without an audio switcher, connect your satellite’s output
directly to the audio card's input and configure the audio card as a mixer
in your audio server's settings. For information about setting up OpX's
mixers, see Chapter 4.

Not Applicable

Fade Up At Start Of Show

Check this check box to have the mixer adjust the volume control up at
the start of the show.

Checked

Fade Down At Start Of Show

Check this check box to have the mixer adjust the volume control down
at the end of the show.

Checked

7. Click Next.

The fourth page appears in the New Satellite Show dialog box.
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Mew Satellite Show
@ Select the method to start the zatellite show. If

= neither are selected, the show will start az it iz
encountered in the log.

[ Start By Time

0000 =

| Start By Clozure

| Hat Applicable J

oo:o0 —=— 5353 —

= Back Mest =

X Cancel |

8. Complete the fields in the dialog box (see Table 8-7).

Table 8-7. Page 4 Fields in the New Satellite Show Settings Dialog Box

Field Description Default
Start By Time Allows you to delay the start of your satellite show until a time of your Unchecked
choosing. Like an offset, if you set your satellite show event to start at
the top of the hour and set this option to 5:00, your satellite show will
not start until 5:00 minutes after. This option is not used in most
circumstances.
Start By Closure Allows you to start your satellite show by closure. If you air a satellite Not Applicable

show that has a floating start, this option allows you to join when the
satellite receiver sends a closure. By default, the closure selected is
“listened to™ for the full hour, but you can limit the active window by

setting the Active Start and Active End fields

Active Start — SS:MM

Start time when this event will be active.

00:00

Active End — SS:MM

End time when this event will no longer be active.

59:59

9. Click Next.

The fourth page appears in the New Satellite Show dialog box.
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New Satellite Show ==
@ Add audio items fired by closures.

Clozure Event

4

%

|

4= Back Mest =

W OF X Cancel |

10. Select audio files or carts to be played when specific closures are received from your
satellite receiver via closure hardware connected to your OpX Audio Server. This function
is useful for station ID closures or “magic calls.” If you do not need to handle these types
of events, click Next to continue to the next page and go to the next step.

To add a new event, click the Add il button. When the Closure Event dialog box
appears, complete the fields in the dialog box (see Table 8-8).
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s "~

Closure Event @

Dezcription

Clozure
| Mot Applicable j

Active Start - M:S5 Active End - M55

o000 == 3Ry ==
Audio Macros

MHame Dezcription

[ |+ [+

* Each audio item will run in rotation

™ Fade Satelite To  [50 Percent While Playing Audio
0 = law, 99 = max volume

x Cancel |

Table 8-8. Fields in the Closure Event Dialog Box

Field Description Default
Description Enter a description for your closure event. —
Closure Select your incoming closure that will fire your event. Not Applicable
Active Start - SS:MM Start time when this event will be active. 00:00
Active End — SS:MM End time when this event will no longer be active. 59:59
Name/Description Add a new event by clicking the Add il button. Drag and drop your —

audio files from the File Library to the Audio list, as shown in Figure 8-8.
You can add multiple items audio list if want multiple items to all play
consecutively each time the closure event is triggered. For rotator
behavior, create a cart of items and add it to the closure event.

Fade Satellite To o Checked = forces the main satellite feed to duck under your Closure Unchecked
Event rather than mute the satellite feed.
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In Title
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IF Fade Saelte To (25 ;;'fﬁ 99 . m‘*"m" ‘ied Ape 30 2008 220 Herie Record Hendki 005250
; Wietewolves Of London  Wanen Zevon 508 oooa x|
[k | X cocel | _ Rehesh | oone |

Figure 8-8. Dragging and Dropping Audio Files

You can add multiple closure events, where each one handles the events for a single
closure during a specified time period. In the figure below, two closure events are

created: one to handle a “magic call” closure event and the other to handle a floating

station ID closure event.
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x
G Add audio itemsz fired by clozures.
Closure Event |
Station 1D
Magic Call P
x|
= Back Mext =
VOK | X cancel |

To edit a closure event, click it in the closure event list and click the Edit ﬁ| button. To
delete a closure event, click it in the closure list and click the Delete _%] button.

11. After you create, edit, or delete closure events, click the Next button to go to the next
page.

The fifth page appears in the New Satellite Show dialog box. These settings determine
how your satellite program will be stopped.
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New Satellite Show ==
@ Select the method to stop the satellite show.

[ Stop By Closure

| Hat Applicable J

o000 = F3E8 =
[ Stop By Lenagth

00:00:00 =

If neither stop by clozure nor stop after a specified length
of time apply, then zatellite shows must be stopped by
inzerting a Stop Existing S atellite Show event.

= Back Mest =

T2 0| % cancel |

12. Complete the fields in the dialog box (see Table 8-9).

Table 8-9. Page 5 Fields in the New Satellite Show Settings Dialog Box

Field Description Default
Stop On Closure Ends your satellite show when a specific closure is received during the Not Applicable
time period you select from the Active Start to the Active End fields.
Active Start — MM:SS Start time when this satellite show will be active. 00:00
Active End — MM:SS End time when this satellite show will no longer be active. 59:59
Stop By Length Runs your satellite show for the specified length. The time you select is Unchecked

a count-down time. For example, if you select 00:45:00 and your
satellite show starts at six minutes after the hour, your satellite show
ends at 56 minutes past the hour.

« Note: Many situations dictate that neither of the above satellite show stop
methods be used. Commonly, a clock uses a separate satellite show stop
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event at the end of the clock, without using the options available on this
page (see section 8.4.5).

@ Tip: There are ways to stop a satellite show in a clock:
- Stopping a show by a closure received from your satellite receiver.
. Stopping a show by a specific length.

- Stopping a show by the starting of another show (either within the same
clock, or a subsequent hour’s clock).

- Stopping a show by adding a satellite show stop event.

13. Click Next.

The sixth page appears in the New Satellite Show dialog box.

New Satellite Show ==

Enter additional commands to execute when the
v zatellite show begins and ends.

Additional Commands To Flun At Start OF Show

Command

[x [+

Additional Cormmands To Fun At End OfF Show

Cormand

[x [+

= Back

o 0K x Cancel |

14. Page 6 is for macro commands you want to execute at the beginning or end of the
satellite show. Uses range from sending serial strings, setting mixer levels, and turning
I/0 devices on or off to running other applications. For more information, see Appendix A
- Macros.
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15. To add an item to either list, click the Add il button next to the particular list and type
your desired macro command into the command window that appears.

16. If you are satisfied with your settings, click OK.

8.4.2 Adding an Existing Satellite Show Start Event

When you create a satellite show start event, as in the previous section, OpX adds it to a
memorized list. This makes it easy to re-use the configuration of a previously set up satellite
show start event without having to “re-invent the wheel.”

The following procedure describes how to add a previously defined satellite show start event
to your clock. To see examples of completed clocks, see section 8.5.

> To add an existing satellite show start event

1. Click the Start Existing Satellite Show button.

G

Drezcription: Il'v'ly Satellite Show

The New Start Satellite Show dialog box appears.
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Mew Start Satellite Show
@ Select zatellite show you want to start.

M ame

Cue

|.-’-'-.ut|:| Start [+] j

Time - MM:55

00:00 =

" 0K

e~

X Cancel |

2. Complete the fields in the dialog box (see Table 8-10).

Table 8-10. Fields in the New Start Satellite Show Dialog Box

Field Description Default
Name Select a satellite show start event you created previously. —
Cue The cue type determines how the satellite show starts based on time or Audio Start [+]
interaction with previous item execution. Under most circumstances,
select Time Immediate. For a description of all available cue types, see
Appendix B - Cue Types.
Time - MM:SS Select the start time of your satellite show. This usually is 00:00 for 00:00

shows that start at the top of the hour.

3. Click OK to add the event to your clock.
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8.4.3 Creating a Commercial Break Event

The previous two sections described how to add a satellite show start event to turn on your
satellite show at the correct time. As part of those procedures, you told OpX what trigger the
satellite show will send to start a local break. Now you need to tell OpX when the breaks will
occur, so that national breaks can be replaced with your local spots.

» To create a commercial break event

1. Click the New Commercial Break button.

Q6Q/8@l

Dieseriotion: {My Satellite Shaw

The New Commercial Break dialog box appears.
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Mew Commercial Break @

Enter the cue_ time. length and type of the
commercial break.

Cue

Time - Mb:55 Length - Mk:55
oooon == oooo ==

% hdandator

™ Optional

Ment =

W OK X Cancel ‘

2. Complete the fields in the dialog box (see Table 8-11).

Table 8-11. Page 1 Fields in the New Commercial Break Dialog Box

Field Description Default
Cue Enter the desired cue type for the break. Choices are: None [Stop / Start By
o None = select for trigger-started breaks. Closure]
o Time Immediate = select for most other non-triggered/non-floating
breaks.
For a description of all available cue types, see Appendix B - Cue
Types.
Time - MM:SS Enter the start time of the break in minutes and seconds (MM:SS Audio Start [+]
format).
 For floating (trigger-started) breaks, time is an estimate of the start
time of the break.
o For breaks with a cue type of Time Immediate or Time Next, time is
the exact start time of the break.
Mandatory Always plays break content, including the audio files added in steps 3 Selected

and 4. If Auto Fill is configured on your Audio Server, breaks that are
not fully filled by your traffic software are filled automatically with the
content you selected.
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Field

Description

Default

Options

Plays content only when your traffic software places spots or other
content within the break. If no content is placed in this break’s time
period, OpX does not replace the satellite show content with local
content (or the audio files selected in step 3 or 4 below), leaving the
satellite show’s underlying audio on the air.

Not selected

3. Click the Next button.

The second page of the New Commercial Break dialog box appears. This page allows
you to have an audio file of your choosing appended to the end of your break. This

means that if you have set your break to 3:00 minutes in step 2, then add a 15-second
station ID file to this page, your total break time will be 3:15 minutes.

Mew Commercial Break @
Add a single audio element to play after the
break ends.
— T+
M ame Description _—
ad
X
[ Fade Satelite To [50 JEneEnl e e e 2

[ Plaw If Break |1z Emphy

Add a virtual cart if rotation from break to break 1=
deszired.

4= Back Mest =

X Cancel |

Figure 8-9. New Commercial Break Dialog Box (Page 2)

4. Complete the fields in the dialog box (see Table 8-12).
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Table 8-12. Page 2 Fields in the New Commercial Break Dialog Box

Field

Description

Default

Name/Description

To add an audio element, click on the Add il button. When the
File Library window appears (similar to Figure 8-8 on page 241), drag
and drop desired audio files to the list on this window.

You can also add an audio element by typing in the name, rather than
dragging and dropping, by clicking the Delete il button.

To remove an audio element from the list, click the selection and click
the Delete _2% | button.

Fade To

o Checked = the selected audio element plays over top of the satellite
show, causing a ducking effect. Use the selector to the right to select
the volume level of the satellite show while the audio element plays.

Checked

Play If Break Is Empty

o Checked = the selected audio element plays even if the break is
empty and the Optional option was selected in step 2.

Unchecked

5. Click the Next button.

The third page of the New Commercial Break dialog box appears. This page allows you
to specify audio elements that are added automatically to all breaks, except breaks you

configure as Optional, which have not been filled in by your traffic software.
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s

Mew Cormmercial Break @
Enter itemsz that you want to run at the
beginning and end of the break.
[temz To Run At The Beaginning OF The Break
M arme Drescription aﬂ:.
hd
X
[temz To Run At The End OF The Break,
Mame Dezcription cH=
d
X
= Back
0K | % cancel |

Figure 8-10. New Commercial Break Dialog Box (Page 3)

6. Complete the fields in the dialog box (see Table 8-13).

Table 8-13. Page 3 Fields in the New Commercial Break Dialog Box

Field

Description

Default

Items To Run At The Beginning

Of The Break

Items To Run At The End Of The

Break

To add an audio element, click on the Add il button. When the
File Library window appears (similar to Figure 8-8 on page 241), drag
and drop desired audio files to the list on this window.

You can also add an audio element by typing in the name, rather than
dragging and dropping, by clicking the Delete il button.

To remove an audio element from the list, click the selection and click
the Delete _2¢ | button.

7. Click OK to add the commercial break to your clock.
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8. Repeat this procedure for each additional break you have in the hour until you build up all
the breaks specified by your syndicator for your satellite show.

8.4.4 Creating a Custom Event

You can add custom events to your clock. Custom events allow the scheduling of macros,
audio files, carts, or comments into your clock that are not part of a satellite show start
event, commercial break, or satellite show end event. Uses of custom events range from
playing station IDs, sending serial strings, setting mixer levels, turning on/off /0O devices,
and running other applications to loading the log for the next day and more. You can even
use custom events in clock hour-blocks that are not part of a satellite rebroadcast.

> To add a custom event to your clock

1. Click the Add Event button.

Description: |My Satelite Shav

The New Event dialog box appears.
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[lzimi= Filel Bl zss B

2. Complete the fields in the dialog box (see Table 8-13).

Table 8-14. Fields in the New Event Dialog Box

Cue Determines how OpX’s automation will start your event. See Appendix —
B - Cue Types.
Time - MM:SS Used with the timed cues Time Immediate and Time Next to determine 00:00

when your custom event will be played.

Category Select the category of your event. —

Name/Macro Commands The entry you add here depends on your selection in the Category —
drop-down list.

o Audio = enter the name of your audio file.
o Comment = enter the actual comment text.

o Macro = enter the macro command followed by any required or
optional variables. See Appendix A - Macros.

o Text = the file name is entered without extension. When this event
executes, the text file opens on the Studio Client modules. This
function is useful for news/weather scripts or general information.

Name Field for Macro Commands —




Clock Builder Module

3. Click OK to add your event to your clock.

8.4.5 Creating a Stop Satellite Show Event

OpX needs to know how and when to end your satellite show, just as it needed to know how
to start your show.

Stop satellite show events are needed only when transitioning from a satellite show to local
audio for a live or time shift satellite show, or ending a recording for a recorded satellite
show. A stop satellite show event is not needed if transitioning directly from one satellite
show to another because the satellite show start event handles the ending the previous
show when starting the next. To see examples of completed clocks, see section 8.5.

> To add a stop satellite show event to your clock

1. Click the Stop Existing Satellite Show button.

iy
Diescriptior: |My Satelite 5how

The New Stop Satellite Show dialog box appears.
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MNew Stop Satellite Show
@- Select the satellite show you want to stop.

M ame

Cue

|.-’-'-.ut|:| Start [+] j

Time - MM:55

00:00 =

" 0K

e~

X Cancel |

2. Complete the fields in the dialog box (see Table 8-15).

Table 8-15. Fields in the New Stop Satellite Show Dialog Box

Field Description Default
Name Name of the satellite show you want to end. —
Cue Type of cue for your stop satellite show event. For most situations, a —
stop satellite show event uses a Time Immediate cue.
Time - MM:SS Time for the event to execute, in minutes and seconds (MM:SS) format. 00:00

3. Click OK to add your event to your clock.
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8.4.6 Creating Multi-Hour Satellite Show Clocks

The procedure is the same as for creating clocks for a multi-hour satellite show and creating
singular hour satellite show clocks, except that the events you place in the set of hour-long
clocks changes subtly. The difference in how you set up your clocks must take into account:

- A satellite show start event is only required in the first hour of the string of the multi-hour
satellite show clocks, although adding them will not hurt in most cases.

- Satellite show stop events are not needed until the end of the last hour of the string of
satellite show clocks, although adding them will not hurt in most cases.

See section 8.5.5 for an example of how a multi-hour satellite show clock is set up.

8.4.7 Recording a Satellite Show

Recording a satellite show is easy to perform using OpX. The recording function of OpX
records the audio content and includes the contact closures/triggers received throughout the
recording. As a result, recording multi-part shows is simplified compared to other automation
systems. Moreover, OpX can play back your recorded material in a completely automated
fashion. You'll never again have to splice a long-form recording manually. You can even air
a show live using the procedures in section 8.4 while recording it by checking the Record
and Live options.

There is no need to add commercial break events to a clock that is strictly recording a
satellite show. Playback of breaks is handled by the Time Shifting clock that plays back your
recorded satellite show.

8.4.8 Time-Shifting a Satellite Show

For OpX, the term “Time Shift” refers to the play back of a satellite show previously recorded
by OpX. When you record a satellite show with the clock builder’s recording functions, the
triggers received are also recorded (see section 8.4). This allows OpX to play back a
recorded show with dynamically inserted spots and/or liners, jingles, and so on. Now you
can record a show and play it back at a later date, with local spots inserted, without any
complicated commands or manual audio file editing or splitting. OpX does it all for you.

The procedure is nearly the same for creating a time shifted satellite show clock and
creating a clock for a live satellite show (section 8.4 describes how to configure a clock for
live satellite shows). The major difference is that the satellite show start event uses the Time
Shift option to play a previously recorded satellite show rather than airing live content from
your satellite receiver. All other configuration steps for setting up your closure device,
commercial break events, and so on are exactly the same as setting up a live satellite show.

Other than the following procedure, setting up a time-shifted show is the same as the
procedure in section 8.4.1.
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1. Perform steps 1 through 9 in section 8.4.1.

2. At step 10, add the TIMESHIFT macro to the Additional Commands To Run At Start Of
Show section. This command prompts your recorded file to play and allows you to
specify your recorded file using meta variables.

To add the TIMESHIFT command:
a. Click the Add Event button to the right of the Additional Commands To Run At Start
Of Show field.

b. Enter the command that specifies your recorded show to the Macro Command field of
the Command window that pops up (for more information about the TIMESHIFT

macro, see Appendix A - Macros).

c. Click OK.

The example shown in Figure 8-11 has a macro that specifies an audio file with the text
roshlimberg followed by the current date. To put it another way, if today’s date is
December 23, 2008, the audio file roshlimberg122308.wav will be played.

New Satelite Show

-

/+1 Enter addiional commands to execute when the
"= satellite show beegins and ends,
Additional Commands To Run &t Start OF Show
Cormerssnd 4 |
TIMESHIFT rochbmberg®mmiddie =
H

Additional Coorenands To Fum it End OF Shows

Command ﬂ

bk |

| o OF I xl'..'-m'ur.ed|

Figure 8-11. Example of Using the TIMESHIFT Macro
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8.5 Sample Clocks

The previous sections describe how to create clocks. This section provides examples of
clocks used for different purposes.

8.5.1 Satellite Talk Show with Top-Of-The-Hour News Example

It is common to use a news service at the top of the hour for the first 5-to-6 minutes of the
hour. The example in Figure 8-12 shows a clock that contains a top-of-the-hour news
broadcast with its break followed by a switch to a second satellite show.

Specifically, this clock contains a satellite show start event to:
«  Switch to news, and then

- At 5 minutes past, play a local spot using a time immediate cued commercial break
event, followed by.

- A satellite show start event for the rest of the hour’s satellite show with its break events.

The stop satellite show event is set with an auto start cue type. This forces the satellite show
to stop automatically at the break just before it finishes playing.

@ wednesdaysom x|
4 i I L._‘ "\I 4 o
QOGIS&|I L OX
Description: ILaurie Calar: IEYBHDW j
| Time | Type | Ealegor}l| Details
55?5" Lid e 4@ 0000 StatSatelite Show  MACRO  SATSHOW START. ABGNEWS o
54 |J & @ 0500 CommercislBreak  MACROD  MANDATORY NOFADE 50MOPLAYIFEMPTY
| b+ D0BO0  StatSatelite Show MACROD  SATSHOW START, LAURIE ¥
&% 1300  CommercialBreak  MACRD  MANDATORY MOFADE 50MOPLAYIFEMPTY
A A & 3200 CommercialBresk  MACRO  MANDATORYNOFADE 50MOPLAYIFEMPTY
o 33 ||9 4700 CommercislBresk  MACROD  MAWDATORY NOFADE SOMOPLAYIFEMPTY
16 1# | |85 5750 CommercialBreak  MACRO  MANDATORYNOFADE 50MOPLAYIFEMPTY
45 15 ||+ B35 StopSatelite Show  MACRO  SATSHOW STOP, LAURIE

24 26
2073130502827

s |
o

Figure 8-12. Sample Clock Containing a Top-of-the-Hour News Broadcast
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8.5.2 Satellite Music Show Example

This example shows a simple music from satellite show. There is no top-of-the-hour news to

worry about and there are four breaks started by trigger.

At 59:50 past the hour, an audio event for “TOH Jingle” (top of the hour jingle) has been
added as a time immediate event. This forces the top-of-the-hour jingle to play, no

matter what else is going on.

The stop satellite show event has a cue type of Auto Start, which means that it will
execute automatically as soon as the top of the hour jingle has played.

; x|
- Ty
QOGS L O X
Description; IJoans Coalor: II:I ‘Yellow j
| Time | Type | Categor_l,l| Detalz
aopatibll 2 o 4@ 0000 StatSatelie Show  MACRO  SATSHOW START, JOANS +
! $ 14:.00 Commercial Break MACRO  MANDATORY MOFADE S0 MOPLAYIFEMPTY
3 28:00 Commercial Break. MACRO  MaNDATORY MOFADE S0MOPLAYIFEMPTY +
i 4300 Commercial Break MACERO  MANDATORY MOFADE S0 MOPLAYIFEMPTY
43 $ 5750 Commercial Break MACRD  MANDATORY MOFADE B0 MOPLATYIFEMPTY
ey % | @@ 5350 Event AUDID  TOH Jingle
414 | |'Zg+ 5959 Stop Satellite Show  MACRO  SATSHOW STOR, JOAMS
45/ - 15
44 116
437 17
12 | 12
H [ 19
5 :..- __-_.-:
33 32 313029 8 27%
< | »
q/DK x Cancel | H 2pely |
A
Figure 8-13. Satellite Music ShowExample
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8.5.3 Background Recording Example

Setting up a clock for recording is simple. As shown in the clock in Figure 8-14, all you need
to add is the satellite show start command to start the recording and the End
Satellite Show command to stop the recording. This example uses the auxiliary Audio

Server, so there is only the recording function taking place. The triggers are recorded

automatically along with the audio, so there is no need to configure anything for breaks or

other events when recording.

To record a show while also airing it live, set up your satellite show start event for your live
show, enabling both the Live option and the Recording option (see section 8.4.1).

I —— x4
- » o n N
QOGS LD X
Description: IABG Mews Record Calor: II:l Aqua j
| Tirne | Tope | Categoly| Details |
G5BT 01 2 5 4@ 0000 StatSat. MACRD  SATSHOW START, ABG FEC T+
@ 0E:00 Stop5at..  MACRD  SATSHOW STOPR, ABG_REC
¥
Hargy 3302928 2?252
Cancel & Apply
X Corcel | 2

Figure 8-14. Background Recording Example
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8.5.4 Time-Shift Playback Example

“Time shifting” refers to the playback of a previously recorded satellite show (see section

8.4.7 for setup instructions). A full satellite show including breaks is configured as if it was a
live satellite show. The only differences is that the satellite show start events in this hour’s

clock specify “Record” as the show type, and after the satellite show start events, the
TIMESHIFT macro has been inserted that references the recorded show to be played (the
TIMESHIFT macro is the mechanism that starts the playback of the recording).

Figure 8-15 shows an example of a clock configured to play back a previously recorded

satellite show.

& 7 § _ L
ORORORE"FIp gIRliED ¢
Deseription: [Laurie Time Shif Color: | Red |
| Time | Type | Category| Cietailz |
e S 4@ 0000 StatSat. MACRO SATSHOW START,ABCTS 4+
54 o @+ 0000 Event MACRO  TIMESHIFT ABC News Zmmddzzyy
%@ 0500 Commerc.. MACRO MANDATORYNOFADE S0MOPLAYIFEMPTY +
4@ 0600 StatSat. MACROD  SATSHOW START.LAURIETS
43 e+ 0RO0 Event MACRO  TIMESHIFT Dr Launefmmiddzyy
y % % 1300 Commers.. MACRO  MANDATORY.MOFADE SOMOPLAYIFEMPTY
16 w [|% 3200  Commerc.. MACRO  MANDATORY NOFADESOMOPLAYIFEMPTY
i 5 ||& 4700 Commerc.. MACRD MANDATORY.NOFADE SONDPLAYIFEMPTY
o o |9 5750 Commerc. MACRO MANDATORY.MOFADE S0MOPLAYIFEMPTY
12 | |@@® 5350 Event 4UDID 10SECID
.+ B959  StopSab. MACRO  SATSHOW STOP, LAURIETS
3332 3130202877
J 0k I x Cancel | E Lpply | -
5

Figure 8-15. Time Shift Playback Example

8.5.5 Multi-Hour Satellite Show Example

Multi-hour satellite programs are common. Handling them in OpX is nearly the same as

handling single-hour satellite programs.

This example shows a 3-hour-long satellite program. Since each OpX clock accounts for one

hour, we create three clocks.

- In Figure 8-16, Figure 8-17, and Figure 8-18, each hour is nearly identical, except for the

first two hours not containing a stop satellite show event, while the third hour does.
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The last event in hours 1 and 2 is a Station ID cart event (which your show may or may
not require, as this is a situational example) with a time immediate cue, while that same
event has an autostart cue in the third hour. This is because the stop satellite show
event has a time immediate cue with the station ID cart event automatically starting after
that event because of its autostart cue.

© Thursday 9 am ' x|

QOUGI$&H /LD X

Description: IBiII 0'Really Hour 1 Calar: I‘ Lime j
| Time | Type | Category | Details |
aoatL i 2 L@ OO0 StatGatelie Show  MACRD  SATSHOW START. ABCMEWS S
%@ 0500 CommerialBresk  MACRO  MANDATORY.MOFADE S0 NOFLAYIFEMPTY
L@ DRO0  StatSatelie Show  MACRD  SATSHOW START, BILLOREALLY +
% 1400 CommercislBresk  MACROD  MANDATORY MOFADE SONOPLAYIFEMPTY
13, & 2800 CommecislBreak  MACRD  MANDATORY MOFADE SONOPLAYIFEMPTY
y o & 4700 CowmewcialBresk  MACRO  MANDATORY.NOFADE SONOPLAYIFEMPTY
16 11 [|& 5750 CommercislBresk  MACRD  MANDATORY.MOFADE SONOPLAYIFEMPTY
W 15 Qi@ B350 Event AUDIO Station D Cart

q/ oK ! x Cancel | E Apply |
4

Figure 8-16. Hour One of a Multi-hour Satellite Show Example
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© Thursday 10 am . |

QOGS4 O X
Description: IBiIIU'F!eaIIy Hour 2 Calar: m

| Time | Type | Cateqory | Details |
sl 2 o 4@ 0000 StatSatelieShow  MACRO  SATSHOW START, ABGHEWS ps
& @ 0500 CommemialBresk  MACRO  MANDATORYNOFADE S0NOPLAYIFEMPTY
4@ O0G00  StatSatelite Show  MACRO  SATSHOW START, BILLOREALLY +
@ 1400 CommerialBresk  MACRD  MANDATORY NDFADE 50 NOPLAYIFEMPTY
by 1 ||$ 2800 CommewislBresk  MACRD  MANDATORY.NDFADE SONOPLAYIFEMPTY
ol @ || & 4700 CommecislBresk  MACRD  MANDATORY.NOFADE SONOPLAYIFEMPTY
16 Yie [|85 5750 CommercialBresk  MACRO  MANDATORYNOFADE S0MOPLAYIFEMPTY
45 15 @ @ 5350  Event AUDIO Station 1D Cart

= |
34 Iy
33 3120292827

Cancel Applyl
Xcoce | y

Figure 8-17. Hour Two of a Multi-hour Satellite Show Example

x
QOCISEH| L O X

Dezcription: IBiII O'Reallp Hour 3 Colar: I- Lime j
| Time | Tvpe | Category | Details
553575“ Bilied aos (4@ 0000 StatSatelite Show  MACRO  SATSHOW START. ABGNEWS &
S @ 0200 Commercial Break MACRD  MaNDATORY MOFADE SOMOPLAYIFEMPTY
@ 0500 Start Satellite Show MACRO  SATSHOW START, BILLOREALLY ¥
$ 14:00 Commercial Break MACRO  MANDATORY NOFADE 50MNOPLAYIFEMPTY
4‘;9 5 @ 2800 Commercial Break MACRO  MANDATORY MOFADE S0MOPLAYIFEMPTY
a7 12 ? 4700 Commercial Break MACRO  MAMWDATORY MOFADE BOMOPLAYIFEMPTY
46 d14 | |% 5780  Commercial Break MACRD  MANDATORY MOFADE SOMOPLAYIFEMPTY
:f :: g B350 Stop Satellite Show MACRO  SATSHOW STOPR, BILLOREALLY
13 17 @ + 5350 Ewent AUDI0 Station 10 Cart
42 1®
5, ' !
Hargy 3 3029 2827

x Cancel | B 2pply | 4

Figure 8-18. Hour Three of a Multi-hour Satellite Show Example
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8.5.6 Utility Tasks without Satellite Show Audio Example

There are many instances where you might want to put utility tasks into your daily log,
without having to worry about putting them into your traffic or music log software before
importing into OpX. You can use the clock builder for these “set-it-and-forget-it” tasks.

The example in Figure 8-19 shows a clock for the last hour of the day that contains only a
macro that tells the OpX Audio Server to load the log for the next day.

x|
QOGGISH|L OO X
Description: IEnd of the Day Calor: I- Mawy vI
| Time | Tupe | Eategor_l,l| Dietails |
2 553575“59 LilZ sy < ¢ @ 5359  Event MACRD  LOADLOG &
+
s 2
4. 2
3%32 3130292877
Cancel =
X Cores | b

Figure 8-19. Utility Tasks without Satellite Show Audio Example
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Starting the Import-Merge
Module (page 266)

Quick Tour (page 267)

Third-Party Log
Requirements for
Importing (page 273)

Configuring the Import —
Merge Module (page 274)

Importing Program Logs
(page 289)

Manually Adding and
Editing Program Log
Events (page 295)

Working with Carts (page
300)

9 Import-Merge Module

This chapter describes the OpX Import-Merge module.

The Import-Merge module is used to import program logs
from traffic- and music log-generating software, and
merge them into a single log along with your clocks
generated with OpX’s Clock Builder.
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9.1 Starting the Import-Merge Module

You must start the File Server module before you start the OpX Import-Merge module.

> To start the Import-Merge module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > Import-
Merge.

You are prompted to select a station.

Select a Station

Stations

3. Using the Stations drop-down list, click a station.

4. Click OK.

The Import-Merge module is populated with the information from the selected station.
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9.2 Quick Tour

The following sections provide a quick tour of the Import-Merge module interface.

JRI=TEY
Q@ ——@ rie it abot
® ¥ =% o i -
0 ——<WH [ HFOIH XODOX|7 4 |8
© ————————@log import Statior: |WBSI - BSI SAT Station =]
# | Cua| Scheduled | Actual | MName | Lenath | Categary | D escription ;I
0 @& 000000 MACRO SATSHOW START, ABCHNEWS =l
1 @ 000500 MACRO COMMERCIALBREAKBEGIN 01:00, MANDATOR
2 + 000800 oMK 07:00 Local Spots
3 + 000500 E435 01:00  AUDIO  Safeway
4+  (00:05:00 MMACRD COMMERCIALBREAKEMND
5 +  00:0B:0D MACRD  SATSHOW START, HEMDRIE
B @ 00:27:00 COMR... Time Sync
7 00:30:00 MACRD COMMERCIALBREAKBEGIN 0400, MANDATOR
o g + [00:30:00 COMRL, 04:00 Local Spots
3 + 00:30:00 E511 01:00  AUDIO Al Harinoton - WhiAFTh
10 +  00:31:00 6309 01:00  AUDIO  Alpine Bank Promo
11+ 00:32:.00 242 01:00  AUDID  Feather Petroleurn / Stop-N-Sawe
12+ 00:33:00 FER4 0100  AUDID  Forrest Faint- Country Fair
13 +  0D:30:00 MACRO  COMMERCIALBREAKEND
14 @ D0:EE00 COMM... Time Svnc
15 00:57:50 MACRO COMMERCIALBREAKBEGIN 02:00, MANDATOR
16+ 00:67:60 COMR., 02:00 Local Spots
17 + D0:E750 E435 01:00  AUDIO  Safeway
18 + 005850 E634 01:00  AUDIO  Emrald Pool & Fatio
8 4 QORRED MACRO COMMERCIALBREAKEMD
20 (@ 01:.00:00 MACRO SATSHOW START, ABCHNEWS
21 @ 01:0500 MACRO COMMERCIALBREAKBEGIN 01:00. MANDATO
22 + 010500 oo e COMM.. 0100 Local Spofs _ -
| |
I 4
Number Description
(1] Menu bar. See section 9.2.1
(2] Tool bar. See section 9.2.2.
© Log name and station selector. See section 9.2.3.
(4] Program log display. See section 9.2.4.
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9.2.1 Import-Merge Module Menu Bar

The menu bar appears at the top of the Import-Merge window. The following sections
describe the menus on the menu bar.

9.2.1.1 File Menu

Open Log = opens a program log so you

Edit About can re-import traffic or modify the log.
Open Log... ] ) )
Cart Properties... Cart Properties = sets Artist/Advertiser and
bd save — Title/Description information, as well as the
Save Ac... average length.
Y3 Using Music Format...  Ctrl+M Save = saves the current file.
% Using Traffic Format...  Ctrl+T .
L (e Chrl+K Save As = saves the current file under a
& Verify Traffic... different name and/or location.
Mew g Using Music Format = imports from your
Import r Music Log software See section 9.5.1.
Export * . . .
= p— Using Traffic Format = imports from your
o=t File Library... Traffic Log software See section 9.5.2.
i Bt Ctrl+Q

Log From Clock = imports data from the
clocks you created using the Clock Builder
Module into your program log.

Verify Traffic = checks the traffic event expire
dates and file existence in your log.

New = creates a new program log or cart

Import = imports music, traffic, alternate,
CSV, and XML formats. See section 9.5.

Export = exports music, traffic, alternate,
CSV, and XML formats. Also, allows you to
save your log to your file server. See section
9.6.

File Library = adds events to your program
log. See section 9.7.1.

Exit = exits the Import-Merge Module.

Page 268 of 487



9.2.1.2 Edit Menu

y@

Log

B

File About

Verify Ctrl+V
Program Log Options...

Select All Ctrl+4

Edit Fields... Ctrl+E
Insert New Item Ctrl+M

7 Settings...

Import-Merge Module

Verify = checks your program log for errors or
missing files.

Program Log Options = opens a calendar with
dates you can click to see options configured for a
particular day.

Undo = reverts to the version before you last saved
the current file (helpful when you make an error while
creating or editing a program).

Cut = removes the highlighted event from your
program log and copies it to the Windows’ Clipboard.

Copy = copies the highlighted event to the Windows’
Clipboard.

Paste = pastes a cut or copied event from the
Windows' Clipboard under the currently highlighted
item in your program log.

Delete = removes an event from your program log,
highlight it and choose this menu option. This option
is similar to the Cut option, but the event is not
copied to your Windows’ Clipboard.

Select All = highlights all events in the program log.
This option can be used with the Cut, Copy, Paste,
and Delete menu options

Edit Fields = edits the fields of the highlighted event
in the program log. This is useful when you want to
correct a mistake or slightly modify an existing entry.

Insert New Item = to add a new item to your
program log, highlight the event in the program log
previous to the location where you want to add your
new event, and then click this menu option. You can
then manually enter the command of your choice.

Randomize = randomize carts. This option is
available when creating carts, not when creating
program logs.

Settings = accesses the Import — Merge Module
configuration settings and adds events to your
program log.
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File Edit |About

Import-Merge Module

Opens a window that shows the version and
build date of the Import-Merge module you are
running. This window also shows the amount
of memory and virtual memory being used,
and the amount of time that the File Manager
module has been running. See Figure 9-1 for
an example. To close the window, click OK.

About

-

(3]

»0.0.0.235

Build D ate:
Ang 14 2014 20:53:35

Memony zage:
14, B00K. £ 14,768E,

Wk Uzage:
TR AT R20K,

m

Figure 9-1. Example of About Information

Page 270 of 487



Import-Merge Module

9.2.2 Tool Bar

The Import-Merge module tool bar appears below the menu bar.

W8 | PEHFO H XDOOX| - 4lE

Table 9-1 describes the tools on the tool bar.

Table 9-1. Import-Merge Module Tool Bar

Tool Tool Name Description Tool Tool Name Description
Import Using Imports from your music Cut Removes the
b Music Format log software. highlighted event from
Jg 3% your program log and
copies it to the
Windows’ Clipboard.
Import Using Imports from your traffic Copy Copies the highlighted
n Traffic Format log software. Iy event from your
z\s L|j program log to the

Windows’ Clipboard.

Open Log From Opens and modifies a Paste Pastes a cut or copied
2 Server log that has been saved = event from the
to the File Server. J Clipboard to the item
— — below the highlighted
item in your program
log.
Verify Program Checks your program Delete Removes an event
. Log log for errors or missing from your program log.
- files. X
Verify Traffic Log Checks a traffic log for Find Finds an event in your
missing or out- of-date . program log using the
$ audio files without # criteria you specify.
— importingit. ——
Go To Next Error Finds errors in the Find Again Finds the next instance
program log marked in . of an event with the
@ red by the Program Log ~ N search criteria used
— option. —— with the Find option.
Save To OpX Saves the program log File Library Adds events to your
H Server to the File Server. 1 program log.
=l

Page 271 of 487




Import-Merge Module

9.2.3 Log Name and Station Selector

The log name and station selector appear below the tool bar. Table 9-1 describes the tools
on the tool bar.

2]

l

Q@ —OlLug 041208 Station: IWDPX - The Best Rockl! ;I

Figure 9-2. Log Name and Station Selector

Table 9-2. Import-Merge Module Log Name and Station Selector

Number Description

(1] Name of the open program log. Your OpX program log is automatically named with the file
name of the first imported item. For example, if you import a traffic log named “041208.log”,
your OpX log automatically inherits “041208.xml" as its file name.

(2] The station you are creating logs for is determined by the station selected in this drop-down
list. In the figure above, logs are being created for the station “WOPX", with the
configuration settings (import format settings, log locations, and so on) particular to the
WOPX station.

9.2.4 Program Log Display

The program log display shows the program log events as they are imported. It uses the
same display formatting as the Audio Server Module’s program log display.

Page 272 of 487



Import-Merge Module

11| Eue| Scheduled | Actual | Mame | Lenath | Category | Description :I
0 & 000000 MACRO SATSHOW START, ABCHNEWS P
1 =& 000500 hACRD COMMERCIALEREAKBEGIN 07:00, MANDATOR
2 + 00500 COkARA. 0100 Lacal Spots
3+ 000500 B436 01:00  AUDID  Safeway
4+ 000500 MACRO COMMERCIALEREAKEMND
5 o+ (000600 MACRD SATSHOW START. HENMDRIE
B @ 002700 COMM... Time Sync
7 00:30:00 MACRO COMMERCIALEREAKBEGIMN 04,00, MANDATOR
g + 003000 COkbA.. 04:00 Local Spots
9 + [00:30:00 B511 01:00  AUDID Al Hatington - WiWAET
10+ 00:31:00 B309 01:00  AUDID  Alpine Bank Fromo
11+ 003200 G242 01:00  AUDID  Feather Petroleur | Stop-M-Sawve
12+  00:33:00 BREG4 01:00  AUDID  Forrest Paint - Country Fair
13 = 003000 MACRO COMMERCIALBREAKEND
14 @ 006500 COMM... Time Sync
15 00:57:50 MACRO COMMERCIALEREAKBEGIMN 02:00, MANDATOR
16 +  00:EFED COkRA.. 02:00 Local Spots
17+  0&E7ED B435 01:00  AUDID Safeway
18 + 00:E8ED BR34 01:00  AUDID  Emrald Fool & Patio
19 + 006750 MACRO COMMERCIALEREAKEND
20 @ 010000 PMACRO  SATSHOW START, ABCHNEWS
21 & 010500 MACRD COMMERCIALEREAKBEGIN 07:00, MANDATOR
22+  071:05:00 COkAR.,. 01:00 Local Spots _ILI
4| | »

Figure 9-3. Program Log Display

9.3 Third-Party Log Requirements for Importing

The program logs you want to import into OpX must meet the following requirements.
« Files must either be delimited or in position-dependent ASCII text format

- Each break/stop set must contain a signifying event as the first event of the break, such
as a comment of BREAK START, STOPSET, or $$COMMERCIALS$$. You configure the
Import — Merge module to recognize your marker text, so it is actual text does not matter
as long as it is consistent.

« At a minimum, every event must contain a scheduled time for each event, a category,
and a file name (without file extension) for audio events.

+ If combining a music log, traffic log, and clocks (from the OpX Clock Builder), ensure that
each log/clock has the same number of breaks scheduled at corresponding times.
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9.4 Configuring the Import — Merge Module

Configuration of the Import — Merge module is critical. In particular, the import format
settings must be accurate for import operations to work properly. The following sections
describe how to configure the Import — Merge module.

¢ Note: Many settings are available only on the Import-Merge module on the File
Server. To access these settings on a different system, you must import the
settings from the File Server to the new machine using the Restore from File
Server button (see the figure in section 9.4.2).

> To configure the Import — Merge module settings

1. Onthe Edit menu, click Settings.
The Settings dialog box appears, with the General tab displayed.
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l Impart Formats ]

I¥ File Server Address
[ 70 - 1~ 1 _ 10
[ Default Station Assignment
Iv Verfy After Merge
v Show Wamings For Out-of -date / Mizsing Cart tems
I Require Restart To Change Stations
Secondary Stations

Primary Station Secondary Station '=9='

x|

* Secondary stations are used for log
verification, the library list and to save the
secondary program log.

Set List Fort

o OK X Cancel |

Figure 9-4. Settings Dialog Box with General Tab Displayed
2. Complete the fields in the dialog box tabs.
3. When you finish, click the OK button.

9.4.1 General Configuration Settings

Figure 9-5 shows the field in the General tab and Table 9-3 describes them.
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Settings @

|l Import Formats

¥ File Server Address
| 10 . 1 . 1 . 10

[ Default Station Assignment
| =l

v Verify After Merge

[v Show VWamings For Out-of -date / Missing Cart tems

I Require Restart To Change Stations

Secondary Stations

Primary Station Secondary Station

[x |2+

* Secondary stations are used for log
verification, the library list and to save the
secondary program log.

Set List Font

o OK |

x Cancel |

Figure 9-5. General Tab

Table 9-3. Fields in the General Tab

Field

Description

Default

File Server Address

¢ Unchecked = Import — Merge module searches your network for the OpX
File Server.

o Checked = Import — Merge module uses the IP address specified to find
the OpX File Server. This can speed up start-up time or aid your
computer in finding the OpX File Server.

10.1.1.10

Default Station Assignment

o Unchecked = you must select your desired station each time you open
the Import-Merge module.

o Checked = specify one of your stations to load automatically when
opening the Import — Merge module.

Unchecked

Verify After Merge

Check this check box to have the system check for duplicate files and valid
air dates as program logs are being imported into the system.

Checked

Show Warnings For Out-of-
date/Missing Cart Items

Check this check box to have the system generate an error message if it
finds a cart of items (such as commercials) that are out of date.

Checked
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Field Description Default
Require Restart To Change Check this check box to force the Import-Merge module to be restarted Unchecked
Stations before the station can be changed.
Secondary Stations If you import program logs or virtual/nonexistent stations whose libraries —
reside on another station, this field allows verification to be performed by the
secondary station.
Set List Font Allows you to select the typeface for the Import-Merge module interface. —

9.4.2 Import Formats Configuration Settings

The Import Formats tab allows you to define the settings for files you will import into the
OpX system.

1. Click the Import Formats tab.

A tab similar to the following appears.

Settings @

Select A Station

[1 Restore From Server " OK x Cancel |

2. Using the Select A Station drop-down list, click the station whose import format settings
you want to configure. The import formats you select are particular to each station.

The Import Formats tab gets populated with fields and buttons (see Figure 9-6).
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Settings @
'General Import Formats |

Station

'WBSI - The Best OF BS1 -

Music Traffic Bl Test

Input Folder & File Select the folder containing the log file that you wish to

LPQ Tupe import. Input the file name template including the file

Filter Setup extension. Apply any applicable options. Click Next.

Block karker

Fieplace Text Input File Folder

| =
File Mame Template
H Secondary File Name Template [ Used for saving only |

Mest =5
" OK X Cancel
| |

[£y Restore From Server

Figure 9-6. Input File Folder and File Settings

3. Click the type you want to configure or modify. There are three types of import format
definitions for each station:

— Music

— Traffic

Alternate import format definition

4. Complete the remaining fields in the Import Formats tab (see Table 9-4).

5. If desired, click the Test button to test your settings.

6. Proceed to section 9.4.3.
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Table 9-4. Fields in the Import Formats Tab

Field Description

Default

Input File Folder Enter the path to the directory where you save your traffic/music log software
export files. Alternatively, click the Browse to Folder button on the far right side
of the field and select the file.

File Name Template Enter the naming format of your log. This can be either static text (such as
“mylog.txt”) or meta-variables so OpX will automatically recognize date/day
specific log names. The meta-variables convert to the current day/date
automatically (using your workstation’s date and time) in the following formats:

° %yy
Year as a 2-digit number.
Examples: For 2009, replace %yy with “09". For 2016, replace %yy with “16”.

o %yyyy
Year as a 4-digit number.
Example: For 2016, replace %yyyy with “2016".

e %m
Month as a 1- or 2-digit number without a leading zero.
Examples: For June, replace %m with “6”. For November, replace %m with
11"

e %mm
Month as a 2-digit number with a leading zero.
Examples: For July, replace %mm with “07”. For October, replace %mm with
“10".

o %mmm
Month as a 3-letter abbreviation.
Example: For November, replace %mmm with “Nov”.

e %mmmm
Month as a full name.
Example: For August, replace %mmmm with “August”.

o %d
Day as a 1- or2-digit number without a leading zero.
Examples: For the 5%, replace %d with “5.” For the 12t replace %d with “12".

o %dd
Day as a 2-digit number with a leading zero
Examples: For the 7, replace %d with “07". For the 24™, replace %d with
24",

o %ddd
Day as a 3-letter abbreviation.
Example: For Tuesday, replace %ddd with “Tue”.

o %dddd
Day as a full name.
Example: For Friday, replace %dddd with “Friday”.

Figure 9-7 on page 280 shows an example of using meta-variables to represent
a log naming convention that uses the month, day, and year as 2-digit numbers.
This means that when you import your log for the next day by selecting
“Tomorrow” during the import process described later in this chapter, on
December 23, 2008, OpX looks automatically for a log file named “122408.log".

Another example, if your traffic log-generating software created a file that looked
like “122308t1.txt", you enter %mm%dd%yytl.txt into the File Name Template
field. OpX treats any character that is not part of a valid meta- variable as literal
text. In this example, “t1" is not a meta-variable and is included as part of the file
name.
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9.4.3 Log Type Configuration Settings
1. Click the Next button or click Log Type in the left pane.
The settings in Figure 9-7 appear.

Settings @
Station
|WESI - The Best Of BSI |
Music Traffic Bl Test

Input Falder & File Select the format of pour log file. For Delimited the Delimited

Lpg Type Character can be a . [comma] | [vertial bar] or the word tab for

Filter Setup the tab character. Click Mext when complete.

Block karker

Feplace Text (% Pagition Dependent

" Delimited

4= Back Mest =
[ Restore From Server | o OK | x Cancel |

Figure 9-7. Log Type Settings

2. Click the format of your logs (Position Dependent or Delimited). See sections 9.4.3.1
and 9.4.3.2 to determine whether your music and traffic logs are in position-dependent or
delimited format. Then proceed to the appropriate step:

— Ifthe log is in position-dependent format, click the Next button or click File Setup in
the left pane. Proceed to step 3 below.

— Ifthe log is in delimited format, click the Next button or click File Setup in the left
pane, and then enter the character used by your log-generation software to
differentiate between its various fields. Proceed to step 4 on page 281.

3. When configuring a position-dependent import format, the settings in Figure 9-8 allow you
to enter the position and length of each piece of data from your log. Enter the starting
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character position of each field type into the Start column, and the total length of the field
into the Length column. Use the Scheduled Format and Length Format fields to specify
the time format your import file gives in the Scheduled and Length fields.

— hh = hour digits

— mm = minutes digits

— ss = seconds digits

— A/P = 12-hour time (AM or PM)

— Other options are in 24 hour format.

General Import Formats |
Station
0OPX - The Best Rock! z
I Muszic Traffic | By Test |
LA ol Input Start and Length for position dependent format or
Log Type Position for Delimited. Click Next when complete.
Filter Setup
Block Marker
Replace Test Start Length . - N
1 3 Enter item beginning position and length
Cue I l of field. Example: If CUE beging with the
second charactor in the line and is one
Scheduled |2 I8 charactor long, enter 2 in the START
Scheduled Ihh. mm'ssﬁv bow and 1 in the START box nest ko
Format sl CUE.
File Mame I1 0 IB
File Mame I
Leading Char
Length |1 a I5
Length Farmat Imm:ss vl
Category |23 IB
Drescription 1 |31 |5D
Description 2 ID ID
[T &dd Awuta Step Cue "+ to all events
<= Back | Mewt = |
[y Restore From Server | o OK I x Cancel |

Figure 9-8. Example of Configuring a Position-Dependent Import Format

4. When configuring a delimited import format, enter the field order of each piece of data
from your log (see Figure 9-9). Enter the field number of each field type into each
corresponding Position field. Use the Scheduled Format and length Format fields to
specify the time format your import file gives in the Scheduled and Length fields.

— hh = hour digits

— mm = minutes digits
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— ss =seconds digits
— A/P = 12-hour time (AM or PM)

— Other options are in 24 hour format.

Gereral  Import Formats I
Station
0P - The Best Rock! hd
I Music Traffic | ET'J/ Test |
Input Folder & File Input Start and Length for position dependent format or
Log Tppe Paosition for Delimited. Click Next when complete.
Filter Setup
Elock Marker o
'ozilion
Bieplaterficat ] Enter delimiting character [, | ar tab),
Cue I then enter a position nurmber. Example: If
CLIE iz the third item in & line separated
Scheduled |2 by commag, enter a comma in the above
Scheduled Ihh'mm'ss j‘ bow and 3 in the Cue box,
Furmnat e
File Marme |3
File Mame I
Leading Char
Length I"-1
Length Format Imm:ss vl
Categomy |5
Description 1 IB
Description 2 I?
[~ Add Aot Step Cue "'+ to all events
4= Back | Mest = |
[§1 Restare From Server | o OK I ¥ Cancel |

Figure 9-9. Example of Configuring a Delimited Import Format

5. Proceed to section 9.4.3.

9.4.3.1 Position-Dependent Format

Position-dependent program logs such as the one in Figure 9-10 are organized with the
various pieces of data in nice columns that are easy for people (not just computers) to read.
Each column starts at the same position on each line when you count the characters from
the left side and each column always contains the same number of characters, including
spaces. Another indicator of position-dependent program logs is that the “white space” is
made up of spaces, not tabs or other characters. If your program log does not fit this
description, you have a delimited program.

Figure 9-10 shows a typical position-dependent program. Each “field” is in a specific column,
with each data type always starting at the same position on all lines/rows. Notice the cursor
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positioned just before the Category column and the “Col 23" shown in the lower right corner.
This indicates that the starting position of the category starts at character 23. Counting the
number of characters to the right, we find that the column can fit 8 characters. Another
indicator that this is a position-dependent log is that the “white space” is made up of spaces,
not tabs or other character.

ol
File Edit Format Wiew Help
+ 00:51:30 5011 0l:00 lupIo  Toma Ads/5011 -
00:52:30 5592 00:30 AUDIO Red Lobster/ 5592
+ 00:53:00 2692 01:00  AUDIO Image Media Marketing Inc. /2692
+ 00:54:00 5451 00:30 AUDIC  Cumulus - Mandan Progress Organ/5451
+ 00:54:30 071a 00:15 AUDIO East 40/0716
01:51:30 COMMENT BREAKSTART
+ 01:51:30 5517 00:30 AUDIO  Heartland Mortgage Company/5517
+ 0l:52:00 26092 01:00  AUDIO Image Media Marketing Inc. /2692
+ 01:53:00 1344 00:30  AUDID  Ccumulus - Joh opportunity/1344
+ 01:53:30 1352 00:30 AUDIO MD Broadcasters Associations/1352
+ 01:54:00 5592 00:30 AUDIO Red Lobster/ 5592
+ 0l:54:30 0716 00:15 AUDIO East 400716
02:51:30 COMMENT BREAKSTART
+ 02:51:30 55072 00:30 AUDIO Red Lobster/ 5592
+ 02:52:00 5011 0L :00 AUDIO Toma Ads 5011
+ 02:53:00 5543 0l:00  AUDIo  cCumulus - Job opportunity 5543 =
« | _>I_I
| | Ln1, Colzs y

Figure 9-10. Sample Position-Dependent Program Log

To configure the Import-Merge module for a position-dependent file, collect the following
information by analyzing your file:

- The starting position of each data type’s field (for example, Cue, Description, Length,
Scheduled Time, Filename, and so on.).

«  The maximum length of each field above.

- The format of each time field (mm:ss or hh:mm:ss).

@ Tip: To find the starting position of each column easily, enable Notepad’s Status
Bar (on the View menu, and enable the Status Bar option). The cursor’s
position appears as column numbers (“Col #”) and line numbers (“Ln #”) appear
in the lower right corner of the Notepad window. Place your cursor at the start of
a column to find the position, place your cursor at the end of the column, and
then subtract that position from the previous one to get the column’s length.

9.4.3.2 Delimited Format

Delimited program logs are quickly apparent in their difference of style from position-
dependent logs. Each piece of data is separated by a specific character, with no spaces
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(“white space”) between the data and the separating character. This means that each row
will have a differing overall length from other rows in your program log.

Figure 9-11 shows a typical delimited program log file. Every line and row is a single event,
and each line contains the same number of “fields”, separated by the “|” delimiting character.
This example has Cue as field 1, Scheduled Time as field 2, File Name as field 3, Length as

field 4, Category as field 5, and Description as field 6.

[ 100608KU.txt - Notepad _

File Edit Formak  Wiew Help

=0l x|

06:26

06:43

e R

0453
0d ;54
05:51:
05:52:
05:453:
05:53:
0554
06:23:
0624 :
06:25:
06:25:
06:26:
10
06:40:
06:41:
Q6:42:
06:43:
:la

30
le]
=0
30
oo
30
oo
30
30
ele]
30
le]

30
30
30
oo

3962
5763
011
5450
3459
13445
2042
4752
56541
4554
5592
L705
4343
3923
5524
3453
5708
36823

0o:

ol4]

ol:
0o
0o
[0

oo

0l
oo:
0o
oo:

oo
oo

0l:
ol:
0o:

oo
oo

30| AUDIC
(15| AUDIO
00| AUDIC
30| AUDIO
30| AUDIC
30| AUDIO
(15| AUDIO
00| AUDIO
30| AUDIOD
30| AUDIO
30| AUDIOD
10| AUDTIO
$15 | AUDIO
00| AUDIO
00| AUDIO
30| AUDIC
$15| AUDIO
15| AUDTIO

Feist Electronics Inc/3962|

walker's W' Daughters Jewelers/5763|
Toma Ads,/ 5011

Cumulus - Mandan Progress organ/5450|
Downtowners Business Associatio/5459]
Cumulus - Job opportunity1345]
schoepp Family Cﬁirupracticf2042|

Sun & Fun Media 4752

Morthwest Tire and Auto (expres/5641]
UPS store, The 4554 |

rRed Lobster 5592 |

wells Fargo Bank (agencyl/L705|
SuEeriDr i1k screenys4343 |

Mobile Ads (TRADE) /3923 |

applebees (Bismarck) /5624 |

Ramkota Hotel (Tradel /3453

Skowvys autoplex/5708]|

Exact Med UTTC/ 5623

o

Llni, Coll

As Figure 9-11 shows, the most common delimiting character is the “|” pipe symbol (this is
usually the upper-case character of the “\” key on your keyboard). If your file does not use
the pipe symbol as its delimiting character, you should be able to recognize it by looking at

Figure 9-11. Sample Delimited Program

the program log, since the delimiting character will be between each piece of data.

To configure the Import-Merge module for a delimited file, collect the following information by

analyzing your file:

«  The delimiting character.

- The order of the fields in each row is (for example, Cue, Description, Length, Scheduled
Time, Filename, and so on). The left-most field is field 1, the next field is 2, and so on.

- The format of each time field (mm:ss or hh:mm:ss).

9.4.4 Block Marker Configuration Settings
1. Click the Next button or click Block Marker in the left pane.
The settings in Figure 9-12 appear.
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'General Import Formats |
Station
|WBSI - The Best Of BSI |
I Music Traffic | B Test |
Input Folder & File Input the stop-set position marker for music logs or start of
ijg Type stop-set block for kraffic logs. Input ignore and change to
Filter Setup comment settings. Click Next when complete.
Block Marker
Replace Test Block Marker
| In Field IEue -
[~ Enable Time Sync Parameters
Change To Comment | In Field | + |
x|
lgnore | In Field | +|
x|
Waicetrack Marker | I Field | +|
x|
= Back | Mest = |
[y Restore From Server | o OK X Cancel |

Figure 9-12. Block Maker Settings

2. Complete the fields in the Import Formats tab (see Table 9-5).

3. Proceed to section 9.4.5.
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Table 9-5. Block Marker Fields in the Import Formats Tab

Field Description Default
Block Marker Enter your Block Marker’s text. —
In Field Select the field that contains that text you entered in the Block marker field. Cue
Enable Time Sync Parameters Enables the automatic insertion of a time-next event prior to the commercial —

break created by the text specified by the Block Marker field. For example, if the
music log contained STOPSET 15:30:00, a time-next event is inserted
automatically before the commercial break with a scheduled time of 15:30:00.
You can specify an optional parameter of the number of elements preceding the
commercial break. For example, STOPSET 15:30:00, 5 inserts the time-next
event five elements prior to the commercial break.

Change To Comment To convert imported events into comments, click the Add button to the right of —
the Change to Comment field. Complete the following fields in the Change to
Comment pop-up window:

o Text = enter the distinguishing text, such as a category of “TEXT" or “NOTE".
o Field is Empty = if the field is empty, check this check box.

o Infield = select the field where OpX will find that text.

Buttons are also provided for editing and deleting entries.

Ignore If your log-generating software includes events that you do not want OpX to —
import, click the Add button to the right of the Ignore field to convert imported
events into comments. Complete the following fields in the Ignore pop-up
window:

o Text = enter the distinguishing text to be ignored.

o Field is Empty = if the field is empty, check this check box.
« Infield = select the field where OpX will find that text.
Buttons are also provided for editing and deleting entries.

Voicetrack Marker From your log-generating software (most commonly from your music log), you —
can add voicetrack markers to your program log using comments. This simplifies
voicetracking with OpX’s Studio Client by allowing your talent to click the NEXT
button to automatically move the Voicetrack Editor to the position in the Program
Log for which they need to record the next voicetrack. To define your voicetrack
marker, click the Add button to the right of the Voicetrack Marker field. Complete
the following fields in the Voicetrack marker pop-up window:

o Text = enter the distinguishing text.

o Field is Empty = if the field is empty, check this check box.
o Infield = select the field where OpX will find that text.
Buttons are also provided for editing and deleting markers.

9.4.5 Replacing Text Configuration Settings

If you need to auto-replace text entries in your import logs, use the Replace Text settings to
configure these entries.

1. Click the Next button or click Replace Text in the left pane.

The settings in Figure 9-13 appear.
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( Settings @

'General  Import Formats |

Station
|WBSI - The Best OF BSI |

Music Traffic B Test

Input Folder & File
Log Type

Filter Setup

Block Marker

Enter replace text settings. These allow text in a field to be
replaced with alternate text or overwrite text in another field.

Replace Text

From Text In Fi... MHame Cateq... | Dez..| Sche.. cﬂ:

[ |2

@ o

4 1 I

4= Back Mest =

[y Restore From Server ‘ J oK x Cancel |

Figure 9-13. Replace Text Settings
. Click the Add button.

The Replace Text dialog box appears (see Figure 9-14).

. Complete the fields in the dialog box (see Table 9-6).

. Click OK.

. If you need to edit or delete entries, use the appropriate buttons to the right of the field.

Below these are buttons for replacing and exporting txt strings and importing replace text
strings.
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[ Replace Text @

From Test

|
I Field

| =]

To Fields

Cue Statuz
| = =l

[ Scheduled [HH:MM:55)

oo:o00n = [

M ame | Length [MF:55]
oo —

Category

| |
Dezcription / M acro Event

x Cancel |

Figure 9-14. Replace Text Dialog Box

Table 9-6. Fields in the Replace Text Dialog Box

Field Description Default
From Text Enter the text to be read. —
In Field Field from which the text is read. —
Cue Cue type to be inserted —
Status Status of the event to be inserted. —
Scheduled Date and time for which the item is scheduled. If unchecked, keeps the 00:00:00

scheduled time in place.

Name Name of the item. —
Length Duration of the item. 00:00
Category Category to which the item belongs. —

Description/Macro Event

Description of the audio item or the parameters of the macro.
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9.5 Importing Program Logs

Most music-oriented stations import a music log containing all the music selections to play
throughout the day, and a secondary traffic log that must be combined with the music log to
insert all the advertisements to be played. These users start the import process described in
section 9.5.1 followed by the procedure in section 9.5.2 on page 291.

For talk stations that do not play music, or for stations that have only a traffic log to import,
skip section 9.5.1 and proceed to section 9.5.2 on page 291. Conversely, to import a music
log only and not a traffic log, perform the procedure in section 9.5.1.

9.5.1 Importing Your Music Log

> To import your music log

1. Click the Import Using Music Import button or click File > Using Music Format.

Eile Edit About
™ s —| @ J
NS | HFO|b| 5

Log: @tled Statior:

I # | Eue| Scheduled | Actual | I ame

The Import Music Log dialog box appears.
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Import Music Log @

Jg Import Music Log

Station
WBSI - The Best Of BSI

= Saturday, January 23, 2016 L3

HMon | Tue | Wed | Thu | Fri | Sat | Sun |
1 2 3

4 5 [ ¥ g 3 10

11 12 13 14 15 16 17

18 19 20 A 22 24

25 26 27 28 23 30 A

. Music . Trslife . Both Music & Traffic

No Information

. Select the month, day, and year from the calendar, and then click OK.

By default, the import function imports from your locally configured import path. To
import from your File Server’s import path for your station, choose the Server option.

. To import a log that does not conform to your configured File Name Template, click the
Browse For File button on the right side of the Local field and select an import file.

. Click OK.

The events in your music log are imported. A progress window shows the progress of
the import, along with any errors or warnings. After the logs are imported, an Information
pop-up window alerts you to the number of errors generated during the import process.
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Integrating clocks for haur 12
Integrating clocks for hour 13
Integrating clocks for haour 14
Integrating clocks for hour 15
Integrating clocks for haur 16
Integrating clocks for hour 17
Integrating clacks for haur 18
Integrating clocks for hour 19 1[
Integrating clocks for hour 20

Integrating clocks for hour 21 -

Integrating clocks for hour 22 \.!’) R Etore
Integrating clocks for hour 23

Integrating clocks for hour 24
Setting air date to; 11,/18/2008
Saved tor Demo_Loge_12-01-2008_
Werify using air date: Tue, Mov 18,0

Pl

@ Open In Motepad | / DOME I

5. Click OK to remove the message.

6. Click Done.

9.5.2 Importing Your Traffic Log

> To import your music log

1. Click the Merge Using Traffic Format button or click File > Using Traffic Format.

== OpX Log Import / Cart Builder

File Edit Abouk
NS EFO K
Log: 111 Bﬂ% Station;

I H | Eue| Scheduled | Actual | I arne

The Import Music Log dialog box appears.
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Irmport Music Log @

GQ Import Music Log

Station
WBSI - The Best Of BSI

= Saturday, January 23, 2016 L3

Mon | Tue | Wed | Thu | Fri | Sat | Sun |
1 2 3
4 5 [ i g 9 10

11 12 13 14 15 16 17

18 19 20 A 22 24

25 26 27 28 23 30 A

. Music . Trslife . Both Music & Traffic

No Information

. Select the month, day, and year from the calendar, and then click OK.

By default, the import function imports from your locally configured import path. To
import from your File Server’s import path for your station, choose the Server option.

. To import a log that does not conform to your configured File Name Template, click the
Browse For File button on the right side of the Local field and select an import file.

. Click OK to remove the message.

. Click Done.

If you imported a music log before importing the traffic log, the events from your traffic
log and clocks are combined automatically with your music log events in the correct
order. You can now edit your log, add new events, or remove events from your final log
before saving it.

. To save your finished program log to the File Server, click the Save To OpX Server
button.
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9.6 Exporting/Saving a Finished Program Log

The following sections describe how to save program logs to the file server and export
program logs for use in third-party applications.

9.6.1 Saving Your Program Log to the File Server

> To save the current program log to the File Server

1. Click the Save To OpX Server button on the tool bar.

< OpX Log Import / Cart Builder

File Edit about
B I
Log  untitled SG&:

| # | Eue| Scheduled | Actual | Mame

A progress window shows the progress of the save operation.

2. Click Done to remove the window.
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9.6.2 Exporting Your Program Log for Third-Party Applications

> To export your current program log for use by a third party

1. Onthe File menu, click Export.

The available import commands appear.

File | Edit About

HIXBBX[” 48]
Cart Properties... % x @
H Save Ctrl+5 | Statiorn: WBSI - The Best OF B5I vI
Save As...
J Mame | Length | Category | D escription
¥ Using Music Format...  Ctrl+M
¥ Using Traffic Format...  Ctrl+T
Log From Clock... Ctrl+K
% Verify Traffic...
New 2
m Using Music Format. Ctrl+M
Export | ¥ Using Traffic Format...  Ctrl+T
E AL Using Alternate Format
CSV Format
@ Bt Cr+Q | XML Format Ctrl+1

2. Click the appropriate option (see Table 9-7).



Import-Merge Module

Table 9-7. Import Options

Option Description

Using Music Format Exports your program log using the settings configured in the preferences for importing in music
format.

Using Traffic Format Exports your program log using the settings configured in the preferences for importing in traffic
format.

Using Alternate Format Exports your program log using the settings configured in the preferences for importing in
alternate format.

CSV Format Exports your program log in comma-separated-value (CSV) format.

XML Format Exports your program log as an .xml file. xml is the format OpX uses natively.

9.7 Manually Adding and Editing Program Log Events

9.7.1 Adding Audio Files Using the File Library

You can add audio files to your program log using the file library to browse through the audio
files on your File Server and then dragging-and-dropping them to your program log. This
method allows you to add audio files. You cannot use this method to add other commands to
your program log. To add macros, or any other event type, to your program log, see
Appendix A - Macros.

> To add audio files using the file library

1. Click the File Library icon on the tool bar or click File > File Library.

B
NOX |4 BN

=

P¥ - The Best Rock! hM) |
File Libr ary |

| Length | Categony | Dezcription

A File Library similar to the following appears, with all audio files from all folders
displayed.

2. Use the following steps to enhance File Library viewing:

— To limit the file list to show only a single folder, click the drop-down list and click the
desired folder.
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— To search through the file list by keyword, type text in the Find field. The label to the
right of the Find field indicates what column will be searched. The column that will be
searched is the same column by which the File List is sorted. As Figure 9-15 shows,
the sort indicator is in the Name column, so OpX searches the Name column for the
text you type in the Find field.

WOPX - The Best Rock! - k|
Fird
! inMame
Faolders Cua N e
g ane ror mokalng Larks
IMUSIC j IAUtD Start{] ;I Auto Start for Program Logs
i 27 ltems
Title | Aitist | M arne & | Lenath | :l
You Showed Me Turtles 402-11 00:03:05
One Fine Day Chiffons 405-10 Qo:0z:.04
Five O'Clock Warld Yogues 405-18 ao:02:.04
Suspicion Stafford, Terry 406-03 [0:02:26
Soulful Strut YYoung-Haolt Unlimited 406-08 00:02:54
The End Of The'World  Dawvis, Skeeter 406-24 00:02:34
Ain't Mothing Like The . Gaye, Marvin & Tamemi... 409-01 o021
Release Me (And Let ... Humperdinck, Engelbert 411-08 00:03:15
Warmth Of The Sun Eeach Bows 411-11 00:02:45
You Belong To ke Duprees 415-18 [0:02:33
Walking To Mew Orlea... Domino, Fats 416-04 00:01:55
Blugherry Hill Diomino, Fats 420-14 Qo:0z:19
The Letter Box Tops 421-08 00:01:50
Ewil Wans Santana 421-09 00:02:60
ou hake ke Feel Lik... Franklin, Aretha 421-23 00:02:37
eather And Lace Stenvie Micks & Do A ;28
California Girls Diavid Lee Roth ER7G7 02:39
by City Wi'as Gone Fretenders 57718 00:05:19
YWhite Foom Cream 57719 00:04:54
1-2-3 Barry, Len B01-24 a0:02:20
In*'our Eves[Edit] Gabriel. Peter 922-01 00:04:4a
Anoel[Edif] McLachlan, Sarah 982-04 00:03:58
A Horse With Mo Name  America cl24-01 00:04:07
The Pink Panther Koz, Dawve HCO0720-11 00:03:38 i

Figure 9-15. Sample File List

— Torefresh the list to show new items added to your file server while the File Library
window has been open, click the Refresh 2| button.

3. Click and drag your desired item from the File Library’s File Listand drop it into your
program log.

— If you drop the event below another in the program log, the new event is added as
the last item in the log.

— If you drop your event on top of an existing event, the new event is added after that
event and all subsequent events shift down to make room.
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WOPX - The Best Rock! =

RS TR =
RS HFO MHIXEOOX] 4% ,:ﬂ B \C:;osm <] Nore o Rtsng Cots
oas ] Ao Start o Program Logs
Log. untitied Siaton. [WOPX - Tho Bost Rlock! i
] Cue | Scheduled | Actusl Name. | Length | Categosy | Descaiption _l“'L' g
0« 42216 0230 Ain't Too Proud To Beq -~ 13 .
1 @20l 04dd In'Your EysfEd] - Gabre {12 7] [Nane [Leogh T =]
2 . 218 0240 |Can See Clearty Now-N | You Showed Me Turtles 40211
3 00 02 Alll Have To Dols Drean | One Fine Day Chifons 405-10
; :gg‘ﬂ? gl; ;2 Ehunser: Of Lgﬁ'DTMP‘Cm Five O'Clock World Vogues. 405-18
i OuShomad e - lilas §f <2oicion Stafford, Termy 406-03
%4 T i e e oo o | Soultul Strut ‘Young-Holt Unlimited  406-08
8+ 0603 0225 Suspicion - Stefford, Temy | The End Of The World - Dewis, Skester 40624
9 1 0608 0254 Seultal Stia-YounaHon | | Ain't Nothing Like The .. Gaye. Mervin & Tammi... 409-01
10 406-24 0234 The End Of The World - D | Release Me (And Let... Humperdinck. Engelbert 411-08
}; ﬁl?-ga gg }15 am‘w wan m{huﬁs; Warmth Of The Sun Beach Boys 41-11
E elease Me etMe | | v lona To M 415-1
13 » A 0zds Wermih Of The Sun - Beac Ymsfqo-;'g Naw Gries. B:ﬂﬁf;m; ﬂg_ﬂg
1 . as18 0233 ou Belong To Me - Dupn g 3
15 . a604 0155 Welking To New Orleans - | Bluebermy Hil Domino, Fels £014
1B+ Q4 0218 Biusbamy Hill - Domino, Fi | The Letter Box Taps 421-08
17 . 2108 0150 The Letier - Box Tops Evil Ways Santana 421-09
18 - 42109 0250 Evil Ways - Santana ‘ou Make Me Feel Lik__Franklin. Aretha 421-23
Stevie Nicke &
Ligathise Andd Laer - Stovie Nicks & Don Hinling o G - T :
#F'Was Gone 572718 2
e Rioom 572719 2
-2-3 Barry. Len B01-24 2
&3 In Your Eves[Edif Gabriel, Peter 922-01 3
AnaellEdit] MeLachlan, Sarsh 982-04 1
AHorse With No Name  America 12401 0407
The Pink Panther Koz, Dave HCo720-11 00:03:38 -

EY

Figure 9-16. Dragging and Dropping from the File Library File List to the Program Log

9.7.2 Adding New Events Manually

> To add new events manually
1. In the program log, click the event above which you want to insert the new event.
2. On the Edit menu, click Insert New Item.

An Adding New Item dialog box similar to the following appears.

Adding New Item B x|

Statuz Cue  Scheduled  Actual Mame Length Categony Drescription
| |@ j100s00 | | | [MACRO  |DEVICE AC582, 0N
Modify T i ] B H v v

Check the field's Modify box to update the coresponding field in the selected

record. [f unchecked the field will be remain unmaodified. J ok I x Cancel |

To clear a field, check the modify box and leave the edit field empty.

3. Click in each field and enter the data pertinent to your event.

4. Click OK.
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9.7.3 Editing Events in Your Program Log

> To edit events in your program log
1. In the program log, click the event you want to modify.
2. On the Edit menu, click Edit Fields.

An Edit Item dialog box similar to the following appeatrs.

I X
Status Cue  Scheduled  Actual MHame Length Categamy Diescription
| = [pooson [f [ [ [MacRO [DEVICE ACs82, OFF
Modify [T W [ | | H [ | | | T
Check the field's Madify box to update the conespanding field in the selected
o loat 5 0l ahed e sl bon et B T il iy SO0k | X concel

Figure 9-17. Edit Item Dialog Box

3. Click in each field you want to change and edit the value.

When you enter a value, the corresponding Modify box gets checked automatically.

4. To clear a field, check the Modify check box and leave the corresponding entry blank.

5. Click OK.

9.7.4 Changing the Cue Type of Events In Your Program Log

The editing method described in section 9.7.3 allows you to edit all fields of an event in your
program log. Sometimes, however, you need only change the cue type of an event.

> To change the cue type

1. Click the event in the program log.

2. Press the key on your keyboard for the new cue type you desire:

— To set your event’s cue type to Auto Start, press the + key.

— To set your event’s cue type to Time Immediate, press the @ key (Shift+2).
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— To set your event's cue type to Time Next, press the # key (Shift+3).

— Totoggle the event to Manual, press the same key as the existing cue type.
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9.8 Working with Carts

9.8.1 Creating a Cart

You create a cart using the same procedure you use to create a program log. A cart is like a
mini-program log. Carts allow you to create a singular item that contains links to multiple
audio files and/or macros. When creating a program log or Hot Key, you can insert a single
cart that you created instead of inserting multiple items to do the same thing. When creating
a trigger set, scheduled event, or program log, using carts instead of single event, allows
you to execute multiple items in succession.

The way carts behave depends how you set the cue types of the events in the cart. See
Table 9-8.

Table 9-8. Cart Behaviors

Cue Type Cart Behavior

All events in the cart have Manual Start (blank) cues When you first play the cart, only the first event is played, and then the cart
stops. The next time the cart is played, only the next event in the cart is
played. The third time the cart is played, only the third item is played. This
sequence continues until the cart is played enough times that all items in
the cart have been played. At this point, the next time the cart is played, it
starts from the top again. This type of cart is referred to as a “rotator.

All the events in the cart have Auto Start (+) cues. When you play the cart, all events in the cart play in succession, from the
first event in the cart through to the last event in the cart.

Some events have Auto Start cues and some have The cart plays in order from top to bottom, continuing to play events from

Manual Start cues. the cart until the cart encounters a Manual Start event, at which point the

cart stops. The next time you play the cart, it starts from where it left off
(the Manual Start item it stopped on last time) and plays the rest of the
events until it encounters another Manual Start event. This sequence
continues until the cart is played enough times that all items in it have been
played. At this point, the next time the cart plays, it starts at the top again.

» To create your cart
1. On the File menu, click New, and then click New Cart.

2. Add events to your cart using the File Library (see section 9.7.1) or by using Edit > Insert
New Item (see section 9.7.2).

¢ Note: All events in a cart must have either an Auto Start (+) or Manual Start
(blank) cue type. No other cue types are valid.

3. After you add the items to the cart, save the cart (see section 9.8.3).
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9.8.2 Editing a Cart

To edit a cart

Y

Create a new cart.

Using the File Library, find the cart you want to edit and drag it into the new cart.

nNoe

The events are placed into the new cart and the file name is updated with the name of
the existing cart.

3. Edit, add, or delete events from the cart.

4. Click the Save To File Server button to overwrite the previous file of the same name or
click File > Save As to save the file under a different name, and then click OK.

9.8.3 Saving a Cart

> To save the current cart

1. Click the Save To File Server button on the tool bar.

& Op¥ Log Import / Cart Builder
File Edit About

|ﬂ3$\|§@@|m5¥
Log  untitled 56&

| # Cue | Scheduled | Actual | Name

You are prompted with the Name & Type dialog box.
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Mame & Type i 5[

% Wirtual Cart

= Program Log

Mame
IM_I,I Cart

W 0K X Cancel |

2. In the Name field, enter a file name for your cart.
3. Click the OK button.

Your cart is saved to the File Server, making it available to your station’s Audio Server.
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10 Info Editor Module

Topics: This chapter describes the OpX Info Editor module.
4 Starting the Info Editor The Info Editor module allows you to edit all available
Module (page 304) tags; set intro, segue, and hook times; and transfer audio

) files to the File Server.
4 Quick Tour (page 305)

4 Setting Intro and Segue
Times (page 313)
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10.1 Starting the Info Editor Module

You must start the File Server module before you start the Info Editor module.

> To start the Info Editor module
1. Start the File Server module (see section 3.1).
2. Click the Windows Start button and click Programs > Broadcast Software > InfoEdit.

A BS Info Editor window similar to the following appears.

A BSlInfo Editor [F=5 Eol 5
Authoring | LCommercial | Muszic | Clazsical | About |
|l Desktop j Description / Times | Server ] Alburn ]
2 Iﬁ él' - <3‘.>. L_b gg CI X ﬂ 3‘1‘7 - | E Title # Description
Mame Size | Modified |

= Audio (D) Artist / Advertiser
s DVD Diive [H:) [
5 DV R Drive [F2)
£ Lacal Disk [T

Start Date & Time [24 hr.) Time ‘Window [24 hr.]
oo a4 | d
End Date & Time [24 hr.] Ta

o lomt- R e

[ IS ] = o
From start Length From end
00:00.0 00:00.0
il
Intra Seque
= =)
wd wd
OutCue
|
Categary Faormat
|atDio |

[ Mo fade at segue

Lacation
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10.2 Quick Tour

The following sections provide a quick tour of the Info Editor module interface.

Authoring | LCommercial | uszic I Classical I About I
Description / Times | S | Album

Title / Description

Artist / Advertizer

DD Drive H:]
2 DVD Riw Diive (F)
&L, Local Disk [T:)

Start D ate & Time [24 hr.) Time Wwindaw (24 hr ]

a Ewl:
End Date & Time [24 hr.] To
7oA d [od

Q00| ¢ims cpmEA

From start Length Framn end
00:00.0 [ | 00:00.0

i
Segue

| e | I
I
Categary Format
st =]

™ Mofade at segue

Location

(1) File list. See section 10.2.1.

(2) Tabbed section. See section 10.2.3.
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10.2.1 File List

The Info Editor’s file list allows you to browse to any folder available on your workstation. It
displays folders and audio files to simplify navigation through your audio files.

I-.._'; Spotz

* @8 |0 RO X|EF-

Table 10-1describes the tools on the file list.

Table 10-1. File List Tools

Tool Tool Name Description Tool Tool Name Description
Go up to parent | Shows the contents of the Cut Copies the highlighted
¥ folder folder that contains the W file to the Clipboard,
folder you are viewing. but once you paste the
file to another location,
the file is removed from
its current location.
Refresh current | Updates the files and folders Paste Puts a cut or copy of
a folder in the file list. = the file currently from
= B the Windows'
Clipboard to the
directory displayed in
the file list.
Gotoselected | Brings the item in the tabbed Delete Moves the highlighted
item section of the Info Editor into X file in the file list to the
== view on the file list. Useful if Windows’ Recycle Bin.
you scroll the file list away
from the tab’s displayed file
and want to find it.
Find Finds the first audio file in Select Columns Allows you to add or
> the file list based on your @ remove the columns in
criteria. the file list.
Find Next Finds the next audio file Favorites Adds the displayed
us!ng the crjteria entered ! folder to a list of
q:'; using the Find button. favorite locations. Click
the drop-down button ™
to access or edit a list
of favorite locations.
Copy Copies to the Windows Explore current Opens Windows
|_'D Clipboard the currently folder Explorer to the Info
highlighted file in the file list. Editor's currently
displayed folder.

Page 306 of 487




Info Editor Module

10.2.2 Editing Multiple Files

The Info Editor can edit the tags of multiple files at the same time.

> To edit multiple files
1. Click the Select Columns button.
The column for the tag you want to modify appears.
2. Click the first file you want to edit.
3. To edit additional files, perform the appropriate step:

— If the files are contiguous to the one you clicked in step 2, hold sown the Shift key
and click the last file. All files between the first and last ones you clicked are selected
automatically.

— If the files are not contiguous, hold down the Ctrl key and click each additional files.

— If you change your mind about a selected file, hold down the Ctrl key and click the file
to deselect it.

4. With all your files selected, right-click the column title.

A Category pop-up window appears.

M ame | Size | Modified Categaons | ”~

=] Copy of GC1747 FAIRGR... S172KB 03/31/2008 42230 Category 1%

+] EMERALD POOL & PATI... 5226 KB 03/31/2008 4:22:28

) FORREST PAINT - LAN... S.21T KB 03/31/2008 42226 ]SF'EITS

4] GC 1655 wav 5193KB  03/31/2008 4:22:14 2 )
-1 GC 1750 092607 wav 9,224 KB 03/31/2008 4:22:14 et Clear | 000
-~ GC 1751 092607 wav 5224 KB 03/31/2008 4:22:14 . :

| GC 1753 092607 wav 5224 KB 03/31/2008 42216 ... 24 hr.]

-1 GC1743 CIVIL WhR. way S172KB 03/31/2008 4:22:28 |1 2/31/2m2 g |23:59
S GC1744 LIQUIDATION . 5157 KB 03/31/2008 42228 .

- GC1745 LIGUIDATION 2... S172KE  03/31/2008 42228 .

-+ GC1746 FAIRGROUMD ... S172KB 03/31/2008 42220 . '
- GC1747 FAIRGROUMD ... S172KB 03/31/2008 4:22:14

- GC1748 ITASCA way 5193KE 03/31/2008 4:2214 From start Leng

5. Enter the data you want to apply to all the selected files, and then click the Set button.
OR
To “blank-out” the entries for the highlighted files, click the Clear button.
OR
To cancel the procedure, click on the pop-up window’s Close button in the top-right
corner.
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10.2.3 Tabbed Section

The Info Editor’'s tabbed section has seven tabs to allow you to enter various data into your
audio files.

> To edit an audio file’s tags

1. Using the File List on the left side of the Info Editor, browse to the file whose tags you
want to edit, and then click it.

2. Edit the file’s tags in the Info Editor’s tabs on the left side of Info Editor.

The following sections describe the Info Editor tabs.

10.2.3.1 Fields in the Description/Times Tab

Authoring | Commercial | b Lisic | Classical | About
Description # Times | Server ] Alburm
) L. Title / Diegcription
Option Description |
Title/Description Enter the name of your audio file. Antist ¢ Advertiser
Artist/Advertiser Enter the name for the creator of the |
file.
Start Date & Time [24 hr.] Time "indaw [24 hr.]
Start Date & Time Sets the date range and time your file 4 E : QI : QI
is to be played. End Date & Time [24 br.] To
) ) . L EHEE :
Time Window When entered, the audio file will only | | QI | QI
be playable between the hours
selected. o @ = =
Play/Stop/Pause buttons Allows you to preview your file inside I Length From snd
the Info Editor. 00000 00000
Tones/Hook When you set tones, you can set both ! '
regular Intro and Secondary Tones. Il
You can also set Hook Tones for use Intio Seque
with Simian's Hook Cart functionality. T i | _Iij
v ad ed
From start Allows you to see how far the slider is OutCue
from the beginning of the file during |
playback.
Category Farmat
Length Shows the length of the file. AUDI0 =l
L [ Nofade at
From end Allows you to see how far the slider is ° A e
from the end of the file during Lez=ltm
playback. |
Slider Allows you to scrub through the song during playback. You can see the Tones or Hook within

the slider: Look for white space at both ends of the blue bar under the slider. The white at the
beginning is your intro and the white at the end is your segue.

Intro button

Visible when Tones is selected. This button allows you to set the intro tone for the audio file,
while the time window allows you to see exactly where the tone is set.

Segue button

Visible when Tones is selected. This button allows you to set the Secondary Tone for the audio
file, while the time window allows you to see exactly where the Secondary Tone is set.
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Option Description
Outcue Text that appears in the decks as the song is going out.
Hook Start Visible when Hook is selected. Allows you to set the start for the "hook" for the audio file.
Hook End Visible when Tones is selected. Allows you to set the end for the audio file's "hook."
Category You can assign a category to a file so that it will always display the correct category in the audio
list and event builder
Format Shows the file attributes of your file.

No fade at segue

Assures that the file will never fade out at the end no matter what settings are configured in
Simian. Great for spots.

Location Shows you where the file is stored on your hard drive.
10.2.3.2 Fields in the Server Tab Rl
WEGL - Spots
Option Description = @ Statons
Folder List Browse to a stations’ audio folder. SO TSR

Save To Server button

Click this button to transfer the currently
loaded audio file to the selected folder on
the file server.

(T Promas
+ a wHOK. - Mews Talk 1440
+- i W0 -0-985
- WZOK - 97 Z0K
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10.2.3.3 Fields in the Album Tab

Album

Alburm

ID izintegration

Year

|1E|89

Genra

I.-’-‘«Iternative

Track #

|s

Option Description
Album Enter the album name.
Year Holds the year information for the file.
Genre Holds the genre information for the file.
Track# Holds the track information for the file.
10.2.3.4 Fields in the Authoring Tab
Option Description
Producer Holds the producer information for the file.
Talent Holds the talent information for the file.
Composer Holds the composer information for the file.
Publisher Holds the publisher information for the file.
Copyright/Record Holds the copyright information for the file.
Company
Comments Holds any comment information that you

want to include in the file.

futhodng |
Prosducer

[Dave dlen
T et

Rickert Sath
E'Eimun Galup
Peel Thorspison
Blcats Wil

Composar

[Frcbert Smih
Publzher

fwER
Copynght / Riecord Comparg

[Elektia
Comments
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Cormmersial

Agency

|The BSI Agency!

Account Executive / Sales Person

|J0hn Doe

Copy

URL

hittp: S, brivza, com

10.2.3.5 Fields in the Commercial Tab
Option Description

Agency Holds the agency information for the file.

Account Holds account executive and sales person

Executive/Sales information.

Person

Copy Holds information you want to add to the file.
This tag can be displayed in a text box within
Simian any time the file is played. Select
Tools/Program Options/General and check
in Display Copy Field option.

URL You can associate a URL with each file and
then send that URL to the Dynamic HTML
Page, or the MS Encoder.

10.2.3.6 Fields in the Music Tab

Option Description

Key Holds the key in which the cut was
performed.

End Holds information about how the cut ends.

Energy Common descriptor for audio cuts.

Texture Helps you sort your cuts by audience.

Tempo Holds the tempo in which the cut was

performed.

Beats Per Minute

Holds the BPM information for the file.

Erd

[Fade
Eraige

(M elires
Testue

|E‘c-|e

[Mecham Shove
Basts peist s
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10.2.3.7 About Tab

The About tab shows the Info Editor
version, a link to the BSI website, and
information about the versions of
supporting dynamic link library (DLL)
files.

The Output device for audition
drop-down list allows you to select the
audio device you want to use for
playback while you're tagging files.

To force your computer to use the
Windows’ CODEC instead of on-
soundcard CODECs that you may
have, check Force use of ACM
CODEC.

Ahot
;
Broadcast
& Software
International
-
BSi ) Wisit BSI on the Web
Info Editor / Tagger
0.0.0.15
Copyright & 2006 Broadcast Software International
Module Werzion
HalyGri32. dll 4.0,0,53
vaavinfo32 dl 40.0.4
Cutput desice for audition
|Speakers [2- High Definition & j

[ Force uze of ACM CODEC
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10.3 Setting Intro and Segue Times

Setting intro and segue points in your music files is critical to smooth-sounding transitions
between songs on a music station. The Info Editor makes it easy to set intro and segue
points.

> To setintro and segue times

1. In the file list on the left side of the Info Editor, browse to and click the audio file to which
you want to add intro and segue points.

The file loads into the tabbed section.

Ioa

| 07 Lights in the Sky way

ﬁﬁ Corona Badiata way 1
3 The Four of U= are Dy...

iy RN - -

[

2. Gotothe Description/Times tab on the tabbed section of the Info Editor.

AUROANG | LOMMErcal | Music | AD
Dezcription 4 Timesz l S apver ] Alb

Title / Description

|Corona Radiata
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3. To set the intro point of your song, click the Play button to start playback of your
audio file.

%0 Q * Tones i~ Hook

Frar Play {Chrl+R) Length From end
. 10:08.0 | 10080

1
e
|

4. As your audio file plays back, listen to the track. When the track gets to the point
where you want to set your intro point, click the Set Start .#| button.

From start Length Fraom end
00:24.9 10:08.0 03:431
I
Intro Segue
= =i
w234 A o

5. If you want to re-set the intro point, move the pointer on the scrubber back in the
file.
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6. To fine-tune your intro point, click the Fine Adjust buttons to increase or decrease the
intro point in tenths of a second.

Irtro Seque
a0 23.3 j‘%ﬁ| |
Mt 1=

7. You add the segue point using the same procedure that is used to add the intro
point. The only difference is that you click the Set End button to set the segue
point.

From start Length From end
03426 10:08.0 00:25.4

[ B | 1 1 1 1 1 1 1 1 1 1 1 1 [ |

l inl

Iritr Seque

00233 j Pl j =

QutCue et End {CtrI+E]I|

8. Re-settings or adjusting the segue point uses the same technique shown in step
3.
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Topics: This chapter describes the OpX File Sync module.
4 Starting the File Sync The File Sync module backs up and maintains your
Module (page 317) station content automatically. Running this module
. copies all audio files and virtual carts, from your File
* Quick Tour (page 318) Server’s Music, Spots, Carts, Fill, Records and
4 Configuring the File Sync VoiceTrack folders to your Audio Server’s local hard
Module (page 323) drive. If the hard drive fails on your File Server machine,
+  Synchronizing Files (page you can use a copy of all your conter.lt (which is at m.ost
325) 24 hours out of date) to get your station up and running.
The File Sync module also acts as a housekeeper for the
Audio Server by deleting obsolete material that has been
deleted from the file server. It is critical for users who run
the OpX Audio Server on a different machine than the
File Server. Running the File Sync module on your Audio
Server machine creates and maintains a current copy of
all the files for that Audio Server’s station on its local
hard drive. You can configure the File Sync module to
run once a day at a specific time.
¢ Note: The File Sync module performs 1-way synchronization. This means it

copies files only from your File Server to your Audio Server. To copy files to your
File Server, use the File Manager module (see Chapter 7).

Tip: For quick recovery from a hardware failure on your File Server, install a
copy of the OpX File Server on your Audio Server machine and leave it dormant
(fully closed) because you can only have a single File Server running on any
LAN. If your File Server machine fails, open the dormant File Server module on
your Audio Server machine. The Audio Server’s hard drive will have all the files
needed to run the dormant File Server to keep your station on the air.

Only one OpX File Server can be run per network. If you have multiple stations,
take each Audio Server machine off the network, so that each Audio Server’s
backup File Server does not conflict with the others.
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11.1 Starting the File Sync Module

You must start the File Server module before you start the File Sync module.

> To start the File Sync module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > File Sync.

A File Sync - BSI window similar to the following appears.

£ File Sync - WBSI Lo o]
File Edit About
} i\ u Mext Run Time: Dizabled 16-46:27
Mame | Local Folder Local D ate Server Folder Server Date
101.1.10/101.1.10
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11.2 Quick Tour

The following sections provide a quick tour of the File Sync module interface.

E= =
(1) File Edit About
o O @ [ N e ST R
| Mame | Local Folder | Local Date | Server Folder | Server Date |
(3) o
QO —o 101.110/10.11.10 p

Menu bar. See section 11.2.1.

Tool bar. See section 11.2.2.

Event list. See section 11.2.3.

Status bar. See section 11.2.4.
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11.2.1 Menu Bar

The menu bar appears at the top of the File Sync window. The following sections describe
the menu options.

11.2.1.1 File Menu

All = selects all files.

Edit About Report Only = toggles between Report Only
D All mode.

Delete = deletes selected files.

[ Report Only
x Delete

Exit = exits the File Sync module.

Exit Ctrl+ Q)

11.2.1.2 Edit Menu

Settings = configures File Sync module

File About settings. See section 11.3.
FY Settings

11.2.1.3 About Menu

Opens a window that shows the version and

File Edit [About] build date of the File Sync module you are
running. This window also shows the amount
of memory and virtual memory being used.
See Figure 11-1 for an example. To close the
window, click OK.
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»0.0.0.131

Build D ate:
Feb 26 2014 11:32:02

kemorny Ugage:
13,000, /£ 13,000k,

Wi | zage:
8,252k / 3. 416k

Figure 11-1. Example of About Information



11.2.2 Tool Bar

The File Server module tool bar appears below the menu bar.

File Sync Module

bE X

MHext Burn Time:

Tomormow, 01:00:00

Table 11-1 describes the tools on the tool bar.

Table 11-1. File Sync Module Tool Bar

Tool Tool Name Description Tool Tool Name Description
Run Triggers a synchronization Delete Files Deletes files that are
operation. If the Report no longer applicable.
Only option is enabled, no
files are copied.
Stop Stops a running File Sync — Next Run Time Shows the scheduled
operation. time for the next
automatic File Sync
operation.
Report Only Runs a test - System Clock Shows the system
synchronization. See the time.

note below and section
11.4.

o

Note: When Report Only is enabled, the File Sync module lists all events that
would be performed during a full synchronization, without copying or deleting files.
This allows you to find duplicate files between your local folders (if the Check for
Duplicates, Keep Newest option is enabled), without removing the duplicates. It is
also useful when you want to archive duplicate files before the system deletes them
during a full synchronization.

The Report Only option stays enabled until you disable it. When enabled, timed
syncs are performed as report-only syncs and your files are not copied. Disable this
option after you finish using it.
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| Mame | Local Folder Local Date Server Folder | ServerDate o
) imagh.way DADRSWESIMingles  Tue, Dec 31, 02,1:2
. [ imagh.wav DADg\Spots Tue, Dec 31,02,12 =
11 2 3 Event L|St K imaghway D:\Op\Gpats Tue, Dec 31,0212
"= & 110wav DADRWESI\Music  Man, Dec 17,01, 12 D:AOp<WwWBSIMusic  Todsy, 11:44:30
: 118.wav DADRAVWBSIWMusic  Wed, Dec 12,01, 30, D:Op<WBSIMusic  Today, 11:44:46
. B HUOTH-02wav  DADEOWESIMusic DADRWESIMusic i Jan 18,08, 2
The event list shows all the events @ {7 Gy DADSOWBSHuse DTS i o 16,05~
. ‘lﬁ" HUD741-04 way  DAOp<VWESINMusic D:A\OpWWWBSI\Music  Fri, Jan 18,08, =
perfOfmed durlng the |aSt @ HUOTA DSwav  DAORKYWESIMusic D:ADRAWESI\Music  Fri.Jan 18,08, 2
@ HUDTAI DB Wy DADEWES\Music DADROWESIMusic  Fii Jan 18,08, 2
Synchronization process. If Report : HUDT41-07.wav  DADE<VWBSIWMusie DADRWES\Music i Jan 18,08, =
: - ® Not o ne on e Miloops
Dawsy D usic : usic i, Jan 18,08, 3
Only is enabled, the event list shows @ HUTT0may DADBAWBSWuc DADRAWESI\Wse  Fdan 1B, 08 =
. @ HUDZHI T way  DADEKOWES\Music DADRWESIMusic i Jan 19,08, 2
the actions that would be performed. & HUDZAT12wey  DADRSWRSIMusic DADRWBSIMusic i, Jan 18, 08, 2
& HUO7#113way  DADEXWESI\Music DADRXWESI\Music  Fi, Jan 18, 08, 2
@ CANCELLED
|
4 [

Table 11-2 describes the columns in the
event list.

Table 11-2. Columns in the Event List

Column Description

Event Type Icon Each line in the event list represents a singular synchronization event. This
column shows an icon for the type of event of each line item. The icons for
the events performed are:

. 'ﬁ' New file copy = file does not yet exist on local hard drive.

. 'ﬁi' New version = local file is older than the version on the File
Server. Overwrite old version on local hard drive with new version
copied from the File Server.

. Eﬁ Duplicate file = file in a local folder by the same name exists in
another local folder. This icon indicates all duplicates by the same name
and not the deletion of any files.

. x Delete file = when duplicate files are found, following the event
line items of the duplicate files, the Delete File event(s) with this icon
appears. This indicates the actual deletion of the specificfile(s).

. . Synchronization Canceled = if the Cancel button is clicked while
a file is being synchronized, a line item is added to the list indicating
where the synchronization was canceled. To restart the synchronization,
click the Run button in the tool bar.

Name Shows the file name involved in each synchronization event.

Local Folder Shows the path to the folder on the local hard drive where the file either
exists or will be copied to.

Local Date Shows the date and time of the most recent file modification. This field only
applies to files that already exist. If a file does not exist locally (i.e., or a
New file copy event), this field is blank.

Server Folder Shows the path on the File Server where the audio is stored. This field is
blank for events not involving file transfer from the File Server, such as
duplicate file and delete file events.

Server Date Shows the date and time of the file on the server involved with the event.
This field is blank for events not involving file transfer from the File Server,
such as duplicate file and delete file events.
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11.2.4 Status Bar

The status bar shows the statistics of the items that will be copied during the current
synchronization process. The statistic types displayed are Duplicates, Deletes, and Copies.

%

iDupFu:ates: 1 'Deletes: 1 :ch:das: 170

11.3 Configuring the File Sync Module

The File Sync module comes with default configuration settings that should suit most users.
Using the Settings option on the Edit menu, you can change these settings to suit your

requirements.

> To configure the File Sync module settings
1. Onthe Edit menu, click Settings.
The Settings dialog box appears.
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Settings

Metwark, Interface

[10.1.1.10- Opix ~]

File Server Addrezs
m . 1 . 1 10

v

[v Check For Duplicates, Keep Mewest

[ Reconcile Everpday &t
01:00:00 =

bl awirmum Drata Transfer Bate
100 El b Bitz # Second [ 0 = Mo Throtting

|Ipdate [nteral

15 Zl Seconds

r

Folders

W 0K

X Cancel |

2. Complete the fields in the dialog box (see Table 11-3).

3. Click OK.
Table 11-3. Fields in the Settings Dialog Box
Field Description Default
Network Interface If your system has more than one network interface, select the proper 10.1.1.10 - OpX
device for your OpX network. Network
File Server Address Enter the IP address of the machine running your OpX File Server module in 10.1.1.10
this field. With an IP address entered the File Sync module will only connect
to the File Server on a specific IP address and will not have to search your
network.
Check For Duplicates, Keep o Checked = File Sync searches local audio folders for duplicates and Checked

Newest

performed
o Unchecked = local audio folders are not searched.

deletes all but the newest copy. Duplicates are determined by their file
name. If you have two files by the same name in two different folders,
only the file modified most recently remains after this operation is
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Field Description Default

Reconcile Everyday At o Checked = File Sync module runs automatically once a day. Use the time Unchecked
selector to select when the file synchronization occurs. Select a time of
low network traffic to perform your synchronization (for example, in the
middle of the night).

o Unchecked = File Sync module does not run automatically once a day.

Maximum Data Transfer Rate Set a maximum data throughput rate for the synchronization operation. 100 M Bits

11.4 Synchronizing Files

After you configure the File Sync module, you can leave it running to perform
synchronizations at the time you scheduled, or you can perform synchronization on-demand.

Note: Because the File Server updates its file list on a cycle, it can take up to 5
minutes for new items to be available for the File Sync module to synchronize. This
does not affect live on-air playback of audio files, since the Audio Server copies
new files for playback on-the-fly automatically.

i

> To start the OpX File Sync module

1. To run a test sync without affecting files on the hard drive, click the Report Only button
on the tool bar [qj or click File > Report Only. With Report Only enabled, your timed
syncs will be performed as report-only syncs and your files will not be copied.

2. Click the Run  button to start a synchronization (or Report Only synchronization if you
performed step 1).

3. After performing your test synchronization, disable the Report Only option if you no
longer want to use it. This option stays enabled until you disable it.

4. Minimize the File Sync module if you want to leave it running in the background, or click
File > Exit to exit the File Sync module.

Q Tip: You can place the File Sync module in your system’s Startup folder, so the
module will start automatically at system boot. Because the File Sync module
must connect to your File Server to run, be sure your File Server is running
before starting File Sync module.
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Topics:

A

Starting the Serial Device
Server Module (page 327)

Quick Tour (page 328)

Configuring the Serial
Device Server Module
(page 332)

Adding a New Profile
(page 333)

Editing a Device Profile
(page 340)

Deleting a Device
Profile (page 341)

Using a Serial Server
Device (page 341)

12 Serial Device Server Module

This chapter describes the OpX Serial Device Server
module.

The Serial Server allows the sharing of a serial device,
such as an audio switcher or a trigger interface, from one
station (i.e., Audio Server) on another station across your
local-area network. This means you can use audio
switchers or trigger devices connected to one of your
audio servers on multiple stations.

Audio Server 1 Audio Server 2 Audio Server 3
With Serial Server
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12.1 Starting the Serial Device Server Module

You must start the File Server module before you start the Serial Device Server module.

> To start the Serial Device Server module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software >
SerialServer.
A Serial Device Server window similar to the following appears.

File Edit Action

E}j Tgfﬁ ﬁ ] ,) WES| - The Best OF BSI

S8 Serial Device Server El [=] @

[02:32:62 12/27 /28] File Server found at; 1001.1.10
[02:32:52 12/27/20158] Uzing netwark, interface; 10.1.1.10
[02: 3252 12/27 /2015] Bound

[02: 3252 12427 /2015] Liztening on 10.1.1.10

m

Address Statuz Time
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12.2 Quick Tour

The following sections provide a quick tour of the Serial Device Server module interface.

E=n

(1] File Edit Action
(2] Om ms” E ” 7 | WESI - The Best OF BSI
(3) —0

[02: 3252 12/27/2015] File Server found at: 10.1.1.10

[02 3252 12/27/2015] Using netwark, interface: 101110

[02:32:52 12/27/2015] Bound

[02:32:52 12/27/2015] Ligtening on 10.1.1.10

Address | Statuz | Time

(4] °

Menu bar. See section 12.2.1.

Tool bar. See section 12.2.2.

Device tabs. See section 12.2.3.

Action history. See section 12.2.4.
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12.2.1 Menu Bar

The menu bar appears at the top of the Serial Device Server window. The following sections
describe the menu options.

12.2.1.1 File Menu

Edit Action

Bat  Ctrl+Q

Exit = exits the Serial Device Server module.

12.2.1.2 Edit Menu

Settings = configures Serial Device Server

File Action module settings. See section 12.3.
—y Settings

12.2.1.3 About Menu

Add Serial Device = adds a new serial

File Edit device profile. See section 12.4.1.
=4 Add Serial Device... dd XDS iver = add S
‘E =4 Add XDS Receiver... Add XDS Receiver = adds a new XD

=4 Add /O Card Device receiver profile. See section 12.4.2.

Add 1/O Card Device = adds a new I/O card
device profile. See section 12.4.3.

Delete Device = deletes a device profile. See
section 12.6.

Edit Device = modifies the settings of a
device profile. See section 12.5.
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12.2.2 Tool Bar

The Serial Device Server module tool bar appears below the menu bar.

i 3 2 [ WOPX - The Best Rock!

Moving the screen pointer over a tool displays the tool’s function as a tooltip. For example:

i

9 Serjal Device Server
File Edit Action

SIER

Add Serial Device|

Table 12-1 describes the tools on the tool bar.

Table 12-1. Serial Device Server Module Tool Bar

Tool Tool Name Description

Add Serial Device Adds a new serial device profile. See section 12.4.1.

ey

Add XDS Receiver Adds a new XDS Receiver profile. See section 12.4.2.
XD35

Add I/0 Card Device Adds a new I/O card device profile. See section 12.4.3.

Delete Device Deletes a device profile. See section 12.6.
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Tool Tool Name Description

Edit Device Modifies the settings of a device profile. See section 12.5.

UNITY4000-1 | STARGUIDEII-1

12.2.3 Device Tabs

After you add devices to your Serial

Description: S58.2 ON WiOP
Device: Broadeast Tool: 554805 8.2

Device Server configuration, a tab IF;_“: fom

appears for each device. The figure .

to the right shows a sample Cycle-Time: 78 ms
configuration of three devices. HEH HEB

HIDEEE L E

Each tab shows device statistics
that include the Description, Device
type, Port, ID number, Connection status, and Cycle-Time for the device.

The closure grid shows the status of closures for the device. Some devices might not have
closures and will not display the closure grid. When a closure is active, its grid block will be
green for the duration of the closure.

12'2'4 ACtlon HIStory [15004:23 1210020081 Staited UMNIT 40001 3
L | st [15:04:23 1210/2008] Reading STARGUIDEIN- conbiguration

[15c04:23 1210/ 20083] Staited Serial Poit

[15004-23 1210/ 2008] Stated STARGUIDEIN-

i 1 [15c04: 24 12 0/2008] Uzing nebwok intedace: 10.1.1.10
The bottom of the Serial Device 15:04:24 13/10/2008] Boxwd
i [1500d: 24 1210/ 2008] Listerig on 10.1.1.10
ﬁerver ImOdUILe SIhOWi the aﬁtlon [15:04:31 12/10/2009] Chent connecting: 10.1.1.71
istorv list. This list Wws t [15:04:31 12/10/2003] Received from 10.1.1.11: UHIT BTSS82
S_O ylis S _S shows the [15:04:36 1210/2008] Chent connecting: 10.1.1.10
actions of all devices and [15:04: 36 12/10/20083] Recanved from 101,110 UMIT BTSS82

commands from connected Audio
Servers since the Serial Device Server module started.
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12.3 Configuring the Serial Device Server Module

Before you use the Serial Device Server module, you must configure its settings. After
setting up the Serial Device Server, you add devices with which the module will

communicate.

> To configure the Serial Device Server module settings

1. Onthe Edit menu, click Settings.
The Settings dialog box appears.

[ Settings @

10.1.1.10 - Op ~|

[ Teminate Inactive Connections

/] % e |

2. Complete the fields in the dialog box (see Table 12-2).
3. Click OK.
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Table 12-2. Fields in the Settings Dialog Box

Field Description Default
Network Interface If the OpX system detects multiple NICs, this drop-down list allows you to 10.1.1.10 - OpX
select the NIC you want the Serial Device Server to use. If you have a single Network
NIC on your machine, the Serial Device Server selects that NIC
automatically, and the drop-down will be gray and unavailable.
Terminate Inactive Connections Check to terminate a connection from another OpX module. Unchecked

12.4 Adding a New Profile

When you open the Serial Device Server module for the first time, there will be no device
profiles. Using the buttons in the tool bar or the options in the Action menu, you can add
profiles for serial devices, XDS receivers, and I/O Card devices.

12.4.1 Adding a Serial Device Profile

> To add a profile for a serial device

1. Click the Add Serial Device E button, or click Action > Add Serial Device.

The Serial Device dialog box appears.
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s

Senial Device @
Mame Description
Port Device

| =]

Broadcast Tools

? —
=
[=8
[41]

Specify the actual Urit [D

600 Unit 1D rat .{-‘«LITEI Iﬁgher‘u Lizing
Data Bits AUTO | mulbple devices on the

zame poart.
T 5
¥ lgnore Subsequent Closures For

N -
one 280 Z Milliseconds

[v¥ Append Temination Characters
Flow Cortrol |CWLF ﬂ

Mone -

% =,
4 4

LﬁLgJ

| x Cancel ‘

Figure 12-1. Serial Device Dialog Box for Serial Device

2. Complete the fields in the dialog box (see Table 12-3).
3. Click OK.

A tab appears at the top of the Serial Device Server dialog box with the name of the
device.

Table 12-3. Fields in the Serial Device Dialog Box (Serial Device)

Field

Description

Default

Name

Enter a short name to identify your device.

Description

Enter a more verbose description to make it easy to identify this device from
others you might add.
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Field

Description

Default

Device

Select your device. The following are built-in profiles you can select:
« Broadcast Tools SS/ACS 8.2

o Broadcast Tools SS 16.4

o Broadcast Tools GPI-32

« Broadcast Tools SRC-8 IlI

« Broadcast Tools 8x2 D/ev

o Broadcast Tools SRC-16

« Broadcast Tools GPI-16

o XDS Receiver

If your device is not listed, the “Raw Serial Device” option allows the output
of serial data to the selected port using macros such as SERTALOUT.
While this option does not support OpX built-in trigger, relay, or switcher
functions, it is ideal for outputting serial data to a satellite receiver, or any
other device that accepts ASCII serial commands.

Port

Select the port through which the OpX system will communicate with the
device. Refer to the documentation for your device.

Baud Rate

Data Bits

Parity

Stop Bits

Flow Control

Append Termi

nation Characters

Select the communication speed, data bits, parity, stop bits, flow control,
and termination character required to communicate with the device. Refer to
the documentation for your device.

9600

None

None

CRILF

Unit ID#

Enter the ID number of the device with which the OpX will communicate.
OpX requires your device to be set to a device ID number that does NOT
have burst mode enabled. Unit ID 0 of most switchers automatically enables
this function. Set your device to an ID other than 0 and enter that same ID
number in this field. Refer to the documentation for your device. If only one
device is connected to your selected serial port, accept the “AUTO” default.
If multiple devices are configured, select a value corresponding to all
connected devices.

AUTO

Number Of Devices On This Port

If this port is available, enter the number of devices with which OpX will
communicate through the specified port.

Ignore Subsequent Closures For

n Milliseconds

If you need the de-bounce feature, check this function and set a threshold in
milliseconds. The number of milliseconds is case-specific, so you might
have to try various values to find the one that suits your situation. If you do
not need a de-bounce feature, uncheck this option.

Checked
250 milliseconds

Closure Descriptions

If Closures are applicable to your setup:

1. Click the Closure Descriptions button. The closure description dialog box
appears (see Figure 12-2).

2. Change the descriptions in the Description field.

3. Click OK.

Switcher Descriptions

If switching is applicable to your setup:

1. Click the Switcher Descriptions button. The switcher description dialog
box appears, with tabs for input and output channel names (see Figure
12-3).

2. Change the descriptions in the Description field.

3. Click OK.
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Clasure i D escription

Clozure #1
Clozure #2
Closure #3
Clozure #4
Clozure #5
Closure #E
Clozure #7
Clozure #2
Clozure #3
Clozure #10
Clozure #11
Clozure #12
Clozure #13
Closure #14
Clozure #15
Clozure #16

XK Cancel |

Figure 12-2. Closure Descriptions Dialog Box

Outputs

Drescription

Input #1
Input #2
Input #3
Input #4
Input #5
Input #E
Input #7
Input #2

Figure 12-3. Switcher Descriptions Dialog Box
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12.4.2 Adding an XDS Receiver Profile

> To add a profile for an XDS receiver

KOS

The Serial Device dialog box appears.

1. Click the Add Serial Device button, or click Action > Add XDS Receiver.

Senal Device @
Mame Description
Port Device

|P€DS Receiver J

g

Data Bits

Mone -

g |=
am
g |4 1

Mone -

[ Closure Descriptions |

ey |

| x Cancel |

Figure 12-4. Serial Device Dialog Box for XDS Receiver
2. Complete the fields in the dialog box (see Table 12-4).
3. Click OK.

A tab appears at the top of the Serial Device Server dialog box with the name of the
device.
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Table 12-4. Fields in the Serial Device Dialog Box (XDS Receiver)

Field Description Default

Name Enter a short name to identify your device. —

Description Enter a more verbose description to make it easy to identify this device from —
others you might add.

Device Read-only field that shows the XSD Receiver. You cannot change this XSD Receiver
value.

Port Select the port through which the OpX system will communicate with the 1
device. Refer to the documentation for your device.

Baud Rate 9600

Data Bits 8
Select the communication speed, data bits, parity, stop bits, flow control,

Parity and termination character required to communicate with the device. Refer to None
the documentation for your device.

Stop Bits 1

Flow Control None

Closure Descriptions If Closures are applicable to your setup: —

1. Click the Closure Descriptions button. The closure description dialog box
appears (see Figure 12-2 on page 336).

2. Change the descriptions in the Description field.
3. Click OK.

Switcher Descriptions If switching is applicable to your setup: —

1. Click the Switcher Descriptions button. The switcher description dialog
box appears, with tabs for input and output channel names (see Figure

12-3 on page 336.
2. Change the descriptions in the Description field.
3. Click OK.
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12.4.3 Adding a I/O Card Device Profile

> To add a profile for a I/O card device

1. Click the Add I/O Card Device E button, or click Action > Add 1/O Card Device.
The I/O Card Device dialog box appears.

'

@8 1/O Card Device ][0 3]
Mame Dezcription

[#0 Card Type
| =l

Device

x Cancel |

Figure 12-5. 1/0 Card Device Dialog Box for I1/O Card Device
2. Complete the fields in the dialog box (see Table 12-5).
3. Click OK.

A tab appears at the top of the Serial Device Server dialog box with the name of the
device.

Table 12-5. Fields in the I/O Card Device Dialog Box (I/O Card Device)

Field Description Default
Name Enter a short name to identify your device. —
Description Enter a more verbose description to make it easy to identify this device from —
others you might add.
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Field

Description

Default

I/O Card Type

Select your device. The following are built-in profiles you can select:
 Advantech 1756
o Sealevel 8004

Device

Select the device corresponding to the I/O card type you selected

Closure Descriptions

If Closures are applicable to your setup:

1. Click the Closure Descriptions button. The closure description dialog box
appears (see Figure 12-2 on page 336).

2. Change the descriptions in the Description field.

3. Click OK.

12.5 Editing a Device Profile

There might be times when you need to edit device profiles. For example, you might need
to change serial port settings, closure descriptions, or audio switcher input and output

descriptions.

> To edit adevice profile

1. Inthe Serial Device Server tool bar, click the tab of the serial device you want to edit.

Examples of device =g

tabs

@8 Serjal Device Server

File Edit Action

Deschption: Used to enhance audio broadcasts.
Demvice: Broadcast Tools GPI-32

Part: Coml

10

Connectior: Disconnected

Cycle-Time:

=] & s

WB5I - The Best Of BSI

[13:49:41 12/27/2015] Reconnecting...
[13:49:42 12/27/2015] Reconnecting...
[13:49:43 12/27/2015] Reconnecting...
[13:49:44 12/27/2015] Reconnecting...

Addresz Statuz Time

Figure 12-6. Examples of Device Tabs
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2. Click the Edit Device 2 button or click Action > Edit Device.

The Serial Device dialog box appears, with the settings defined for that device.
3. Edit the settings as required.
4. When you finish, click the OK button.

12.6 Deleting a Device Profile

If you no longer need a serial device profile, you can delete it from the OpX system.

> To delete a device profile

1. Inthe Serial Device Server tool bar, click the tab of the serial device you want to delete
(see Figure 12-6 on page 340).

2. Click the Delete Device E button or click Action > Delete Device.
A prompt asks whether you are sure you want to delete the device.

3. Click the Yes button to delete the device.

12.7 Using a Serial Server Device

After you configure your serial server devices in the OpX system, add the devices to your
OpX Audio Servers (including the Audio Server on the same machine as your Serial Server
is running) to have your Audio Servers use the devices. For instructions about adding serial
server devices and other I/O devices to your OpX Audio Server, see Chapter 4.
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Topics: This chapter describes the OpX Allow Stations module.
4 Starting the Allow Stations The Allow Stations module permits the limitation of
Module (page 343) station profiles from being available to any OpX modules

on the local machine.
4 Quick Tour (page 345)

4+ Configuring the Allow
Stations Module (page
347)

4 Limiting Station Profiles
(page 348)
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13.1 Starting the Allow Stations Module

You must start the File Server module before you start Allow Stations Module.

> To start the Allow Stations Module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > Allow
Stations.

You are prompted to enter a password.

[ Password? @

x Cancel |

3. Inthe field, type password (which is the default case-sensitive password), and then click
OK.

An Allow Stations dialog box similar to the following appears

« Note: You can change the default password using the Settings menu (see section
" 13.3).
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H <3

Station | Dezcription
[l B The Best Of BSI
I kEsI The worst Of BSI
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13.2 Quick Tour

The following sections provide a quick tour of the Allow Stations module interface.

@ ————efile Edit

o—tH @
Station | D' ezcriptian
[w] wESI The Best Of BSI

© [JkEBSI The "Warst Of BSI

Menu bar. See section 13.2.1.

Tool bar. See section 13.2.2.

Station list. See section 13.4.
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13.2.1 Menu Bar

The menu bar appears at the top of the Mixer window. The following sections describe the
menu options.

13.2.1.1 File Menu

Edit Save = saves the allowed station
H save configuration.
“d Bit  CileQ

Exit = exits the Allow Stations module. If you
have not saved your current configuration, you
are prompted to save changes before exiting.

13.2.1.2 Edit Menu

File . Settings = allows you to configure the network
i Settings interface, file server IP address, and

password. See section 13.3.
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13.2.2 Tool Bar

The Mixer tool bar appears below the menu bar.

I
|'_.: !
H
Table 13-1 describes the tools on the tool bar.

Table 13-1. Allow Stations Tool Bar

Tool Tool Name Description
Save Saves the allowed station configuration.
Exit Exits you from the Allow Stations module. If you have not saved your
current configuration, you are prompted to save changes before exiting.
g
o

13.3 Configuring the Allow Stations Module

Configuration of the Import — Merge module is critical. In particular, the import format
settings must be accurate for import operations to work properly. The following sections

describe how to configure the Import — Merge module.

> To configure the Allow Stations module settings
1. Onthe Edit menu, click Settings.
The Settings dialog box appears.

Page 347 of 487



Allow Stations Module

( Settings @

Metwaork, Interface

File Server Address
| 10 . 1 . 1 . 10

Paszwiard

HEREEEER

¢' OF. x Cancel |

Figure 13-1. Settings Dialog Box
2. Complete the fields in the dialog box (see Table 13-2).
3. When you finish, click the OK button.

Table 13-2. Allow Stations Module Settings

Field Description Default

Network Interface If the OpX system detects multiple NICs, this drop-down list allows you to 10.1.1..10 - OpX
select the NIC you want the Serial Device Server to use. If you have a single
NIC on your machine, the Serial Device Server selects that NIC
automatically, and the drop-down will be gray and unavailable.

File Server Address IP address of the file server.. 10.1.1.10

Password Case-sensitive password used to log in to the Allow Stations module. —

13.4 Limiting Station Profiles

The Audio Stations window shows all of the stations associated with the IP addresses
entered in the Settings dialog box (see section 13.3). Check boxes in front of each station
allow you to limit station profiles from being available to any OpX modules on the local
machine.
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\4

File Edit

Station | Dezcription
[l B The Best Of BSI
I kEsI The worst Of BSI

To limit station profiles

Check the station so an X appears in the check box in front of the station.

To not limit station profiles

Uncheck the station so the X does not appear in the check box.




14 FTP Server Module

Topics: This chapter describes the OpX FTP Server module.
4 Starting the FTP Server The FTP Server module is responsible for transferring
Module (page 351) files to the audio servers.

4 Quick Tour (page 352)

4« Configuring the FTP
Server Module (page 357)

4 Starting and Stopping the
FTP Server (page 357)
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14.1 Starting the FTP Server Module

You must start the File Server module before you start the FTP Server module.

> To start the FTP Server module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX FTP
Server.

An OpX FTP Server window similar to the following appears.

e

5 OpX FTP Server E=REcR <=

File Edit About!

} el Fre et conc Il Fles

[13:46:10] File modified: 0:YwEBSIAConfighSerialS erver Settings. =ml -
[13:48:10] File rmodified: D:\WEBSINConfighSerals erver Settings. xml
[13:46:30] File modified: D:A\WEBSINConfighD evice_TALK =ml

[13:46:30] File modified: [:YWwBSIAConfighSenalS erver Settings. =ml
[13:46:30] File modified: D:\WwWEBSINConfighSerials erver Settings. xml
[13:46:44] Storing updates far: D:AMWESINConfighDevice_alD =ml
[13:46:53] File modified: 0:YwBSIAConbighDevice_aALIDT . «ml

[13:46:53] File modified: D:\WWEBSINConfighD evice_aAllDT . wml

[13:46:53] File modified: 0:YwEBSI\ConfighSerialS erver Settings. =ml
[13:46:53] File modified: D:\WEBSINConfighSeralS erver Settings. xml
[13:47:04] Storing updates far: D:AWESMConfighDevice_TALET xml
[13:47:24] Stonng updates for: [:YwBSIMConfighSenalS erver Settings. sml
[13:47:31] Storing updates far: DAWESIAConfighDewvice_allD1 sml
[14:24:16] FTF Server started

m

Type Addrezs Station b odule Status Last Reply
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FTP Server Module

The following sections provide a quick tour of the FTP Server module interface.

1. OpX FTP Server
@ ————®File Edit About!

() 0} el Fre I oat: Il S N Fies

=)l = ]

14:33:36

[12:46:10] File modified: D:\WEBSMConfighSenalServer Settingz. xml
[12:46:10] File modified: D:WWBSAConfighSenalServer Settingz. xml
[13:46:30] File modified: D:WEBSMConfighDevice_TALKT . «ml
[13:46:30] File modified: D:WWWBSMConfighSenalServer Settings. «ml
[13:46: 30] File modified: D:\WwWBSIN\ConfigiSenalServer Settings. =ml
[13:48: 44] Staring updates far O NWESConfighDevice_ALDT sl
[13:46:53] File modified: D:\WESSConfighDewvice_ALIDT sml
[12:46:53] File modified: D:\WEBSAConfighDewvice_AUDT wml

9 [12:46:53] File modified: D:\WEBSMConfighSenalServer Settingz. xml

[12:46:53] File modified: D:\WEBSMConfighSenalServer Settingz. xml
[12:47:04] Storing updates for: DVWEBSIWConfighDevice_TALE xml
[12:47:24] Storing updates for: DVWESIWConfighS enalServer Settings. xml
[13:47:31] Storing updates for: DVWESIWConfighDevice_aAUDT il
[14:24:16] FTF Server started

m

Tupe Address

Statinm Module Status Lazt Reply

(4] °
Number Description
(1] Menu bar. See section 14.2.1.
(2] Tool bar. See section 14.2.2.
(3] FTP server status. See section 14.2.3.
(4] FTP server status list. See section 14.2.4.
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FTP Server Module

The menu bar appears at the top of the FTP Server window. The following sections describe

the menu options.

14.2.1.1 File Menu

Edit  About!

Build Databases

Exit

14.2.1.2 Edit Menu

File About!

Settings
ﬂv’ Status Display

14.2.1.3 About Menu

File Edit | About!

Build Databases = rebuilds the FTP Server
database.

Exit = exits the FTP Server module.

Settings = configures FTP Server module
settings. See section 14.3.

Status Display = shows (checked) or hides
(unchecked) the status display.

Opens a window that shows the version and
build date of the FTP Server module you are
running. This window also shows the amount
of memory, virtual memory being used, and
the amount of time that the FTP Server has
been running. See Figure 14-1 for an example.
To close the window, click OK.
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w0.0.0.83

Build D ate:
Apr 152013 07:49:42

kemorny Ugage:
14 600K, / 14,876k

Wi | zage:
10,002k, A 10,276k,

-

Funning Time: 2 Hours, 3 Minutez, 38 Seconds

Figure 14-1. Example of About Information
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14.2.2 Tool Bar

The FTP Server module tool bar appears below the menu bar.

} el FrP Il ca= M cvec M Fies

Table 14-1describes the tools on the tool bar.

Table 14-1. FTP Server Module Tool Bar

Tool Tool Name Description
Start FTP Server Starts the OpX FTP server. See section 14.4.
Stop FTP Server Stops the OpX FTP server. See section 14.4
TCP Shows the number of files transferred via TCP.
il 0 |
FTP Shows the number of files transferred via FTP.
2 O |
Data Shows the number of pending database updates.
Data n
Sync Shows the number of files remaining to be synchronized between the FTP
5 Server module and the File Sync module.
5y 0 |
Files A color-coded field that shows the status of the transfers.
Files o Green = normal operation.
o Red = problem with transfers.
Clock Shows the amount of time that the OpX FTP server has been running.
14:33:36
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14.2.3 FTP Server
Status

The FTP Server status shows
any activity on the FTP Server
module, such as files that are
being retrieved and the status of
the FTP Server itself.

FTP Server Module

[13:46:10] File modified: D:\WEBSINConfighSenalServer Settings. xml
[13:46:10] File modified: D:\WEBSINConfighSenalServer Settings. xml
[13:46:30] File modified: D:\WEBSINConfighDevice_TALK. xml
[13:46:30] File modified: D:\WEBSINConfighSenalServer Settings. xml
[12:46:30] File modified: D:\WEBSINConfighSenalServer Settings. sml
[12:46:44] Storing updates for: D NWESIAConfighDevice_aAUDT xml
[12:46:53] File modified: D:\WEBSI\ConfighDevice_AUD1 =ml
[12:46:53] File modified: D:\WEBSI\ConfighDevice_AUD1 =ml
[12:46:53] File modified: D:\WEBSINConfighSenalServer Settings. sml
[12:46:53] File modified: D:\WEBSINConfighSenalServer Settings. sml
[12:47:04] Storing updates for: D:SWESIWConfighDevice_TALKT xml
[12:47:24] Storing updates for: D NWESIAConfighSenalServer Settings.sml
[12:47:31] Storing updates for: D NWESIAConfighDevice_aAUDT . xml
[14:24:16] FTF Server started

14.2.4 FTP Server Status List

The bottom of the FTP Server module shows the FTP server status list. This list shows

status of various connections to the FTP Server module.

m

Type Addresz Station kadule Statuz
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14.3 Configuring the FTP Server Module

Before you use the FTP Server module, you must configure its settings. After setting up the
FTP Server, you add devices with which the module will communicate.

> To configure the FTP Server module settings
1. Onthe Edit menu, click Settings.
The Settings dialog box appears.

e "~

Settings @

Metwark, Interface

[10.1.1.10- Opix =]

[ Reindex Databaszes On Rebuild

o OF x Cancel |

2. Complete the fields in the dialog box (see Table 14-2).

3. Click OK.
Table 14-2. Fields in the Settings Dialog Box
Field Description Default
Network Interface If the OpX system detects multiple NICs, this drop-down list allows you to 10.1.1.10 - OpX
select the NIC you want the FTP Server to use. If you have a single NIC on
your machine, the FTP Server selects that NIC automatically, and the drop-
down will be gray and unavailable.
Reindex Database On Rebuild Do not change the default setting unless otherwise instructed by BSI Unchecked
support.

14.4 Starting and Stopping the FTP Server
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> To start the OpX FTP server
1. Click the Start FTP Server button }

A message in the FTP server status list shows that the FTP server started. If this
message does not appear, check the FTP server settings (see section 14.3).

> To stop the OpX FTP server

1. Click the Stop FTP Server button £
A message in the FTP server status list shows that the FTP server stopped. If this
message does not appear, check the FTP server settings (see section 14.3).
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15 UMix

Topics: This chapter describes UMix.

4 Starting UMix (page 360) UMix is a virtual mixer used for incoming audio feeds

. from satellites or internet streams.
4 Quick Tour (page 361)

4+ Creating Mixer Layouts
(page 367)

4 Opening Mixer Layouts
(page 369)
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15.1 Starting UMix

You must start the File Server module before you start UMix.

> To start UMix
2. Start the File Server module (see section 3.1).
3. Click the Windows Start button and click Programs > Broadcast Software > Mixer.

A Mixer window similar to the following appears.

i "

BB Mixcer - Untitled.mix o |- 5]

File View Help
Ded [g B

B 1-ASI6520 /03 WL
[--4gk= Master Valume
B 1-AS5I6520 /01 W
[--4gk= Master Valume
B 1-ASIER20 /04 Wl =
[--4gk= Master Valume
B 1-ASI6520 /02w
[--4gk= Master Valume
B 1-AS5I6520 /01 Wi
[--4gk= Master Valume
B 1-ASI6R20 /02w

4= Master Yalurme
= 1 . ACICEN hivar
4 m b

Speakers (2- High Definition Au  Master Valume % a000EOSD
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15.2 Quick Tour

UMix

The following sections provide a quick tour of the Mixer interface.

r

Q@ ———oFie

View Help

A0 Mixer - Untitled.mix

© —& =8 1-45iER20./03W

< |

L

4= Master Volume
B 1 - 2516520 407 W
4= Master Volume
B 1 - 2516520 /04 W
B = Master Volume
B 1 - 4516520 /02T
4= Master Yolume
B 1 - 4516520 /07 WI—
4= Master Yolume

B 1-A516520 /02w

FH--4= Master Walume
BT 1. ACIERIN hdivar

3

m

o —_PSpeakers (2- High Definition Au | |Master Yolume

[ e >

iy | 0x000ED30

Number

Description

Menu bar. See section 15.2.1.

Tool bar. See section 15.2.2.

Item list. See section 15.2.3.

Status bar. See section 15.2.4

© 0 000

Workspace. See section 15.2.5.
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15.2.1 Menu Bar

The menu bar appears at the top of the Mixer window. The following sections describe the
menu options.

15.2.1.1 File Menu

New = creates a new mixer layout,

View Help Open = opens an existing mixer layout.
[0 New Ctrl+N Save = saves a mixer layout under its current
& Open.. Ctrl+0 hame.
B save Cirl+S S.ave As = saves a mixer I:?lyout under a
different name and/or location.
Save As... Exit = exits the Mixer.
Exit Ctrl+ ¥

15.2.1.2 View Menu

Mixer Tree = shows (checked) or hides

File Help (unchecked) the mixer tree in the left pane of

Ol Mixer Tree Ctrl+T the Mixer window.

Expand Mixer Tree  Ctrl+E Expand Mixer Tree = expands all subitems
in the mixer tree.

Collapse Mixer Tree  Ctrl+C
Collapse Mixer Tree = hides all subitems in
Auto Add Controls the mixer tree.

Lock Control ' i
ock Lontrols Auto Add Controls = adds mixer controls in

B3 :

-4 Arrange Mixer Controls the workspace.
g 1 &5 Mixer Ctrl+1 Lock Controls = locks or unlocks mixer
3 1| = kem Information controls. When locked, the mixer controls
R . cannot be changed. Clicking this option
=4 = toggles the lock icon on the status bar

' Stay On Top between locked and unlocked.

Arrange Mixer Controls = arranges mixer

Select All .
S controls in the workspace.
Mixer = shows mixers in the workspace.

ltem Information = shows item information
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15.2.1.3 Help Menu

File  View

O & |

Contents F1

About

UMix

in the workspace. If you prefer to view item
information as a popup, right-click the item in
the item list and click Iltem Info.

Log = shows log information in the
workspace.

Stay On Top = keeps the Mixer on top of
other windows on the Desktop.

Select All = selects all mixer controls in the
workspace.

About = opens a window that shows the build
date of the Mixer you are running. See Figure
15-1 for an example. To close the window,
click OK.

About

Universal Mixer

0.0.0 Build 95 Pre-releasze. Private
Copyright & 2012

Figure 15-1. Example of About Information
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15.2.2 Tool Bar

The Mixer tool bar appears below the menu bar.

D eEd & B8 [E

Moving the screen pointer over a tool displays the tool’s function as a tooltip. For example:

A0 Mixer - Untitled.mix
File View Help

Eﬁkﬁn i

|ﬂ Mew Mixer Layout

o

Table 15-1 describes the tools on the tool bar.

Table 15-1. Mixer Tool Bar

Tool Tool Name Description
New Mixer Layout Creates a new mixer layout.
Open Mixer Layout Opens an existing mixer layout.
=
Save Mixer Layout Saves the current mixer layout.
Mixer Shows mixers in the workspace.
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Tool Tool Name Description
Item Information Shows item information in the workspace.
=
Log Shows log information in the workspace.
15.2.3 Item LlSt Hﬁi Speakers [2- High Definition Au -
3= Master Volume L
The item list shows the components you can add -] Mute
to your mixer layouts. Plus and minus signs allow - T Volume:
. == CO Audio
you to expand or collapse the items shown. You L [E] Mute
can also use Expand Mixer Tree and Collapse : ] Volume
Mixer Tree in the View menu to expand or - Master Yolume
collapse items. [ Mute
b {El Walume

When you click an item in the item list, a 1-line
description of the item appears in the status bar.

15.2.4 Status Bar

H'_ﬁi 1 -ASIE520 /023 W DM Out [AudicS
E--#d= Master Valume

o .IE 'l.',l'|:||ume
-l Master Valume

B 1 - ASIESZ0 /01 WD Out [AudiaS -

The status bar shows a 1-line description about the item selected in the item list, along with
the item’s hexadecimal value. An icon between the description and hex value shows
whether the item is locked or unlocked. You can click this icon to lock or unlock the selected

item.

1 - ASIGS20 /01 WDM In (AudioS Master Volume / Master Volume / M % 0:0003016E
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15.2.5 Workspace

The workspace is the area where the items in your mixer layouts appear. If you use the
View menu to display item information or log, that information appears in the workspace.

"J-:ulume

"v"-:ulume
v normal
FWap

=S LtoS
FitoS

Stal
StoR

I I
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15.3 Creating Mixer Layouts

> To create a new mixer layout
1. Click the New Mixer Layout icon [3 * on the menu bar or click File > New.

2. Use the following steps to add volume controls, peak meters, and channel mode
indicators to your mixer layout.

— Expand the item list in the left pane, and then drag and drop items from the left pane
onto the workspace.

— On the View menu, click Auto Add Controls to add six sets of volume controls at a
time to the workspace.

Q Tip: Before you drag items from the item list, right-click an item in the list and
then use the View Control and Item Info options to make sure you drag the
appropriate item to the workspace.

I!:,i Speakers [2- High Definition A
El-B:]= b aster Yolume

...... ] Volume
- CD Audio
El-I-& b azter Yolume

b El Mute

- Em_ :
g9 1-Aslesc0mawl o ol
[H-f= Master Yolume Item Info
= 1 - ASTERAO M WA THoF T8 e

Page 367 of 487



UMix

3. After the appropriate items appear in the workspace, you can right-click an item to
detach, remove, or align it.

alurme
4
e Detach
1 Remove
Align r Tops

Lefts
Space equally

4. If you added volume controls, adjust the volume levels for each control in the workspace.

5. If you added channel mode indicators, check the indicators you want to monitor:

1717171 %17
o
o

6. When you are satisfied with your layout, click the Save icon = on the menu bar or
click File > Save. (Or click File > Save As to save the layout under a different name
and/or location.)

Page 368 of 487



UMix

15.4 Opening Mixer Layouts

> To open a mixer layout that you created previously
1. Click the Open icon = on the menu bar or click File > Open.
The Open Picture dialog box appears.

2. Inthe Picture dialog box, go to the location where the mixer layout is located, and then
click the layout and click Open.

The mixer layout appears in the workspace.
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16 Data Repeater Module

Topics: This chapter describes the OpX Data Repeater module.
4 Starting the Data The Data Repeater module takes the PAD data output
Repeater Module (page from the Audio Server, reformats it if needed, and sends
371) it to multiple destinations, such as to RDS or stream
encoders.

4 Quick Tour (page 372)

4+ Working with Data
Repeaters (page 376)

4« Changing the Network
Interface and Port (page
382)

4 Starting and Stopping the
Data Repeater (page 382)
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16.1 Starting the Data Repeater Module

You must start the File Server module before you start the Data Repeater module.

> To start the Data Repeater module

Repeater.

Start the File Server module (see section 3.1).

Click the Windows Start button and click Programs > Broadcast Software > OpX

An OpX Repeater window similar to the following appears.

OpX Repeater
File About

> B

Listen Network Interface

Listen Port

10.1.1.10 - OpX

o

Default Title

Default Artist

* These are used when a STOP trigger is received.

[l B s

IEEEE
ol x| o] s
[ Active |

f* UDP (" TCP [ Connect/Send/Disconnect {~ HTTP
Network Interface
10.1.1.10 - OpX

Address Port

o .0 .0 .0

i Seral COM1, 9600, M, 8.1 Configure

Delay Repeat Last Every Substitutions
T T

|ﬂ' |A| ms |ﬂ‘ w seconds Temphds

v Append CR/LF
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16.2 Quick Tour

The following sections provide a quick tour of the Data Repeater module interface.

File About

o
° > B R

Listen Network Interfface F‘ort +New| ¢ e 171 - -
(3] J10.1.1.10-0px =] [ _I _l _l
_|_ Active _| =
& UDP (" TCP [ Connect/Send/Disconnect (~ HTTP
MNetwork Interface
J10.1110-0px =1
Address Port
Jo .0 .0 .0
€ Serial COM1, 9600, N, 8, 1
Defautt Ttle Default Aist _ Configure_|
I Delay Repeat Last Every Substiutions
* These are used when a STOP trigger is received. Iu Eams lu_@ m.
“ | ¥ Append CR/LF

Menu bar. See section 16.2.1.

Tool bar. See section 16.2.2.

Data repeater settings. See section 16.2.3.

Data repeater status list. See section 16.2.4.

Data repeater parameters. See section 16.3.
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16.2.1 Menu Bar

The menu bar appears at the top of the Data Repeater window. The following sections
describe the menu options.

16.2.1.1 File Menu

Exit = exits the Data Repeater module.

16.2.1.2 About Menu

Opens a window that shows the version and

File | About build date of the Data Repeater module you

[ are running. This window also shows the

amount of memory, virtual memory being
used, and the amount of time that the data
repeater has been running. See Figure 16-1
for an example. To close the window, click
OK.

[ About =)

»0.0.0108 &

Build D ate:
Jun B 2014 20:19:57

m

kemarny Uzage:
8.956k. / 8,956k

Wi | zage:
4 852K / 4,852k

-

Running Tirme: 0 Hours, O Minutes, 28 Seconds

Figure 16-1. Example of About Information
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16.2.2 Tool Bar

The Data Repeater module tool bar appears below the menu bar.

> B

Moving the screen pointer over a tool displays the tool’s function as a tooltip. For example:

OpX Repeater
File About

> B

_ Start

1:a S T

Table 14-1 describes the tools on the tool bar.

Table 16-1. Data Repeater Module Tool Bar

Tool Tool Name Description

Start Starts the Data Repeater. See section 14.4.

Stop Stops the Data Repeater. See section 14.4

Clock Shows the amount of time that the Data Repeater has been running.
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16.2.3 Data Repeater Listen Networs Interface Listen Port
Interface and Port 10.1.1.10 - OpX 8 § (1000

The Listen Network Interface and Listen Port fields show the IP address and port that the
current data repeater is using to communicate.

If the OpX system detects multiple NICs, this drop-down list allows you to select the NIC you
want the data repeater to use. If you have a single NIC on your machine, OpX selects that
NIC automatically, and the drop-down will be gray and unavailable.

If you want to change the port number that the current data repeater is using, change the
value in the Listen Port field.

16.2.4 . Data Repeater Status List

The data repeater status list shows when the OpX data repeater is listening using the IP
address and port number shown in the list. The IP address and port number are separated
by a slash (/). This list also shows when the data repeater stops.

[15:51:25] Listening on 0.0.0.0 / 1000 »
[15:51:29] Stopped

[15:54:27] Listening on 10.1.7.710 / 1000

[15:54:31] Stopped
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16.3 Working with Data Repeaters

The right side of the OpX Repeater window provides buttons and fields for creating, editing,
and deleting data repeaters.

CH:New‘ b | 1/1 Jj

[ Active |
(¢« UDP " TCP | Connect/Send/Disconnect " HTTP
Metworl Interface

0-OpX

Address Port
|l o 0o . 0o o0

{ Seral COM1, 9600, N, 8.1 Corfigure

Delay F{epeat Last Every Substitutions

| |E| |E| seconds Template

Iv Append CR/LF

.

16.3.1 Creating a Data Repeater

> To configure a data repeater

1. You cannot create a data repeater while another data repeater is running. Check the data
repeater status list to ensure that a data repeater is not running. If one is running, click
the Stop button on the tool bar.

2. Click the New button M

3. Complete the fields on the right side of the window (see Table 16-2).
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Table 16-2. Fields in the OpX Repeater Window

Field

Description

Default

Active

You can set up multiple rata repeaters, but only one can be active. To make
this repeater check this check box.

Unchecked

UCP/TCP/HTTP

Select the protocol that the data repeater will use.

Ucp

Network Interface

If the OpX system detects multiple NICs, this drop-down list allows you to
select the NIC you want the Data repeater to use. If you have a single NIC
on your machine, the Data repeater selects that NIC automatically, and the
drop-down will be gray and unavailable.

10.1.1.10 - OpX

Address

Enter the IP address for the data repeater.

0.0.0.0

Port

Enter the number of the port that the data repeater will use for
communications.

Serial

If the device with which the data repeater will be communicating requires
serial parameters be configured:

1. Click Serial.

2. If the serial device uses settings other than the OpX defaults, click the
Configure button to display the Serial Device dialog box (see Figure 16-2).

3. Configure the settings based on the requirements of your serial device
(refer to the documentation for your serial device).

4. Click OK.

COM1, 9600, N,8.1

Delay

Number of milliseconds between when data is received and when data is
transmitted. This feature can be used to guard against profanities from being
sent over the airwaves.

Repeat Last Every

Number of seconds when received data is transmitted repeatedly.

Substitutions button

If substitutions are applicable to your setup:

1. Click the Substitutions button to display the Substitutions dialog box (see Figure
16-3 on page 378).

2. Click the Add button ﬂ to display the Substitutions dialog box (see Figure
16-4 on page 379).

3. Complete the fields in the dialog box (see Table 16-3 on page 379).

4. Click the OK button two times.

The Substitution dialog box also has buttons for editing and deleting substitutions.

Template button

If templates are applicable to your setup:

1. Click the Template button to display the Template dialog box (see Figure 16-5 on
page 380).
2. Click the buttons at the top of the dialog box to define your template.

3. Click the OK button.

Append CR/LF

o Checked = appends a carriage return when a line feed is received.

o Unchecked = do not append a carriage return when a line feed is
received.

Checked
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Figure 16-2. Serial Device Dialog Box

| Contitian | From alue | Action | MHew Values |

Figure 16-3. Substitutions Dialog Box
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Substitution ==
Field

I -

Condition

|Car|tains ﬂ

From Value

" |gnore

{* Substitute

MNew CutlD Mew Folder
New Title Mew Categony
Mew Artist MNew Type

MNew Length

| x Cancel |

Figure 16-4. Substitution Dialog Box

Table 16-3. Fields in the Substitution Dialog Box

Field Description Default
Field File to be searched for a specific string of text. —
Condition Condition associated with the search. Contains
From Value String that is being searched. —
Ignore Allows you to skip the data shown at the bottom of the dialog box. —
Substitute Replaces the string with the values shown at the bottom of the dialog box.

¢ Note: Leave the tab blank for raw output.
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'

Temprate
EutID| Titlel Artist| Len | mm:ss| Fldr | Cat | Type|

" OK

X Cancel |

Figure 16-5. Template Dialog Box

16.3.2 Editing a Data Repeater

There may be times when you need to edit a data repeater. For example, you might have to

change the serial settings.

> To edit a data repeater

1. You cannot edit a data repeater while a data repeater is running (either the one you want
to edit or a different repeater). Check the data repeater status list to ensure that a data

repeater is not running. If one is running, click the Stop button on the tool bar.

2. Onthe right side of the OpX Repeater window, use the scroll arrows to find the data
repeater you want to edit (see Figure 16-6). The field to the left of the arrows shows the
number for the current data repeater and the total number of data repeaters that have
been set up (for example, 2/5 means the settings for data repeater number 2 is displayed

out of 5 data repeaters that have been set up).
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F New | 3¢ Del | 2f5 ﬂ l#— Scroll arrows

[ Active |
(« UDP « TCP [ Connect/Send/Disconnect & HTTP
Metwork Interface

[10.1.1.10 - OpX ~]
Address Part
l o .0 .0 .0 |

{~ Senal COM1, 9600, N, 8,1 Configure

Delay Repeat Last Every Substitutions
|1]' % ms |ﬂ' % seconds Template

v Append CR/LF

Figure 16-6. Scroll Arrows
3. Change the fields on the right side of the window (see Table 16-2 on page 377).

16.3.3 Deleting a Data Repeater

If you no longer need a data repeater, you can delete it from the OpX system.

i Note: A precautionary message does not appear before you delete a data

<
repeater. Therefore, be sure you do not need a data repeater before you delete
it. You cannot undo a data repeater after it has been deleted.

> To delete a data repeater

1. You cannot delete a data repeater while a data repeater is running (either the one you
want to delete or a different repeater). Check the data repeater status list to ensure that a
data repeater is not running. If one is running, click the Stop button on the tool bar.
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2. On the right side of the OpX Repeater window, use the scroll arrows to find the data
repeater you want to delete (see Figure 16-6).

3. Click the Delete button # Del

16.4 Changing the Network Interface and Port

The OpX Repeater window has a Listen Network Interface drop-down list and a Port
button that make it easy to change these values for the currently used data repeater (see
Table 16-4).

Listen Metwork Interface Listen Part

10.1.1.10 - OpX ~| 9

Table 16-4. Listen Network Interface and Port Fields in the OpX Repeater Window

Field Description Default

Listen Network Interface If the OpX system detects multiple NICs, this drop-down list allows you to 10.1.1.10 - OpX
select the NIC you want the data repeater to use. If you have a single NIC
on your machine, the data repeater selects that NIC automatically, and the
drop-down will be gray and unavailable.

Port Enter the number of the port that the data repeater will use for —
communications.

16.5 Starting and Stopping the Data Repeater

> To start the OpX Data Repeater
1. Click the Start button }

A message in the Data Repeater status list shows that the Data Repeater started. If this
message does not appear, check the Data Repeater network interface and ports.

> To stop the OpX Data Repeater

1. Click the Stop button _
A message in the Data Repeater status list shows that the Data Repeater stopped. If this
message does not appear, check the Data Repeater network interface and ports.
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Topics:

A

Starting the Mobile
Gateway/Client Module
(page 384)

Quick Tour (page 386)

Configuring the Mobile
Gateway/Client Module
(page 389)

Starting and Stopping the
Mobile Gateway/Client
(page 390)

17 Mobile Gateway/Client Module

This chapter describes the OpX Mobile Gateway/Client
module.

The Mobile Gateway/Client module is used for I0OS
remote operation. The gateway runs on the OpX network
and allows access from the I0OS device.
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17.1 Starting the Mobile Gateway/Client Module

You must start the File Server module before you start the Mobile Gateway/Client module.

> To start the Mobile Gateway/Client module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX
Mobile Gateway.

A Settings dialog box similar to the following appears.

Settings @
Dpes Hetwork, Interface
[10.1.1.10 - Opix

|nternet Metwark, Interface

[10.1.1.10 - Op =]
Part

—

Paszwiard

[ Connect &t Start LUp

Figure 17-1. Settings Dialog Box

3. Complete the fields in the dialog box (see Table 17-1).
4. Click OK.
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Table 17-1. Fields in the Settings Dialog Box

Field

Description

Default

OpX Network Interface

If the OpX system detects multiple NICs, this drop-down list allows you to
select the NIC you want the mobile gateway/client module to use for
accessing the OpX network. If you have a single NIC on your machine, the
mobile gateway/client module selects that NIC automatically, and the drop-
down will be gray and unavailable.

10.1.1.10 - OpX

Internet Network Interface

If the OpX system detects multiple NICs, this drop-down list allows you to
select the NIC you want the mobile gateway/client module to use for
accessing the Internet. If you have a single NIC on your machine, the mobile
gateway/client module selects that NIC automatically, and the drop-down
will be gray and unavailable.

10.1.1.10 - OpX

Port

Enter the number of the port that the mobile gateway/client module will use
for communications.

Password

Enter the case-sensitive password for accessing the mobile gatewayi/client
module. Record the password for future reference.

Connect At Startup

Select whether you want the mobile gateway/client module to start (check)
or not start (uncheck) automatically when the OpX system starts. If
configured to start automatically, a Mobile Gateway/Client module icon
appears in the system tray.

Unchecked
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17.2 Quick Tour

The following sections provide a quick tour of the Mobile Gateway/Client module interface.

> M

Station | D ezcription | Syghem | Addresz | Port

[13:32:11 12/28/2015] Ready...

Menu bar. See section 17.2.1.

Tool bar. See section 17.2.2.

Connection list. See section 17.2.3.

Module status panel. See section 17.2.4.
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17.2.1 Menu Bar

The menu bar appears at the top of the Mobile Gateway/Client window. The following
sections describe the menu options.

17.2.1.1 File Menu

Exit = exits the Mobile Gateway/Client

Edit module.

Exit

17.2.1.2 Edit Menu

Settings = displays the Settings dialog box in
File Figure 17-1 on page 384.

Settings
h q
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17.2.2 Tool Bar

The Mobile Gateway/Client module tool bar appears below the menu bar.

> B

Table 14-1 describes the tools on the tool bar.

Table 17-2. Mobile Gateway/Client Module Tool Bar

Tool Tool Name Description

Start Starts the Mobile Gateway/Client module and places a Mobile
D Gateway/Client module icon in the system tray.

Stop Stops the Mobile Gateway/Client module.

17.2.3 Connection List

The connection list shows the connections to the Mobile Gateway/Client module.

193211 12/28/2015] Ready...
17.2.4 Module Status Panel {13:32:4412;’28;"2015}St0ppyed
[19:32:46 12/28/2005] Binding to: 10.1.1.10
[19:32:46 12/28/20015] Bound
The module statqs panel shows'the e
status of the Mobile Gateway/Client [1955:56 12/28/2015] Started
[19:65:67 12/28/2015] Stopped
module.
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17.3 Configuring the Mobile Gateway/Client Module

The Mobile Gateway/Client module prompts you for settings the first time you launch it.
If you need to change these settings, use the following procedure.

> To change the Mobile Gateway/Client module settings

1. If the Mobile Gateway/Client module is not displayed, double-click its icon in the system
tray.

The OpX Mobile Gateway window appears.
2. Onthe Edit menu, click Settings.
The Settings dialog box appears (see Figure 17-1 on page 384).
3. Complete the fields in the dialog box (see Table 17-1 on page 385).

4. Click OK.
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17.4 Starting and Stopping the Mobile Gateway/Client

> To start the OpX Mobile Gateway/Client

1. Click the Start button }

A message in the module status panel shows that the Mobile Gateway/Client started. If
this message does not appear, check the Mobile Gateway/Client settings (see section
17.3).

> To stop the OpX Mobile Gateway/Client

1. Click the Stop button

A message in the module status panel shows that the Mobile Gateway/Client stopped. If
this message does not appear, check the Mobile Gateway/Client settings (see section
17.3).
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Starting the Stinger
Module (page 392)

Quick Tour (page 393)

Configuring the Stinger
Module (page 397)

Setting Up Hot Keys
(page 403)

Playing Items in a Hot Key
Set (page 409)

Configuring Item
Properties (page 411)

Listing Items (page 413)
Deleting Items (page 414)

Working with Stinger
Decks (page 415)

18 Stinger Module

This chapter describes the OpX Stinger module.

OpX Stinger is a stand-alone Hot Key module that
updates Hot Keys in real time across multiple clients.
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18.1 Starting the Stinger Module

You must start the File Server module before you start the Stinger module.

> To start the Stinger module
1. Start the File Server module (see section 3.1).

2. Click the Windows Start button and click Programs > Broadcast Software > OpX
Stinger.

A screen appears briefly as OpX loads the pages associated with the Stinger module,
and then a default OpX Stinger page similar to the following appears.

£7 OpX Stinger - WESI - The Best Of BSI = e =S

] Y L STOP
wil [ 0‘ + MODE Default

Figure 18-1. OpX Stinger Page
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18.2 Quick Tour

The following sections provide a quick tour of the Stinger module interface.

£7 OpX Stinger - WBSI - The Best Of B3I [E=8Eon 555
] X I F,
o (RS c, B fe Default b2

L

Number Description
(1] Tool bar. See section 18.2.1
(2) Hot Key set. See section 18.2.2.
© Function key legend. See section 18.2.3.
(4] Module status panel. See section 18.2.4.
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18.2.1 Tool Bar

The Stinger module tool bar appears below the menu bar.

B oo Default

Moving the screen pointer over a tool displays the tool’s function as a tooltip in the module
status panel. For example:

Moving the
pointer over £7 OpX Stinger - WBSI - The Best Of BSI =N G~

this icon... ..!| e O 4 [sto

MODE
L3

...displays the
icon name here.

Save SetAs

Table 18-1 describes the tools on the tool bar.
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Table 18-1. Stinger Module Tool Bar

Tool Tool Name Description
Save Set As Saves the current Hot Key set.
|
. '
Refresh Page Updates the information shown on the page.
~
s
Page Settings Configures the page settings for the current Hot
E Key set. See section 18.4.1.
Insert Displays the items you can add to Hot Key sets.
See section 18.4.2.
Button Mode Toggles between pause and stop mode.
STOP « Pause mode = temporarily stops the cut at
MODE the location when you clicked this button.
« Stop mode = stops the cut and reloads to the
beginning.
Select Set Allows you to select Hot Key sets. See section
18.4.1.
Settings Configures Stinger module settings. See section
18.3.
Exit Exits the Stinger module.
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18.2.2 Hot Key Set

The Hot Key set has cells that hold items you drag from the Insert dialog box (see section
18.4.2). After you add items to the Hot Key set, you can play them (see section 18.5).

18.2.3 Function Key Legend

The function key legend shows the 12 function (or “F”) keys that can be assigned to a Hot
Key set. To select a function key, either click a button in this legend or press the function key
on your keyboard. Either step highlights the corresponding function key in the legend. In the
following example, the F1 key is highlighted.

18.2.4 Module Status Panel

The module status panel shows status messages. The left icon in module status panel
allows you to show or hide network messages If you move the pointer over an icon in the
tool bar, the tool function appears in the module status panel.

Click this icon to show or
hide network messages.
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18.3 Configuring the Stinger Module

The Stinger module comes with default configuration settings that should suit most users.
Using the Settings icon, you can change these settings to suit your requirements

> To change the Stinger module settings

1. Click the Status icon in the tool bar

The Settings dialog box appears, with the General tab displayed.

[ Settings @

General | Playback | Serial Server |

Metwork Interface
[10.1.1.10 - OpX =]

File Server Address
| 10 . 1 . 1 . 10

Hot Button Folder
|C:\ngmm Files (86)"Broadcast Software Irrtematianal\@p)('g

x Cancel |

Page 397 of 487



Stinger Module

2. Complete the fields in the dialog box tabs.

General Settings — see section 18.3.1

Playback settings — see section 18.3.2

Serial server settings — see section 18.3.3

3. When you finish, click the OK button.

18.3.1 General Configuration Settings

Figure 18-2 shows the configuration settings on the General tab and Table 18-2 describes
them.

=

[ Settings @

General | Playback | Serial Server |

Metwork Interface
[10.1.1.10 - OpX |

File: Server Address
10 . 1 . 1 10

Hot Button Folder
|C:\Frogmm Files {<B&)"Broadcast Software Irrtematinnalkﬂp)(‘ﬂ

T/ 0K | X cancel |

Figure 18-2. General Tab
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Table 18-2. Fields in the General Tab

Field

Description

Default Value

Network Interface

If the OpX system detects multiple NICs, this drop-down list allows you
to select the NIC you want the mobhile gateway/client module to use for
accessing the OpX network. If you have a single NIC on your machine,
the mobile gatewayi/client module selects that NIC automatically, and
the drop-down will be gray and unavailable.

File Server Address

Accept or change the IP address of the File Server.

10.1.1.10

Hot Button Folder

Specify the location where the Hot Button profiles will be stored. To
change this location, either change the path in the field or click the =
icon, go to a location in the Select Directory dialog box, and click OK.

See the tab
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18.3.2 Playback Configuration Settings

Figure 18-3 shows the configuration settings on the Playback tab and Table 18-3 describes
them.

[ Settings @

'General Playback | Serial Server ]

Mumber of Play Decks 1] 2

Playback Device #1
|Speakers (2- High Definition Au j

Playback Device H2
|Speakers (2- High Definition Au ﬂ

Playback Device H3
|Speakers (2- High Definition Au ﬂ

| Rotate Playback Devices

Set deck playback devices by zhift-click on the eject button

x Cancel |

Figure 18-3. Playback Tab

Table 18-3. Fields in the Playback Tab

Field Description Default Value
Number of Play Decks Select the number of playback decks. 0
Playback Device #1 Select the device that will be used as the playback device. Speakers (2-High
Playback Device #2 Definition Audio)
Playback Device #3
Rotate Playback Devices o Checked = items are rotated among the three playback devices. Unchecked
o Unchecked = item playback starts at the beginning of the list each time
an item is started.
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18.3.3 Serial Server Configuration Settings

Figure 18-4 shows the configuration settings on the Social Server tab and Table 18-4
describes them.

' General | Playback Serial Server

Station
| =
Device
| =
—I Relay Defaulis

Relay When Playback Starts

JN/A =]

Relay When Playback Stops

fh/a =

[~ Relay Latched For Duration OF Playback

Figure 18-4. Serial Server Tab
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Table 18-4. Fields in the Serial Server Tab

Field Description Default Value

Station Station to which the serial device is connected. —
Device Serial device. —
Connect button Click this button to test your station and device settings. —
Relay Defaults Check this button to define the default relay playback settings. Unchecked
Relay When Playback Starts If you checked Relay Defaults, check to fire a relay at the same time N/A

that playback on stinger starts.
Relay When Playback Stops If you checked Relay Defaults, check to fire a relay at the same time N/A

that playback on stinger stops.
Relay Latched For Duration Of If you checked Relay Defaults, check to keep the relay closed during Unchecked

Playback

the entire playback.
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18.4 Setting Up Hot Keys

Setting up Hot Keys involves the following steps:
1. Load a Hot Key set. See section 18.4.1.
2. Add items to the Hot Key set. See section 18.4.2.

3. Assign the Hot Key set to a function key. See section 18.5.

18.4.1 Loading a Hot Key Set

The first step when setting up Hot Keys is to load a Hot Key set. This can be a Hot Key set
you previously created or a new one. As part of this effort, you can configure the number of
Hot Key cells that will hold selected items (described in section 18.4.2).

> To select a Hot Key set
1. Click the Select Set drop-down list.

The Select a Set dialog box appears.

Select a Set @

NEW SET CANCEL
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2. Select the Hot Key set to which you want to add your Hot Keys:
— If the set exists, click it in the dialog box, and then click Load.

— If the set does not exist, click New Set. When the Save Set As dialog box appears
(see Figure 18-5), enter a name for the set in the Name field and click Done.

The Hot Key set appears in the workspace and the name of the selected set appears in
the Select Set drop-down list.

 Save Set As ==

CANCEL

Figure 18-5. Save Set As Dialog Box

3. By default, a Hot Key set has five columns and eight rows of cells that can accommodate
items. If this arrangement is satisfactory, proceed to the next step; otherwise, use the
following steps to configure the Hot Key set.

a. Click the Page Settings icon ﬂ

The Page Settings dialog box appears.
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Page Settings @

Caption: ]
Rows: “
Buttons / Row: “

CANCEL

b. Complete the fields in the dialog box (see Table 18-5).
c. Click the Done button.

Table 18-5. Fields in the Page Settings Dialog Box

Field Description Default Value
Caption Enter a name for this Hot Key set. The name should allow you to —
identify this Hot Key set from the others you configure.
Row Select the number of rows to be displayed on the Hot Key set. —
Buttons/Row Select the number of rows to be displayed on the Hot Key set. —

18.4.2 Adding Items to the Hot Key Set

After you select the Hot Key set, add items to it from the Insert dialog box. As part of this
effort, you select the function keys that will be associated with the items.

> To add items to the Hot Key set

1. By default, the items you select will be associated with the F1 function key. To select a
different function key, select the key at the bottom of the page.

The function key turns green to show it is selected. In the following example, the F3 key
is selected.

=7 IEEs |
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2. Click the Insert icon

An Insert dialog box similar to the following appears.

FILTER FULL
OFF TEXT

SORT
up

1424 Items

Wed, Jan 27, 10, 14:49:32

Fri. Jan 29, 10, 10:22:20

Tue, Jan 26, 10, 13:21:36

Tue. Jan 26. 10, 13:22:54

HB200846-01
<4:136> 733 Tue, Jan 26, 10, 13:22:38

REFRESH

3. Use the fields and buttons at the top of the dialog box to find the items you want to add to
the Hot Key set:
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— Find = enter search criteria in the field, and then click the Filter Off button to show
only the items that match your text. To show complete names, click the Fulll Text
button.

— Sort = allows you to sort items by title, artist, name, length, or by title, artist, and
name/ Use the Sort Up or Sort Down key to sort your selection in ascending (A-Z,
0-9) or descending (Z-A, 9-0) order.

— Folder = select the folder for the items you want to search and use, or click All to
select all folders.

— Buttons on the right side of the dialog box allow you to move to the first last,
previous, and next items.

4. Click an item in the Insert dialog box, hold down the mouse button, and drag the item to a
cell on the Hot Key set.

A green arrow shows the location where the item will be added to the Hot Key set.

£ OpX Stinger - WBSI - The Best Of BSI

|| ~ _T_ sTOP

N MODE
Find

OFF TEXT
Sort
N
Folder
1424 tems

(Rock) Superstar[Clean Edit-no intro.]
Cypress Hill

Wed, Jan 27, 10, 14:49:32

Fri. Jan 29, 10, 10:22:20

Tue, Jan 26, 10, 13:21:36

Tue, Jan 26, 10, 13:22:54

Tue, Jan 26, 10, 13:22:38

REFRESH

5. When the green arrow is pointing to the desire cell, release the mouse button to add the
item to that cell in the Hot Key set.
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? OpX Stinger - WBSI - The Best Of BSI

m [~ L
A < (@ [P oo

FILTER FULL
OFF TEXT

< S0RT
T
Folder
1424 ltems

(Rock) Superstar[Clean Edit-no intro.]
Cypress Hill
347b-09
Wed. Jan 27, 10, 14:49:32

(Rock) Superstar[Clean

140 Edif] 2 (¥ou Gotta) Fight For Your Right (To Party!)
Beastie Boys

Fri. Jan 29 10. 10:22:20

" And Justice For All
Metallica

Tue, Jan 26, 10, 13:21:36

Tue. Jan 26. 10, 13:22:54

Tue, Jan 26, 10, 13:22:38

Repeat steps 4 and 5 to add more items to the Hot Key set.

When you finish adding items to the Hot Key set, click Done to close the Insert dialog
box.

Click the Save icon

The Save Set As dialog box appears.
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Save Set As ==

Oldies Set

CANCEL

9. To change the name of the Hot Key set, enter the name in the Name field. This is the
name that will identify the Hot Key set in the Select Set drop-down list. The name should
allow you to identify this Hot Key set from the others you configure.

10. Click Done to save the Hot Key set.

18.5 Playing Items in a Hot Key Set

After you add items to a Hot Key set, you can click one or more items to play them. The
running time of an item appears in the bottom-left corner of the cell. The number in the
bottom right shows the instance number. The number 1 in the figure below indicates that this
is the first instance of this item. If you dropped the same item — (Rock) Superstar[Clean
Edit] — in this Hot Key set, that item would have an instance number of 2. The item number
will increment each time you add the same item to the Hot Key set.

(Rock) Superstar[Clean [tem title

N Edit]
[tem running time 4:14.0 1 Instance number
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When you click an item in the Hot Key set:
« The item plays.
- Atimer in the cell shows the remaining play time.

- A VU meter of the item being played appears to the right of the Select Set drop-down

list.
£7 OpX Stinger - WBSI - The Best Of BSI | = o=
A 2 Q] [F e | Example of a
VU meter for
the item that
is playing
. (Rock) Supe_rstarICIean
Example of an item . 1

Example of a
clicked item

To stop an item from being played, click the item.
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18.6 Configuring Item Properties

Each item you add to a Hot Key set has default properties. If desired, you can change these
properties to suit your preferences.

> To configure the properties for an item
1. Load the appropriate Hot Key set (see section 18.4.1).
2. Right-click the item in the Hot Key set.

The following pop-up menu appears.

3. Click Properties.
The Properties dialog box appears.
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(Rock) Superstar[Clean Edit] [

Caption

I Custom... h

Font

T —

Picture

1| Clear

Relay When Playback Starts
N/A

Relay When Playback Stops
N/A

[l Relay Latched For Duration Of Playback

Device

OK CANCEL

4. Complete the fields in the dialog box (see Table 18-6).

5. Click OK.
Table 18-6. Fields in the Properties Dialog Box

Field Description Default
Caption Caption associated with the item. See the dialog box
Color Color of the caption. Custom
Font Typeface of the caption. Click the Font button to change the typeface. Arial
Picture Picture associated with the item. Click the ﬂ icon to select a picture. -

Use the Clear button to remove the picture.

Relay When Playback Starts Fires a relay at the same time that playback on stinger starts. N/A
Relay When Playback Stops Fires a relay at the same time that playback on stinger stops. N/A
Relay Latched For Duration Of Check to keep the relay closed during the entire playback. Unchecked
Playback
Device Serial device connected to the serial server. See the dialog box
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18.7 Listing Items

You can create a rotator that allows you to have multiple items share the same Hot Key. For
example, if you have 5 bumpers that essentially perform the same function, you can add

them to the same Hot Key for convenience.
1. Load the appropriate Hot Key set (see section 18.4.1).
2. Right-click the item in the Hot Key set.

The following pop-up menu appears.

3. Click List.
A dialog box similar to the following appears.
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Page: 1 - Button: 12 - "100 In A 55"

Mext To Play: #1

HE 20091502 100 In & 55

DONE CANCEL

4. Drag items from the file list to the dialog box shown above.

5. When you finish dragging items, click Done.

18.8 Deleting ltems

If you no longer need an item, you can delete it from your Hot Key set.

(fﬂ Note: A precautionary message does not appear before you delete an item.
Therefore, be sure you do not need an item before you delete it. You cannot
undo an item after it has been deleted.

> To delete an item
1. Load the appropriate Hot Key set (see section 18.4.1).
2. Inthe Hot Key set, right-click the item you want to delete.

The following pop-up menu appears.
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Properties ...

3. Click Clear.
The item is deleted from the Hot Key set.

18.9 Working with Stinger Decks

Figure 18-6 shows an example of the Stinger deck user interface and Figure 18-6. Stinger
Deck User Interface

Table 18-7 describes the key components. The same controls called out in Deck 1 below
also apply to decks 2 and 3.

Figure 18-6. Stinger Deck User Interface
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Table 18-7. Stinger Deck Buttons

Field Description

o Name of the deck.

(2] Eject button. Click this button to remove items. To configure Stinger, hold down the Shift key and
click this button.

(3] Play button. This button toggles to a pause button when playing.

o To toggle the plus sign, click the stop button when nothing is playing. This works like the + cue in
the Program Log, where it will continue to play the next item.

(5] Time remaining bar. Includes a progress indicator. If configured, you can click inside the time

remaining bar to jump back or forward.

18.9.1 Configuring a Stinger Deck

> To configure a Stinger deck

1. From the Stinger deck user interface, hold down the Shift key and click the Eject button
(see Figure 18-6 and Table 18-7 on page 415). A dialog box similar to the following

appears.

Deck Settings - DECK #1 i x|

[reck Caption
DECK. #1

Flayback Device

Start Clozure

I Mot Aszigned j
Stop Closure

I Mat Aszigned :I
[ Manual Eject

[~ Allaw Senbbing Wwhile Playing

« Ok I X Cancel |

2. Complete the fields in the dialog box (see Table 18-8).

3. Click OK.
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Table 18-8. Stinger Deck Settings

Field

Description

Deck Caption

Name displayed for the deck on the Stinger deck user interface.

Playback Device

Device where the audio goes.

Start Closure

Stop Closure

Defined in the stinger configure Serial Server tab.

Manual Eject

Stops Stinger from automatically removing items from the deck list at the end of the file.

Allow Scrubbing When Playing

Allows you to click around inside the time remaining progress bar to jump around within the cut.
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Starting the Watchdog
Module (page 419)

Quick Tour (page 420)

Configuring the Audio
Server Watchdog Timer
(page 422)

Starting and Stopping the
Audio Server Watchdog
Timer (page 423)

19 Audio Server Watchdog Module

This chapter describes the OpX Audio Server Watchdog
module.

The Audio Server Watchdog module is a precautionary
module that monitors the Audio Server process. If the
Audio Server Watchdog module detects that the Audio
Server stopped responding (or is “hanging”), it restarts
the Audio Server module automatically.
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19.1 Starting the Watchdog Module

You must start the File Server module before you start the Watchdog module.

> To Start the Audio Server Watchdog module

1. Start the File Server module (see section 3.1). "_@”._ |
2. Double-click the Audio Server Watchdog icon on your desktop St or click the
Windows Start button and click Programs > Broadcast Software > OpX Audio Server

Watchdog.

An Audio Server Watchdog window similar to the following appears.

—ioix]

File About

Interwal [ms] Timeaut [mes) Falures

Mupd [0 pd ol sen |

Parameters Start On

| |#udio Only =] | Stop

Le Exerk: |
=
-
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19.2 Quick Tour

The following sections provide a quick tour of the Audio Server Watchdog module interface.

Il
@ ———@File About
Irkeral [ms) Timneout [me] Failures
1000 |5II| E |2 |£1 Start |
[
©—0—7F7-— e Parameles Start On ©
| ihudiu Only :i | Stop
Last Exant
(5) . |
(4] °
Number Description

Menu bar. See section 19.2.1.

Parameters. See section 19.2.2.

Last Event field. See section 19.2.2.

Status area. See section 19.2.3.

© 0000

Start and Stop buttons. See section 19.4.
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19.2.1 Audio Server Watchdog Module Menu Bar

The menu bar appears at the top of the Audio Server Watchdog window. The following
sections describe the menus on the menu bar.

19.2.1.1 File Menu

Exit = exits the Audio Server Watchdog

File | fAbout module.

Exit

19.2.1.2 About Menu

Opens a window that shows the version and

File | About build date of the Audio Server Watchdog
module you are running. This window also
shows the amount of memory and virtual
memory being used, and the amount of time
that the Audio Server Watchdog module has
been running. See Figure 19-1 for an example.
To close the window, click OK.

[ About |

»0.0.0.11 s

Build D ate:
Jan 25 2015 11:48:36

m

kemorny Ugage:
a.424k 7 8.544k

Wi | zage:
19328 7/ 2104k

-

Funning Time: 1 Hour, 2 Minutes, 51 Secondz

Figure 19-1. Example of About Information
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19.2.2 Last Event Field

The Last Event field shows the date and time
when the Audio Server Watchdog module

detected that the Audio Server was not responding.

19.2.3 Status Area

The Status area shows the status of the Audio
Server Watchdog time.

Last Ewvent

[11:57:02] Start

[11:57:02] Audio zerver handle = 0x00020593
[11:57:02] Audio server PID = 1236
[11:67:12] Audio zerver handle = 000020593
[11:57:12] Audio zerver PID = 1236

[11:57: 23] Audio server handle = 000020593
[11:57:23] Audio server PID = 1238

19.3 Configuring the Audio Server Watchdog Timer

You configure the Audio Server Watchdog Timer module using the fields on the module

window. Figure 19-2 shows the fields and Table 19-1 describes them.

Audio Server Watchdog =10 ]

File Abouk

Interval [mz] Tirneout [me)

Mmed o pd [ _ s |

Faramelers Start On

| ]hudiu Only j Stop

Lagt Even: |
=
|

Figure 19-2. Audio Server Watchdog Module Configuration Fields
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Table 19-1. Audio Server Watchdog Module Configuration Fields

Field Description Default
Interval (ms) How often the Audio Server Watchdog module checks that the Audio Server 1000
is running.
Timeout (ms) The maximum number of timeouts that must occur before the Audio Server 500

Watchdog module resets the Audio Server.

Failures (ms) The maximum number of failures that must occur before the Audio Server 2
Watchdog module resets the Audio Server.

Parameters Enter any of the following optional parameters you want to run with the -

Audio Server. Before using these parameters contact BSI technical support.

o —auxi lialry = starts the Audio Server as an auxiliary instead of as
aa primary.

o — s <ip address> =tells the Audio Server where the file server
is located.

e —nic <ip address> =tells the Audio Server to use a specific
network-interface card to use on the system.

Start On Allows the Audio Server to start on a non-audio log item or requires the Audio Only
Audio Server to start on an audio item.

19.4 Starting and Stopping the Audio Server Watchdog
Timer

> To start the Audio Server Watchdog Timer

1. Click the Start button Start

Messages in the status area show that the Audio Server Watchdog Timer started.

[11:57.02] Start -
[11:57:02]) Audio zerver handle = 000020532

[11:57.02] Adudio server PID = 1236

[11:57:12]) Audio zerver handle = Ox00020592

[11:57:12) Audio zerver FID = 1236

[11:57:23] Audio zerver handle = 0x00020593

[11:57:23] iudio zerver PID = 123§

> To stop the Audio Server Watchdog Timer

1. Click the Stop button M
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20 Troubleshooting

Topics: In the unlikely event you encounter a problem using
OpX, refer to the information in this chapter to identify

+ "Security key /driveris notR et the problem.

installed” Message (page
426)

4« Program Does Not
Activate (page 427)
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20.1 “Security key / driver is not installed” Message

If the message Security key / driver is not installed appears
Server module or click Edit > Register:

when you launch the File

Register

Senal Mumber

[l

|5E5A.—1 167-347B-22AC

Autharization Code

|5E5A.-1 167-347B-22A0

Security key £ driver iz not installed

W 0K

x Cancel |

1. Be sure the BSI-supplied dongle is inserted into a working USB port on your computer.

2. Remove the dongle and re-insert it into another USB port that is known to work. Confirm
that a message in the system tray states that the device driver is being installed.

i) Found New Hardware

Saferet USE SuperProfUlkraPro

X|

3. If all troubleshooting efforts fail, contact BSI technical support.
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20.2 Program Does Not Activate

If your program does not activate:

1.

Check the version of your program (Help > About) and confirm that it matches the code
version given.

To avoid possible typing errors, copy the code and serial numbers provided, and paste
them into the appropriate fields. Otherwise, check the characters in the authorization
code:

a. Codes are entered with all uppercase letters and a dash after every four characters.
b. Codes contain the letters A — F only.
c. The programs take up to 60 seconds to activate.
Is there a dongle key inserted into the same computer that is running your program?
Is your program using the dongle key serial number?

Do you have the latest version of the Sentinel hardware key drivers installed (see section
2.4).

If all troubleshooting efforts fail, contact BSI technical support.
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Topics:
4 List of Macros (page 429)

4 Macro Descriptions (page
431)

Appendix A - Macros

This chapter describes the OpX macros.

In OpX, the term “macro” refers to commands that may
use variables to allow you to perform automation
functions. Using macros, for example, you can record
audio files, send data via the serial port, enable or
disable hardware devices, switch OpX'’s playback mode,
and add a comment to your program log.

You can add macros to program logs, carts, scheduled
events, triggers, clocks, and Hot Keys.

Macros have a specific syntax that must be followed. In
this appendix, macro names are shown in capital letters,
required variables are enclosed in [brackets], and
optional variables are enclosed in {squiggly brackets}.

Tip: Most users will not need to enter macros manually because the Clock
Builder module enters automatically the most commonly used macros.
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A.1 List of Macros

Table 20-1 lists the macros in alphabetical order and describes their function. For more
information about a macro, go to the page in the “See Page” column.

¢ Note: Some macros have abbreviated or alternate names that can be used to
execute them. The TCPOUT, macro, for example, can also be executed by typing
UDPOUT, IPOUT, or IPSEND instead of TCPOUT. If a macro has one or more
alternative names, the names are shown in parentheses in the heading of the

macro.
Table 20-1. Macros
Macro Description See Page
ADDTORUNLOG Adds an entry to the run log. 431
APPLICATION Runs the specified application. 431
ATTIME Runs a command at a specified time. 432
AUTOFILLENABLE Enables or disables auto-fill. 432
CHANNELRELAY Enables or disables channel relays. 433
CLEARASYNC Clears items from the auxiliary deck. 434
CLOSURE Fire a specified closure. 434
COMMENT Adds comments to your log. 435
COMMERCIALBREAKBEGIN Starts a commercial break. 436
COMMECIALBREAKEND Ends a commercial break. 437
CONSOLEOUT Sends a command to an Axia console. 437
DECKTIMER Superimposes a countdown timer over the top deck on the Studio Client 438
Playback Deck Stack.
DEVICE Enable or disables the use of a hardware 1/O device. 439
FADECURRENT Fades out the currently playing items. 440
FADEOUTLASTITEM Looks ahead from the current item for a @ time-immediate cue, and then 440
backs up to find an audio item before the time-immediate event.

FLUSHEVENTLOG Flushes the run log. 440
GETFILLFILES Scans the folders for your station that contain Fill material, and copy any 441
new or modified files to the Audio Server's local folder.

GETPROGRAMLOGS Updates program logs form the file server. 442
GETVOICETRACKS Gets voicetracks from the file server program log for the specified hour. 442
LOADLOG Loads a program log. 443
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Macro Description See Page
LOADLOGFROMSERVER Loads a program log from the file server. 444
LOADSCHED Loads a Scheduled Event Set. 444
LOADSCHEDULEDEVENTS Switches between different Scheduled Events sets. 445
LOADTRIGGERS Loads a trigger set. 446
MIXFADE Forces one of the Audio Server's configured mixers to fade in, fade out, or 447

fade to a specific level.
MIXVOLUME Forces one of the Audio Server's configured mixers to cut to a specific 448
volume level instantly.
MODE Set the automation mode. 449
PADENABLE Enables or disables PAD output. 450
PADOUT Outputs PAD from the specified parameters. 450
PAUSE Wait for pause time. 451
PLAYASYNC Plays an audio file in the auxiliary playback deck. 451
PLAYTIMESHIFT Plays a file in the timeshift deck. 452
RECORD Records a file in the background. 453
RELAY Runs a relay command. 455
RESETCART Resets a cart to play at the first item. 456
RUN Starts the next item regardless of cue. 456
RUNAPPLICATION Allows you to enter the path to an executable file on your Audio Server 457
machine.
SAVEPROGRAMLOG Saves the program log. 457
SATSHOW Starts or stops a satellite show. 458
SATSHOWTIMER Shows a sat show count-up in the playback deck. 459
SCHED Enables or disables the execution of scheduled events loaded in the Audio 460
Server
SCHEDULEDEVENTS Turns the scheduled events function on or off. 461
SENDPAD Outputs PAD from a file name. 462
SERIALOUT Sends a serial string out the serial port of any configured serial device. 462
START Starts playback of the next event in your program log. 463
STARTDECK Starts the specified deck. 463
STARTNEXT Similar to the START macro, but changes its behavior based on the state 464
of the Playback Deck Stack.
STARTENABLE Enables or disables the start command. 464
STEPTHROUGH Allows you to turn the Step-Through function on or off. 465
STOP Stops playback of all events being played by the Playback Deck Stack. 466
STOPDECK Stops the specified deck. 466
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Macro Description See Page
SYNCRECORDSFOLDER Immediately syncs the Records folder to the file server. 467
SUNCYRUNLOGSFOLDER Immediately syncs the RunLogs folder to the file server. 467
TCPOUT Sends a command to a TCP/UDP device 468
TIMEDBLOCKSTART 469

Specifies the length of a block of audio.
TIMEDBLOCKEND 470
TIMEEVENTS Changes the Time Events mode on the Audio Server. 471
TIMESCALEITEM Sets the time scaling for the specified program log item. 472
TRIGGERS Enables or disables the trigger functionality of the Audio Server. 473
TRIM Trims silence from the specified file 474

A.2 Macro Descriptions

A.2.1 ADDTORUNLOG (or RUNLOG)

This macro adds an entry to the run log.

ENTRY FORMAT

ADDTORUNLOG [CATEGORY], [DESCRIPTION]

VARIABLES

- CATEGORY = adds a category that can be used as a key when running reports.

- DESCRIPTION = any text.

EXAMPLE

This example adds the entry BROWNS BENGALS GAME STARTED to the run log.

| ADDTORUNLOG INFO, BROWNS BENGALS GAME STARTED
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A.2.2 APPLICATION (or APP)

This macro runs an external application.

ENTRY FORMAT

APPLICATION [NAME]

VARIABLES

- NAME = name of the application you want to run.

A.2.3 ATTIME

This macro runs a command at a specified time.

ENTRY FORMAT

ATTIME [TIME], [COMMAND]

VARIABLES

« TIME =time, in mm:ss format, when the command will run. Add a plus sign (+) in front of
this variable to specify forward relative time. For example, +0100 corresponds to one
minute from the present time. Omitting the plus sign allows you to include a scheduled
event in the program log. For example, 18000 means that an event will run at 18:00

(6:00 pm).
. COMMAND = command that is to run.

EXAMPLE 1

| ATTIME +0010, START
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A.2.4 AUTOFILLENABLE (or ENABLEAUTOFILL, FILLENABLE, or
ENABLEFILL)

This macro enables or disables auto-fill.

ENTRY FORMAT

AUTOFILL [*“ON / OFF]

VARIABLES
ON = enable autofill.

OFF = disable autofill.

EXAMPLE 1

[ AUTOFILL ON

A.2.5 CHANNELRELAY (or CHANNELRELAYENABLE or
CHANNELRELAYENABLED)

This macro enables or disables channel relays.

ENTRY FORMAT

CHANNELRELAY [*“ON / OFF"]

VARIABLES
ON = enable channel relays.

OFF = disable channel relays.

EXAMPLE 1

| CHANNELRELAY ON
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A.2.6 CLEARSYNC (or CLEARAUX)

This macro enables or disables channel relays.

ENTRY FORMAT

CLEARSYNC

VARIABLES

None.

EXAMPLE 1

| CLEARSYNC

A.2.7 CLOSURE (or TRIGGER)

This macro simulates the sending of a virtual closure from a device that supports closures to
the Audio Server. For example, if you have a satellite receiver on closure 5, you can issue
this macro to mimic the sending of a virtual closure from that receiver to the Audio Server.
This macro often is used for troubleshooting. For ease of use, you might want to map this
macro to a Hot Key.

ENTRY FORMAT

CLOSURE [NAME], #

VARIABLES
«  NAME = name of the device, as configured in the Audio Server.

- # = number of the closure.

EXAMPLE 1

| CLOSURE BTACS82, 1
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A.2.8 COMMENT (or THECOMMENT)

This macro allows you to add comments to your run log. The cue type of comment macro
events can be used to affect playback of your program log. Common examples are:

- Stopping playback and making it obvious why.

- Creating a COMMENT macro similar to Example 1 below with a Manual Start (aka Stop)
cue type. You can mark your top of the hour with a comment by creating a COMMENT
macro similar to Example 2, with a cue type of Time Immediate or Time Next.

These are but a few of the many functions you can perform using the COMMENT macro.

ENTRY FORMAT

COMMENT [THECOMMENT]

VARIABLES

- THECOMMENT = comment text.

EXAMPLE 1

This example shows a comment about going live on the air using a manual cue type.

| COMMENT Talent: Go live on the air!

EXAMPLE 2

This example shows a comment about a top-of-the-hour resync, with a Time Immediate or
Time Next cue type.

| COMMENT Top of the hour re-sync
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A.2.9 COMMERCIALBREAKBEGIN (or BREAKBEGIN)

This macro signifies the start of a commercial break.

ENTRY FORMAT

COMMERCIALBREAKBEGIN [LENGTH], ['MANDATORY/OPTIONAL'"], {"FADE"}, {FADE%}, {'PLAYIFEMPTY },
{NAMETOPLAY}

VARIABLES

LENGTH = length in mm:ss format.

MANDATORY = the break must be filled with content. The system fills the break
automatically to the alllotted time, even if there is no content.

OPTIONAL = the system skips the break automatically if empty.
FADE = uses the fade percentage specified.

FADE% = if FADE is included, sets the volume of the “rejoin liner” (typically, a 10-second
blurb of audio that you hear after a commercial break before returning to a satellite
broadcast). If FADE is omitted, this variable is ignored.

PLAYIFEMPTY = plays an event if a break has no items.
NAMETOPLAY = filename of item to play if empty.

EXAMPLE

| COMMERCIALBREAKBEGIN 3:00, MANDATORY
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A.2.10 COMMERCIALBREAKEND (or BREAKEND)

This macro signifies the end of the break period.

ENTRY FORMAT

| COMMERCIALBREAKEND

VARIABLES

None.

EXAMPLE

| COMMERCIALBREAKEND

A.2.11 CONSOLEOUT

This macro sends a command to an Axia console.

ENTRY FORMAT

[ CONSOLEOUT [NAME], [COMMAND]

VARIABLES
- NAME = name of the Axia console.

- COMMAND = command to be sent to the Axia console.

EXAMPLE

| COMMERCIALBREAKEND
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A.2.12 DECKTIMER

This macro superimposes a countdown timer over the top deck on the Studio Client
Playback Deck Stack. This is useful to run during a live show to display to the on-air talent
the amount of time remaining in a show segment, among other uses. When a new event
starts, or when the time runs out, the superimposed countdown timer disappears.

In the following figure, the countdown timer created by the DECKT IMER macro appears over
top of the top deck in the Studio Client’s Playback Deck Stack.

LIVE! - DINGO & THE BABY SEGMENT 1

U s, 90 s, and Lodlayl

Entry FORMAT

[ DECKTIMER [DESCRIPTION], [DURATION]

VARIABLES
- DESCRIPTION = description to display on the deck.

- DURATION = duration of the countdown timer, in mm:ss format.

EXAMPLE

| DECKTIMER LIVE! — Dingo & The Baby Segment 1, 13:00
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A.2.13 DEVICE

Use this macro to enable or disable the use of a hardware 1/O device, such as a switcher or
trigger/relay hardware.

¢ Note: Use the exact name of the device you configured on the Device I/O page
_ of your Audio Server module’s configuration settings. If the name differs from the
one specified in the macro or is misspelled, your macro will return an error when
it executes.

ENTRY FORMAT

[ DEVICE [NAME],["ON" / "OFF”]

VARIABLES
- NAME = name of the device.
« ON = turn on the device.

« OFF =turn off the device.

EXAMPLE 1

This example turns on the Broadcast Tools ACS 8.2 audio switcher/GPIO device, which is
named “WBSIACS8.2” when it was configured. This device connects to the WBSI Audio
Server. This example makes the device available to send audio channel switching
commands, relay commands, and receive triggers from OpX.

| DEVICE WBSIACS8.2, ON

EXAMPLE 2

This example allows OpX to disable communications with the ACS 8.2 from Example 1. As a
result, triggers are no longer acknowledged, and switching and relay commands are not sent
to the device.

| DEVICE WBSIACS8.2, OFF
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A.2.14 FADECURRENT (or FADECUR)

This macro fades out the currently playing items.

Entry FORMAT

| FADECURRENT

VARIABLES

None.

EXAMPLE

| FADECURRENT

A.2.15 FADEOUTLASTITEM (or FADE_OUT_LAST_ITEM)

This macro looks ahead from the current item for a @ time-immediate cue, and then backs
up to find an audio item before the time-immediate event. It then sets the fade on that item,
which will be the last audio item before the time-immediate.

Nothing happens when you run the macro. It merely sets the fade out on the last item before
the time-immediate event. See the example below.

Entry FORMAT

[ FADEOUTLASTITEM [TIME], [LENGTH]

VARIABLES
« TIME = the time to start the fade in HH:MM:SS

« LENGTH = length of the fade, in milliseconds.

EXAMPLE

Assume that your log looks resembles the following:

+ 17:56:00 SONG
+ 17:58:00 LAST
@ 18:00:00 SATSHOW START, THESHOW
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Also, assume that some time before the last item in the hour starts, the following macro is
executed:

| FADEOUTLASTITEM 17:59:55, 4000

This macro sets the fade to start at 17:59:55 over four seconds, giving a second of silence
before the satellite show starts at 18:00:00.

You can run the macro in the log, for example, 15 minutes prior to the end of the hour.

A.2.16 FLUSHEVENTLOG (or FLUSHRUNLOG)

This macro flushes the run log.

Entry FORMAT

| FLUSHEVENTLOG

VARIABLES

None.

EXAMPLE

| FLUSHEVENTLOG

A.2.17 GETFILLFILES (or GETFILL)

This macro forces the File Server to scan the folders for your station that contain Fill
material, and copy any new or madified files to the Audio Server’s local folder.

Entry FORMAT

| GETFILLFILES

VARIABLES

None.

EXAMPLE

| GETFILLFILES
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A.2.18 GETPROGRAMLOGS

This macro forces the File Server to scan the program log folder for your station, and copy
any new or modified program logs to the Audio Server’s local folder.

Entry FORMAT
| GETPROGRAMLOGS

VARIABLES

None.

EXAMPLE
| GETPROGRAMLOGS

A.2.19 GETVOICETRACKS

This macro forces the Audio Server to compare the specified hour of the currently loaded
program log with the same hour in the File Server’s copy of the program log, and update the
on-air log with any new remotely created voicetracks.

Entry FORMAT
| GETVOICETRACKS [HH]

VARIABLES

« HH = hour of voicetrack events update.

EXAMPLE

The following example updates the voicetrack files in the current on-air log for the 2:00pm

hour with any newly created or modified remote voicetrack files currently on the File Server.
| GETVOICETRACKS 14 |
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A.2.20 LOADLOG

This macro loads a program log using the entry in the Program Log Name Template field
of the General tab in the Audio Server configuration settings.

This macro always loads the log using the date of your workstation’s system date. If this
macro is run before noon of the current day the current day’s log is loaded. If after noon, the
next day’s log is loaded. This means that if your system’s date is Tuesday December 23,
2015 at 11:55:25 PM when the LOADLOG macro is run, the program log for Wednesday
December 24, 2015 is loaded. No variables apply to this macro.

For options about loading specifically named program logs and additional options for
reloading today'’s log using the Audio Server’s Program Log Name Template settings, see
the LOADLOG macro later in section A.2.20.

If {NAME} is omitted, the configured program template log is loaded.

Entry FORMAT

| LOADLOG {NAME}

VARIABLES

- NAME = name of the log to be loaded.

EXAMPLE

| LOADLOG
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A.2.21 LOADLOGFROMSERVER

This macro loads a program log from the file server. If {NAME} is omitted, the configured
program log template is loaded.

Entry FORMAT
| LOADLOGFROMSERVER {NAME}

VARIABLES

NAME = name of the log to be loaded.

EXAMPLE
| LOADLOGFROMSERVER

A.2.22 LOADSCHED (or LOADSCHEDULED or
LOADSCHEDULEDEVENTS)

This macro loads a Scheduled Event set.

Entry FORMAT
| LOADSCHED {NAME}

VARIABLES

NAME = name of the Scheduled Event Set to be loaded.

EXAMPLE
| LOADSCHED BEACHSONGEVENTSET
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A.2.23 LOADSCHEDULEDEVENTS (or LOADSCHEDULED)

The OpX Audio Server can use only one Scheduled Events set at a time. Using this macro,
however, makes it possible to switch between different Scheduled Events sets. Running this
macro loads the named Scheduled Events set and unloads the previously loaded set. If the
name of the Scheduled Events set is omitted, the Audio Server unloads any currently loaded
scheduled events set.

Entry FORMAT

| LOADSCHEDULEDEVENTS [NAME]

VARIABLES

- NAME = name of Scheduled Events set.

EXAMPLE 1

The following example unloads the currently loaded Scheduled Events set, so the events in
that set will no longer execute. The BaseballSchedSet loads and all events in that set
execute at their configured times, as long as the Scheduled Events function is enabled
(turned on).

| LOADSCHEDULEDEVENTS Basebal 1SchedSet

EXAMPLE 2

Since no scheduled events set name is specified, the Audio Server unloads any currently
loaded scheduled events set. In this example, the alternate macro name LOADSCHEDULED is
used instead of LOADSCHEDULEDEVENTS. The two macros are functionally equivalent. The
only difference is that one macro name is longer than the other macro name.

| LOADSCHEDULED
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A.2.24 LOADTRIGGERS

This macro loads a trigger set. You can run this macro from a scheduled event, the program
log, a cart, or another trigger set.

Entry FORMAT
| LOADTRIGGERS [NAME]

VARIABLES

- NAME = filename of the trigger set.

EXAMPLE 1

The following example loads a trigger set named DavesTriggerSet.
| LOADTRIGGERS DavesTriggerSet

EXAMPLE 2

Since no trigger set is named, running this example unloads the currently loaded trigger set.
| LOADTRIGGERS |
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A.2.25 MIXFADE

Use this macro to force one of the Audio Server’s configured mixers to fade in, fade out, or
fade to a specific level (for ducking or other purposes). You can use either the name you've
given your mixer or the mixer's number. Volume is in percent, with 100% being fully open/up
and 0% being fully closed/down.

Entry FORMAT

[ MIXFADE [NAME OR #], [START%], [STOP%], [TIME]

VARIABLES

«  NAME OR # = mixer name or number,
- START% = start volume percentage.

« STOP% = stop volume percentage.

. TIME = duration, in milliseconds.

EXAMPLE

The following example fades the mixer named SATELLITE from an initial 0% to a final 100%
over a length (or ramp time) of 2.5 seconds.

| MIXFADE SATELLITE, O, 100, 2500
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A.2.26 MIXVOLUME

Use this macro to force one of the Audio Server’s configured mixers to cut to a specific
volume level instantly. Use either the name you’ve given your mixer or the mixer's number.
Volume is specified as a percentage, with 100% being fully open/up and 0% being fully
closed/down.

Entry FORMAT

[ MIXVOLUME [NAME OR #], [PERCENT]

VARIABLES
-  NAME OR # = mixer name or number.

- PERCENT = volume percentage.

EXAMPLE

The following example set the volume of the first defined mixer to 100%.

| MIXVOLUME 1, 100
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A.2.27 MODE

This macro allows you to change the Audio Server’'s automation mode to Auto, Assist, or
Manual mode.

Entry FORMAT

| MODE [“AUTO” / *“ASSIST” / “MANUAL’"]

VARIABLES
« AUTO = change the Audio Server's automation mode to auto.
« ASSIST = change the Audio Server's automation mode to assist.

«  MANUAL = change the Audio Server’s automation mode to manual.

EXAMPLE 1

The following example sets change the Audio Server’'s automation mode to auto.

| MODE auto

EXAMPLE 2

The following example sets change the Audio Server’'s automation mode to assist.

| MODE assist

EXAMPLE 3

The following example sets change the Audio Server’'s automation mode to manual.

| MODE manual
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A.2.28 PADENABLE (or ENABLEPAD)

This macro enables or disables PAD output.

Entry FORMAT

| PADENABLE [*“ON” / *“*OFF~]

VARIABLES
« ON = enable PAD output.
« OFF = disable PAD output.

EXAMPLE

| PADENABLE ON

A.2.29 PADOUT (or OUTPAD)

This macro outputs PAD from the specified parameters.

Entry FORMAT

| PADOUT

VARIABLES

None.

EXAMPLE

| PADOUT
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A.2.30 PAUSE

This macro allows you to put a pause between events.

Entry FORMAT

| PAUSE [LENGTH]

VARIABLES

« LENGTH = length of the pause, in mm:ss format.

EXAMPLE

The following example pauses playback of events for 10 seconds.

| PAUSE :10

A.2.31 PLAYASYNC (or PLAYAUX)

This macro plays an audio file in the auxiliary playback deck. This is useful to play a
background audio file at the same time audio is playing in the main playback decks, such as
a backing track behind a weather forecast.

Entry FORMAT

[ PLAYASYNC [NAVE]

VARIABLES

«  NAME = filename of audio file to play without extension.

EXAMPLE

If the following macro is run from the program log followed by an audio file containing a dry
reading of the weather, the audio file weatherbed1.wav executes on the Async deck, and
then the weather would play immediately over top.

| PLAYASYNC weatherbed1
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A.2.32 PLAYTIMESHIFT (or PLAYTS or TIMESHIFT)

This macro plays a file in the timeshift deck. After using a clock from the Clock Builder to
record a satellite show, this macro is added to a clock to play back the recorded audio. This
macro prompts the OpX system to start playback of your pre-recorded satellite show’s audio
file.

Entry FORMAT

[ PLAYTIMESHIFT [NAVE]

VARIABLES

- NAME = name of the audio file to play.

EXAMPLE

This example starts playback of the audio file BILLOREALLYHR1.wav. This file was
created with the record function of the Clock Builder module.

| PLAYTIMESHIFT BILLOREALLYHR1
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A.2.33 RECORD

Use this macro to record audio using one of your Audio Server’s record decks (for recording
audio manually rather than using the record function of the Clock Builder).

Audio files can be recorded to a specified length by entering a [Length to record] variable
with a specific time (such as 30:00). To record a variable-length audio file, specify the time
as 00:00, and when you want to stop recording, run a second RECORD STOP, [Deck #]
macro.

Time is interpreted as mm:ss if only five digits are entered (including the colon), or as
hh:mm:ss if 8 digits are entered (including the two colons).

The Filename, Title/Description, and Artist variables you use can include meta
variables for the date or time, as shown in the following table.

Meta Variable Description
%yy Year as a 2-digit number (00-99)
%yyyy Year as a 4-digit number (0000-9999)
%m Month as a number without a leading zero (1-12)
%mm Month as a number with a leading zero (01-12)
%mmm Month as a 3-letter abbreviation (Jan-Dec)
%mmmm Month as a full name (January-December)
%d Day as a number without a leading zero (1-31)
%dd Day as a number with a leading zero (01-31)
%ddd Day as a 3-letter abbreviation (Mon-Sun)
%dddd Day as a full name (Monday-Sunday)

Entry FORMAT
| RECORD [“'START"/"STOP"], [DECK#], [NAME], [LENGTH], [TITLE],[Artist], [UPLOAD], [TRIM] |

VARIABLES

« START = starts recording.

« STOP = stops recording.

«  DECK# = number of the deck on which recording is to start or stop.
«  NAME = filename to save to.

+ LENGTH = length to record.
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« TITLE = description.
« ARTIST = name of the artist.
« UPLOAD = copies a file from the Audio Server to the File Server.

« TRIM =removes the silence (“dead air”) from the start or end of the specified file.

EXAMPLE 1

This example records an audio file that will be 5 minutes long from Record Deck 1. The file
will be saved with the file name NEWS.wav (or other extension for other file types), with the
audio file’'s Title field showing ABG News and the artist field showing Doug Haiku.

| RECORD START, 1, NEWS, 05:00, ABG News, Doug Haiku

EXAMPLE 2

This example records an audio file of variable length that must be stopped at some point
with the RECORD STOP, 2 macro or it will eventually fill up the hard drive. The file is played
from Record Deck 2 with the file name Rosh-122315.wav (if the file were recorded on
December 23, 2015) and the audio file's Title/Description field would show Rosh Limberg
Show — 12/23/2008.

| RECORD START, 2, Rosh-%mm%dd%yy, 00:00, Rosh Limberg Show - %mm/%dd/%yyyy

EXAMPLE 3

This example stops Record Deck 2 from recording and save its audio file to the File Server.

| RECORD STOP, 2
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A.2.34 RELAY

This macro forces a relay closure open (on), closed (off), or to pulse closed for a period of
milliseconds.

Entry FORMAT

[ RELAY [NAME], [#], [“ON” / “OFF” / MS]

VARIABLES

« NAME = name of the device.
« # =relay number.

« ON =relay is turned on.

«  OFF =relay is turned off.

« MS = milliseconds.

EXAMPLE

This example pulses for 500 milliseconds the first relay on the device named ACS8.2
configured in the Audio Server’s Device I/O settings.

| RELAY ACS8.2, 1, 500
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A.2.35 RESETCART

This macro resets a cart’s “event executed” flags, so that all items within a cart are marked
as unplayed. The next time the cart is played, the first item is played (or in randomized carts,
all items within the cart will be available to play again).

Entry FORMAT

[ RESETCART [NAME]

VARIABLES

- NAME = name of the cart to reset.

EXAMPLE

This example causes the cart named STATIONIDCART to remove the internal event
executed flags from each event in the cart, so that the next time that cart executes, it starts
playing from the first event in the cart.

| RESETCART STATIONIDCART

A.2.36 RUN (or START)

This macro starts the next item regardless of cue.

Entry FORMAT

| RUN

VARIABLES

None.

EXAMPLE

| RUN
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A.2.37 RUNAPPLICATION

OpX can execute any application that can be executed using the Microsoft Windows
Command Prompt. This allows you to have OpX start any custom application you might
need.

This macro allows you to enter the path to an executable file on your Audio Server machine,
including any parameters required by that executable file, as the macro’s variable.

Entry FORMAT

[ RUNAPPLICATION [PATH]

VARIABLES

« PATH = full path and parameters for executable file.

EXAMPLE

This example tells Windows to execute the command C:\Program Files\My
Apps\CustomApp.exe /X, which starts the CustomApp .exe executable and passes it the
parameter /x.

| RUNAPPLICATION C:\Program Files\My Apps\CustomApp.exe /X

A.2.38 SAVEPROGRAMLOG

This macro saves the program log.

Entry FORMAT

| SAVEPROGRAMLOG

VARIABLES

None

EXAMPLE

| SAVEPROGRAMLOG
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A.2.39 SATSHOW

This macro is usually generated by the Clock Builder module to start a satellite show.
However, it is possible to manually use this macro. If placed in a Hot Key, you can restart a
satellite show if necessary.

Entry FORMAT

| SATSHOW ["START'™ / "STOP' / *“*STOPLIVE” / *“*STOPRECORD*’], [NAME]

VARIABLES

« START = start the satellite show.

«  STOP = stop the satellite show.

- STOPLIVE = stop live satellite show.

« STOPRECORD = search the list of active satellite shows and stop the ones that are
recording.

. NAME = name of the satellite show.

EXAMPLE

This macro puts all the settings configured in the Clock Builder for the Satellite Show Start
event titled BILL OREALLY.

| SATSHOW START, BILL OREALLY
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A.2.40 SATSHOWTIMER

This macro shows a sat show count-up in the playback deck.

Entry FORMAT

| SATSHOWTIMER ["START"™ / "STOP'], [NAME], [DESCRIPTION]

VARIABLES

« START = start the satellite show count-up in the playback deck.

« STOP = stop the satellite show count-up in the playback deck.

- NAME = name of the satellite show count-up in the playback deck.

- DESCRIPTION = description of the satellite show count-up in the playback deck.

EXAMPLE

This macro puts all the settings configured in the Clock Builder for the Satellite Show Start
event titled BILL OREALLY.

| SATSHOWTIMER START, BILL OREALLY
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A.2.41 SCHED (or SCHEDULED)

This macro enables or disables the execution of scheduled events loaded in the Audio
Server.

Entry FORMAT

[ SCHED ["ON" / "OFF"]

VARIABLES
- ON = enable execution.

- OFF = disable execution.

EXAMPLE

| SCHED ON

SEE ALSO

LOADSCHED (or LOADSCHEDULED or LOADSCHEDULEDEVENTS) on page 444.
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A.2.42 SCHEDULEDEVENTS (or SCHEDULED)

This macro turns the scheduled events function on or off.

Entry FORMAT

| SCHEDULEDEVENTS ["ON* / "OFF'"]

VARIABLES
- ON = enable the scheduled events function.

- OFF = disable the scheduled events function.

EXAMPLE 1

This macro turns on the Scheduled Events function, so that the events in the currently
loaded Scheduled Events set executes its events at the specified times.

| SCHEDULEDEVENTS ON

EXAMPLE 2

This macro turns off the Scheduled Events function, so if events in the currently loaded
Scheduled Events set are set to execute at a specific time, they are ignored. In the following
example, the command SCHEDULED is used instead of SCHEDULEDEVENTS. The two macros
are functionally equivalent. The only difference is that one macro name is longer than the
other macro name.

| SCHEDULED OFF
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A.2.43 SENDPAD (or PADSEND)

This macro outputs PAD from a file name.

Entry FORMAT

| SENDPAD

VARIABLES

None.

EXAMPLE

| SENDPAD

A.2.44 SERIALOUT

This macro sends a serial string out the serial port of any configured serial device.

Entry FORMAT

[ SERIALOUT [NAME], [COMMAND]

VARIABLES
- NAME = name of the device.

»  COMMAND = serial string.

EXAMPLE

This macro sends the serial string *1051 out the serial port or serial server to which the
device named ACS82 on the Audio Server is connected. This serial string is commonly used
to switch most Broadcast Tools switchers, such as the ACS 8.2 and others, to set Output 1
to open Input 5.

| SERIALOUT ACS82, *1051
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A.2.45 START

This macro starts playback of the next event in your program log. If audio is already playing,
this macro starts the next event playing at the same time, without cutting off the currently
playing event. For a macro that stops the currently playing event and start the next event,
see the STARTNEXT macro in section A.2.48.

Entry FORMAT

| START

VARIABLES

None.

EXAMPLE

| START

A.2.46 STARTDECK

This macro starts the specified deck.

Entry FORMAT

[ STARTDECK [DECK#]

VARIABLES

- DECK# = number of the deck to be started.

EXAMPLE

This example starts deck number 2.

| STARTDECK 2
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A.2.47 STARTENABLE

This macro enables or disables the start command. Use this macro when your programming
is automated and you want to prevent manual intervention.

Entry FORMAT

| STARTENABLE [*“ON” / *“*OFF’"]

VARIABLES
- ON = enable the start command.

. OFF = disable the start command.

EXAMPLE

| STARTENABLE ON

A.2.48 STARTNEXT

This macro is similar to the START macro, but changes its behavior based on the state of the
Playback Deck Stack:

- If an event is playing when this macro executes, it fades out and the next event in the
program log executes.

- If no event is playing in the Playback Deck Stack, the item loaded in the top of the
Playback Deck Stack executes.

Entry FORMAT

| STARTNEXT

VARIABLES

None.

EXAMPLE

| STARTNEXT
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A.2.49 STEPTHROUGH

The Step-Through function of the Audio Server determines how timed events (events with a
Time Immediate or Time Next cue type) start. This macro allows you to turn the Step-
Through function on or off.

- If the Step-Through function is enabled, timed events start when their time is reached. If
a particular timed event is reached before its scheduled time, that event starts
automatically, as if it were an Auto Start cued event. This is useful for “Music-from-Hard-
Drive” stations that encounter missing audio files and want their timed events to run early
rather than having dead air until a timed event’s time is reached.

- If the Step-Through function is disabled, timed events do not execute until their specified
time is reached. This is the standard setting for OpX, since it is the expected behavior of
timed events for most users.

Entry FORMAT

| STEPTHROUGH [**ON” / *“*OFF’"]

VARIABLES
ON = enable stepthrough.
OFF = disable stepthrough.

EXAMPLE 1

| STEPTHROUGH ON

EXAMPLE 2

| STEPTHROUGH OFF

Page 465 of 487



Macros

A.2.50 STOP

This macro stops playback of all events being played by the Playback Deck Stack. This
macro is most commonly used with the trigger set function to allow you to configure stop
buttons on consoles.

Entry FORMAT

[ sTop

VARIABLES

None.

EXAMPLE

[ sToP

A.2.51 STOPDECK

This macro stops the specified deck.

Entry FORMAT

[ STOPDECK [DECK#]

VARIABLES

- DECK# = number of the deck to be stopped.

EXAMPLE

This example stops deck number 2.

| STOPDECK 2
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A.2.52 SYNCRECORDSFOLDER (or SYNCRECORDS)

This macro forces the File Server and Audio Server to synchronize the Records folder for
your station. It copies any new or modified files between the Audio Server’s local folder and
the File Server’'s Records folder, so both have the most recent versions of all files. You can
use this macro to ensure that all files in the Audio Server’s local folder are up to date.

Entry FORMAT

| SYNCRECORDSFOLDER

VARIABLES

None.

EXAMPLE

| SYNCRECORDSFOLDER

A.2.53 SYNCRUNLOGSFOLDER (or SYNCRUNLOGS)

This macro forces the File Server and Audio Server to synchronize the Runlogs folder for
your station. It copies any new or modified files between the Audio Server’s local folder and
the File Server's Runlogs folder, so both have the most recent versions of all files.

ENTRY FORMAT

| SYNCRECORDSFOLDER

VARIABLES

None.

EXAMPLE

| SYNCRECORDSFOLDER
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A.2.54 TCPOUT (or UDPOUT, IPOUT, or IPSEND)

This macro sends commands to a TCP/UDP device.

ENTRY FORMAT

[ TCPOUT [NAME], [COMMAND]

VARIABLES
- NAME = name of the device.

. COMMAND = command to be sent to the device.

EXAMPLE

| SYNCRECORDSFOLDER
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A.2.55 TIMEDBLOCKSTART

This macro is used with the TIMEDBLOCKEND macro to specify the length of a block of audio,
such as a break, and have OpX “stretch” (slow down) or “squeeze” (speed up) the audio so
that the audio fits the specified block length.

ENTRY FORMAT

| TIMEDBLOCKSTART [LENGTH]

VARIABLES

« LENGTH = length of block, in hh:mm:ss format.

EXAMPLE

This example adds to the start of a break which the operators wants to be stretched or
squeezed automatically to be a total of 3:00 minutes long. When using this macro, add the
TIMEDBLOCKEND macro after the block of audio. The pair of these macros is the way OpX
ascertains which audio files are to be stretched or squeezed. Without the TIMEDBLOCKEND
macro at the end of your block of audio files, OpX would not know the end point of your
block of audio and cannot fit your audio properly to the specified length.

| TIMEDBLOCKSTART 03:00

¢! Note: Do not use carts and timed events (events with a Time Immediate or Time
_ Next cue type) within the TIMEDBLOCKSTART / TIMEDBLOCKEND macro pair. This
is because the length of audio events within carts cannot be determined until the
cart itself starts to play, and timed events affect the start point of playback (either
stopping playback or starting early if their specified time is reached), Both of
these actions are beyond the control of this macro.
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A.2.56 TIMEDBLOCKEND

This macro is used with the TIMEBLOCKSTART macro to specify the length of a block of
audio files, so that OpX can time scale the block of audio automatically to your desired
length. The TIMEDBLOCKEND macro is added to the end of your block of audio (with the
block started with the TIMEDBLOCKSTART macro), which is to be time-scaled.

Entry FORMAT

| TIMEBLOCKEND

VARIABLES

None.

EXAMPLE

| TIMEBLOCKEND
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A.2.57 TIMEEVENTS (or TIMEDEVENTS)

This macro changes the Time Events mode on the Audio Server to change OpX’s behavior
when playing time cued events in the Program Log and when executing events from your
current Scheduled Events set.

Entry FORMAT

| TIMEEVENTS ["'ON" / "OFF" / "ALL™

VARIABLES
- ON =turn on time events.
«  OFF = turn off time events.

« ALL =turn on stepthrough.

EXAMPLE 1

| TIMEEVENTS ON

EXAMPLE 2

| TIMEEVENTS OFF

EXAMPLE 3

| TIMEEVENTS ALL
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A.2.58 TIMESCALEITEM (or SCALEITEM or TSITEM)

This macro sets the time scaling for the specified program log item. For example, if you have
an infomercial that is 14:45 long, but must fit into a 15-minute timeframe, you can use this
macro to stretch the infomercial so it fills the 15-minute spot. Similarly, you can use this
macro to squeeze content that exceeds the time in which it is scheduled to play.

Entry FORMAT

| TIMESCALEITEM [“NEXT” / +#, #]

VARIABLES
«  NEXT = next program log item.
- +# = number of item forward from current position.

- # = absolute log position.

EXAMPLE

This example sets the time scaling for 5 items forward.

| TIMESCALEITEM +5
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A.2.59 TRIGGERS
This macro enables or disables the trigger functionality of the Audio Server.

- If triggers are turned on, all incoming triggers execute the events from your currently
loaded Trigger Set.

- If triggers are turned off, all incoming triggers are ignored.

Entry FORMAT

| TRIGGERS ['"ON" / "OFF'"]

VARIABLES
«  ON =turn on triggers.

«  OFF = turn off triggers.

EXAMPLE 1

This example turns on triggers.

| TRIGGERS ON

EXAMPLE 2

This example turns off triggers.

| TRIGGERS OFF
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Macros

This macro trims silence from the specified file.

Entry FORMAT

| TRIGGERS [NAME]

VARIABLES

- NAME = name of the file.

EXAMPLE

[ TRIM 50954
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Appendix B - Cue Types

This appendix describes the cue types supported by OpX event playback. Cue types
determine how events are started in the program log or from within carts.

- With program logs, every event is started by a scheduled time (such as with Time
Immediate cued events) or from the interaction of previous items playing back. Examples
of the latter include Auto Start cued events, which start when the previous event finishes,
and Stop cued events, which stop playback after the previous event finishes.

- Carts use the Stop cue and Auto Start cue to determine how many events are played
from a cart. When a Stop cued event is reached during cart play, the cart quits. If the cart
is being played from a program log, the next event in the program log executes with
respect to its specified cue type.

Cue Type Description
Stop (blank) Event will not start playing when the previous item finishes.
Auto Start (+) Event starts playing automatically when the previous itemfinishes

Time Immediate (@)

If playback has not reached the event at the time set in the Scheduled Time field:
o The currently playing event(s) stops.

o All events in the program log between the currently playing event and the Time Immediate event
are skipped.

¢ The Time Immediate event plays. Playback continues from this point forward and all previous
events are skipped.

If playback reached the event at the time specified in the Scheduled Time field, playback stops
until the specified scheduled time, at which time it starts playing the Time Immediate event.

Time Next (#)

The behavior of the Time Next cue type is almost identical to the Time Immediate cue type. The
difference is in when the Time Next event executes. While the Time Immediate event cuts off any
playing events and starts playing, a Time Next event waits for the currently playing event to finish
before executing.

The trade-off is that the Time Next event might be delayed by the end of the previous event, while
the Time Immediate event will play at exactly the time specified in the Scheduled Time field. For
most ‘music-from-hard-drive’ stations, close to the top-of-the-hour is satisfactory for station IDs, so
a song is not cut off, which would offend the listening audience.
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Appendix C - Glossary

Term

Definition

Audio pass-through

The ability of an audio device to route the audio coming through the line-in directly to the
line-out, usually with the ability to control the volume of that audio from 0% (not passing
through) to 100% (fully passed-through). This function is used for spot replacement when
broadcasting syndicated satelliteshows.

Cart

In OpX, a cart is a special file created by the Log Import/ Cart Builder program that
contains references to other files. Think of it as a mini program log. It can contain audio
cuts to rotate or a list of macros to execute. OpX treats carts just like an audio cut, but the
cart its self can contain a set of audio files/commands to execute (playing multiple audio
files/commands when the cart is ‘played’), or a rotation of audio files (playing a different
audio file/command each time the cart is ‘played).

Categories

OpX can visually differentiate different types of audio files in the OpX Studio Client. It
does this according to which category each audio cut is assigned to. The category
attribute is stored in the tagging information of each audio file.

Closures

Momentary contacts from an external source received through a device and relayed to an
OpX Audio Server. Closures are also known as outgoing triggers, or relays.

Database

The internal database OpX keeps of all audio files and carts in your OpX system. The
database exists on the OpX File Server.

De-bouncing

A function that allows a trigger system to ignore triggers for a specified amount of time
after a trigger has been received. This helps combat accidentally repeated triggers from a
satellite syndicator, sloppy relays in a satellite receiver, or if wired to a console switch,
accidentally pressing a button multipletimes.

Default ducking level

The OpX Audio Server reduces the volume level of audio cuts playing underneath
voicetracks by this amount unless a different amount is specified when a voicetrack is
recorded.

Default segue time

If no segue time is specified in a certain audio cut, OpX uses the default segue time to
determine when to segue into the next audio cut following it in the program log. The
default value is 250 milliseconds or ¥ second.

Device

A piece of equipment that communicates with an OpX Audio Server to facilitate
communication with external equipment or switch audio, such as a BSI Trigger Kit,
Broadcast Tools audio switcher or an Axia node.

Device I/0

A setting in the OpX Audio Server module that allows the module to interface with external
devices such as BSI Trigger Kits, Broadcast Tools switchers, and Axia nodes.

FTP

File Transfer Protocol. A standard “language” for communicating data/files across a
network. It is also the means by which audio files and carts are transferred from one OpX
module to another.

Macro

A command issued to the OpX Audio Server as a string of text or text and numbers to
perform various functions.

Maximum fade out

A user-selectable option on each Audio Server that allows you to set a maximum amount
of time OpX will fade each audio cut during playback. This is useful for song libraries
where you want each song to fade over a certain period of time after the segue point of
each song is reached. The default is 3,000 milliseconds or 3 seconds.

Page 476 of 487



Term

Definition

Mixers

Each OpX Audio Server can control the audio levels of some audio devices such as audio
pass-through in sound cards and Axia nodes. The level controls of each audio device are
accessed through the mixers command.

Mode

Designates how each OpX Audio Server advances through a program log. There are two
modes for each Audio Server — auto and manual. In auto mode, the audio server
advances through the log automatically unless it encounters a command in a log directing
it to do otherwise. In manual mode, the audio server steps through the log manually,
relying on outside input before advancing

Network

A system of communication between 2 or more computers. This is also referred to as a
LAN, or local area network. Some in the radio/broadcasting industry use the term
“network” interchangeably to mean either a satellite show, or a computer network. This
manual uses it to mean a computer network.

NIC

Network Interface Card. An expansion board you insert into a computer to connect to a
network.

PAD

Program Associated Data. Each OpX Audio Server is capable of sending PAD data via
UDP to a single device such as an HD Radio importer, streaming audio encoder or RDS
encoder. PAD data is useful for providing artist / title information, commercial substitution,
etc.

Playback device

An audio device in or connected to your OpX system for audio playback. For example:
This could be an audio card, an individual channel of a multi- channel audio card, or
individual output of an Axia node.

Record deck

A device that allows background recording of any type of audio. Recording is a function of
the OpX Audio Server, with up to 4 simultaneous background records possible.

Satellite show

A function of the OpX Clock Builder — a simple, Q&A method of building clocks for
syndicated programming. This is the same as what some refer to as a “network” show.
The term “satellite show” is used to differentiate between it and a computer data network.

Sample rate

The number of samples taken of an audio source per second in digitally recorded audio.
By default, OpX operates at a sample rate of 44,100 Hz.

Scheduled events

Events programmed to execute in the background on an OpX Audio Server, independent
of the program log. Scheduled events are most commonly used for utility tasks or “set-it-
and-forge- it” tasks.

Segue

A general term used to indicate the transition between two audio cuts. For example: This
can be a “cold” transition, where one audio cut stops and the next one starts, or a cross-
fade between two cuts.

Step through

A preference setting that, when enabled, causes timed events to automatically start if they
are reached in the program log before their specified time effectively treats timed events
as an “Auto Start” cued event. Disabling this setting (which is the default setting) causes
playback of the program log to wait to play an item until its specified time. Typically used
for non-music live, voicetracked or satellite programming.

System tray

Area in the Windows desktop that contains the system clock and status icons of many
applications. The system tray usually appears the right side section of the Taskbar, which
also contains the “Start” button. For example:

WA I G 2zsem

Time shift

Recording a satellite show for playback at a later time, complete with triggers. These are
played back through a special deck in the OpX Audio Server.

Triggers

Also known as closures, they are signals typically from a satellite receiver relay closure or
start/stop buttons on a console that OpX receives through a “trigger kit” device and uses
to play audio files or perform commands.
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Trigger set

A collection of commands or audio files that OpX executes when specific closures are
received. Each trigger set is individually named and can be loaded into the OpX Audio
Server at any time.

Time events

Audio or Macro events scheduled to execute at a specific time. For example, a timed
event is used to ensure that your top of the hour ID will play exactly at the top of the hour.

Verify

A command in the OpX Studio Client that checks to see whether the files specified in the
currently loaded program log are available to play. This process also verifies that the
artist, title, and description information listed in the program log matches the data
imbedded within each specified audio cut.

Voicetrack

An audio file recorded in OpX Studio Client to be inserted between two audio cuts and
simulate live air talent. A voice track is a pre-recorded voice-over.
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Adding

a common folder to a station, 55
a folder to a station, 54
audio files using file library, 295
categories, 84
events to Hot Keys, 168
events to program log, 165
1/0 card device profile, 339
items to the program log, 130
local files to carts, 205
new program log events, 297
satellite show start event, 245
serial device profile, 333
stations to file server, 52
XDS receiver profile, 337
Adding items to Hot Key sets, 405
ADDTORUNLOG macro, 431
Allow Stations module, 342
configuring, 347
limiting station profiles, 348
menu bar, 346
quick tour, 345
starting, 343
Allow Stations Module
tool bar, 347
Appearance of Studio Client, 185
APPLICATION macro, 432
ATTIME macro, 432
Audience, 12
Audio events loading into Voicetrack Editor, 179
Audio files
adding using file library, 295
editing tagging info, 208

Audio Server module

Index

auto fill and time scaling configuration settings, 79

closure and relay configuration settings, 123
configuring, 72

Connections tab, 70

data configuration settings, 115

device configuration settings, 87

Devices tab, 70

general configuration settings, 74

menu bar, 64

mixer configuration settings, 112

mode and log configuration settings, 122
playback configuration settings, 77
Playback tab, 67

program log display, 71

quick tour, 63

record configuration settings, 82

Record tab, 68

scheduled event set configuration settings, 118

starting, 61

Status tab, 69

trigger set configuration settings, 109
Audio Server Watchdog module

menu bar, 421

quick tour, 420

starting, 419
Audio tagging info, editing, 211
Audition/cue configuration settings, 157

Authorization code, modifying, 42

Auto fill and time scaling configuration settings, 79

AUTOFILLENABLE macro, 433

Automation report template, 212

Automation reports, 212
running, 217

Auxiliary Audio Server module, starting, 135
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Background recording example, 260

Block marker configuration settings, 284

C

Carts
adding local files, 205
creating, 202, 300
editing, 204, 301
saving, 301
Categories
adding, 84
deleting, 85
editing, 85
CHANNELRELAY macro, 433
CLEARSYNC macro, 434
Clock Builder module
adding a satellite show start event, 245
configuring, 229
creating a commercial break event, 247
creating custom event, 252
creating multi-hour satellite show clocks, 256
creating satellite show start event, 233
creating stop satellite show event, 254
menu bar, 223
quick tour, 222
recording a satellite show, 256
starting, 220
time-shifting a satellite show, 256
tool bar, 225
Clocks, samples, 258
Closure and relay configuration settings, 123
CLOSURE macro, 434
COMMENT macro, 435
Commercial break event, 247
COMMERCIALBREAKBEGIN macro, 436
COMMERCIALBREAKEND macro, 437
Configurations
dual workstation/single station, 19
production workstation, 23
robust multi-station, 22

simple multi-station, 21

Index

single workstation/single station, 19

triple workstation/single station, 20
Configuring

Allow Stations module, 347

Audio Server module, 72

Clock Builder module, 229

File Manager module, 196

File Server module, 51

File Sync module, 323

FTP Server module, 357

Import-Merge module, 274

item properties, 411

Mobile Gateway/Client module, 389

Serial Device Server module, 332

stinger deck, 416

Stinger module, 397

studio client module items, 146
Connections List, File Server module, 50
Connections tab, Audio Server module, 70
CONSOLEOUT macro, 437
Conventions in this document, 13
Copying

events to program log, 167

files from file server, 200

files to file server, 198
Creating

automation report template, 212

carts, 300

commercial break event, 247

custom event, 252

data repeater, 376

mixer layouts, 367

multi-hour satellite show clocks, 256

new carts, 202

rotating Hot Keys, 169

satellite show start event, 233

stop satellite show event, 254

voicetracks, 179
Cue types, 475

program log events, 298
Current authorization code, modifying, 42

Custom event, 252
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Index

D program log, 165

. . . . program log events, 298
Data configuration settings, Audio Server module, 115

Enabling
Data repeater

. Virtual Audio Server, 57
creating, 376
deleting, 381
editing, 380

starting and stoppping, 382

Voictrack Transfer module, 58
Events
adding to Hot Keys, 168
Data Repeater module adding to program log, 165
menu bar, 373 changing cue types, 298
copying, 167

for Hot Keys, 171

quick tour, 372

starting, 371

tool bar, 374
DECKTIMER macro, 438

loading into Voicetrack Editor, 179
moving from program log, 166

. removing from program log, 166
Deleting
. Exporting
categories, 85
rogram log for third-party applications, 294
data repeater, 381 prog & party app

program log to file server, 293
device profile, 341

items, 414 F
items from the program log, 133

Device configuration settings, Audio Server module, 87 FADECURRENT macro, 440

DEVICE macro, 439 FADEOUTLASTITEM macro, 440

Device profile File library, using to add audio files, 295
deleting, 341 File Manager module
editing, 340 quick tour, 191

Devices tab, 70 starting, 190

Disabling File Server module
Virtual Audio Server, 57 adding a common folder to a station, 55

Voictrack Transfer module, 58 adding a folder to a station, 54

Document conventions, 13 adding stations, 52

Dual workstation/single station configuration, 19 configuring, 51

Ducking levels, 183 Connections List, 50

menu bar, 47
E quick tour, 46
" starting, 45
Editing
. N Station Folder List, 50
audio tagging info, 211
tool bar, 49

carts, 301

. File Sync module
categories, 85
configuring, 323
data repeater, 380

. ) menu bar, 319
device profile, 340
. quick tour, 318
items to the program log, 132
starting, 317

tool bar, 321

local audio file tagging info, 208

new carts, 204
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Files
added to carts, 205
copying from file server, 200
copying to file server, 198
synchronizing, 325
Final Manager module, 196
Folders
adding a common folder to a station, 55
adding a new folder to a station, 54
FTP Server module
configuring, 357
menu bar, 353
quick tour, 352
starting, 351
tool bar, 355
FTP Server, starting and stoppping, 357

G

General configuration settings
Audio Server module, 74
Import-Merge module, 275
Stinger module, 398
Studio Client module, 148

GETFILLFILES macro, 441

GETPROGRAMLOGS macro, 442

GETVOICETRACKS macro, 442

H

Hot Key pages
loading from file server, 175
navigating, 175
refreshing, 175
saving, 175
Hot Key sets
adding items, 405
loading into Stinger module, 403
playing items, 409
Hot Keys
adding an event, 168
list of events, 171
properties, 172
rotating, 169

Index

1/0 card device profile, adding, 339
Import formats configuration settings, 277
Importing
music log, 265
third-party logs, 273
traffic log, 291
Import-Merge module
adding audio files using file library, 295
adding new program log events, 297
block marker configuration settings, 284
changing cue types for program log events, 298
configuring, 274
editing program log events, 298
exporting program log for third-party applications,
294
exporting program log to file server, 293
general configuration settings, 275
import formats configuration settings, 277
importing music log, 265
importing traffic log, 291
log type configuration settings, 280
menu bar, 268
quick tour, 267
replacing text configuration settings, 286
starting, 266
tool bar, 271
Info Editor module
quick tour, 305
starting, 304
Inserting voicetracks into program log, 184
Installing
OpX, 25
OpX system requirements, 24
USB registration key, 35
Intro times, 313
Item properties, Stinger module, 411
Items
deleting, 414
listing, 413
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Limiting station profiles, 348
List of macros, 429
Listing items, 413
Loading
audio events into the Voicetrack Editor, 179
Hot Key pages from the file server, 175
Hot Key sets into the Stinger module, 403
program log, 129, 162
LOADLOG macro, 443
LOADLOGFROMSERVER macro, 444
LOADSCHED macro, 444
LOADSCHEDULEDEVENTS macro, 445
LOADTRIGGERS macro, 446
Local audio file tagging info, 208
Local files added to carts, 205
Log type configuration settings, 280
Logs
importing music, 265

importing traffic, 291

Macros, 428
ADDTORUNLOG, 431
APPLICATION, 432
ATTIME, 432
AUTOFILLENABLE, 433
CHANNELRELAY, 433
CLEARSYNC, 434
CLOSURE, 434
COMMENT, 435
COMMERCIALBREAKBEGIN, 436
COMMERCIALBREAKEND, 437
CONSOLEOUT, 437
DECKTIMER, 438
DEVICE, 439
FADECURRENT, 440
FADEOUTLASTITEM, 440
GETFILLFILES, 441
GETPROGRAMLOGS, 442
GETVOICETRACKS, 442
list, 429

Index

LOADLOG, 443
LOADLOGFROMSERVER, 444
LOADLOGSCHED, 444
LOADSCHEDULEDEVENTS, 445
LOADTRIGGERS, 446
MIXFADE, 447
MIXVOLUME, 448
MODE, 449
PADENABLE, 450
PADOUT, 450
PAUSE, 451
PLAYASYNC, 451
PLAYTIMESHIFT, 452
RECORD, 453
RELAY, 455
RESETCART, 456
RUNAPPLICATION, 457
SATSHOW, 458
SATSHOWTIMER, 459
SAVEPROGRAMLOG, 457
SCHED, 460
SCHEDULEDEVENTS, 461
SENDPAD, 462
SERIALOUT, 462
START, 463
STARTDECK, 463
STARTENABLE, 464
STARTNEXT, 464
STEPTHROUGH, 465
STOP, 466
STOPDECK, 466
SYNCRECORDSFOLDER, 467
SYNCRUNLOGSFOLDER, 467
TCPOUT, 468
TIMEDBLOCKEND, 470
TIMEDBLOCKSTART, 469
TIMEEVENTS, 471
TIMESCALEITEM, 472
TRIGGERS, 473
TRIM, 474

Matching users with OpX modules, 17

Menu bar
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Allow Stations module, 346
Clock Builder module, 223
Data Repeater module, 373
File Audio Server module, 64
File Audio Server Watchdog module, 421
File Serial Device Server module, 329
File Server module, 47
File Sync module, 319
FTP Server module, 353
Import-Merge module, 268
Mobile Gateway/Client module, 387
Stinger module, 394
UMix, 362
Mixer layouts
creating, 367
opening, 369
Mixers
configuration settings for Audio Server module, 112
creating and editing for Audio Server module, 112
MIXFADE macro, 447
MIXVOLUME macro, 448
Mobile Gateway/Client module
configuring, 389
menu bar, 387
quick tour, 386
starting, 384
tool bar, 388
Mobile Gateway/Client, starting and stoppping, 390
Mode and log configuration settings, Audio Server
module, 122
Mode configuration settings, Studio Client module, 152
MODE macro, 449
Modifying current authorization code, 42
Moving events in program log, 166
Multi-hour satellite show
clocks, 256

example, 261

N

Navigating Hot Key pages, 175
Network interface and port, Data Repeater module, 382

New events, adding, 297

Index

0,

Opening mixer layouts, 369
Operating modes for Studio Client module, 159
OpX modules

Allow Stations, 342

AS Watchdog, 418

Audio Server, 60

Aucxiliary Audio Server, 134

Clock Builder, 219

Data Repeater, 370

descriptions, 16

File Manager, 189

File Server, 44

File Sync, 316

FTP Server, 350

Import-Merge, 265

Info Editor, 303

matching users, 17

Mobile Gateway/Client, 383, 428

Remote Voice Track Transfer, 59

Serial Device Server, 326

Stinger, 391

Studio Client, 136

UMix, 359

PADENABLE macro, 450
PADOUT macro, 450
PAUSE macro, 451
PLAYASYNC macro, 451
Playback configuration settings
Audio Server module, 77
Stinger module, 400
Studio Client module, 154
Playback tab, Audio Server module, 67
Playing back
items from the program log, 133
program log, 164
Playing items in a Hot Key set, 409
PLAYTIMESHIFT macro, 452
Previewing voicetracks, 182

Production workstation configuration, 23
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Index

Program log RECORD macro, 453
adding events, 165, 297 Record tab, Audio Server module, 68
adding items, 130 Recording
changing event cue types, 298 satellite show, 256
copying events, 167 voicetracks, 180
deleting items, 133 Refreshing Hot Key pages from the file server, 175
display on Audio Server module, 71 Registering the OpX system, 41
editing, 165 Registration key, 35
editing events, 298 RELAY macro, 455
editing items, 132 Remote Voice Track Transfer module, 59
exporting for third-party applications, 294 Removing
exporting to file server, 293 events to program log, 166
inserting voicetracks, 184 Replacing text configuration settings, 286
loading, 129, 162 Requirements for importing third-party logs, 273
moving events, 166 RESETCART macro, 456
playing back, 164 Robust multi-station configuration, 22
playing back items, 133 Rotating Hot Keys, 169
removing events, 166 RUNAPPLICATION macro, 457
verifying, 161 Running automation reports, 217
Properties, Hot Keys, 172
S
Q Sample clocks, 258
Quick tour background recording, 260
Allow Stations module, 345 multi-hour satellite show, 261
Audio Server module, 63 satellite music show, 259
Audio Server Watchdog module, 420 satellite talk show with top-of-the-hour news, 258
Clock Builder module, 222 time-shift playback, 261
Data Repeater module, 372 utility tasks without satellite show audio, 264
File Manager module, 191 Satellite
File Server module, 46 adding show start event, 245
File Sync module, 318 background recording example, 260
FTP Server module, 352 commercial break event, 247
Import-Merge module, 267 creating show start event, 233
Info Editor module, 305 custom event, 252
Mobile Gateway/Client module, 386 multi-hour satellite show example, 261
Serial Device Server module, 328 multi-hour show clocks, 256
Stinger module, 393 music show example, 259
Studio Client module, 138 record show, 256
UMix, 361 stop satellite show event, 254

talk show with top-of-the-hour news, 258

R

time-shift playback example, 261

Record configuration settings, Audio Server module, 82 time-shifting show, 256
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utility tasks without satellite show audio example,
264
SATSHOW macro, 458
SATSHOWTIMER macro, 459
SAVEPROGRAMLOG macro, 457
Saving
carts, 301
Hot Key pages, 175
SCHED macro, 460
Scheduled event set configuration settings, Audio Server
module, 118
SCHEDULEDEVENTS macro, 461
Segue
start points, 183
times, 313
SENDPAD macro, 462
Serial device profile, adding, 333
Serial Device Server module
configuring, 332
menu bar, 329
quick tour, 328
starting, 327
tool bar, 330
Serial server configuration settings, Stinger module, 401
SERIALOUT macro, 462
Simple multi-station configuration, 21
Single workstation/single station configuration, 19, 20
START macro, 463
STARTDECK macro, 463
STARTENABLE macro, 464
Starting
data repeater, 382
FTP Server, 357
Mobile Gateway/Client, 390
OpX modules
Allow Stations, 343
Audio Server, 61
Audio Server Watchdog, 419
Aucxiliary Audio Server, 135
Clock Builder, 220
Data Repeater, 371
File Manager, 190

Index

File Server, 45
File Sync, 317
FTP Server, 351
Import-Merge, 266
Info Editor, 304
Mobile Gateway/Client, 384
Serial Device Server, 327
Stinger, 392
Studio Client, 137
UMix, 360
STARTNEXT macro, 464
Station Folder List, File Server module, 50
Station profiles, limiting, 348
Stations
adding a common folder, 55
adding a folder, 54
adding to a file server, 52
Status tab, Audio Server module, 69
STEPTHROUGH macro, 465
Stinger deck
configuring, 416
Stinger module
configuring, 397
configuring item properties, 411
decks, 415
general configuration settings, 398
menu bar, 394
playback configuration settings, 400
quick tour, 393
serial server configuration settings, 401
starting, 392
STOP macro, 466
Stop Satellite show event, creating, 254
STOPDECK macro, 466
Stopping
data repeater, 382
FTP Server, 357
Mobile Gateway/Client, 390
Studio Client module
audio/cue configuration settings, 157
configuring, 146

general configuration settings, 148
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mode configuration settings, 152

operating modes, 159

playback configuration settings, 154

quick tour, 138

starting, 137

verifying program log, 161

voicetracking configuration settings, 155
Studio Client, changing appearance, 185
Synchronizing files, 325
SYNCRECORDSFOLDER macro, 467
SYNCRUNLOGSFOLDER macro, 467

System requirements, 24

TCPOUT macro, 468
Third-party log import requirements, 273
TIMEDBLOCKEND macro, 470
TIMEDBLOCKSTART macro, 469
TIMEEVENTS macro, 471
TIMESCALEITEM macro, 472
Time-shift
playback example, 261
satellite show, 256
Tool bar
Allow Stations Module, 347
Clock Builder module, 225
Data Repeater module, 374
File Serial Device Server module, 330
File Server module, 49
File Sync module, 321
FTP Server module, 355
Import-Merge module, 271
Mobile Gateway/Client module, 388
UMix, 364
Trigger set configuration settings, Audio Server module,
109
TRIGGERS macro, 473

Index

TRIM macro, 474

UMix
menu bar, 362
quick tour, 361
starting, 360
tool bar, 364
USB registration key, 35
Utility tasks without satellite show audio, 264

\'

Verifying program log, 161
Virtual Audio Server, enabling or disabling, 57
Voicetrack Editor
creating voicetracks, 179
ducking levels, 183
inserting voicetracks into program log, 184
interface, 178
loading audio events, 179
previewing voicetracks, 182
recording voicetracks, 180
seque start points, 183
Voicetrack Transfer module, enabling or disabling, 58
Voicetracking configuration settings
Studio Client module, 155
Voicetracks
creating, 179
ducking levels, 183
inserting into program log, 184
previewing, 182
recording, 180

seque start points, 183

X

XDS receiver profile, adding, 337
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